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Overview of this manual
About this manual

RobotStudio is a PC application for modeling, offline programming, and simulation
of robot cells. This manual describes how to create, program and simulate robot
cells and stations using RobotStudio. This manual also explains the terms and
concepts related to both offline and online programming.

Usage
This manual should be used when working with the offline or online functions of
RobotStudio.

Who should read this manual?
This manual is intended for RobotStudio users, proposal engineers, mechanical
designers, offline programmers, robot technicians, service technicians, PLC
programmers, Robot programmers, and Robot System integrators.

Prerequisites
The reader should have basic knowledge of:

• Robot programming
• Generic Windows handling
• 3D CAD programs

Organization of chapters
The operating manual is structured in the following chapters:

ContentsChapter

Contains installation instructions, basic explana-
tions of the terms and concepts related to robotics
and programming, and a description of the GUI.

Introduction toRobot-
Studio on page 25

1

Describes how to build stations in RobotStudio.
This includes importing and configuring the equip-
ment to be simulated, as well as testing the reach-
ability for finding the optimal station layout.

Building stations on
page 83

2

Describes how to create robot movements, I/O
signals, process instructions and logics in a RAPID
program for the robots. It also describes how to run
and test the program.

Programming robots
on page 109

3

Describes how to simulate and validate robot pro-
grams.

Simulating programs
on page 145

4

Describes how to transfer systems between Robot-
Studio’s virtual controllers and real IRC5 control-
lers, how to copy programs, how to package an
active station for moving between RobotStudio
PCs, and how to capture a screen.

Deploying and distrib-
uting on page 141

5

Covers the functionality of the Minimal Installation,
describing such online functions as building sys-
tems (with offline examples), handling I/O and
events, and configuring systems.

Working online on
page 155

6

Continues on next page
Operating manual - RobotStudio 13
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

Overview of this manual



ContentsChapter

Describes the options to create new station, create
new robot system, connect to a controller, save
station as viewer, and RobotStudio options.

File tab on page 2097

Describes the controls required for building sta-
tions, creating systems, programming paths and
placing items.

Home tabonpage2258

Describes the controls for creating and grouping
components, creating bodies, measurements and
CAD operations.

Modeling tab on
page 281

9

Describes the controls for setting up, configuring,
controlling, monitoring, and recording simulations.

Simulation tab on
page 349

10

Describes the controls for managing a real control-
ler and also the controls for synchronization, con-
figuration and tasks assigned to the virtual control-
ler (VC).

Controller tab on
page 379

11

Describes the features of the RAPID editor, man-
agement of RAPID files and other controls for
RAPID programming.

RAPID tab on
page 443

12

Describes the control for PowerPacs .Add-Ins tab on
page 475

13

Describes the options available from the context
menus.

Context menus on
page 483

14

Describes the ScreenMaker development tool, how
to manage projects in ScreenMaker and the various
menus and commands used in the application.

ScreenMaker tab on
page 539

15

References

Document IDReference

3HAC021313-001Product manual - IRC5
IRC5 of design M2004

3HAC047136-001Product manual - IRC5
IRC5 of design 14

3HAC050941-001Operating manual - IRC5 with FlexPendant

3HAC050947-001Technical reference manual - RAPID overview

3HAC050948-001Technical reference manual - System parameters

3HAC050961-001Application manual - MultiMove

3HAC050991-001Application manual - Conveyor tracking

3HAC050974-001Application manual - SafeMove

3HAC050996-001Application manual - Electronic Position Switches

3HAC044251-001Application manual - Integrated Vision

Note

The document numbers that are listed for software documents are valid for
RobotWare 6. Equivalent documents are available for RobotWare 5.

Continues on next page
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Revisions

DescriptionRevision

First revision, called RobotStudio 2008, released for Partner Days. The
entire manual has been adapted to the new GUI, in which RobotStudioOn-
line has been integrated.

A

Released with RobotStudio 5.12.B
The following updates were made in the manual:

• Conveyor Tracking on page 376
• Create Conveyor on page 338
• Conveyor Simulation on page 377
• Two robot systems sharing the same task frame position
• Two robot systems having different task frame positions.
• Creating a system with external axes automatically on page 87
• Track motion of type RTT or IRBTx003 on page 90
• Track motion of type IRBTx004 on page 91
• The Operator Window on page 65
• Station Viewer on page 215
• Recording the simulation on page 375
• Viewpoint
• Linked Geometry on page 507

Released with RobotStudio 5.13.C
• Merged chapters The Offline tab and The Online tab
• Added the missing information from RobotStudio Online manual.
• Integrated ScreenMaker. See ScreenMaker on page 386.

Added the following new content:
• Smart Component on page 284
• The Simulation Watch window on page 314
• The Documents window on page 67
• Station Logic on page 359
• Simulation Setup on page 351

Updated the changes related to handling Task Frames.
• Updated Modifying Task frame on page 439.
• Added Placing robots on page 106.
• Updated Creating a system from layout on page 228.

Released with RobotStudio 5.13.02.D
The ScreenMaker tutorial was updated. See Tutorial on page 576 .

Released with RobotStudio 5.14.E
• Added The Controller Status window on page 63.
• Updated the sectionsSimulation Setup on page351 andSimulation

Control on page 361.
• MovedRAPIDWatch window on page472 to the chapterCommon

features in Online and Offline tabs.
• Updated The Documents window on page 67 (added Station

mode).
• UpdatedCreating and loading aStationViewer on page215 (Record

to Viewer)
• Added Jog Reorient on page 269.
• Added The 3D View group.
• Updated The Compose tab on page286 (added Export to XML and

updated Base Component menu).

Continues on next page
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DescriptionRevision
• Updated Coordinate systems on page 33 (improved task frame

description).
• Updated Supported 3D formats on page 42 .

Added the following new content:
• AutoPath on page 248
• Online Monitor on page 418
• Adjust Robtargets on page 462
• Using the RAPID Profiler on page 468
• Markup
• Signal Analyzer on page 366
• External Axis Interpolation on page 497
• Auto Configuration on page 487
• The Design tab on page 295

The following are the ScreenMaker updates:
• Added ScreenMaker Doctor on page 570.
• Added new controls VariantButton on page 553 and Conditional-

Trigger on page 554.
• Updated Creating a new project on page 547 (added pre-defined

templates).
• UpdatedController object data binding on page568 (added inform-

ation on shared data).

Released with RobotStudio 5.14.02.F
Added the following new content:

• Gearbox Heat Prediction
• External Axis Wizard on page 231

Added the following new contents in Settings tab:
• Selecting a Task on page 262
• Selecting a Workobject on page 263
• Selecting a Tool on page 264

UpdatedCreating bootmedia on page178 (added information on creating
a new system)
Added information on Logic Expression in Signals and Properties on
page 296
Added a Note for Call .Net Method in Designing screens on page 549 of
the ScreenMaker tab
Added information on I-start in Result on page 174 for the Modifying a
system section
Added information on Offs in the Note for Prerequisites on page 462 in
Using Adjust Robtargets
Added a Note for the Execute button in Using Adjust Robtargets on
page 462
Added information on Always on top in Create Markup of the Markup
section
Updated Note for Using ScreenMaker Doctor inScreenMaker Doctor on
page 570

Released with RobotStudio 5.14.02.01.G
Updated the section Activating a network license on page 47.

Released with RobotStudio 5.14.03.H
Added a note regarding the usage of .NET DLLs underAdvanced Actions
on page 555
Added scenarios in Errors fixed by ScreenMaker Doctor on page 570
Updated the procedure in Creating Markup

Continues on next page
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DescriptionRevision
Updated the note in Prerequisites on page 462 for Adjust Robtargets
Updated the procedure for Using Adjust Robtargets on page 462
Updated the table under LogicExpression for Signals and Properties on
page 296
Added a procedure for adding events to a menu item underCommandBar
on page 553
Updated the details for Creating autopath under AutoPath on page 248
Updated the table showing the Supported 3D formats on page 42

Released with RobotStudio 5.15.J
In addition to the following important updates, numerous minor im-
provements and corrections have been made throughout the docu-
ment.
Introduced the following new chapters containing both new features and
also updated features;

• Controller tab on page 379, which contain features related to real
and virtual controllers.

• RAPID tab on page443, which contains features related to RAPID
programming.

Added the following new content:
• Edit RAPID data on page 455
• Transfer on page 400
• Stopwatch on page 365
• Go to Visualization and Go to Declaration on page 501
• Offset Position on page 523
• Protected Smart Component on page 526

Updated, reworked the following sections:
• Edit RAPID code on page 446
• RAPID Watch window on page 472
• Installing and licensing RobotStudio on page 44
• Virtual controller on page 92
• Screen Capture on page 143
• Pack and Go on page 213 and Unpack and Work on page 214

Released with RobotStudio 5.15.01.K
• Added section What is RAPID array on page 574.
• Added a sample code snippet to the advanced option Call .Net

Method. SeeAdvanced Actions on page 555.
• Added an advanced optionCall FP Standard View. SeeAdvanced

Actions on page 555.
• Added a note in the section Controller object data binding on

page 568.
• Renamed the section ScreenMaker Doctor scenarios as Errors

fixed by ScreenMaker Doctor and made some updates. SeeErrors
fixed by ScreenMaker Doctor on page 570.

Released with RobotStudio 5.60.L
• Removed all instances of VSTA, Import of S4 stations and Defea-

turing and updated the ScreenRecorder section.
• Updated the information on Backup and save in Controller grants

on page 427.
• Updated the section Working online on page155 with information

on the new main computer DSQC1000.
• Updated the section Overview on page 514.
• Updated the section Adjust Robtargets on page 462.

Continues on next page
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DescriptionRevision
• Added a new section Visualizing Safety Zones in Online Monitor

on page 419 in Online Monitor.
• Updated the section AutoPath on page 248.
• Added a new section Graphics Tools on page 271.
• Added a new section Tags on page 316.

Released with RobotStudio 5.61.M
• Added description about the General tab in Modifying Project

properties on page 557 in ScreenMaker chapter.
• Added a new section Creating Production Screen Widget on

page 561 in ScreenMaker chapter.
• Added a note in the section General keyboard shortcuts on

page 78.
• Updated the section Supported 3D formats on page 42.
• Updated the prerequisites in the sectionScreenMaker on page386.

Released with RobotStudio 6.0.N
• Added a new section on Jobs on page 431.
• Added a new section on About Installation Manager on page183.
• Added a new section on Zone visualization on page 502.
• Added a new section on Zone visualization on page 502.
• Added a new section on RobotStudio Solutions on page 209.
• Added a new section on RobotApps on page 476.
• Added a new section on Visual SafeMove on page 420.
• Updated the section Installing and licensing RobotStudio on

page 44.

Released with RobotStudio 6.01.P
• Added a new section on Work envelope on page 492.
• Added a new section on I/O Signal Data Editor on page 385.
• Added a new section on Windows layout on page 61.
• Added a new table for Supported RobotWare 6 configurations for

positioners, motor units, gear units and track motions on page88.
• Added a new section on 3D Mouse on page 75.
• Added a new section on Automatic transparency on page 273.

Released with RobotStudio 6.02.Q
• Added a new section on Shallow rectangle selection on page317.
• Added following sections about conveyor tracking.

- Create connection between virtual controller and conveyor
on page 339

- Modifying the connection between VC and conveyor on
page 230

- Removing objects from conveyor on page 230
- Create Conveyor on page 338

Released with RobotStudio 6.03R
• Added a section about Renaming a system on page 193
• Added a section about RAPID Breakpoints window on page 470
• Added a section about RAPID Call Stack window on page 471
• Added a section about Setting the IP address of the controller on

page 415
• Added a section about Collision Avoidance on page 406
• Added a section about Selected tasks on page 465
• Added a section about Calibrating the baseframe position on

page 441

Continues on next page
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DescriptionRevision
• Added a section about Settings file on page 184

Released with RobotStudio 6.03.01.S
• Updated the section Network security on page 23.
• Updated information about the default user in UAS, see User Au-

thorization on page 162

Released with RobotStudio 6.04.T
• Added a new section on Options:General:Autosave on page 218.
• Added a section aboutOptions:Graphics:Stereo/VR* on page223
• Added a section about Four Bar joint on page 342
• Updated information about the TCP Trace, see The TCP Trace

tab on page 364.
• Added a new section on Gravity parameters in online monitor on

page 418.
• Updated information about the Supported actions in Jobs, see

Supported actions on page 433.
• Added a new section on Jobs with several actions on page 434.
• Added a new section on Running job from the Command Prompt

window on page 435.
• Updated the section Edit RAPID code on page 446.

Released with RobotStudio 6.05.U
• Added a new section onDeployment packages and the repository

on page 183.
• Added a section The recovery disk function on page 196.
• Added a section Instruction Template Manager on page 261.
• Added a section Virtual Reality on page 274.
• Added a new section on Physics Tools on page 347.
• Added a new section on RobotApps on page 476.
• Minor updates in the following sections.

- Options on page 217
- Configurations on page 487
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Product documentation, IRC5
Categories for user documentation from ABB Robotics

The user documentation from ABB Robotics is divided into a number of categories.
This listing is based on the type of information in the documents, regardless of
whether the products are standard or optional.
All documents listed can be ordered from ABB on a DVD. The documents listed
are valid for IRC5 robot systems.

Product manuals
Manipulators, controllers, DressPack/SpotPack, and most other hardware is
delivered with a Product manual that generally contains:

• Safety information.
• Installation and commissioning (descriptions of mechanical installation or

electrical connections).
• Maintenance (descriptions of all required preventive maintenance procedures

including intervals and expected life time of parts).
• Repair (descriptions of all recommended repair procedures including spare

parts).
• Calibration.
• Decommissioning.
• Reference information (safety standards, unit conversions, screw joints, lists

of tools).
• Spare parts list with exploded views (or references to separate spare parts

lists).
• Circuit diagrams (or references to circuit diagrams).

Technical reference manuals
The technical reference manuals describe reference information for robotics
products.

• Technical reference manual - Lubrication in gearboxes: Description of types
and volumes of lubrication for the manipulator gearboxes.

• Technical reference manual - RAPID overview: An overview of the RAPID
programming language.

• Technical referencemanual - RAPID Instructions, Functions and Data types:
Description and syntax for all RAPID instructions, functions, and data types.

• Technical reference manual - RAPID kernel: A formal description of the
RAPID programming language.

• Technical reference manual - System parameters: Description of system
parameters and configuration workflows.

Continues on next page
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Application manuals
Specific applications (for example software or hardware options) are described in
Application manuals. An application manual can describe one or several
applications.
An application manual generally contains information about:

• The purpose of the application (what it does and when it is useful).
• What is included (for example cables, I/O boards, RAPID instructions, system

parameters, DVD with PC software).
• How to install included or required hardware.
• How to use the application.
• Examples of how to use the application.

Operating manuals
The operating manuals describe hands-on handling of the products. The manuals
are aimed at those having first-hand operational contact with the product, that is
production cell operators, programmers, and trouble shooters.
The group of manuals includes (among others):

• Operating manual - Emergency safety information
• Operating manual - General safety information
• Operating manual - Getting started, IRC5 and RobotStudio
• Operating manual - IRC5 Integrator's guide
• Operating manual - IRC5 with FlexPendant
• Operating manual - RobotStudio
• Operating manual - Trouble shooting IRC5
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Safety
Safety of personnel

A robot is heavy and extremely powerful regardless of its speed. A pause or long
stop in movement can be followed by a fast hazardous movement. Even if a pattern
of movement is predicted, a change in operation can be triggered by an external
signal resulting in an unexpected movement.
Therefore, it is important that all safety regulations are followed when entering
safeguarded space.

Safety regulations
Before beginning work with the robot, make sure you are familiar with the safety
regulations described in the manualOperatingmanual - General safety information.
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Network security
Network security

This product is designed to be connected to and to communicate information and
data via a network interface, It is your sole responsibility to provide and continuously
ensure a secure connection between the product and to your network or any other
network (as the case may be). You shall establish and maintain any appropriate
measures (such as but not limited to the installation of firewalls, application of
authentication measures, encryption of data, installation of anti-virus programs,
etc) to protect the product, the network, its system and the interface against any
kind of security breaches, unauthorized access, interference, intrusion, leakage
and/or theft of data or information. ABB Ltd and its entities are not liable for
damages and/or losses related to such security breaches, any unauthorized access,
interference, intrusion, leakage and/or theft of data or information.
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1 Introduction to RobotStudio
1.1 What is RobotStudio

RobotStudio is a PC application for modeling, offline programming, and simulation
of robot cells.
RobotStudio allows you to work with an off-line controller, which is a virtual IRC5
controller running locally on your PC. This offline controller is also referred to as
the virtual controller (VC). RobotStudio also allows you to work with the real physical
IRC5 controller, which is simply referred to as the real controller.
When RobotStudio is used with real controllers, it is referred to as the online mode.
When working without being connected to a real controller, or while being connected
to a virtual controller, RobotStudio is said to be in offline mode.
RobotStudio offers the following installation options:

• Complete
• Custom, allowing user-customized contents and paths
• Minimal, allowing you to run RobotStudio in online mode only.
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1.2 Terms and concepts

1.2.1 Hardware concepts

Overview
This section introduces the hardware in a typical IRC5 robot cell. For detailed
explanations, see the manuals related to IRC5 robots specified in References on
page 14.

Standard hardware
The table below describes the standard hardware in an IRC5 robot cell.

ExplanationHardware

An ABB industrial robot.Robot manipulator

Contains the main computer that controls the motion of the
manipulator. This includes RAPID execution and signal hand-
ling. One control module can be connected to 1 – 4 drive
modules.

Control module

A module containing the electronics that power the motors of
a manipulator. The drive module can contain up to nine drive
units, each controlling one manipulator joint. Since the standard
robot manipulators have six joints, you usually use one drive
module per robot manipulator.

Drive module

The controller cabinet for the IRC5 robots. It consists of one
control module and one drive module for each robot manipulat-
or in the system.

FlexController

The programming pendant, connected to the control module.
Programming on the FlexPendant is referred to as “online
programming”.

FlexPendant

A device usually mounted on the robot manipulator to allow it
to perform specific tasks, such as gripping, cutting or welding.

Tool

The tool can also be stationary, see below for more information.

Optional hardware
The table below describes the optional hardware for an IRC5 robot cell.

ExplanationHardware

A moving stand holding the robot manipulator to give it a larger
work space. When the control module controls the motion of
a track manipulator, it is referred to as a “Track External Axis”.

Track manipulator

A moving stand normally holding a work piece or a fixture.
When the control module controls the motion of a positioner
manipulator, it is referred to as an “External Axis”.

Positioner manipulator

A second robot manipulator acting as a positioner manipulator.
It is controlled by the same control module as the positioner
manipulator.

FlexPositioner

A device that stands in a fixed location. The robot manipulator
picks up the work piece and brings it to the device to perform
specific tasks, such as gluing, grinding or welding.

Stationary tool

The product being worked on.Work piece

Continues on next page
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ExplanationHardware

A construction holding the work piece in a specific position so
that the repeatability of the production can be maintained.

Fixture
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1.2.2 RobotWare concepts

Overview
This section introduces terminology regarding RobotWare. For detailed
explanations, see the manuals related to IRC5 robots specified in References on
page 14.

RobotWare
The table below describes the RobotWare terminology and concepts that can be
useful when working with RobotStudio.

ExplanationConcept

As a concept, refers to both the software used to create a Ro-
botWare System and the RobotWare systems themselves.

RobotWare

When installing RobotStudio, only one version of RobotWare
will be installed. To simulate a specific RobotWare system, the
RobotWare version used for this particular RobotWare system
must be installed on your PC.

RobotWare installation

RobotWare 5 is installed into the PC’s program files folder using
a standard PC installer. RobotWare 6 is automatically installed
for the Complete installation option of RobotStudio. Alternat-
ively, use the RobotApps page in the Add-Ins tab to install
RobotWare 6.

Used when you create a new RobotWare system or upgrade
an existing system. The RobotWare keys unlock the RobotWare
options included in the system, and determine the RobotWare
version from which the RobotWare system will be built.

RobotWare Key

For IRC5 systems there are three types of RobotWare keys:
• The controller key, which specifies the controller and

software options.
• The drive keys, which specify the robots in the system.

The system has one drive key for each robot it uses.
• add-ins specify additional options, like positioner extern-

al axes.
A virtual key allows you to select any RobotWare options you
wish, but a RobotWare system created from a virtual key can
only be used in a virtual environment such as RobotStudio.

A set of software files that, when loaded into a controller, en-
ables all functions, configurations, data and programs con-
trolling the robot system.

RobotWare system

RobotWare systems are created in the RobotStudio software.
The systems can be stored and saved on a PC, as well as on
the control module.
RobotWare systems can be edited by RobotStudio or the
FlexPendant.

Each RobotWare is released with a major and a minor version
number, separated by a dot. The RobotWare version for IRC5
is 6.xx, where xx identifies the minor version.

RobotWare version

When ABB releases a new robot model, a new RobotWare
version will be released with support for the new robot.

Continues on next page
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ExplanationConcept

For RobotWare 5, the mediapool is a folder on the PC in which
each RobotWare version is stored in a folder of its own.

Mediapool

The files of the mediapool are used to create and implement
all the different RobotWare options. Therefore, the correct
RobotWare version must be installed in the mediapool when
creating RobotWare systems or running them on virtual con-
trollers.

A RobotWare add-in is a self-contained package that extends
the functionality of a robot system. RobotWare add-ins are the
RobotWare 6 equivalent of RobotWare 5 additional options.

RobotWare Add-In

In the context of RobotWare 6, a product can be either a Robot-
Ware version or a RobotWare add-in. Products can be free or
licensed.

Product

The license unlocks the options you can use in your robot
system, for example robots and RobotWare options.

License

If you wish to upgrade from RobotWare version 5.15 or earlier,
you must replace the controller main computer and get Robot-
Ware 6 licenses. Contact your ABB Robotics service represent-
ative at www.abb.com/contacts.

A Distribution package may contain RobotWare and RobotWare
add-ins. RobotWare 6 Distribution package also contains Ro-
botWare Add-Ins for Positioners and TrackMotion. For more
information, see Distribution package on page 477.

Distribution package
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1.2.3 RAPID concepts

Overview
This section introduces the basic terminology of RAPID. The manuals related to
RAPID and programming are listed in References on page 14.

Terminology of the RAPID structure
The table below describes the RAPID terminology that you may come across when
working with RobotStudio. The concepts are listed by size, from most basic to
increasingly large.

ExplanationConcept

Used to create instances of variables or data types, like num
or tooldata.

Data declaration

The actual code commands that make something happen, for
example, setting data to a specific value or a robot motion. In-
structions can only be created inside a routine.

Instruction

Create the robot motions. They consist of a reference to a target
specified in a data declaration along with parameters that set
motion and process behavior. If inline targets are used, the
position is declared in the move instructions.

Move instructions

Instructions that perform other actions than moving the robot,
such as setting data or sync properties.

Action instruction

Usually a set of data declarations followed by a set of instruc-
tions implementing a task. Routines can be divided into three
categories: procedures, functions and trap routines.

Routine

A set of instructions that does not return a value.Procedure

A set of instructions that returns a value.Function

A set of instructions that is triggered by an interrupt.Trap

A set of data declarations followed by a set of routines. Modules
can be saved, loaded and copied as files. Modules are divided
into program modules and system modules.

Module

Can be loaded and unloaded during execution.Program module (.mod)

Used mainly for common system-specific data and routines,
for example, an arcware system module that is common for all
arc robots.

System module (.sys)

In IRC5 a RAPID program is a collection of module files (.mod)
and the program file (.pgf.) that references all the module files.
When loading a program file, all old program modules are re-
placed by those referenced in the .pgf file. System modules
are unaffected by program load.

Program files (.pgf)
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1.2.4 Concepts of programming

Overview
This section introduces the terminology regarding programming. The manuals
related to programming and IRC5 Robots are listed in References on page 14.

Programming concepts
The table below describes the terminology and concepts that are used in robot
programming.

ExplanationConcept

Programming when connected to a real controller. This expres-
sion also implies using the robot to create positions and motion.

Online programming

Programming without being connected to the robot or the real
controller.

Offline programming

Refers to the ABB Robotics concept of connecting a simulation
environment to a virtual controller. This enables not only pro-
gram creation, but also program testing and optimizing offline.

True offline programming

A software that emulates a FlexController to allow the same
software (the RobotWare system) that is controlling the robots
to run on a PC. This gives the same behavior of the robots
offline as you get online.

Virtual controller

Running multiple robot manipulators with the same control
module.

MultiMove

Used to define positions and orientations. When programming
a robot, you can take advantage of using different coordinate
systems to more easily position objects relative to each other.

Coordinate systems

A synonym for coordinate system.Frame

If all your targets refer to workobjects, you only need to calib-
rate the workobjects when deploying offline programs.

Workobject calibration
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1.2.5 Targets and paths

Overview
Targets (positions) and paths (sequences of move instructions to targets) are used
when programming robot motions in RobotStudio.
When you synchronize the RobotStudio station to the virtual controller, RAPID
programs are created from the paths.

Targets
A target is a coordinate that the robot shall reach. It contains the following
information:

DescriptionInformation

The position of the target, defined in a workobject coordinate
system, see Coordinate systems on page 33.

Position

The orientation of the target, relative to the orientation of the
workobject. When the robot reaches the target, it will align the
TCP’s orientation with the target’s orientation, see Coordinate
systems on page 33.

Orientation

Configuration values that specify how the robot shall reach the
target. For more information, see Robot axis configurations on
page 39.

Configuration

Targets are converted to instances of the data type robtarget when synchronized
to the virtual controller.

Paths
A sequence of move instructions, paths are used to make the robot move along a
sequence of targets.
Paths are converted to procedures when synchronized to the virtual controller.

Move instructions
A move instruction consists of:

• a reference to a target
• motion data, such as motion type, speed and zone
• a reference to a tooldata
• a workobject reference

Action instructions
An action instruction is a RAPID string that can be used for setting and changing
parameters. Action instructions can be inserted before, after or between instruction
targets in paths.
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1.2.6 Coordinate systems

Overview
This section provides an introduction to the coordinate systems used mostly for
offline programming. In RobotStudio, you can either use the coordinate systems
(that are explained below) or the user-defined coordinated systems for co-relating
elements and objects.

Hierarchy
The coordinate systems are co-related hierarchically. The origin of each coordinate
system is defined as a position in one of its ancestries. The following are the
descriptions of the commonly used coordinate systems.

Tool Center Point Coordinate system
The tool center point coordinate system, also called TCP, is the center point of the
tool. You can define different TCPs for one robot. All robots have one predefined
TCP at the robot’s tool mounting point, called tool0.
When a program runs, the robot moves the TCP to the programmed position.

RobotStudio World Coordinate system
The RobotStudio world coordinate system represents the entire station or robot
cell. This is the top of the hierarchy to which all other coordinate systems are related
(when using RobotStudio).

Base Frame (BF)
The base coordinate system is called the Base Frame (BF). Each robot in the
station, both in RobotStudio and the real world has a base coordinate system which
is always located at the base of the robot.

Task Frame (TF)
The Task Frame represents the origin of the robot controller world coordinate
system in RobotStudio.
The following picture illustrates the difference between the base frame and the
task frame.

Continues on next page
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In the picture to the left, the task frame is located at the same position as the robot
base frame. In the picture to the right, the taskframe has been moved to another
position.

en1000001303

The following picture illustrates how a task frame in RobotStudio is mapped to the
robot controller coordinate system in the real world. For example, on the shop
floor.

en1000001304

World coordinate system in RobotStudioRS-WCS

World coordinate system as defined in the robot controller.RC-WCS
It corresponds to the task frame of RobotStudio.

Robot Base FrameBF

Tool Center PointTCP

Robot targetP

Task FrameTF

WorkobjectWobj

Continues on next page
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Stations with multiple robot systems
For a single robot system, RobotStudio’s task frame corresponds to the robot
controller world coordinate system. When several controllers are present in the
station, the task frame allows the connected robots to work in different coordinate
systems. That is, the robots can be located independent of each other by defining
different task frames for each robot.

en1000001442

World coordinate system in RobotStudioRS-WCS

Tool Center Point of robot 1TCP(R1)

Tool Center Point of robot 2TCP(R2)

Base Frame of robot system 1BF(R1)

Base Frame of robot system 2BF(R2)

Robot target 1P1

Robot target 2P2

Task Frame of robot system 1TF1

Task Frame of robot system 2TF2

WorkobjectWobj

Continues on next page
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MultiMove Coordinated systems
The MultiMove functions helps you create and optimize programs for MultiMove
systems where one robot or positioner holds the work piece and other robots
operate on it.
When using a robot system with the RobotWare option MultiMove Coordinated, it
is important that the robots are working in the same coordinate system. As such,
RobotStudio do not allow task frames of the controller to be separated.

en1000001305

en1000001306

World coordinate system in RobotStudioRS-WCS

Tool Center Point of robot 1TCP(R1)
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Tool Center Point of robot 2TCP(R2)

Base Frame of robot 1BF(R1)

Base Frame of robot 2BF(R2)

Base Frame of robot 3BF(R3)

Robot target 1P1

Task FrameTF

WorkobjectWobj

MultiMove Independent systems
For a robot system with the RobotWare option MultiMove Independent, robots
operate simultaneously and independently while being controlled by one controller.
Even though there is only one robot controller world coordinate system, robots
often work in separate coordinate systems. To allow this setup in RobotStudio, the
task frames for the robots can be separated and positioned independent of each
other.

en1000001308

World coordinate system in RobotStudioRS-WCS

Tool Center Point of robot 1TCP(R1)

Tool Center Point of robot 2TCP(R2)

Base Frame of robot 1BF(R1)

Base Frame of robot 2BF(R2)

Robot target 1P1

Robot target 2P2

Task Frame 1TF1

Task Frame 2TF2

WorkobjectWobj
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Workobject coordinate system
The workobject normally represents the physical work piece. It is composed of two
coordinate systems: the User frame and the Object frame, where the latter is a
child to the former. When programming a robot, all targets (positions) are related
to the object frame of a workobject. If no other workobject is specified, the targets
will be related to the default Wobj0, which always coincides with the base frame
of the robot.
Using workobjects provides the chance to easily adjust robot programs with an
offset, if the location of the work piece has been changed. Thus, workobjects can
be used for calibrating offline programs. If the placement of the fixture or work
piece relative to the robot in the real station does not completely match the
placement in the offline station, you simply adjust the position of the workobject.
Workobjects are also used for coordinated motion. If a workobject is attached to
a mechanical unit (and the system uses the option for coordinated motion), the
robot will find the targets in the workobject even when the mechanical unit moves
the workobject.
In the picture below the grey coordinate system is the world coordinate system,
and the black ones are the object frame and the user frame of the workobject. Here
the user frame is positioned at the table or fixture and the object frame at the
workpiece.

xx0500001519

User coordinate systems
User coordinate systems are used for creating reference points of your choice.
For example, you can create user coordinate systems at strategic points in the
work piece to simplify programming.
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1.2.7 Robot axis configurations

Axis configurations
Targets are defined and stored as coordinates in a WorkObject coordinate system.
When the controller calculates the position of the robot axes for reaching the target,
it will often find more than one possible solution to configuring the robot axes.

configur

To distinguish between the different configurations, all targets have a configuration
value that specifies the quadrant in which each axis shall be located.

Storing axis configurations in targets
For targets that are taught after jogging the robot to the position, the used
configuration will be stored in the target.
Targets created by specifying or calculating positions and orientations get a default
configuration value (0,0,0,0), which might not be valid for reaching the target.

Common problems related to robot axis configurations
It is most likely that targets created by other ways than jogging cannot be reached
at their default configuration.
Even if all targets in a path have validated configurations, you might encounter
problems when running the path if the robot cannot move from one configuration
to the other. This is likely to occur where an axis shifts greater than 90 degrees
during linear movements.
Repositioned targets keep their configuration, but the configurations are no longer
validated. As a result, the problems described above might occur when moving
targets.

Common solutions for configuration problems
To resolve the problems described above, you can assign a valid configuration to
each target and verify that the robot can move along each path. You can also turn
configuration monitoring off, which means that you ignore the stored configurations
and let the robot find working configurations at runtime. If this is not done the
proper way, you might get unexpected results.
In some cases there might not be any working configurations. Possible solutions
might then be to reposition the work piece, reorient targets (if acceptable for the
process) or add an external axis that either moves the work piece or the robot for
increasing reachability.

Continues on next page
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How configurations are denoted
The robot’s axis configurations are denoted by a series of four integers, specifying
in which quadrant of a full revolution significant axes are located. The quadrants
are numbered from zero for positive (counterclockwise) rotation and from -1 for
negative (clockwise) rotation.
For a linear axis, the integer specifies the range (in meters) from the neutral position
in which the axis is located.
A configuration for a six-axis industrial robot (like IRB 140) may look like:

[0-121]

The first integer (0) specifies the position of axis 1: somewhere in the first positive
quadrant (between 0 and 90 degrees rotation).
The second integer (-1) specifies the position of axis 4: somewhere in the first
negative quadrant (between 0 and -90 degrees rotation).
The third integer (2) specifies the position of axis 6: somewhere in the third positive
quadrant (between 180 and 270 degrees rotation).
The fourth integer (1) specifies the position of axis x, a virtual axis used for
specifying the wrist center in relation to other axes.

Configuration monitoring
When executing a robot program, you can choose whether to monitor configuration
values. If configuration monitoring is turned off, configuration values stored with
the targets are ignored, and the robot will use the configuration closest its current
configuration for reaching the target. If turned on, it will only use the specified
configuration for reaching the targets.
Configuration monitoring can be turned off and on for joint and linear movements
independently and is controlled by the ConfJ and ConfL action instructions.

Turning configuration monitoring off
Running a program without configuration monitoring may result in different
configurations each time a cycle is executed: When the robot returns to the start
position after completing a cycle, it may choose a different configuration then the
original.
For programs with linear move instructions this might cause a situation where the
robot gets closer and closer its joint limits and eventually will not be able to reach
the target.
For programs with joint move instructions this might cause sweeping, unpredictable
movements.

Turning configuration monitoring on
Running a program with configuration monitoring forces the robot to use the
configurations stored with the targets. This results in predictable cycles and
predictable motions. In some situations, however, like when the robot moves to a
target from an unknown position, using configuration monitoring may limit the
robot’s reachability.
When programming offline, you must assign a configuration to each target if the
program shall be executed with configuration monitoring.

40 Operating manual - RobotStudio
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

1 Introduction to RobotStudio
1.2.7 Robot axis configurations
Continued



1.2.8 Libraries, geometries and CAD files

Overview
For programming or simulating in RobotStudio, you need models of your work
pieces and equipment. Models for some standard equipment are installed as
libraries or geometries with RobotStudio. If you have CAD models of your work
pieces and custom equipment, these can be imported as geometries to RobotStudio.
If you do not have CAD models, you can create them in RobotStudio.

Difference between geometries and libraries
The objects you import to a station can be either geometries or libraries.
Geometries are basically CAD files, which, when imported, are copied to the
RobotStudio station.
Libraries are objects that have been saved in RobotStudio as external files. When
you import a library, a link from the station to the library file is created. Accordingly,
the station file does not grow in the same way as when importing geometries.
Furthermore, besides the geometrical data, library files can contain
RobotStudio-specific data. For example, if a tool is saved as a library, the tool data
is saved together with the CAD data.

How geometries are constructed
An imported geometry is displayed as one part in the Layout browser. From
RobotStudio’s Modeling tab, you can see the components of the geometry.
The top node of the geometry is called a Part. The part contains Bodies, which
can be of the types solid, surface or curve.
Solid bodies are 3D objects, made up of Faces. You recognize a true 3D solid by
this one body containing multiple faces.
Surface bodies are 2D objects of just one face. A part that contains several bodies
with one face each that together constitute a 3D object is created from 2D surfaces,
and is therefore not a true 3D solid. If these parts are not created correctly, they
might cause problems both in their display and graphical programming. see
Troubleshooting and optimizing geometries on page 96.
Curved bodies, represented by the body node alone in the Modeling browser, do
not contain any child nodes.
From the Modeling tab, you can edit the parts by adding, moving, rearranging or
deleting bodies. Thus, you can optimize existing parts by removing unnecessary
bodies, as well as create new parts by grouping bodies.
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Importing and converting CAD files
For importing geometries from single CAD files, you use RobotStudio’s import
function, see Importing a station component on page 94.

Note

RobotStudio retains assembly structures in the imported CAD part. For parts
with many entities, the import may take long. To workaround this problem, in the
Home tab, click Import Geometry and then select Convert CAD geometry to
single part.

Supported 3D formats
The native 3D CAD format of RobotStudio is SAT. The CAD support in RobotStudio
is provided by the software component ACIS release 2017 1.0.1.
RobotStudio also supports other formats for which you need an option. The
following table shows the supported formats and the corresponding options:

Option requiredFile extensionsFormat

-.3ds3DStudio

-.sat, .sab, .asat, .asabACIS, reads versions R1 -
2017 1.0, writes versions R18
- 2017 1.0

CATIA V4.model, .exp, .sessionCATIA V4, reads versions
4.1.9 to 4.2.4

CATIA V5.CATPart, .CATProduct,
.CGR, .3DXML

CATIA V5/V6, reads versions
V5R8 – V5/V6R2016
writes V5R15 – V5/V6R2016

-.daeCOLLADA 1.4.1

-.xDirectX writes 2.0

AutoCAD.dxf, .dwgDXF/DWG, reads versions
2.5 - 2016

-.fbxFBX writes version 7.5

IGES.igs, .igesIGES, reads up to version
5.3, writes version 5.3

Inventor.ipt, .iamInventor, reads V6 – 2017

JT.jtJT, reads versions 8.x and
9.x

-.ldr, .ldraw, .mpdLDraw, reads version 1.0.2

NX.prtNX, reads versions NX 1 –
NX 11

-.objOBJ

Parasolid.x_t, .xmt_txt, .x_b, .xmt_binParasolid, reads versions
9.0.* – 29.0.*

Pro/ENGINEER.prt, .prt.*, .asm, .asm.*Pro/E / Creo, reads versions
16 – Creo 3.0

SolidEdge.par, .asm, .psmSolid Edge, reads versions
V18 – ST9
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Option requiredFile extensionsFormat

SolidWorks.sldprt, .sldasmSolidWorks, reads versions
2003 – 2017 1

STEPstp, step, p21STEP, reads versionsAP203,
AP214, AP242 , writes ver-
sion AP214

-stlSTL, ASCII STL supported
(binary STL not supported)

VDA-FSvda, vdafsVDA-FS, reads 1.0 and 2.0,
writes 2.0

-wrl, vrml, vrml2VRML, reads VRML2 (VRML1
not supported)

1 indicates that from SolidWorks 2015 onwards only 64-bit Operating System is supported. 32-bit is not

supported.

To import these files into RobotStudio, use the Import Geometry function.

Mathematical versus graphical geometries
A geometry in a CAD file always has an underlying mathematical representation.
Its graphical representation, displayed in the graphics window, is generated from
the mathematical representation when the geometry is imported to RobotStudio,
after which the geometry is referred to as a part.
For this kind of geometry, you can set the detail level of the graphical representation,
thus reducing the file size and rendering time for large models and improving the
visual display for small models you might want to zoom in on. The detail level only
affects the visual display; paths and curves created from the model will be accurate
both with coarse and fine settings.
A part can also be imported from a file that simply defines its graphical
representation; in this case, there is no underlying mathematical representation.
Some of the functions in RobotStudio,such as snap mode and creation of curves
from the geometry, will not work with this kind of part.
To customize the detail level settings, see Options on page 217.
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1.3 Installing and licensing RobotStudio

1.3.1 Installation options and prerequisites

Prerequisites
You should have administrator privileges on the PC before installing RobotStudio.

Installation options
You can download RobotStudio from
http://new.abb.com/products/robotics/robotstudio/downloads, and install it.
RobotStudio offers the following installation options:

• Minimal - Installs only the features required to program, configure, and
monitor a real controller connected over Ethernet.

• Complete - Installs all the features required to run the complete RobotStudio.
If installed with this option, additional features of Basic and Premium
functionality are available.

• Custom - Installs user-customized features. This option allows excluding
unwanted robot libraries.

Note

Both the 32 and 64-bit versions of RobotStudio are installed for the Complete
installation option on computers that have a 64-bit operating system. The 64-bit
edition allows large CAD-models to be imported as it can address more memory
than the 32-bit version.
However, the 64-bit edition has the following limitations:

• ScreenMaker and Integrated Vision are not supported.
• Add-ins will be loaded from the following folder

C:\Program Files (x86)\ABB Industrial IT\Robotics

IT\RobotStudio 6.04\Bin64\Addins

Installing RobotWare
A matching RobotWare version will be installed with RobotStudio. You can download
and install additional RobotWare versions through RobotStudio when connected
to the Internet. In theAdd-Ins tab, clickRobotApps. The RobotWare section shows
the RobotWare versions available for downloading.
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1.3.2 Activating RobotStudio

RobotStudio feature levels
RobotStudio is categorized into the following two feature levels:

• Basic - Offers selected RobotStudio functionality to configure, program, and
run a virtual controller. It also includes online features for programming,
configuring, and monitoring a real controller connected over Ethernet.

• Premium - Offers full RobotStudio functionality for offline programming and
simulation of multiple robots. The Premium level includes the features of the
Basic level and requires activation. To purchase a Premium license, contact
your local ABB Robotics sales representative at www.abb.com/contacts.

The following table lists the features provided with Basic and Premium licenses.

PremiumBasicFeature

YesYesNecessary features for commissioning a real or virtual
robot1 , such as:

• System Builder
• Event Log Viewer
• Configuration Editor
• RAPID Editor
• Backup / Restore
• I/O Window

YesProductivity features, such as:
• RAPID Data Editor
• RAPID Compare
• Adjust robtargets
• RAPID Watch
• RAPID Breakpoints
• Signal Analyzer
• MultiMove tool
• ScreenMaker1,2

• Jobs

YesYesElementary offline features, such as:
• Open station
• Unpack & Work
• Run Simulation
• Go Offline
• Robot jogging tools
• Gearbox heat prediction
• ABB Library of robots

YesAdvanced offline features, such as:
• Graphical programming
• Save station
• Pack & Go
• Import / Export Geometry
• Import Library
• Create station viewer and movies
• Transfer
• AutoPath
• 3D operations

Continues on next page
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PremiumBasicFeature

YesAdd-Ins

1. Requires the RobotWare option PC Interface on the real robot controller system to enable
LAN communication. The option is not needed for connection via the Service port or for
virtual controller communication.
2. Requires the RobotWare option FlexPendant Interface on the robot controller system

In addition to the Premium functionality, add-ins like PowerPacs is also available.
• PowerPacs provide enhanced features for selected applications.

Activating RobotStudio
The activation procedures are different for standalone and network licenses. If you
have a standalone license, refer Activating a standalone license on page 46 and
if you have a network license, refer Activating a network license on page 47.

Note

If you accidentally activate a network license through the standalone activation
procedure, the license becomes invalid. You must contact ABB for support.

Activating a standalone license
Standalone licenses are activated through the Activation Wizard. If your computer
has Internet access, RobotStudio gets activated automatically, otherwise manual
activation is required.
Use the following steps to start the Activation Wizard.

1 Click the File tab, and then click the Help section.
2 Under Support, click Manage Licenses. The Options dialog appears with

the Licensing options.
3 Under Licensing, clickActivationWizard to view RobotStudio license options.

Note

To resolve issues during activation, contact your local ABB customer support
representative at the e-mail address or telephone number provided at
www.abb.com/contacts. Alternatively, with your activation key attached, send
an e-mail to softwarefactory_support@se.abb.com.

With Internet access
When your computer is connected to Internet, the Activation Wizard automatically
sends your activation request to the ABB licensing servers. Your license will then
be automatically installed and your product will be ready for use. RobotStudio must
be restarted after activation.

Without Internet access
If your computer is not connected to Internet, you must proceed with manual
activation.

1 Create a license request file by selecting the option Step 1:Create a license
request file.
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Proceed through the wizard, enter your activation key and save the license
request file to your computer.

2 Use removable storage, such as a USB stick, to transfer the file to a computer
with an Internet connection. On that computer, open a web browser, go to
http://manualactivation.e.abb.com/ and follow the instructions given.
The result will be a license key file that should be saved and transferred back
to the computer having the installation awaiting activation.

3 Relaunch the activation wizard and go through the steps until you reach the
Activate a Standalone License page.

4 Under Manual Activation, select the option Step 3:Install a license file.
Proceed through the wizard, selecting the license key file when requested.
Upon completion, RobotStudio is activated and ready for use.

RobotStudio must be restarted after the activation.

Activating a network license
Network licensing allows you to centralize license management by installing licenses
on a single server rather than on each individual client machine. The server
administers the licenses to the clients as required. A single network license allows
several clients to use the software.
Network Licensing is set up in the following stages:

1 Install the server for network licensing (See Installing the Network Licensing
Server on page 47)

2 Activate the licenses for network licensing (See Using the SLP Server Web
Interface on page 48)

3 Set up the client for network licensing (See Setting up Network Licensing in
the client on page 50)

Tip

Network licenses are displayed as Network in the View Installed Licenses link
of the Licensing page.

Installing the Network Licensing Server
Network licensing in RobotStudio uses the SLP Distributor server as the network
licensing server. It manages the allocation of network licenses to the clients.
You can install the SLP Distributor server from the Utilities\SLP Distributor directory
of the RobotStudio distribution.

Note

You need administrative privileges for installing and configuring the SLP
Distribution server. The installer requires the following details:

• Windows Server 2012 or 2008, Windows 8, Windows 7, or Windows Vista
• .NET Framework 3.5 SP1
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The SLP Distributor server is installed as a service that starts automatically with
Windows. It requires two open TCP ports, by default 2468 (for the web interface)
and 8731 (for licensing). The installer opens these ports in the standard Windows
Firewall, but any third-party firewall must be configured manually by the system
administrator.

Using the SLP Server Web Interface
Once the SLP server is online, you can access its web interface on the address
http://<server>:2468/web.
The following table shows how to use the server's web interface.

Use...To...

The Activation tab.Activate a network license auto-
matically
(for PCs with Internet connection)

Type in the Activation Key provided by ABB, and then
click Submit.
The number of concurrent users activated depends on
the activation key provided.

xx1300000052
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Use...To...

The Activation tab.
1 Click Manual Activation.
2 Type in your activation key provided by ABB, and

then click Submit.
3 Save the file to a removable storage, such as a

USB stick, then transfer the file to a machine with
an Internet connection. On that machine, open a
web browser and browse to http://manualactiva-
tion.e.abb.com/ and follow the instructions given.
A license key file will be generated and saved and
will be returned to the machine which hosts the
installation.

4 Once you recieve the license file, click Browse to
upload and install the license file.

Your network license is now activated.

xx1300000051

Activate a network license manu-
ally
(for PCs without Internet connec-
tion)

In the Home tab, under Dashboard, click Details.
Alternatively, click the Products tab.
The Product details for RobotStudio page opens which
shows the installed licenses details.

View the installed licenses

In the Home tab, under Dashboard, click Usage.
Alternatively, click the Usage tab.
The Current usage of RobotStudio page opens in which
the following details are tabulated.

• Licenses which are currently allocated
• Client to which each license is allocated to
• Number of remaining licenses available for use

Each table row corresponds to one client system.

View the usage of licenses
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Note

Certain proxy issues upon activation in the web interface of SLP server may
produce a message which only statesActivation failed. This issue happens when
the system account that executes SLP-Distributor-service does not have the
rights to read the user profile. As a workaround, follow this procedure:

1 Open the Services control panel (services.msc)
2 Open properties for Software Potential Distributor
3 Change Log on as to an actual named user, preferably the currently logged

on user
4 Restart the service and re-attempt an activation.
5 After your re-attempt, change Log on as back to Local System account and

restart the service.

Setting up Network Licensing in the client

Note

You require Administrative privileges to store this configuration.

You need to use the RobotStudio Activation Wizard in the client system for setting
up Network Licensing.
Use this procedure to set up Network Licensing for a client system.

Action

On the File tab, click Options and go to General:Licensing.1

On the Licensing page to the right, click Activation wizard to launch the Activation
Wizard.

2

In the Activation Wizard, on the Activate RobotStudio page, choose the option I want to
specify a network license server and manage server license, and then click Next.

3

You will proceed to the License Server page.

Specify the name or IP address of the License Server, and then click Finish.4
If Windows UAC is enabled, a confirmation dialog appears. This prompts you to restart
RobotStudio in order to start using the specified server.
To go to the SLP Distributor server web interface, click the Open the server dashboard
link. For information about using the server dashboard, see Using the SLP Server Web
Interface on page 48.
Note that the changes made are not applied until RobotStudio is restarted.

Note

For Network Licensing to work, the client system should be online with the server.
For information about enabling licensing while working offline, see Using
Commuter Licenses on page 51.
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Using Commuter Licenses
Commuter licenses allow a client system to work offline from the license server.
You can check out a license from the server for a specified number of days. During
this period the checked out license is unavailable to other users. The commuter
license is made available for other clients only when it is manually checked in back
to the server.
The commuter license in the client system expires when the check out time expires.
In this case, on starting RobotStudio in the client system, the Network License
dialog opens automatically and prompts you to check in the license back to the
server.

Note

It is not possible to check out specific features in the license. All features in a
license are included when it is checked out.

To check in/check out a commuter license, you need to use the Activation Wizard.
Use this procedure to check in/check out a commuter license.

Action

On the File menu, click Options and select General: Licensing1

On the Licensing page to the right, click Activation wizard to launch the Activation
Wizard.

2

In the Activation Wizard, on the Activate RobotStudio page, choose I want to check out
or check in a commuter license and click Next.

3

You will proceed to the Commuter License page.

UnderCommuter License, you will be presented one of the following options as per your
requirement:

• Check out a commuter license - In the Check out days box specify the specify
the number of days for which you wish to keep the license.
This option is disabled if you already have a commuter license checked out.

• Check in a commuter license - Choose this option to return the currently checked
out license to the server.
This option is enabled only if a commuter license is already checked out. If so,
the expiration date and time of the license is also displayed.

4

Click Finish to complete the check in/check out.5

Tip

Network licenses that are checked-out as commuter licenses will be displayed
as Floating (checked out) in the View Installed Licenses link of the Licensing
page.
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1.4 User interface

1.4.1 Ribbon, tabs and groups

The following figure shows the ribbon, tabs and groups of the Graphical User
Interface.

en0900000215

DescriptionTab

Contains the options to create new station, create new robot
system, connect to a controller, save station as viewer, and
RobotStudio options. For more information, see File tab on
page 209.

File1

Contains the controls required for building stations, creating
systems, programming paths and placing items. For more
information, see Home tab on page 225.

Home2

Contains the controls for creating and grouping components,
creating bodies, measurements and CAD operations. For
more information, see Modeling tab on page 281.

Modeling3

Contains the controls for setting up, configuring, controlling,
monitoring and recording simulations. For more information,
see Simulation tab on page 349.

Simulation4

Contains the controls for synchronization, configuration and
tasks assigned to the Virtual Controller (VC). It also contains
the controls for managing the real controller.

Controller5

For more information, see Controller tab on page 379.

Contains the integrated RAPID editor, used for editing all
robot tasks other than robot motion.

RAPID6

For more information, see RAPID tab on page 443.

Contains the control for PowerPacs . For more information,
see Add-Ins tab on page 475.

Add-Ins7
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1.4.2 Layout browser

Overview
The layout browser is a hierarchical display of physical items, such as robots and
tools.

Icons

DescriptionNodeIcon

The robot in the station.Robot
xx050000

A tool.Tool
xx050001

Contains all the links of the objects.Link collection
xx050002

A physical object in a joint connection. Each link
is made up of one or several parts.

Link
xx050003

Contains all the frames for an object.Frames
xx050004

A grouping of parts or other assemblies, carrying
its own coordinate systems. It is used to structure
a station.

Component group
xx050005

A physical object in RobotStudio. Parts with
geometric information are made up of one or
more 2D or 3D entities. Parts without geometric
information (such as imported .jt files) are empty.

Part
xx050006

Contains all collision sets. Each collision set in-
cludes two groups of objects.

Collision set
xx050007

Contains references to the objects that are sub-
ject to collision detection.

Objects group
xx050008

The objects in the collision set.Collision set mechanisms

xx050009

The frames in the station.Frame

xx050010
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1.4.3 The Paths & Targets browser

Overview
The paths & targets browser is a hierarchical display of non-physical items.

Icons

DescriptionNodeIcon

Your station in RobotStudio.Station
xx050011

The system for controlling the robots, just like a
real IRC5 controller.

Virtual controller
xx050012

Contains all logical elements in the station, such
as targets, paths, workobjects, tooldata and in-
structions.

Task
xx050013

Contains all tooldata.Tooldata Collection

xx0500001376

A tooldata for a robot or a task.Tooldata
xx050014

Contains all workobjects and targets for the task
or robot.

Workobjects & Targets
xx050015

A specified position of the robot axes.Jointtarget Collection and
Jointtargetxx050016

The workobject collection node and the workob-
jects it contains.

Workobject Collection and
Workobjectxx050017

A defined position and rotation for a robot. A
target equals a RobTarget in a RAPID program.

Target
xx050018

A target for which no axis configuration has been
assigned, for example, a repositioned target or
a new target created by means other than
teaching.

Target without assigned
configuration

xx050019

An unreachable target, that is, for which no axis
configuration has been found.

Target without found con-
figuration

xx050020

Contains all paths in the station.Path Collection
xx050021

Contains the instructions for the robot move-
ments.

Path

xx050022

A linear TCP motion to a target. If the target has
no valid configuration assigned, the move instruc-
tion gets the same warning symbols as the target.

Linear Move Instruction
xx050023
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DescriptionNodeIcon

A joint motion to a target. If the target has no
valid configuration assigned, the move instruction
gets the same warning symbols as the target.

Joint Move Instruction
xx050024

Defines an action for the robot to perform at a
specified location in a path.

Action Instruction
xx050025
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1.4.4 The Modeling browser

Overview
The modeling browser is a display of editable objects and their building blocks.

Icons

DescriptionNodeIcon

Geometric items corresponding to the objects in
the Layout browser.

Part
modeling

Geometric building blocks that comprise the
parts. 3D bodies contain several faces, 2D bodies
one face, and curves no faces.

Body
modelin0

The faces of the bodies.Face
modelin1
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1.4.5 The Controller browser

Overview
The Controller browser is a hierarchical display of controller and configuration
elements found in the Controller tab view.

Icons

DescriptionNodeIcon

Contains the controllers that are connected to
the Robot View.

Controllers
controll

Represents a controller with a working connec-
tion.

Connected Controller
control0

Represents a controller which is currently being
connected.

Connecting Controller
control1

Represents a controller that has lost its connec-
tion. It might have been turned off or disconnec-
ted from the network.

Disconnected Controller
control2

Represents a controller that denies you access
to login. Possible reasons for denied access are:

• User lacks necessary access privileges
• Too many clients connected to the control-

ler
• The RobotWare version of the system

running on the controller is newer than the
RobotStudio version

Denied login
control3

Contains the configuration topics.Configuration

configu0

Each parameter topic is represented by a node:
• Communication
• Controller
• I/O
• Man-machine communication
• Motion

Topic

configu1

With the Event Log, you can view and save con-
troller events.

Event Log

eventrec

Represents the controller I/O system. The I/O
system consists of industrial networks and units.

I/O System

io

An industrial network is a connector for one or
several devices.

Industrial Network

io-node

Continues on next page
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A device is a board, panel or any other device
with ports through which the I/O signals are sent.

Device

io-devic

Contains the active tasks (programs) of the con-
troller.

RAPID Tasks
rapid16t

A task is a robot program, which executes alone
or together with other programs. A program is
composed of a set of modules.

Task
prgintas

Program modules contain a set of data declara-
tions and routines for a specific task. Program
modules contain data specific to this task.

Program Modules

xx1500000335

System modules contain a set of type definitions,
data declarations and routines. System modules
contain data that applies to the robot system, re-
gardless of the program modules that are loaded.

System ModulesSystem Mod-
ules

A module that cannot be entered during step-by-
step execution, that is, all instructions in the
module are treated as one if the program is ex-
ecuted step-by-step.

Nostepin Module

nostepin

An icon for program modules that are either view-
only or read-only.

View-only and Read-only
Program Modules

modules

An icon for system modules that are either view-
only or read-only.

View-only and Read-only
System Modules

module_e

A routine that does not return any value. Proced-
ures are used as subprograms.

Procedure
procedur

A routine that returns a value of a specific type.Function
function

A routine that provides a means of responding
to interrupts.

Trap
trap16tr
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1.4.6 Files browser

Overview
The Files browser in the RAPID tab allows you to manage RAPID files and system
backups. Using the Files browser you can access and then edit standalone RAPID
modules and system parameter files that are not residing in the controller memory.

Icons

DescriptionNodeIcon

See Managing RAPID files on page 456.Files

xx1200000824

See Managing system backups on page 456.Backups

xx1200000825
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1.4.7 Add-Ins browser

Overview
The Add-Ins browser shows the installed PowerPacs, General add-ins , if available,
under their respective nodes.

Icons

DescriptionNodeIcon

Indicates an available add-in loaded into the
system

Add-In
xx1200000826

Indicates a disabled add-inDisabled Add-In
xx1200000827

Indicates an add-in un-loaded from the systemUnloaded Add-In
xx1200000828
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1.4.8 Windows layout

Overview
RobotStudio has a set of predefined window layouts. These layouts determine the
size and location of the four main windows, Layout, Paths&Targets,Tags and
Output. These windows are enabled by default and can be shown or hidden by the
Windows menu.
You can access the Windows menu from Customize Quick Access Toolbar >
Windows Layout > Windows.

Windows layout options
The Windows Layout menu provides the following options:

To..Select this option

Reduce the size of the ribbon.Minimize the Ribbon

Set window layouts to default settings.Default Layout

To enable or disable the window layouts(Layout, Paths&Targets,Tags
and Output).

Windows

Note

The Default Layout option does not work for Windows that RobotStudio Add-Ins
and PowerPacs add. However, the individual windows can be shown or hidden
by the Windows menu.
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1.4.9 The Output window

Overview
The output window displays information about events that occur in the station,
such as when simulations are started or stopped. This information is useful when
troubleshooting stations.

Layout of the Output tab
The Output tab contains two columns: the first states the event, the second the
time the message was generated. Each row is a message.

Event types
The three event types indicate the severity of the event:

DescriptionEvent type

An information message is a normal system event, for example,
starting and stopping programs, changing the operational
mode, and turning motors on and off.

Information

Information messages never require an action from you. They
can be useful for tracking errors, collecting statistics or monit-
oring user-triggered event routines.

A warning is an event of which you should be aware, but it is
not so severe that the process or RAPID program needs to be
stopped.

Warning

Warnings must occasionally be acknowledged. Warnings often
indicate underlying problems that at some point will need to
be resolved.

An error is an event that prevents the robot system from pro-
ceeding. The running process or RAPID program cannot con-
tinue and will be stopped.

Error

An error must occasionally be acknowledged. Some errors
require some immediate action from you in order to be resolved.
Double-click an error to display a detailed information box.

Some of the events are active. These are linked to an action for resolving the
problem that generated the event. To activate the linked action, double-click the
message.

Handling messages in the Output window

ProcedureGoal

Right-click in the Output window and then click Show mes-
sages. From the options All Errors, Information, Warnings
and Warnings and Errors, select the type of messages you
want to display.

To filter messages...

Select it, right-click and then click Save to file. Choose a name
and location in the dialog box. Multiple messages can be selec-
ted by pressing SHIFT while clicking each.

To save a message to file...

Right-click in the Output window and then click Clear.To clear the Output win-
dow...
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1.4.10 The Controller Status window

Overview
The Controller Status window shows the operational status of the controllers in
your robot view.

Layout of the Controller Status window
The Controller Status window has the following columns:

1 System Name : Displays the name of the system running on the controller.
2 Controller Name : Displays the name of the controller.
3 Controller State : Displays the state of the controller.

the robot is...When the controller is in
state...

starting up. It will shift to state motors off when it has
started.

Initializing

in a standby state where there is no power to the robot's
motors. The state has to be shifted to motors on before
the robot can move.

Motors off

ready to move, either by jogging or by running programs.Motors on

stopped because the safety runchain is opened. For in-
stance, a door to the robot's cell might be open.

Guard Stop

stopped because emergency stop was activated.Emergency Stop

ready to leave emergency stop state. The emergency stop
is no longer activated, but the state transition isn't yet
confirmed.

Waiting for motors on
after e-stop

in a system failure state. Restart required.System Failure

4 Program Execution State : Displays if the robot is running any program or
not.

the robot...When the controller is in
state...

is running a program.

Note

A Job will not be executed in this state.

Running

has a program loaded and is ready to run it when a PP
(starting point in the program) has been set.

Ready

has a program loaded, with a PP, and is ready to run it.Stopped

has not initialized the program memory. This indicates an
error condition.

Uninitialized

5 Operating Mode : Displays the operating mode of the controller.

the robot is...When the controller is
in mode...

starting up. It will shift to the mode selected on the controllers
cabinet when it has started.

Initializing
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the robot is...When the controller is
in mode...

ready to run programs in production.Auto
In Auto mode it is possible to get remote Write access to the
controller, which is necessary for editing programs, config-
urations and other things when connected to a real controller.

only able to move if the three-position enabling device on
the FlexPendant is activated. Furthermore, the robot can
only moved with reduced speed in manual mode.

Manual

In manual mode it is not possible to get remote Write access
to the controller, unless it is configured for this and the re-
mote Write access granted on the FlexPendant.

only able to move if the three-position enabling device on
the FlexPendant is activated.

Manual full speed

In manual mode it is not possible to get remote Write access
to the controller, unless it is configured for this and the re-
mote Write access granted on the FlexPendant.

about to enter Auto mode, but the mode transition has not
yet been acknowledged.

Waiting for acknow-
ledge

6 Logged on as: Displays the user name the PC is logged on to the controller
with.

7 Access : Displays the users having write access to the controller, or if it is
available.
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1.4.11 The Operator Window

Overview
Operator Window is an alternative to the corresponding feature in the Virtual
FlexPendant for communicating with the user during RAPID program execution.
It displays the same output as displayed on the Virtual FlexPendant Operator
Window.
When running in a Virtual Controller, the RAPID program communicates with the
operator via messages on the FlexPendant screen. The Operator Window integrates
this functionality and allows the user to run interactive RAPID programs without
starting the Virtual FlexPendant.

Note

The Operator window starts when a Virtual Controller starts. The Virtual Controller
starts while opening a station or when adding a system.

Enabling Operator Window
To enable an operator window:

1 On the File menu, click Options.
2 On the Navigation pane to the left, select Robotics:Virtual Controller.
3 On the Virtual Controller page to the right, selectAutomatically open virtual

Operator Window .
4 Click Apply.

Note

When theShow virtual OperatorWindow feature is enabled, an Operator Window
is automatically created for each controller in the station. By default, the window
is located in the tab area below the graphics window.

RAPID Instructions
The following are the RAPID instructions supported by the Operator Window. When
these instructions are executed, the behavior is similar to that of Virtual
FlexPendant:

• TPErase
• TPReadFK
• TPReadNum
• TPWrite
• UIAlphaEntry
• UIMsgBox
• UINumEntry
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The following are the RAPID instructions not supported by the Operator Window.
When these instructions are executed, an error message is displayed in the Operator
Window prompting you to use the Virtual Flexpendant instead:

• TPShow
• UIShow
• UINumTune
• UIListView

The controller switches to automatic mode when UIShow is executed.

Note

You should not run both the Virtual Flexpendant and Operator Window
simultaneously. RobotStudio will automatically request mastership when
committing data to the controller, when actions are taken in Virtual Operator
Window. This can cause undesired effect when using the Virtual FlexPendant at
the same time.
The emergency stop button pressed on the Virtual FlexPendant cannot be reset
through the virtual controller control panel. You must resent this button on the
Virtual FlexPendant.
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1.4.12 The Documents window

Overview
The Documents window allows you to search and browse the RobotStudio
documents like libraries, geometry and so on in large numbers and from different
locations. You can also add associate documents with a station, either as a link or
by embedding a file in the station.

Opening a Documents window
1 On the Home tab, click Import Library and select Documents from the

dropdown menu.
The Documents window appears.

Layout of the Documents window
The Documents window is a docked area that by default takes the right-hand corner.
The upper part of the window contains controls for searching and browsing the
document locations. The lower part consists of a list view that displays the
documents and folders and a status area.

DescriptionControl

Allows to add documents associated with the station, either
by adding the file/folder as a reference (link) or by embedding
the file in the station. See Using the Station mode on page 67.

Station
Search

Allows to search for keywords or query. See Using the Search
mode on page 68.

Search

Displays a folder structure of the document locations. See
Using the Browse mode on page 70.

Browse

Allows to configure the document location. See Document
Locations window on page 72.

Location

Using the Station mode
Use this procedure to add documents associated with the current station:

1 Click Station from the Document Manager.
2 Click Add button and select what to add to the current station:

• File Reference
• Folder Reference
• Embedded File
• New Text Document

Note

• The referenced file/folder is displayed with an arrow icon
• The embedded file and new text document are displayed with a diskette

icon

3 In the Documents window, right-click the document.

Continues on next page
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The following context menu items appear depending on the document type
selected:

DescriptionItem

Opens the document in the program associated with its file
type. For example, a .docx file is opened in Microsoft Word.

Open

An embedded file is saved to a temporary location before
opening. If RobotStudio detects that the temporary file has
changed, you will be asked to update the embedded file.

Opens the folder containing the file in Windows Explorer.Open containing folder
This option is not available in embedded files.

Converts a referenced file to an embedded file.Copy to Station

Saves an embedded file to disk.Save as

Specifies if a referenced file/folder should be included when
a Pack and Go file is created.

Include in Pack and Go

For a referenced folder, all files in the folder will be included.
To use this option, the file must be located in the parent
folder of the station file. For example, if the station file is
D:\Documents\Stations\My.rsstn, the reference must be
located in D:\Documents to be included in Pack and Go.
Embedded files are always included when a Pack and Go
file is created, since they are part of the station file.

Specifies that subfolders of a referenced folder should be
included in Pack and Go.

Include Subfolders

Removes the selected document.Remove

Note

Some context menu items can be disabled and the document marked as
Locked in the API.

Using the Search mode
1 Click the option Search and enter a query or syntax in the text box.

For more information about the available syntaxes, see Search syntax on
page 69.

Note

The drop-down list contains the search history of the previous ten queries
between sessions.

2 Click the Expand button to access additional controls.
This allows you to specify if the search should cover all the enabled locations
or one specific location.
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3 Select Search in results check box to search for the resulting documents of
the previous search.

Note

The search is performed automatically, after you stop typing in the text
box or manually, by clicking the glass icon. During the search, this icon is
changed to a cross and clicking this cancels the search operation.

Search syntax
The search field supports certain keywords and operators which allows you to
specify an advanced search query.

Note

Keywords are not localised.

The following table displays the keywords that specifies an advanced search query:

DescriptionKeywords

matches the filename of the documents.filename

matches the title field of the document metadata.title

matches the type field of the document metadata.type
For library (.rslib) files, this is a user-defined string. For ex-
ample, Robot.
For other files, this is the Windows description of the file type.
For example, Text Document.

matches the author field of the document metadata.author

matches the comment field of the document metadata.comments

matches the revision field of the document metadata.revision

matches the last time the file was modified.date
For the colon operator, the match is done against a string
representation of the modified date.
For other operators, the search string should interpret as a
date according to .NET standards.

matches the file size (in KB).size

used to group or invert queries.and, or, parentheses (), not

The following table displays the operators that specifies an advanced search query

DescriptionOperator

matches if the field contains the search string.:

matches if the field equals the search string.=

matches if the field is smaller than the search string.<

matches if the field is greater than the search string.>
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Operating manual - RobotStudio 69
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

1 Introduction to RobotStudio
1.4.12 The Documents window

Continued



Note

• Quotation marks can be used to specify a string with whitespace. An empty
string is specified by "".

• All search strings are case insensitive.
• Text without a preceding keyword is matched against the filename and all

metadata.
• If queries are specified without a grouping keyword, "and" is implied.
• Some metadata (title, author, comments and revision) is not available for

all file types.

Examples
• 1400 - Matches documents with the string 1400 in the filename or any

metadata.
• not author:ABB - Matches documents where the author field does not contain

the string ABB.
• size>1000 and date<1/2009 - Matches documents larger than 1000KB and

modified before 1/1/2009.
• IRBP comments="ABB Internal" - Matches documents with the string IRBP

in the filename or any metadata, and where the comment field equals ABB
Internal.

Using the Browse mode
1 Click the option Browse from the Document Manager.

A folder structure of the document location is displayed.

Note

The top level of the folder structure lists the configured locations. If a
location is unavailable (for example, an offline network path) it is marked
as Unavailable and cannot be opened. The text box displays the path of
the current folder relative to the location root.

2 You can open a folder in either of the two ways:
• Double-click the document location.
• Right-click the document location and select Open from the context

menu.
3 You can navigate through the folders in either of the two ways:

• Click the folder icon at the top-right corner.
• Select the parent folder from the dropdown list.

Note

You can browse and add component xml files (*.rsxml) to your station.
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4 Click Refresh icon in the text box to manually refresh the contents of the
folder.

Note

The refresh operation can be time consuming, if a folder resides in a
network location or contains many documents. During this time, the refresh
icon changes to a cross icon allowing you to cancel the operation.

Results view
In the Browse mode, items are grouped into folders and documents. The resulting
folders and documents are displayed in a list view.
The search result appears in the status bar at the bottom, displaying the number
of items found, and progress made during the search. The Search results are
grouped beneath headers according to their location.
Each document is represented by an image, the document title or filename in black
text, and the metadata and file information in grey text. For library files, the image
can be a screenshot or other custom image. For other document types, the image
is the icon associated with the file type.

Using the Context menu
In the results view, right-click a document or folder. The following context menu
items appears:

DescriptionItem

This command opens the selected folder, library or geometry
files, station files, and document.

• For folders, browses into the selected folder.
• For library or geometry files, imports the file into the

station. (If no station is open ,a new empty station is first
created.)

• For station files, opens the station.
• For other documents, attempts to open the selected

document according to its file association. For example,
Microsoft Word starts when a .doc file is opened.

Open

This command opens the folder containing the document or
the folder in the Windows Explorer.

Open containing folder

This command is disabled for folders.Properties
This command opens a dialog that displays complete metadata
and file information about the selected document.

Tip

Double-click an item to import the library and geometry files and open the other
documents.
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In the results view, right-click an empty area. The following context menu appears
that controls how the documents are grouped and sorted:

DescriptionItems

Controls how the documents are arranged in groups.Group by:
The following options are available:

• Location
• Folder
• Type

Controls how the documents are sorted within the group.Sort by:
The following options are available:

• Name
• Date
• Size

Items are sorted in the ascending and descending order.Ascending and Descending

Using the drag and drop feature
You can import a library or a geometry file into the station by dragging it from the
results view into either the graphics window, or onto an object node in the Layout
browser.

• When dragging into the Layout browser, the component will be placed as a
child object under the station, component group or smart component.

• When dragging into the graphics window, the component will be positioned
at the point on the station floor where you drop it. You can snap the point to
the UCS grid by enabling the Snap Grid or by holding down the ALT key
while dragging.

Document Locations window
You can launch the Document Locations window in any one of the following ways:

1 Select Locations from the Documents window.
2 On the File menu, click Options and select Files & Folders in the navigation

pane. Click Document Locations on the right side.
3 On the Home tab, click Import Library and select Locations from the

dropdown menu.

Layout of the Document Locations window
It consists of a menu bar and a list displaying the configured locations. The list
displays general information about the locations. The menu bar contains the
following controls:

DescriptionControls

The following options are available from the dropdown menu:
• Import : Opens a dialog box to import document loca-

tions from an xml file. If a location with the same URL
already exists, you have the option to retain or delete
the existing location.

• Export : Opens a dialog box to export all the configured
locations to an xml file.

• Reset to Default : Loads the default locations (ABB
Library, User Library, and User Geometry).

Locations
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DescriptionControls

Opens a dialog box to add a document location. By default,
there is one location type available.

Add Location

For more information, see File System location on page 73.

Deletes the selected location.Remove

Opens a dialog box to modify the selected location. For more
information, see File System location on page 73.

Edit

File System location
1 Click Add Locations and select File System from the dropdown menu. The

File System dialog box appears.
The File System dialog box contains the following controls:

DescriptionControl

Specifies a name associated with the location.Location Name

Specifies the file system directory that corresponds to the root
folder of the location. This can be on a local or network disk.

Path

Specifies a filename filter to include only certain files when
searching and browsing. Multiple filters are separated by a
semicolon. If the filter is empty all files are included.

Filter

Specifies that the library and geometry files from a network
location should be copied to a local directory and imported
from there, rather than directly from the network path.

Cache files from network

This will ensure that a station containing such files can be
opened even if the network location is unavailable. This option
is only available for network locations.

Specifies the directory where to store the local copies. This
must be on a local disk.

Directory

Specifies that the contents of the location should be displayed
as a gallery in the specified ribbon menu.

Show as gallery

• Flat - Specifies that all documents are displayed in a
single gallery with subfolder names as headers.

• Recursive - Specifies that the documents are displayed
in submenus corresponding to the folder structure.

Style

Specifies if the search should cover all the enabled locations.Include when searching all
locations

Select this check box to define a custom location for packages.
You can access this package from the RobotApps window in
the section as named in the Location Name box.

Note

You must close and re-open the RobotApps window for the
changes to happen.

Package (.rspak) installa-
tion source
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1.4.13 Using a mouse

Navigating the graphics window using the mouse
The table below shows how to navigate the graphics window using the mouse:

DescriptionUse the keyboard
/mouse combination

To

Just click the item to select. To select
multiple items, press CTRL key while
clicking new items.

left-cli

Select items

selectio

Press CTRL + SHIFT + the left mouse but-
ton while dragging the mouse to rotate the
station.

CTRL + SHIFT +

left-cli

Rotate the station

rotate

With a 3-button mouse you can use the
middle and right buttons, instead of the
keyboard combination.

Press CTRL + the left mouse button while
dragging the mouse to pan the station.

CTRL +

left-cli

Pan the station

pan

Press CTRL + the right mouse button while
dragging the mouse to the left to zoom out.
Dragging to the right zooms in.

CTRL +

right-cl

Zoom the station

zoom

With a 3-button mouse you can also use
the middle button, instead of the keyboard
combination.

Press SHIFT + the right mouse button while
dragging the mouse across the area to
zoom into.

SHIFT +

right-cl

Zoom using window

window_z

Press SHIFT + the left mouse button while
dragging the mouse across the area to
select all items that match the current se-
lection level.

SHIFT +

left-cli

Select using window

window_s

74 Operating manual - RobotStudio
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

1 Introduction to RobotStudio
1.4.13 Using a mouse



1.4.14 3D Mouse

Overview
The 3Dconnexion 3D mouse has a pressure-sensitive controller cap designed to
flex in all directions. Push, pull, twist, or tilt the cap to pan, zoom, and rotate the
current view. A 3D mouse is used along with a regular mouse. Connecting a 3D
mouse to your RobotStudio environment lets you to interact with the graphical
environment.
You can connect the programmable buttons of the 3D mouse to your commonly
used RobotStudio commands by assigning the commands to custom keyboard
shortcuts. The custom keyboard shortcuts are configured with the same user
interface as the Quick Access Toolbar. When the keyboard shortcuts are configured
in RobotStudio, you must connect the programmable buttons to the keyboard
shortcuts in the 3D mouse applications control panel. For more information, refer
the user manual of the 3D mouse application.

Using a 3D mouse
The 3D mouse can move in six axes as mentioned in the following table.

DescriptionAxesIndividual Axis

Moves the model right and left.Pan Right/Left

xx1500000297

Zoom the model in and out.Zoom

xx1500000299

Moves the model up and down.Pan Up/Down

xx1500000298

Rotate around vertical axis.Spin

xx1500000301

Tilts the model forwards and backwards.Tilt

xx1500000300

Rolls the model sideways.Roll

xx1500000302
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1.4.15 Selecting an item

Overview
Each item in a station can be moved to achieve the required layout, so you first
have to determine its selection level. The selection level makes it possible to select
only specific types of items, or specified parts of objects.
The selection levels are curve, surface, entity, part, mechanism, group, target/frame
and path. The target/frame and path selection can be combined with any of the
other selection levels.
Objects may also be grouped together as component groups, see Component
Group on page 282.

Selecting an item in the graphics window
To select items in the graphics window, follow these steps:

1 At the top of the graphics window, click the desired selection level icon.
2 Optionally, click the desired snap mode icon for the part of the item you wish

to select.
3 In the graphics window, click the item. The selected item will be highlighted.

Multiple selection of items in the graphics window
To select multiple items in the graphics window, do the following:

1 Press the SHIFT key, and in the graphics window drag the mouse diagonally
over the objects to select.

Selecting an item in the browsers
To select items in a browser, do the following:

1 Click the item. The selected item will be highlighted in the browser.

Multiple selection of items in the browsers
To select multiple items in a browser, follow these steps:

1 Make sure that all the items to be selected are of the same type and located
in the same branch of the hierarchical structure; otherwise, the items will not
be operable.

2 Do one of the following:
• To select adjacent items: In the browser, hold down the SHIFT key and

click the first and then the last item. The list of items will be highlighted.
• To select separate items: In the browser, hold down the CTRL key and

click the items you want to select. The items will be highlighted.
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1.4.16 Attaching and detaching objects

Overview
You can attach an object (child) to another object (parent). Attachments can be
created on part level and on mechanism level. When an object has been attached
to a parent, moving the parent also moves the child.
One of the most common attachments is to attach a tool to a robot. For procedures,
see Attach to on page 486 and Detach on page 495.
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1.4.17 Keyboard shortcuts

General keyboard shortcuts
The following table lists general keyboard shortcuts in RobotStudio.

Key CombinationCommand

General Shortcuts

F10Activate menu bar

ALT + F1Open API Help

F1Open Help

CTRL + F5Open Virtual FlexPendant

CTRL + TABSwitch between windows

General Commands

F4Add Controller System

CTRL + OOpen Station

CTRL + BTake Screenshot

CTRL + SHIFT + RTeach Instruction

CTRL + RTeach Target

CTRL + GImport Geometry

CTRL + JImport Library

CTRL + NNew Empty Station

CTRL + SSave Station

Arrow keysRotate the station

PgUp and PgDnZoom the station

CTRL + arrow keysPan the station

General Editing Commands

CTRL + CCopy

CTRL + XCut

CTRL + VPaste

DELETEDelete

CTRL + YRedo

F5Refresh

F2Rename

CTRL + ASelect All

Ctrl+Shift+SSave All

CTRL + ZUndo

Continues on next page
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Note

Robotstudio allows you to add standard commands and keyboard shortcuts to
the quick access toolbar using the Customize Quick Access Toolbar >
Customize Commands option. The quick access toolbar settings and the
customized shortcuts can be saved as an *.xml file in a PC. You can export this
file from one PC and later can import it to another PC.

RAPID Editor shortcuts
The following table lists the keyboard shortcuts specific to the RAPID Editor.

Key CombinationCommand

RAPID Editor Intellisense

CTRL + SPACEBARComplete Word, displays the list of instruc-
tions that the user can select

CTRL + SHIFT + SPACEBARParameter Info

TAB (when the cursor located at the end of
an identifier)

Auto Complete

General RAPID Editor Commands

F8Start Program Execution

F11Step In

SHIFT + F11Step Out

F12Step Over

SHIFT + F8Stop

F9Toggle Breakpoint

CTRL + SHIFT + SApply Changes

CTRL + PPrint

RAPID Editor Text Commands

CTRL + InsertCopy
or, CTRL + C

SHIFT + DeleteCut
or, CTRL + X

CTRL + LCut line

CTRL + SHIFT + LDelete line

CTRL + BACKSPACEDelete to beginning of word

CTRL + DeleteDelete to end of word

F3Find next occurance

TabIndent

CTRL + UMake the selected text lowercase

CTRL + SHIFT + UMake the selected text uppercase

CTRL + HomeMove to beginning of document

HomeMove to beginning of line

Continues on next page
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Key CombinationCommand

CTRL + EndMove to end of document

EndMove to end of line

CTRL + RightMove to next word

CTRL + LeftMove to previous word

CTRL + Page DownMove to visible bottom

CTRL + Page UpMove to visible top

Ctrl+F1Minimize the Ribbon

CTRL + EnterOpen line above

CTRL + SHIFT + EnterOpen line below

SHIFT + TABOutdent

SHIFT + InsertPaste
or, CTRL + V

CTRL + SHIFT + ZRedo
or, CTRL + Y

CTRL + DownScroll down

CTRL + UpScroll up

ALT + SHIFT + DownSelect block down

ALT + SHIFT + LeftSelect block left

ALT + SHIFT + RightSelect block right

ALT + SHIFT + UpSelect block up

SHIFT + DownSelect down

SHIFT + LeftSelect left

SHIFT + Page DownSelect page down

SHIFT + Page UpSelect page up

SHIFT + RightSelect right

CTRL + SHIFT + HomeSelect to beginning of document

SHIFT + HomeSelect to beginning of line

CTRL + SHIFT + EndSelect to end of document

SHIFT + EndSelect to end of line

CTRL + SHIFT + RightSelect to next word

CTRL + SHIFT + LeftSelect to previous word

CTRL + SHIFT + Page DownSelect to visible bottom

CTRL + SHIFT + Page UpSelect to visible top

SHIFT + UpSelect up

CTRL + SHIFT + WSelect word

Ctrl+BScreenshot

Ctrl+Shift+MSet Program Pointer to Main in all tasks

F9Toggle Breakpoint

Continues on next page
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Key CombinationCommand

InsertToggle overwrite mode

CTRL + TTranspose characters

CTRL + ALT + SHIFT + TTranspose lines

CTRL + SHIFT + TTranspose words

Ctrl+F5Virtual FlexPendant

Note

When the user presses the ALT key, shortcut keys are displayed on the
RobotStudio ribbon. Use these shortcut keys with ALT key to access the
corresponding menu item.
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2 Building stations
2.1 Workflow of building a station

Overview
The following sections outline the workflow for building a new station. It also
includes the prerequisites for creating and simulating robot programs. The workflow
includes:

• Options for creating a station with a system.
• Importing or creating the objects to work with
• Optimizing the station layout by finding the best placement of robots and

other equipment.

Note

For most scenarios, you are recommended to follow the workflows from start to
finish, even though other sequences maybe possible.

Creating a station with a system
The table below shows the options for creating a station with a system.
For the exact procedures, see New tab on page 211.

DescriptionActivity

This is the simplest way to create a new station containing a
robot and a link to a rudimentary system template.

Create a station with a
template system

This creates a new station containing one or more robots in
accordance with an existing, built system.

Create a station with an
existing system

An advanced user can build a station from scratch and then
add a new or existing system to it.

Create a station with no
system

Manually starting the VC
The table below shows the alternatives for manually starting with a system. Perform
only those steps applicable to your station.

DescriptionActivity

See Starting a VC on page 92.Manually connecting a
library to the VC

See Restarting a VC on page 93.Restarting the VC

Importing station components
The table below shows the workflow for importing station components. Perform
only those steps applicable to your station.
For procedures, see Importing a station component on page 94.

DescriptionActivity

See Robot System on page 228.Import a robot model

See Import Library on page 227.Import a tool

Continues on next page
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DescriptionActivity

See ABB Library on page 226.Import a positioner

See Import Library on page 227.Import a track

If you have CAD models of the equipment, you can import
them, see Import Library on page227. Otherwise, you can create
models in RobotStudio, see Mechanisms on page 100.

Import other equipment

If you have CAD models of the work piece, you can import
them, see Workobject on page 239. Otherwise, you can create
models in RobotStudio, see Objects on page 98.

Add work piece

Placing objects and mechanisms
The table below shows the workflow for placing the objects in the station.

DescriptionActivity

If you are building a model of a real station, start by placing all
objects with known positions. For objects without known posi-
tions, find a suitable placement, seePlacing objects on page103
and Placing external axes on page 104.

Place objects

Attach the tools to the robot, see Attach to on page 486.Attach tools

If track external axes are used, attach the robots to the tracks,
see Attach to on page 486.

Attach robots to tracks

If positioner external axes are used, attach the work pieces to
the positioners, see Attach to on page 486.

Attach work pieces to po-
sitioners

Test if the robot can reach critical positions on the work piece.
If you are satisfied with how the robot reaches the positions,
your station is ready for programming. Otherwise, continue
adjusting the placement or trying other equipment as described
below, see Testing positions and motions on page 128.

Test reachability
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2.2 Setting the Conveyor tracking station

2.2.1 Setting Conveyor tracking

Overview
This section describes conveyor tracking with two robot systems. The baseframes
of the mechanical units in both the robot systems have the same or different task
frame position.

Prerequisites
• Two robot systems with conveyor tracking option (system 1 and system 2)
• A conveyor is created as described in Create Conveyor on page 338.

Setting up the conveyor tracking station
1 Add existing system (system 1) to the station. SeeRobot System on page228.
2 Set the position of robot / conveyor to new location:

a See Updating the baseframe position on page 440 to update the
baseframe position of the robot.

b Set the position of conveyor to required position
3 Set a connection between system1 and conveyor, see Create connection

between virtual controller and conveyor on page 339.

Setting up a conveyor tracking station with two robot systems
1 Add existing system (system 1) to the station. SeeRobot System on page228.
2 Set the position of robot / conveyor to new location:

a See Updating the baseframe position on page 440 to update the
baseframe position of the robot.

b Set the position of conveyor to required position.
3 Set a connection between system1 and conveyor, see Create connection

between virtual controller and conveyor on page 339.
4 Add the existing system (system 2) to the station. See Robot System on

page 228.
5 Modify the baseframe positions of robot (system 2).

a Move the mechanical unit (robot) to its new location.
b See Updating the baseframe position on page 440 to update the

baseframe position of the robot.
6 Set a connection between system 2 and conveyor. See Create connection

between virtual controller and conveyor on page 339.

Setting up conveyor tracking station with a robot system and two conveyors
1 Add the existing system (system 1) to the station. See Robot System on

page 228.

Continues on next page
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2 Import two conveyor libraries and set the position of robot / conveyors to
new location:

a See Updating the baseframe position on page 440 to update the
baseframe position of the robot.

b Set the position of conveyor to required position.
3 In the Controller tab, click Load Parameters, and select cnv2_eio.cfg,

cnv2_moc.cfg and , cnv2_prc.cfg files from C:\Users\<Current
User>\AppData\Local\ABB Industrial IT\Robotics
IT\RobotWare\RobotWare_6.xx\options\cnv.

4 Restart the controller.
5 Set a connection between system1 and conveyor1, and similarly between

system 1 and conveyor 2, see Create connection between virtual controller
and conveyor on page 339.
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2.3 Creating a system with external axes automatically

Automatically create a system with external axes
1 Import the desired robots, positioners, and track libraries into the RobotStudio

station. See Import Library on page 227.
If a robot and track are selected, attach the robot to the track. See Attach to
on page 486.

2 Create a robot system from layout. See Robot System on page 228.

Note

To create a robot system with IRBT4004, IRBT6004, or IRBT7004, the
TrackMotion mediapool must be installed. For more information, see
Installing and licensing RobotStudio on page 44.

Supported external axes configurations for RobotWare 5
The following table shows a combination of different external axes configurations:

Positioner typeCombination

R2xLLKDCBA

YYYYYYYYOne IRB (Positioner in same
task)

YYYYYYYYOne IRB (Positioner in sep-
arate task)

YNYYYYYYTwo IRB (Positioner in sep-
arate task)

NYYYXNNNYOne IRB on Track Motion
(Positioner in same task)

NYNNNNNNOne IRB on Track Motion
(Positioner in separate task)

• Y - Combination is supported
• N - Combination is not supported
• YX - Combination is supported and manual mapping of mechanical units and

joints required

Note

Creating a system from layout only supports tracks of type RTT and IRBTx003
in combination with positioners. i.e. IRBTx004 is not supported in combination
with the positioners.
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Supported RobotWare 6 configurations for positioners, motor units, gear units and track motions
The following table shows various RobotWare 6 configurations:
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* : Track motion that does not use a dynamic model, applicable for RTT.
**: RobotWare add-in that contains a dynamic model for track motion is used,
applicable for IRBT 4004, 6004, 7004 and 2005.

Note

You can configure dynamic (IRBTx004 and IRBT2005) tracks only for T_ROB1
and T_ROB2. This is limited by RobotWare add-in for track motion.
MU does not support MultiMove in System From Layout. Dynamic tracks cannot
be combined with MU.

Manual mapping of mechanical units and joints
If the system contains more than one mechanical unit, the number of tasks and
base frame positions of the mechanism should be verified in the System
Configuration.

1 On the Controller tab, in the Virtual Controller group, click Edit System.
This opens the System Configuration dialog.

2 Select the robot from the node in the hierarchical tree.
The property page of this node contains controls for mapping and setting
axes and joints.

3 Click Change to open a dialog box.
4 Manually map the mechanical unit and mechanism joints. Click Apply.
5 Modify the baseframe positions of the mechanical unit. See Updating the

baseframe position on page 440.
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2.4 Manually setting up system based on RobotWare 5.xx with track motion

2.4.1 Track motion of type RTT or IRBTx003

Manually setting up a system with track motion of type RTT or IRBTx003
Use this procedure to manually set up a system with track motion type RTT Bobin,
RTT Marathon or IRBT4003, IRBT6003, or IRBT7003.

1 Build and start a new system. See Building a new system on page 167.

DescriptionAction

In the New Controller System wizard of the
Installation Manager, naviagte to Modify Op-
tions page and scroll down to Drive Module
1 > Drive module application group and ex-
pand ABB Standard manipulator option and
select Manipulator type (IRB6600).

Select the desired robot variant
(IRB6600).

1

In the New Controller System wizard of the
Installation Manager, naviagte to Modify Op-
tions page of the Installation Manager, scroll
down to Drive Module 1> Additional axes
configuration group and expand theAdd axes
IRB/drive module 6600 option and select the
770-4 Drive W in pos Y2 option.

Select the Additional axes config-
uration.

2

The option 770-4 Drive W in pos Y2, the Drive
module, and the Position varies depending
on theAdditional axes configuration selected.
Make sure to select at least one drive in any
position.

Close the Modify Options page.Click Finish.3

2 Add the system to the station. See Adding a system on page 92
3 Add the corresponding track configuration file of the desired robot variant

(IRB 6600) and the desired track model to the station. See Adding the track
to the system on page 94.

Note

In the Select Library group, select either the existing track or import a
different track.
The system may fail unless the correct additional axes configuration is
selected.

4 Specify whether the baseframe is moved by another mechanism.
a On theController tab, in theVirtual Controller group, clickEdit System.

This opens the System Configuration dialog.
b Select ROB_1 node from the hierarchical tree.
c Select the option Track from the BaseFrame moved by list.
d Click OK. When asked if you want to restart the system, answer Yes.

Close the System Configuration window.
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2.4.2 Track motion of type IRBTx004

Overview
For configuration of tracks of type IRBT4004, IRBT6004, or IRBT7004, the
TrackMotion mediapool must be installed. For more information, see Installing and
licensing RobotStudio on page 44.

Manually setting up a system with track motion of type IRBTx004
1 Build and start a new system. See Building a new system on page 167.

DescriptionAction

See Adding additional options on page 168.Add add-ins for IRBTx004.1
Browse and select the key file (.kxt) located
in the mediapool Track 5.XX.YYYYwhere 5.XX
indicates the latest RobotWare version being
used.

On the Modify Options page of the Installa-
tion Manager, scroll down to Drive Module 1
> Drivemodule application group and expand
ABBStandardmanipulator option and select
Manipulator type (IRB6600).

Select the desired robot variant
(IRB6600).

2

On the Modify Options page of the Installa-
tion Manager, scroll down to Drive Module
1> Additional axes configuratin group and
expand the Add axes IRB/drive module 6600
option and select the 770-4 DriveW in pos Y2
option.

SelectAdditional axes configur-
ation.

3

The option 770-4 DriveW in pos Y2, theDrive
module, and the Position varies depending
on the Additional axes configuration selec-
ted. Make sure to select at least one drive in
any position.

On the Modify Options page of the Installa-
tion Manager, scroll down to the TRACK and
expand the Drive module for Track motion
group. Select Drive Module 1 >Track Motion
type >IRBT 6004 > Irb Orientation on Track
> Standard carriage In Line > Select Track
Motion Length > 1.7m (or any other variant).

Select the desired track motion
(IRBT 6004).

4

Close the Modify Options page.Click Finish.5

2 Add the system to the station. See Adding a system on page 92.
3 Add the desired track model to the station using the following procedure.

See Adding the track to the system on page 94.
a In the Select Library group, click Other to import a different track

motion library.
b Click OK. When asked if you want to restart the system, answer Yes.

Close the System Configuration window.
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2.5 Virtual controller

2.5.1 Starting a VC

Overview
RobotStudio uses virtual controllers for running the robots. Virtual controllers can
run both systems for real robots and specific virtual systems for testing and
evaluation purposes. A virtual controller uses the same software as the controller
to execute the RAPID program, to calculate robot motions and to handle I/O signals.
When starting a virtual controller, point out which system to run on it. Since the
system contains information about the robots to use and important data such as
robot programs and configurations, it is important to select the right system for
the station.

Note

You can start and stop a virtual controller, using a given system path and without
needing a station. For more information, see Start Virtual Controller on page381.

Starting a VC
The table below describes the different ways a virtual controller may start:

DescriptionStartup

In most cases, a VC is automatically started when you create
a new station. Library files for the robots used by the system
are then imported to the station.

Automatic, when creating
a station

If your station uses several systems or if you started with an
empty station, you can add systems to an open station. Library
files for the robots used by the the systems are then imported
to the station.

Automatic, when adding a
system to an existing sta-
tion

If you have manually imported a robot library you want to use
with a system, instead of importing a new library at startup,
you can connect this library to a controller.

Manually, when connecting
to an imported library

If you have manually imported a robot library you want to use
with a system, instead of importing a new library at startup,
you can connect this library to a controller.
A library may only be connected to a single-robot system and
may not be already connected to another VC.

The Start Virtual Controller commands allows you start and
stop a virtual controller, using a given system path and without
needing a station.

Manually, when starting a
controller from the Control-
ler tab.

Adding a system
To add a system to a new station, see New tab on page 211.
To add a system to an existing station, see Robot System on page 228.
For information how to create a system with specific options, see The System
Builder on page 164.
To start or add a virtual controller which is not part of a station, see Add Controller
on page 380.

92 Operating manual - RobotStudio
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

2 Building stations
2.5.1 Starting a VC



2.5.2 Restarting a VC

For information on when and how to restart a VC in RobotStudio, see Restart a
controller on page 388.
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2.6 Station components

2.6.1 Importing a station component

Importing a robot model
This is how to import a robot model without a controller to your station.
A robot which is not connected to a controller cannot be programed. To import a
robot connected to a virtual controller, configure a system for the robot and start
it in a virtual controller, see Building a new system on page 167 and Starting a VC
on page 92, respectively.
To import a robot model, in the Home tab, click Robot System and then select a
robot model from the gallery.

Importing a tool
A tool is a special object, for example, an arc weld gun or a gripper, that operates
on the work piece. For achieving correct motions in robot programs, the parameters
of the tool have to be specified in the tool data. The most essential part of the tool
data is the TCP, which is the position of the tool center point relative to the wrist
of the robot (which is the same as the default tool, tool0).
When imported, the tool will not be related to the robot. So in order for the tool to
move with the robot, you must attach it to the robot.
To import a tool, in the Home tab, click Tool and then select a tool from the gallery.

Importing a positioner
To import a tool, in the Home tab, click Positioner and then select a positioner
from the gallery.

Adding the track to the system
To select the model of the external axis to use, follow these steps:

Note

This procedure is not applicable for a robot system with track motions IRBT4004,
IRBT6004, or IRBT7004. They are configured by the TrackMotion mediapool and
not by adding separate configuration files. For information on installation
instructions, see Installing and licensing RobotStudio on page 44.

1 Start the system in a virtual controller, either in a new empty station or in an
existing station, see Robot System on page 228.

2 In the Layout browser, select the system to add the track to.
3 On the Controller tab, click System Configuration.
4 Click Add to add parameters for the track to the system. Browse to the

parameter file (.cfg) for the track to add and click Open.
If you have a specific parameter file for you track, use that one. Otherwise,
parameter files for some standard tracks are delivered with the RobotStudio
installation. These can be found in the folder ABB Library/ Tracks in

Continues on next page
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RobotStudio’s installation folder. The ABB Library folder can also be opened
from the Quick access pane at the left of the Open dialog box used for adding
parameter files.
The file name of each parameter file tells which tracks it supports. The first
part tells the length of the track and the second the number of tasks.
For example, the file TRACK_1_7.cfg supports all tracks with the length 1.7
meters in systems with one single task. For Multimove systems or other
systems with several tasks, use the configuration file with the matching
number of tasks.
For example, if the track length is 19.9 m and the robot attached to the track
is connected to task 4 of the MultiMove system, then select
TRACK_19_9_Task4.cfg file.

5 In the System Configuration window, click OK. When asked if you want to
restart the system, answer Yes.

6 During the restart a list of all tracks compatible with the configuration file is
displayed. Select the one to use and click OK.
After the restart the track appears in the station. Continue with attaching the
robot to the track.

Importing a library, geometry or piece of equipment
A library component is a RobotStudio object that has been saved separately.
Normally, components in a library are locked for editing.
A geometry is CAD data which you can import to use in RobotStudio. For a list of
importable CAD formats, see Libraries, geometries and CAD files on page 41.
To import a library, geometry or piece of equipment, see Import Library on page227.
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2.6.2 Troubleshooting and optimizing geometries

Overview
The characteristics of the geometries and CAD models in the station may have
great effect on your work in RobotStudio, both in aspects of making the objects
easier to program as well as enhancing simulation performance.
Below are some guidelines for troubleshooting geometries.

InformationTrouble

This problem might be caused by wrong snap mode settings,
imprecise selecting, hidden or lack of geometrical information.
To resolve these problems, do the following:

• Check the selection level and snap mode settings. For
more information, see Selecting an item on page 76.

• When making the selection, zoom and rotate the object
so that you are sure to click inside the object.

• Check if the object has hidden details that might affect
the snapping. Remove details that are not necessary for
your programming or simulation. For more information,
see Modifying a part on page 99.

• Some file formats only contain a graphical representation
and no geometrical data. Import the geometry from a
file format that also contains geometrical data. For more
information, see Libraries, geometries and CAD files on
page 41.

The pointer snaps to the
wrong parts of the objects
when selecting in the
graphics window

This might be due to the performance of your computer not
being high enough for the size of the geometry files in your
station.

The graphics window re-
draws or updates slowly

To reduce the size of the geometry files, do any of the following:
• Use a lower detail level for rendering the geometry. For

more information, seeGraphic Appearance on page498.
• Check if the object has unnecessary details. Remove

details that are not necessary for your programming or
simulation. For more information, see Modifying a part
on page 99.
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InformationTrouble

If parts of the geometry are not visible from some views, a
probable cause is that the object is made up of 2D surfaces
and the option Backface culling is on.

Parts of the geometry are
not visible

Backface culling means that the faces of the object are only
visible from the front, and if the object (or any of its faces) is
oriented differently, they will not be visible.
To correct the problem, do one of the following:

• Switch to modeling mode and invert the direction of the
face that is not displayed correctly. This not only corrects
the display, it also decreases the chance of faulty orient-
ations during graphical programming. For more inform-
ation, see Invert on page505 or To invert the direction of
all faces of a part on page 97.

• Turn backface culling off for the specific object. This
makes the object display correctly, but does not affect
the direction of the face, which might cause problems if
the face will be used for graphical programming. For
more information, see To deactivate backface culling
for a single object on page 97.

• Turn backface culling off for all objects in the station.
This makes the objects display correctly, but does not
affect the direction of the face, which might cause
problems if the face will be used for graphical program-
ming. It also decreases the performance of the graphic
handling. For more information, see To change the
generic setting for backface culling on page 97.

To invert the direction of all faces of a part
To invert the direction of all faces of a part, follow these steps:

1 Select the part on which faces you want to invert the directions.
2 On the Modify menu, click Graphic Appearance.
3 On the Rendering tab, click Flip normals and then click OK.

To deactivate backface culling for a single object
To change the backface culling setting for a single object, follow these steps:

1 Select the part for which you want to change the backface culling setting.
2 On the Modify menu, click Graphic Appearance.
3 On the Rendering tab, clear the Backface culling check box and then click

OK. The faces of the object will now be displayed even if the generic setting
for backface culling is on.

To change the generic setting for backface culling
The generic setting for backface culling affects all new objects and existing objects
that do not have backface culling specifically deactivated.

1 On the File menu, click Options.
2 On the Navigation pane .to the left, select Graphics: Performance.
3 On the Performance page to the right, select or clear the Cull back-facing

triangles check box and then click OK.
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2.7 Modeling

2.7.1 Objects

Overview
This section describes how to create or modify geometrical objects.

Creating a frame
A frame is a generic coordinate system that you can use as reference when
positioning objects. Generic frames can also be converted to special kinds of
coordinate systesm, like workobjects or tool center points.
For procedures, see Frame on page236 and Frame from Three Points on page237.

Creating a solid
With the create solids commands you can create and build models of objects you
do not have CAD files or libraries for. With the create solids commands you create
primitve solid bodies; these can later be combined to more complex bodies.
For procedures, see Solid on page 318.

Creating a surface
For procedures, see Surface on page 322.

Creating a curve
When creating paths with targets based on the object geometries, curves are the
geometrical objects that RobotStudio uses. For example, if you want the robot to
run along the edge of an object, you can first create a curve along the border and
then generate a complete path along that curve, instead of manually finding and
creating the necessary targets.
If the CAD model/geometry of the work piece does not already contain curves, you
can create the curves i RobotStudio.
For procedures, see Curve on page 324.

Modifying a curve
When creating paths with targets based on the objects geometries, curves are the
geometrical objects that RobotStudio uses. By optimizing the curves before starting
programming, you reduce the touch-up of the generated paths.
For procedures, see Modify Curve on page 514.

Creating a border
For procedures, see Border on page 329.

Creating a line from normal
A line can be created as a new part and body perpendicular to a surface.
For a procedure, see Line from Normal on page 336.
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Extruding a surface or curve
Curves and surfaces and curves can also be extruded to 3D objects, which may
then be converted to solids. You can extrude along either a vector or a curve.
For procedures, see Extrude Surface or Curve on page 334.

Modifying a part
When you import a geometry or create an object, it will be one part. A part can,
however, contain several bodies. In RobotStudio’s modeling mode you can modify
the parts by adding, moving and deleting the bodies.
To modify a part, follow this step:

1 In theModeling browser, expand the node for the part to modify. Then modify
the part by doing any of the following:

Do thisTo

Select the body and press the DEL key.Delete a body

Drag the body or use the Copy and Paste commands on
the Edit menu.

Move a body from one
part to another

Select the body and then move it using any of the ordinary
commands for moving objects, see Placing objects on
page 103.

Move one body relative
to the others

Modifying a library component
As external files, libraries are merely linked from a station. Therefore, to modify
an imported library component, the link must first be broken and later reestablished.
For procedures, see Modify Library Component on page 508.
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2.7.2 Mechanisms

Workflow
This information topic describes how to create a new mechanism, that is, a graphical
representation of a robot, tool, external axis or device. The various parts of a
mechanism move along or around axes.
Creating a mechanism is dependent upon skillful construction of the main nodes
of the tree structure. Four of these—links, joints, frames/tools and calibration—are
initially marked red. As each node is configured with enough subnodes to make it
valid, the marking turns to green. As soon as all nodes have become valid, the
mechanism will be considered compilable and can be created. For additional validity
criteria, see the table below.

Validity criteraNode
• It contains more than one subnode.
• The BaseLink is set.
• All link parts are still in the station.

Links

• At least one joint must be active and valid.Joints
• At least one frame/tool data exists.
• For a device, no frames are needed.

Frame/tool Data

• For a robot, exactly one calibration is required.
• For an external axis, one calibration is required for each

joint.
• For a tool or device, calibrations are accepted, but not

required.

Calibration

• None.Dependencies

The modify mode of the Mechanism Modeler has two purposes: to enable
modification of an editable mechanism in its tree structure, and to complete the
modeling of a new or modified mechanism.
It is recommended to configure each main node in the tree structure from the top
down. Depending on its current status, right-click or double-click a node or subnode
to add, edit or remove it.
For procedures, see Create Mechanism on page 338.
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2.7.3 Tools and tooldata

Overview
To simulate the robot tool, you need tooldata for the tool. If you import a predefined
tool or if you create a tool using the Create Tool Wizard, the tooldata is
automatically created; otherwise, you have to create the tooldata yourself.
The tooldata simplifies the programming work with respect to the different tools
that may come in use. Defining separate sets of tooldata for different tools makes
it possible to run the same robot program with different tools: only the new tooldata
has to be defined. The tooldata contains the information required for moving and
simulating the tool.
Two methods for manipulating tooldata in RobotStudio are as follows:

• Create or modify tooldata, see Tooldata on page240 andModify Tooldata on
page 519, respectively. This will create all data necessary for programming,
but there will be no visual tool during the simulation.

• Create tooldata for an existing geometry, Create Tool on page 345.

Creating and setting up a stationary tool
This information topic describes how to create a stationary tool. For information
about creating a robot hold tool, see Create Tool on page 345.
Using a stationary tool, the robot holds and moves the work piece in relation to
the tool. Thus, both the tooldata and the workobject must be set up correctly.
To create the tooldata for a stationary tool, follow these steps:

1 Import the geometry or library that represents the tool, see Import Geometry
on page 234.
If you do not have the geometry or library at hand but know the position, you
can skip this step. The tool will be programable, but not visible in the station.

2 Create the tooldata for the tool, see Tooldata on page 240.
Make sure to set the Robot holds tool option to false.

3 Create a workobject that is moved by the robot. see Workobject on page239.
Make sure to set the Robot holds workobject option to true.

4 If you have a geometry or library component for the work piece, attach it to
the robot, see Attach to on page 486.
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2.7.4 Setting the local origin of an object

Overview
Each object has a coordinate system of its own called local coordinate system in
which the object dimensions are defined. When the object’s position is referred
from other coordinate system, it is the origin of this coordinate system that is used.
With the Set Local Origin command you reposition the object’s local coordinate
system, not the object itself.
For a procedure, see Set Local Origin on page 532.
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2.8 Placement

2.8.1 Placing objects

Overview
To achieve the required layout of your station, you need to import or create objects,
place them accordingly and, if applicable, attach them to other objects.
Placing objects means setting their position and rotation. If the objects are to be
attached to robots or other mechanisms, they will be placed at their attachment
point automatically.
The following table describes the actions relating to placement:

DescriptionActions

To place an object is to put the object in the required position
in the station, see Place on page 524 and Set Position on
page 534.

Placing an object

The objects in the station can be rotated to achieve the required
layout, see Rotate on page 530.

Rotating an object

The measurement functions calculates distances, angles and
diameters between points you select from the graphics window.

Measuring distance or
angles

When using measurements, results and instructions on how
to proceed are displayed in the Output window, see The
Measure Group on page 337.

A component group groups related object in the browser, see
Component Group on page 282.

Creating a component
group

Objects that are to be used by the robots in any way, such as
tools, need to be attached to the robot, seeAttach to on page486
and Detach on page 495.

Attaching or detaching an
object

Robots can be placed by jogging. The robot axes can also be
postioned by jogging, see Jogging mechanisms on page 111.

Jogging a robot

Modifying the task frame repositions a controller and all its ro-
bots and equipment in the station.

Modifying the task frame

By default the controller world and the station world coordinate
system coincide. This is convenient when building a station
with one single controller. For a procedure, see Set Task
Frames on page 439.
However, when you have several controllers in one station, or
need to reposition a controller in an existing station, you need
to modify the Edit System on page 440.

Modifying the baseframe position sets an offset between the
controller’s world coordinate system and the baseframe of the
mechanical unit.This is necessary when having several mech-
anical units belonging to one controller, for example, several
robots in MultiMove systems or when using positioner external
axes. For a procedure, see Edit System on page 440.

Modifying the baseframe
position
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2.8.2 Placing external axes

Overview
When starting a system with a track or positioner external axis in a RobotStudio
station, you have to set up the system to load a model for the track or positioner
and get the motions to work properly.

Prerequisites
The system shall be created with support for track or positioner external axes, see
A system with support for one robot and one positioner external axis on page 179.

Attaching the robot to the track
To attach the robot to the track, follow these steps:

1 In the Layout browser, drag the robot icon and drop it on the track icon.
2 To the question Should the robot be coordinated with the track?, answer

Yes to be able to coordinate the track’s position with that of the robot in robot
programs. To program the track and the robot independently, answer No.

3 When asked if you want to restart the system, answer Yes.
The track is now added to the system and ready to be programmed, see
Programming external axes on page 137 for more information on how to
program the track.

CAUTION

If you restart the system using the restart mode Reset controller, the setup is
deleted and the procedures described here must be performed again.

Placing the positioner in the station
To place the positioner in the station, follow these steps:

1 Move the positioner to the desired position using any of the ordinary functions
for placing and moving objects, see Placing objects on page 103.

2 Modify the baseframe position of each mechanical unit of the positioner
except the INTERCH unit, if it exists. When asked if you want to restart the
system, answer Yes.
After the restart the system is updated with the positioner’s new location.
Continue attaching fixtures and workobjects to the positioner.

Attaching objects to the positioner
To program robot motions on an object that is held by the positioner, the targets
must be created in a workobject that is attached to the positioner. For a complete
visual simulation, CAD models that are moved by the positioner should also be
attached. To attach the objects, follow these steps:

1 Import the models of the fixture and the work piece if you do not have them
in the station already, see Importing a station component on page 94.
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2 Attach the fixture to the positioner, see Attaching and detaching objects on
page 77. When asked whether to keep the current position, answer No.
If the positioner has several stations, you will be asked which one to attach
the object to.

3 Attach the work piece to the fixture. When asked whether to keep the current
position, answer No.

4 Attach the workobject in which you will program the work piece to either the
fixture, the work piece or the positioner. If you have defined calibration
positions on either the work piece or the fixture, it is a good practice to use
that object. When asked whether to keep the current position, answer No.
The positioner is now set up and ready to be programed, see Programming
external axes on page 137 for more information.

Tip

If the positioner is of an interchangeable type with several stations, you can either
attach individual fixtures, work pieces and workobjects to each station flange,
or you can use one set of objects that you attach and detach to the different
flanges by events.

CAUTION

If you restart the system using the restart mode Reset controller, the setup is
deleted and the procedures described here must be performed again.
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2.8.3 Placing robots

Overview
When modifying the position of a robot connected to a VC there is a possibility to
modify the related task frame or any stationary RAPID objects (tooldata,
workobjects) connected to the robot.

Prerequisites
A robot library must be present in the station and connected to a VC, see Creating
a station with a system on page 83.

Modifying the robot position using a positioning tool
1 Modify the baseframe position of a robot connected to a VC using any of the

following options:
• Set Position. See Positioning an item on page 534.
• Place object by One Point, Two Points, Three Points, Frame, and Two

Frames. See Placing an item on page 524.
• Rotate. See Rotating an item on page 530.

2 Click Apply.
To the question, Do you also want to move the Task Frame?. Click Yes or
No.

• Click Yes to move the task frame, but the base frame keeps its relative
placement to the task frame.

• ClickNo to move the base frame and the placement relative to the task
frame will change.

Note

If there are any stationary RAPID objects (tooldata, workobjects) in the
corresponding task, the following question appears Do you want to keep the
positioning of all stationary RAPID objects?

• Click Yes to keep all the stationary RAPID objects in their global coordinates.
• Click No to move all the stationary RAPID objects along with the base frame

(same coordinates relative to base frame). Workobjects attached to any
other object in the station will not be affected. Workobjects attached to any
other object in the station will not be affected.

If the base frame configuration of the VC is updated, the VC has to be restarted
for the changes to take effect. i.e. if the base frame changes its placement relative
to task frame, the following question appears Do you want to update the
controller configuration and restart?

• Click Yes to restart the controller and update the base frame configuration
of the connected VC.

• Click No if the base frame is not in accordance with the controller.
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Modifying the robot position using Freehand move or rotate
1 Modify the baseframe position of a robot connected to a VC using the

following Freehand options:
• Move. See The Freehand Group on page 265.
• Rotate. See Rotating an item on page 266.

For information on updating the robot baseframe, seeUpdating the baseframe
position on page 440.

2 A warning message is displayed in the Output window.
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3 Programming robots
3.1 Workflow for programming a robot

Overview
In most cases, going through the workflow from start to finish is recommended,
even if it is possible to work in other sequences as well.
Synchronizing will save and load text files containing RAPID modules, and create
RAPID programs from your station.

Prerequisites
Before creating a program for your robot, you should set up the station, including
robots, work pieces and fixtures, in which your robot will work.

Programming a robot
The table below describes the workflow for programming a robot to perform the
task you require.

DescriptionTask

Create the targets and paths the robot requires to perform the
work tasks.

Create targets and paths

To create targets and paths, do one of the following:
• Create a curve to match your required shape. Then use

the Create path from curve command to generate a
path, complete with targets, along the shape you have
created. See Curve on page 324 and AutoPath on
page 248.

• Create targets at the requested positions, then create a
path and insert the created targets into it. See Create
Target on page242, Teach Target on page241 andEmpty
Path on page 247.

Make sure that the targets are oriented in the most efficient
way for the tasks to be performed. If not, reorient the targets
until you are satisfied. See Orientations on page 117.

Check the target orienta-
tions

Check that the robot and tool reach all targets in the path. See
Testing positions and motions on page 128.

Check reachability

Generates RAPID code from the RobotStudio items and enables
the program to be simulated.

Synchronize the program
to the virtual controller

If you need to edit the instructions or data created by RobotStu-
dio, you can start the RAPID Editor. See Examples of using
the RAPID editor on page 473.

Perform text-based editing

Check that the robot or tool does not collide with the surround-
ing equipment or the fixtures. If it does, adjust the placements
or orientations until no collisions occur. SeeDetecting collisions
on page 147.

Collision detection

Test the program by moving along the paths. See Testing pos-
itions and motions on page 128.

Test the program
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3.2 Workobjects

Creating a workobject
A workobject is a coordinate system used to describe the position of a work piece.
The workobject consists of two frames: a user frame and an object frame. All
programed positions will be related to the object frame, which is related to the user
frame, which is related to the world coordinate system.

xx050000

For creating a workobject, see Workobject on page 239.

Modifying a workobject
For a procedure, see Modify Workobject on page 520.

Converting a frame to a workobject
You can create a new workobject from an existing frame. The converted workobject
gets the same name and position as the selected frame.
For a procedure, see Convert Frame to Workobject on page 491.

Creating a frame by points
You can create a frame by specfiying points on the axes of the coordinate system
and letting RobotStudio calulate the placement and orientation of the frame’s origin.
For a procedure, see Frame from Three Points on page 237.
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3.3 Jogging mechanisms

Jogging a robot
To check if the robot can reach all positions on the work piece, you can jog the
TCP or the joints of the robot, either with the freehand commands of through dialog
boxes. Jogging the robot close to its boudaries is best done with the latter method.

ProcedureTo

For freehand, see Jog Joint on page267. For a dialog box, see
Mechanism Joint Jog on page 509.

Jog the joints of a robot

For freehand, see Jog Linear on page268. For a dialog box, see
Mechanism Linear Jog on page 511.

Jog the TCP of a robot

Prerequisites
To jog the TCP of a robot, the robot’s VC must be running.

Jogging several mechanisms

DescriptionFunction

When using multirobot jog, all selected mechanisms will follow
the TCP of the one being jogged.

Mutlirobot jog

Multirobot jog is available for all kinds of jogging.
See MultiRobot Jog on page 270.

When jogging a mechanism that moves a robot (like a track
external axis) with locked TCP, the robot will reposition so that
the position of the TCP does not change, even though its
baseframe is moved.

Jogging with locked TCP

When jogging an external axis that moves the work object with
locked TCP, the robot will reposition so that its TCP follows
the work object in the same way as when using multirobot jog.
Locked TCP is available when jogging a mechanism that be-
longs to the same task as a robot.
See Mechanism Joint Jog on page 509.
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3.4 Targets

Creating a target
You can create a new target manually either by entering the position for the target
in the Create Target dialog box or by clicking in the graphics window.
The target will be created in the active workobject.
For a procedure, see Create Target on page 242.

Creating a jointtarget
A jointtarget is a specification of the position for the robot axes.
For a procedure, see Create Jointtarget on page 244.

Teaching targets
You can create a new target by jogging the robot and teaching a target at the active
TCP. Taught targets will be created with the axis configuration used when jogged
to the target.
The target will be created in the active workobject.
For a procedure, see Teach Target on page 241.

Modifying a target position
By using the modify position command you can modify the position and rotation
of a target.
For procedures, see Set Position on page534 andRotate on page530, respectively.

Modifying a target with ModPos
The position of an existing target can be modified by jogging the robot to a new,
preferred position. By selecting a move instruction for the target in a path, the
ModPos command can be used to move the target to the TCP of the active tool.
When ModPos is executed, the target, referenced to by the move instruction, will
be updated with the following information:

• position and orientation corresponding to the TCP of the active tool
• the current configuration of the active robot
• the current position and orientation values of all active external axes for the

active robot

Note

To jog a robot linearly, a virtual controller must be running for that robot. For
detailed information, see Starting a VC on page 92.

Renaming targets
With this command you can change the name of several targets at once. You can
either rename targets individually, or you can rename all targets in one or several
paths at once.

Continues on next page
112 Operating manual - RobotStudio

3HAC032104-001 Revision: U
© Copyright 2008-2017 ABB. All rights reserved.

3 Programming robots
3.4 Targets



The new target names will consist of an optional prefix, an incremental number
and an optional suffix.
For a precedure, see Rename Targets on page 528.
When renaming targets, make sure that the new targets conform to the naming
rules. The target names must:

• start with an alphabetical character in the ISO 8859-1 encoding (that is, an
ordinary letter from the English alphabet)

• be shorter than 16 characters
• not be empty strings
• not contain any characters illegal in RAPID. See RAPID reference manual

for details.

Removing unused targets
If deleting or changing paths or move instructions during programming, you might
end up with large numbers of targets that are no longer used in any instructions.
To make the workobjects and their targets easier to grasp, you can delete all unused
targets.
For a procedure, see Remove Unused Targets on page 527.
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3.5 Paths

Creating an empty path
A path is a sequence of targets with move instructions that the robot follows. An
empty path will be created in the active task.
For a procedure, see Empty Path on page 247.

Creating a path from curve
If the work piece has curves or contours that correspond to the path to be created,
you can create the paths automatically. The create path from curve command
generates paths, complete with targets and instructions along existing curves.
The path will be created in the active task.
The orientation of the targets that will be created will be according to the settings
of the approach/travel vectors in the Options dialog box.
To create a path from a curve, the curve must have first been created in the station.
See AutoPath on page 248.

Setting robot axis configuration for paths
The robot axis configuration specifies the position of the axes as the robot moves
from target to target, when multiple solutions are possible. This is necessary for
executing move instructions using configuration monitoring.
Taught targets have validated configurations, but targets created in any other way
do not. Also, targets that are repositioned lose their configuration. In RobotStudio,
targets without a valid configuration are marked with a yellow warning symbol. See
Robot axis configurations on page 39 for more information about configurations.
To set a configuration for all targets in a path, see Configurations on page 487.
To set a configuration for a single target, see Configurations on page 490.

Reversing paths
The reverse path commands change the sequence of targets in the path so that
the robot moves from the last target to the first. When reversing paths, you can
reverse either the target sequence alone or the entire motion process.
For procedures, see Reverse Path on page 529.

Note

When reversing paths, the original paths are deleted. If you want to keep them,
make copies before reversal.

Note

When reversing paths, only move instructions are handled. Action instructions,
if any exist, have to be inserted manually after the reversal.
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Rotating paths
With the rotate path command you can rotate complete paths and move the targets
used by the paths accordingly. When rotating paths, the included targets will lose
their axis configurations, if any have been assigned.
A frame or target must exist at the position to rotate around before starting the
rotate path command.
For a procedure, see Rotate Path on page 531.

Translating a path
The translate path function moves a path and all included targets.
For a procedure, see Translate Path on page 536.

Compensating paths for tool radius
You can offset a path so that it compensates for the radius of a rotating tool. Since
the targets in the path are moved, they will lose their axis configurations, if any
have been assigned.
For a procedure, see Tool Compensation on page 535.

Interpolating a path
The interpolate functions reorient the targets in a path so that the difference in
orientation between the start and end targets is distributed evenly among the
targets in between. The interpolation can be either linear or absolute.
Linear interpolation distributes the difference in orientation evenly, based on the
targets’ positions along the length of the path.
Absolute interpolation distributes the difference in orientation evenly, based on
the targets’ sequence in the path.
Below are examples of the difference bewteen linear and absolute interpolation.
The interpolate functions reorient the targets in a path so that the difference in
orientation between the start and end targets is distributed evenly among the
targets in between. The interpolation can be either linear or absolute.
For a procedure, see Interpolate Path on page 504.

No interpolation
This is the path before any interpolation. Note that the last target is oriented
differently than the others.

xx050026
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Linear interpolation
This is the same path after linear interpolation.

xx050027

Note that the targets are oriented based on their placement relative to the start
and end targets.
If a target were moved and you reran the linear interpolation, it would be reoriented
according to its new position.
If new targets were inserted between the existing ones and you reran the linear
interpolation, it would not affect the orientation of the existing targets.

Absolute interpolation
This is the same path after absolute interpolation

xx050028

Note that the targets are orientated based on their sequence in the path: each
target has been reoriented equally, regardless of its place.
If a target were moved and you reran the absolute interpolation, it would not affect
the orientation.
If new targets were inserted between the existing ones and you reran the absolute
interpolation, it would change the orientation of all targets.

Mirroring a path
The mirror path function mirrors all motions instructions and their targets to a new
path.
For a procedure, see Mirror Path on page 512.
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3.6 Orientations

Overview
This is an overview of the tools for automating the modification of target orientations.
When creating paths from curves in RobotStudio, the orientation of the targets
depends on the characteristics of the curves and the surrounding surfaces. Below
is an example of a path with unordered target orientations and examples of how
the different tools have affected the targets.

Unordered orientations
In the path below, the target orientations are unordered. The function View tool at
target has been used for illustrating how the targets point in different directions.

xx050029
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Effect of target normal to surface
In the picture below, the targets, which previously were orientated randomly, have
been set normal to the flat round surface at the right side of the path. Note how
the targets’ Z axis has been orientated normal to the surface; the targets have not
been rotated in the other directions.

xx050030

Setting a target normal to surface
To set a target orientation normal to a surface is to make it perpendicular to the
surface. The target can be oriented normal to the surface in two different ways:

• The entire surface can be used as a reference for the normal. The target will
be oriented as the normal to the closest point at the surface. The entire
surface is the default surface reference.

• A specific point on the surface can be used as the reference for the normal.
The target will be orientated as the normal to this point, regardless of whether
the normal to the closest point at the surface has another orientation.

Objects imported without geometry (for example, .jt files) can only refer to specific
points on the surface.
For a procedure, see Set Normal to Surface on page 533.
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Effect of align target orientation
In the picture below, the targets, which were previously orientated with the Z axis
normal to the surface but with the X and Y axes orientated randomly, have been
organized by aligning the targets’ orientation around the X axis with the Z axis
locked. One of the targets in the path has been used as reference.

xx050031

Aligning a target orientation
With the align target orientation command you align the rotation of selected targets
around one axis without changing the rotation around the others.
For a procedure, see Align Target Orientation on page 485.

Tip

You can also align ordinary frames in the same way.
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Effects of copy and apply orientation
In the picture below, the targets, which were previously oriented randomly, have
been organized by copying the exact orientation of one target to all the others.
This is a quick way to fix workable orientations for processes where variations in
approach, travel, or spin directions either do not matter or are not affected, due to
the shape of the work piece.

xx050032

Copying and applying an orientation for objects
To transfer an orientation from one object to another is an easy way to align different
frames for simplifying the programming of the robot. Target orientations may also
be copied.
For procedures, see Copy / Apply Orientation on page 494.
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3.7 RAPID Instructions

Note

For information on the RAPID Editor, which is used for creating and modifying
RAPID program code, see RAPID tab on page 443.

Move and action instructions
For RAPID programming, RobotStudio’s main advantage is in the area of motion
programming.
A move instruction is an instruction for the robot to move to a specified target in
a specified manner. With RobotStudio, you can create move instructions in three
ways:

DescriptionMethod

Creates move instructions based on one or several targets
selected in the Paths&Targets browser. For a procedure, see
Add to Path on page 483.

Create a move instruction
based on an existing target

Creates a move instruction and a corresponding target at
once. The position of the target can either be selected from
the graphics window or typed numerically. For a procedure,
see Move Instruction on page 259.

Create a move instruction
and a corresponding target

Teaching a move instruction creates a move instruction and
a corresponding target at the robot’s current position.
Teaching a move instruction also stores the current configur-
ation with the target. For a procedure, see Teach Instruction
on page 258.

Teach a move instruction

In addition to move instructions, you can also create and insert action instructions
from RobotStudio. An action instruction is an instruction other than a move
instruction that can, for example, set parameters, or activate or deactivate
equipment and functions. The action instructions available in RobotStudio are
limited to those commonly used for affecting the robot’s motions. For inserting
other action instructions or another kind of RAPID code in the program, use the
RAPID Editor. For a procedure, see Action Instruction on page 260.
The table below lists the action instructions that can be created. For details, see
the RAPID Reference Manual.

DescriptionAction instruction

ConfL specifies whether to monitor the robot’s configurations
during linear movements. When ConfL is set to Off, the robot
may use another configuration than the programed one for
reaching the target during program execution.

ConfL On/Off

ConfJ specifies whether to monitor the robot’s configurations
during joint movements. When ConfJ is set to Off, the robot
may use another configuration than the programed one for
reaching the target during program execution.

ConfJ On/Off

Actunit activates the mechanical unit specified by UnitName.Actunit UnitName

Deactunit deactivates the mechanical unit specified by Unit-
Name.

DeactUnit UnitName
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DescriptionAction instruction

ConfJ specifies whether to monitor the robot’s configurations
during joint movements. When ConfJ is set to Off, the robot
may use another configuration than the programed one for
reaching the target during program execution.

ConfJ On/Off

Actunit activates the mechanical unit specified by UnitName.Actunit UnitName

Deactunit deactivates the mechanical unit specified by Unit-
Name.

DeactUnit UnitName

Modifying an instruction
Most instructions have arguments that specify how the instruction shall be carried
out. For example, the MoveL instruction has arguments that specify the speed and
accuracy with which the robot moves to the target.
For a procedure, see Modify Instruction on page 517.

Note

Some arguments are read from the virtual controller. If the virtual controller has
not been started, only the arguments stored in the station can be modified.

Converting to move circular
To create a circular motion to an instruction target, you must convert the motion
type to circular motion (that is, MoveC in RAPID).
A circular motion is defined by two motion instructions, where the first is the
via-point and the second contains the end point of the circular motion.
The circular motion can only be used for open circular arcs, not for closed circles.
To create a path for a closed circle, use two circular motions.
For a procedure, see Convert to Move Circular on page 493.

Creating RAPID instructions for setting I/O signals
For controlling I/O signals in the robot program, you use RAPID commands that
set the signals. These require that you first create instruction templates for the
instructions that set the signals. See RAPID referencemanual for details about the
instructions that control I/O signals.
To add RAPID instructions that set I/O signals, follow these steps:

1 Synchronize the system in which you want to add the instructions to the
virtual controller, see Synchronization on page 140.

2 In programming mode, select the module for editing, right-click it and then
click Edit program.

3 In the RAPID editor, add the instructions for setting the signals.
4 When you are done adding instructions, synchronize the task and paths from

the Virtual Controller back to the station.
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Using cross-connections and groups for setting I/O signals
You can also create cross-connections and signal groups, which make one signal
set the value of several other signals. See System parameters reference manual
for details about cross-connections and groups.
To make one signal set several others, follow these steps:

1 Request write access, and then open the configuration topic I/O in the
configuration editor. Add configure instances for the cross-connections and
groups to create.

Instruction templates
Instruction templates contain predefined sets of argument values that are applied
to the instructions you create using the template. You can create templates for all
instructions in the system running on the virtual controller. To see which instructions
are available and what their arguments do, see the RAPID reference manual for
your RobotWare version and the reference sections in manuals for software options,
if you have any installed on the system.
Move instruction templates are always part of process templates. The process
templates contain one instruction template for each type of move instruction that
might be used by the process.
The process templates are instances of process definitions, which define the types
of move instructions (move instruction definitions) that might be used by the
process.
To create new move instruction templates, start by creating a new process template
for a process that uses the type move instructions you want to create templates
for. If such a process does not exist, you first have to create a new process
definition.
If no move instruction definition for the type of instruction you want to create a
template for exists, you must create it first.
When creating instruction descriptions, the virtual controller must be running, since
the available instruction types are read from the system.
Templates can be imported and exported on four levels: tasks, move instruction
descriptions, action instruction descriptions and process definitions. The default
directory for imported and exported template files is My Documents/RobotStudio.
Simply choosing another directory will then make that directory default. As a default
.xml is the file format.
The validation procedure checks for duplicate names, incomplete process definitions
and virtual controller equality. It is performed automatically, after a template file
has been imported or a node renamed or deleted.
For procedures, see Instruction Template Manager on page 261.

Instruction Template Manager
The Instruction Template Manager is used to add support for instructions other
than the default set that comes with the RobotStudio.
For example, a robot controller system with the RobotWare Dispense option has
specialized move instructions related to glueing like DispL and DispC. You can
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manually define the instruction templates for these using the Instruction Template
Manager. The instruction templates are exported to XML format and reused later.
The instruction template supports the following Robotware options:

• Cap (Continuous Application Process)
• Disp (Dispense)
• Trigg (Fixed Position Events)
• Spot Pneumatic
• Spot Servo
• Spot Servo Equalizing
• Paint

RobotStudio has pre-defined XML files that are imported and used for robot
controller systems with the appropriate RobotWare options.These XML files has
both the Move and Action instructions.

Note

Use RobotStudio ArcWelding PowerPac while using RobotWare Arc.

Creating a process template with move instruction templates

Note

Move instructions are always related to processes.

1 On the Home tab, from the active Task list, select the task for the robot for
which you want to create the instruction template.

2 On the Create menu, click Instruction Template Manager. This opens the
Instruction templates page in the work space.

3 In the Instruction Templates tree to the left, make sure there are move
instruction definitions for the types of move instructions you want to create
templates for. If not, follow the procedure in Creating a move instruction
description on page 125 for creating them.

4 Make sure there is a process definition that uses the types of move
instructions you want to create templates for. If not, follow the procedure in
Creating a process definition on page 125 for creating it.

5 Right-click the process definition for which you want to create a new templates
and click Create Process Definition.

6 In the Create Process Definition dialog box, enter a name, with characters
from ASCII set, for the new template and clickCreate. A new process template
node with a set of move instruction templates is now created.

7 Select each new template one at a time, and in the arguments grid to the
right of the tree view, set the argument values that shall be applied when you
create new instructions based on the template. Finish for each template by
clicking Apply changes at the bottom of the grid.
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For details about available arguments and what they do, see the RAPID
reference manual for ordinary RAPID instructions and the option manual for
software option instructions.

Creating a move instruction description
To create templates for other instructions than the one that already exists in the
tree view, you first have to create an instruction description that defines the
arguments that belong to the instruction. To create the instruction description,
follow these steps:

1 Right-click the Move Instructions node and click Create Move Instruction
Description. This opens the Create Move Instruction Description dialog
box.

2 In the Controller Description list, select the instruction you want to make a
description for. All action instructions installed on the controller, both through
RobotWare and software options, are available.

3 In the Motion type list, select the motion type for the instruction.
4 Optionally, in the Information text box, enter a comment to the instruction.
5 Click Create. The instruction description appears in the tree view and its

settings are displayed in the grid.
6 In the instruction grid, set the point type values. If necessary, also change

the other settings.
7 After changing the settings, click Apply Changes in the bottom of the grid

view.

Editing an instruction template
To edit an instruction template, follow these steps:

1 In the active task list, select the task for the robot for which you want to edit
the instruction template.

2 On the Create menu, click Instruction Template Manager. This opens the
Instruction templates page in the work space.

3 In the Instruction Templates tree to the left, browse to and select the template
to edit.

4 In the arguments grid to the right of the tree view, set the argument values
that shall be applied when you create new instructions based on the template.
Finish by clicking Apply changes at the bottom of the grid.
For details about available arguments and what they do, see the RAPID
reference manual for ordinary RAPID instructions and the option manual for
software option instructions.

Creating a process definition
To create a process definition, follow these steps:

1 Make sure there are move instruction definitions for the types of move
instructions you want to create templates for. If not, follow the procedure
above for creating them.
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2 Right-click theProcess definitions node and clickCreate Process Definition.
This opens the Create Process Description dialog box.

3 In the Create Process Definitions dialog box, enter a name for the process
definition, a name for its first process template and then select the move
instruction types to use. Finish by clicking Create.

Creating an action instruction template
To create a template for an action instruction, follow these steps:

1 In the active task list, select the task for the robot for which you want to create
the instruction template.

2 On the Home menu, click Instruction Template Manager.
3 In the Instruction Templates tree to the left, right-click the instruction

description (corresponding to the instructions as described in the RAPID
reference manual) for which you want to create a new template and click
Create Action instruction Template.
If the instruction description does not exist in the tree, create it by following
the procedure described in Creating an action instruction description on
page 126.

4 In the Create Action Instruction Template dialog box, enter a name for the
new template and click Create. The new template is now created under the
instruction description node it belongs to.

5 Select the new template and in the arguments grid to the right of the tree
view, set the argument values that shall be applied when you create new
instructions based on the template. Finish by clicking Apply changes at the
bottom of the grid.
For details about available arguments and what they do, see the RAPID
reference manual for ordinary RAPID instructions and the option manual for
software option instructions.

Creating an action instruction description
To create templates for other instructions than the one that already exists in the
tree view, you first have to create an instruction description that defines the
arguments that belong to the instruction.
To create the instruction description, follow these steps:

1 Right-click theAction Instructions node and clickCreate Action Instruction
Description. This opens the Create Instruction Description dialog box.

2 In the Controller Description list, select the instruction you want to make a
description for. All action instructions installed on the controller, both through
RobotWare and software options, are available.

3 Optionally, in the Information text box, enter a comment to the instruction.
4 Click Create. The instruction description appears in the tree view, and its

settings are displayed in the grid.
After changing the settings (if necessary), clickApply Changes in the bottom
of the grid view.
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5 Continue with creating templates for the instruction description, as described
in Creating an action instruction template on page 126.
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3.8 Testing positions and motions

Overview
RobotStudio has several functions for testing how robots reach and move to targets.
They are useful both for finding the optimal layout when building a station and
during programming.
Below are brief descriptions of the functions for testing reachability and motions.

Checking reachability
The check reachability function displays whether the robot can reach selected
targets and motion instructions by changing the frames’ colors in the graphic view.
Reachable frames are colored green, unreachable red, and frames with reachable
positions but not with current orientation are colored yellow.
The reachability check is useful when building the station, since the reachability
of several targets are displayed at once. For a procedure, see Check Reachability
on page 489.

Jumping to target
Jump to target tests whether the robot can reach a specific position. This is useful
when building the station: by creating targets at critical positions on the work piece
and jumping the robot to them, you get an early indication of whether the items
are positioned correctly or not. For a procedure, see Jump to Target on page 506.

Viewing a robot at target
When View robot at target is activated, the robot is automatically positioned with
the tool at the target when one is selected. If several robot axis configurations are
possible for reaching the target, the robot will use the one nearest the configuration
it had before jumping to the target. For a procedure, see View Robot at Target on
page 537.

Viewing tool at target
View tool at target displays the tool at target, without checking that the robot can
reach it. This test is useful both when building the station and when programming
the robot, since the orientation of targets both affects the reachability and the
process performance. For a procedure, see View Tool at Target on page 538.

Executing move instructions
Execute move instruction tests if the robot can reach a specific position with the
programed motion properties. This is useful for testing motions during programming.
For detailed information, see Execute Move Instruction on page 496.

Moving along path
Move along path executes all move instructions in a path. It is thereby a more
complete test than Execute move instructions, but not as complete as a full
simulation, since it ignores RAPID code that is not move instructions. For a
procedure, see Move Along Path on page 521.
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Moving to a pose
Moving to a pose moves a mechanism to a predefined joint value at a predefined
time without using the Virtual Controller. This is useful when movement of the
external equipment (such as a clamp or conveyer) must be simulated. For a
procedure, see Move to Pose on page 522.

Simulating programs
Simulating programs involves running a program on the virtual controller as it is
run on a real controller. It is the most complete test whereby you can see how the
robot interacts with external equipment through events and I/O signals. For a
procedure, see Simulation Setup on page 351.

Improving the reachability
If the robot cannot reach the target, or if you are not satisfied with the motions, try
the following for improving the reachability:

1 Set ConfL or ConfJ to Off for enabling the robot to use new configurations
for reaching the target.

2 Change the orientation of the target.
3 Change the position of either the robot or the work piece.
4 Use a system with a track external axis for increasing the robot’s range.
5 Use a system with a positioner external axis for enabling different work piece

positions for different targets.
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3.9 Programming MultiMove systems

3.9.1 About programming MultiMove

About MultiMove
The MultiMove functions helps you create and optimize programs for MultiMove
systems where one robot or positioner holds the work piece and other robots
operate on it. Below is an outline of the main workflow for programming MultiMove
systems with RobotStudio, with references to detailed instructions further down
in the section.

Prerequisites
For using the MultiMove functions you must first have the following:

• A virtual controller running a MultiMove system started in RobotStudio, see
AMultiMove systemwith two coordinated robots on page194 for an example.

• All coordinate systems and tools used by the system.
• The paths along which the tool shall move. The paths must be created in a

workobject that belongs to a tool robot and is attached to the work piece
robot. A wizard will guide you through attaching the workobjects if this has
not been done before starting the MultiMove functions.

For detailed information about MultiMove in RobotWare systems and RAPID
programs, see MultiMove application manual.

Normal workflow
This is the typical workflow for creating MutliMove programs using the MultiMove
function:

DescriptionAction

Select the robots and paths to use in the program, see
Setting up the MultiMove on page 132.

Setting up the MultiMove

Execute the motion instructions along the paths, see
Testing the MultiMove on page 133.

Testing the MultiMove

Tune motion behavior, such as tolerances and constraints
for TCP motions, see Tuning the motion behavior on
page 134.

Tuning the motion behavior

Generate the tasks for the robots, see Creating paths on
page 136.

Creating the program
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Additional actions
In addition to using the functions that calculate and create optimized MulitMove
paths, you can program MulitMove manaully using a combination of the ordinary
programming tools in RobotStudio and a set of tools specific for MultiMove
programming.
The main actions for programming MulitMove manually are outlined below. Not all
actions might be necessary, but the order in which they shall be carried out depends
on the contents of the station and your goals.

DescriptionAction

This data specifies the tasks and paths that shall be
synchronized with each other. See The Create Tasklist
tool on page 257 and The Create Syncident tool on
page 257, respectively.

Creating Tasklists and Syncid-
ents

To add IDs to the intructions, you can use one of the fol-
lowing methods:

Adding and updating ID argu-
ments to the instructions to syn-
chronize Using The Recalculate ID tool on page 256 to add and

update IDs for instructions in paths that already are syn-
chronized.
UsingTheConvert path toMultiMove path tool on page257
to add IDs to instructions in paths that have not yet been
synchronized.

Add SyncMoveon/Off or WaitSyncTask instructions
to the paths to synchronize and set their tasklist and
Syncident parameters. SeeCreating an action instruction
on page 260.

Adding and adjusting Sync in-
structions to the paths.

It is also possible to jog all robots to the desired positions
and then teach instructions to new synchronized paths.
See MultiTeach tab on page 253.

Teaching MultiMove instructions
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3.9.2 Setting up the MultiMove

Selecting robots and paths
This procedure is for selecting the robots and paths in the station that shall be
used for the MutliMove program. All robots for the MultiMove program must belong
to the same system.

1 On the Home tab, click MultiMove. Click the Setup tab below the MutliMove
work area.

2 In the work area, click the System config bar for expanding the system config
section.

3 In the Select System box, select the system that contains the robots to
program.
The robots of the selected system are now displayed in the System grid
below the Select system box.

4 For each robot that shall be used in the program, select the check box in the
Enable column.

5 For each robot that shall be used in the program, specify whether it carries
the tool or the work piece using the options in the Carrier column.

6 In the work area, click the Path config bar for expanding the path config
section.

7 Select the Enable check box for the tool robot and click the expand button.
This displays the paths of the robot.

8 Select the order of the paths to execute by specifying them in right order
using Path name column.

9 For each path that shall be included in the program, select the check box in
the Enable column.

10 When you have set up the robots and paths, continue testing the Multimove
and then tune the motion properties, if necessary.
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3.9.3 Testing the MultiMove

Overview
Testing the MultiMove executes the motion instructions along the paths according
to the current settings on the setup and motions properties pages.

Testing Paths
This procedure is for setting the robots start position and testing the resulting
movements along the path sequence.

1 Jog the robots to what seems to be a good start position.
2 On the Home tab, click MultiMove. Click the Test tab at the bottom of the

MultiMove work area for displaying the test area.
3 Optionally, select the Stop at end check box to make the simulation stop

after moving along the paths. Clearing this check box makes the simulation
continue in a loop until you click Pause.

4 Click Play to simulate the motions along the paths based on the current start
position.
If you are satisfied with the motions, continue generating multimove paths.
If the simulation cannot complete or if you are not satisfied with the motions,
pause the simulation and perform any of the actions below to adjust the
motions:

DescriptionAction

Click Pause and then use the arrow buttons to move to
one target a time.

Examine the robots’ posi-
tions for critical targets.

New start positions might result in changed motions,
since the robots will use different configurations. In most
cases, positions near the robots’ joint limits shall be
avoided.

Jog the robots to new start
positions.

The default setting for the motion properties is no con-
straints. If this has been changed, constraints might
exist that limit motions more than necessary.

Go to the Motion Behavior
tab and remove con-
straints.
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3.9.4 Tuning the motion behavior

Overview
Tuning the motion behavior means to set up rules for the robot’s motions, for
example, constraints on the position or orientation of the tool. Generally, the
MultiMove program will obtain the smoothest motions with the fastest cycle and
process times with as few constraints as possible.
For procedures, see Motion Behavior tab on page 250.

Modifying the joint influences
The joint influence controls the balance of how much the robots will use their joints.
Decreasing the weight value for one axis will restrict the motion for this axis, while
increasing it will promote motion on this axis relative to alternative axes.

1 On the Home tab, click the Motion Behavior tab.
2 Expand the Joint Influence group by clicking its title bar.
3 In the Select Robot box, select the robot whose joint influence you want to

modify.
The weight values for the robot axes are now displayed in the grid.

4 For each axis whose motion you want to restric or promote, adjust the Weight
value. A lower value restricts, and a higher value promotes, motions on that
axis.

Modifying the TCP constraints
The joint influence controls the balance of how much the robots will use their joints.
Decreasing the weight value for one axis will restrict the motion for this axis, while
increasing it will promote motion on this axis relative to alternative axes.

1 On the Simulation tab, click the Motion Behavior tab.
2 Expand the TCP Constraints group by clicking its title bar.

The directions and rotations in which you can constrain the TCP’s motion
are now displayed in the grid

3 For each pose you want to constrain, select the Enable check box and specify
the constraint values (location in the TCP coordinate system). To use the
values from the current TCP position, click Pick from TCP.

4 Optionally, adjust the Weight value for the constraint. A low value results in
a harder constraint, while a high value allows a larger deviation.

Modifying the tool tolerance
The joint influence controls the balance of how much the robots will use their joints.
Decreasing the weight value for one axis will restrict the motion for this axis, while
increasing it will promote motion on this axis relative to alternative axes.

1 On the Simulation tab, click the Motion Behavior tab.
2 Expand the Tool Tolerance group by clicking its title bar.

The directions and rotations in which you can enable tolerances are now
displayed in the grid
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3 For each offset you want to set, select the Enable check box.
4 In the Value column, specify the allowed deviation.
5 Optionally, adjust the Weight value for the tolerance. A low value increases

the use of the tolerance, while a high value promotes motions that do not
use the tolerance.

Modifying the tool offset
The tool offset sets a fixed distance between the tool and the paths.

1 On the Simulation tab, click the Motion Behavior tab.
2 Expand the Tool Offset group by clicking its title bar.

The directions and rotations in which you can set offsets are now displayed
in the grid.

3 For each offset you want to set, select the Enable check box.
4 In the Offset column, specify the offset distance.
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3.9.5 Creating paths

Overview
When you are satisfied with the motions displayed when testing the Multimove
program, the next step is to convert the temporary move instructions used by the
MultiMove function to ordinary paths in RobotStudio.

Creating the paths
To create paths for the MultiMove program in RobotStudio, follow these steps:

1 On the Home tab, click Create Paths tab.
2 Expand the Settings group by clicking on the its title bar.
3 Optionally, change the naming settings in the following boxes:

DescriptionBox

Specify the first ID number for the synchronization of the
instructions for the robots.

Start ID

Specify the increment between ID numbers.ID step index

Specify a prefix for the syncident variable, which connects
the sync instructions in the tasks for the tool robot and the
work piece robot with each other.

Sync ident prefix

Specify a prefix for the tasklist variable, which identifies
the tasks for the tool robot and the work piece robot to
synchronize.

Task list prefix

4 Expand the WP Robot Settings group by clicking on its title bar and then
check the settings in the following boxes:

DescriptionBox

Specify the workobject to which the targets generated for
the workpiece robot shall belong.

WP Workobject

Specify which tooldata the workpiece shall use when
reaching its targets.

WP TCP

Specify a prefix for the generated paths.Path prefix

Specify a prefix for the generated targets.Target prefix

5 Expand the Generate path group by clicking on its title bar and then click
Create Paths.
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3.10 Programming external axes

Overview
This is a brief overview of the functions and commands for programming external
axes in RobotStudio. For a more detailed description of external axes and how to
program them, see the product manual for the external axis to use and the RAPID
reference manual.

Coordinated motions
Normally, external axes are used to move the workpiece, the robot or any other
mechanism. The motions of an external axis can be coordinated with those of a
robot in two ways, depending on the task in which the external axis is defined.

Coordination methodTask for external axis

If the external axis is in the same task as the robot, the current
position of active external axes is stored with each target that
is created. When the robot then moves to the target, the extern-
al axis will move to the stored position as well.

Same task as the robot´s

Modifying and optimizing the position of positioner external
axes can be automated using the MultiMove function, or be
performed manually for selected targets. Positions of track
external axes can only be modifed manually.
For information about using the MultiMove function, see About
programming MultiMove on page 130. For information about
how to modify the position of external axes manually, see be-
low.

If the external axis is in another task than that of the robot it
shall be coordinated with, the motions of the external axis are
created byMoveExt instructions, and the coordination is made
by sync instructions.

Other task than the robot’s

For positioner external axes creating or optimizing MoveExt
and sync instructions can be automated way using the Mul-
tiMove function, or be performed manually by creating a path
with MoveExt instructions for the positioner and then adding
sync instructions to the path for the robot and the external axis.
Track external axes can only be programed manually.
For information about using the MultiMove function see About
programming MultiMove on page 130. For information about
how to use the sync instructions, seeRAPID referencemanual
and MultiMove application manual.

Modifying positions of external axes
When programming external axes, you often need to adjust the position of the
external axis for some targets. For example, if you create a path from curves on a
work piece that is attached to a positioner, the positioner will initially have the same
position for all targets. By repositioning the work piece for some of the targets you
might improve process time and reachability.
When targets are created in stations with a coordinated external axis, the position
values of the external axis are stored in the target. With the Modify External Axis
function you can reposition the external axis, thus making it possible for the robot
to reach the target in new ways. For a procedure, see Modify External Axis on
page 516.
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To modify the external axis values for a target, the following conditions must be
met:

• The external axis must be added to the system and set up correctly. For
examples of how to add support for an external axis to a system, see A
system with support for one robot and one positioner external axis on
page179. For information about how to set up an external axis in a RobotStudio
station, see Placing external axes on page 104.

• The external axis must be defined in the same task as the robot.
• The external axis must be activated.

Activation and deactivation
Activating a mechanical unit makes it controlled and monitored by the controller.
Consequently, the mechanical unit must be activated before programming or
running programs. If a system uses several external axes or interchangeable
models with several work stations, several mechanical units might share common
drive units. If this is the case, you must make sure to set the mechanical unit as
active.
For more information about activating and deactivating mechanical units, see
RAPID reference manual on the instructions ActUnit and DeactUnit.
Activating and deactivating mechanical units can be done either manually, see
Activate Mechanical Units on page360, or programmatically by RAPID instructions,
see below.

To activate or deactivate mechanical units programmatically
To set the mechanical units to be active programmatically by RAPID instructions,
follow these steps:

1 In the Paths&Targets browser, browse down to the path in which you want
to insert the activation or deactivation instruction. To insert it as the first
instruction in the path, select the path node and to insert it between existing
instructions, select the instruction before the intended insertion point.

2 On the Home tab, click Action Instruction to bring up a dialog box.
3 In the Instruction Templates list, select one of the ActUnit or DeactUnit

instructions.
4 In the Instruction Arguments grid and the MechUnit list, select the unit to

activate or deactivate.
5 Click Create. When the path is executed either through the Move along path

command, or running the RAPID program, the instruction will be carried out.
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3.11 Loading and saving programs and modules

Overview
RAPID programs and modules are normally stored in the RobotWare systems, as
they are created. You can also save the programs to files on the PC, which makes
it possible to load them to other controllers, either other virtual controllers or real
IRC5 controllers.

Programs are saved from the VC
When saving a program to files on the PC from RobotStudio, it is the RAPID program
stored in the system of the VC that is saved. This program is created and updated
by synchronizing the station to the VC, see Synchronize to RAPID on page 445.

Procedures
To create or load a module or load a program, see:

• Creating a new RAPID module on page 453
• Loading a RAPID module on page 453
• Loading a RAPID program on page 457

To save a module or program, see:
• Saving a RAPID module on page 454
• Saving a program on page 457
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3.12 Synchronization

Overview
To synchronize is to make sure that the RAPID program in the system running on
the virtual controller corresponds to the programs in RobotStudio. You can
synchronize both from RobotStudio to the virtual controller and from the virtual
controller to RobotStudio.
In a RobotStudio station, robot positions and movements are defined by targets
and move instructions in paths. These correspond to data declarations and RAPID
instructions in the modules of the RAPID program. By synchronizing the station
to the virtual controller, you create RAPID code out of the data in the station. By
synchronizing the virtual controller to the station, you create paths and targets out
of the RAPID program in the system running on the virtual controller.

When to synchronize the station to the VC
Synchronizing the station to the VC updates the RAPID program of the virtual
controller with the latest changes in the station. This is useful to do before:

• Performing a simulation.
• Saving a program to files on the PC.
• Copying or loading RobotWare systems.

To synchronize a station to the VC, see Synchronize to RAPID on page 445.

When to synchronize the VC to the station
Synchronizing the VC to the station creates paths, targets and instructions that
correspond to the RAPID program in the system running on the virtual controller.
This is useful to do when you have:

• Started a new virtual controller which system contains existing programs.
• Loaded a program from a file.
• Text-edited the program.

To synchronize the VC to a station, see Synchronize to Station on page 444.
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4 Deploying and distributing
4.1 Copying programs

Overview
RAPID programs are normally stored in the systems that run on the virtual
controllers of your station. To copy programs to systems on other controllers, save
the programs to file on the PC and then load these files to the destination
controllers. You can save either entire programs or specific modules.

Copying a program
To copy a program from one controller to another, follow these steps:

1 In the Controller browser, select the controller that contains the program to
copy.

2 Save the program to file on the disc. For details, see Saving a program on
page 457.

3 If necessary, copy the files to a location that is accessible to the other
controller.

4 For instructions on loading the program to a system on a virtual controller,
a FlexController or a non-running system, see the table below.

Do thisSystem location

See Loading a RAPID program on page 457.Virtual controller, running
in RobotStudio

Connect to the FlexController and load the program.FlexController

Start the system in a virtual controller, then load the
program, see Adding a system on page 92 and Loading
a RAPID program on page 457, respectively.

A non-running system
stored on the PC

Operating manual - RobotStudio 141
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

4 Deploying and distributing
4.1 Copying programs



4.2 Pack & Go / Unpack & Work

Overview
The Pack & Go / Unpack & Work feature makes it possible to create a package
(zip file) of an active station that can be unpacked on another computer. The
package contains all necessary files, except media pools, but add-in based media
pools are included.
For procedures, see Pack and Go on page213 and Unpack andWork on page214.
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4.3 Screen Capture

Overview
Screen capture entails two functions useful for demonstrations and training
purposes:

• The Screenshot function which allows you to capture an image of the
application.

• The Record Movie function which allows you to make a recording of your
work in RobotStudio, either of the entire GUI or just the graphics window.

Taking screenshots
The Screenshot function allows you to capture an image of the entire application
or an active document window such as the graphics window.

Note

The Screenshot feature is available only for RobotStudio Premium users.

Configure the options for the screenshot function as per your requirement under
Options:General:Screenshot in the File tab. For more information, see
Options:General:Screenshot on page 219.
You can take screenshots using the keyboard shortcut CTRL + B. Alternatively,
you can use the Screenshot button on the Quick Access Toolbar, but you must
enable it first.
To enable the screenshot command button:

1 Click the Quick Access Toolbar’s down arrow. The Customize Quick Access
Toolbar menu is displayed.

2 Click Screenshot to add the check mark to the command. This adds the
screenshot button to the Quick Access Toolbar.

Recording movies
You can record your activities in the RobotStudio application as a video. You can
also record videos of simulations. For information on how to record videos in
RobotStudio, see Record Movie on page 375.
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5 Simulating programs
5.1 Simulation Overview

About this chapter
This chapter describes how to simulate and validate robot programs. Below are
short introductions to the simulation functions in RobotStudio.

DescriptionFunction

Simulations run entire robot programs on a virtual controller.Play simulations
Before you run a simulation you need to decide which paths
are to be simulated. To set up a simulation, see Simulation
Setup on page351. To run a simulation, see Simulation Control
on page 361.

Collision detection displays and logs collisions and near-misses
for specified objects in the station. Normally used during sim-
ulation of robot programs, it can also be used when building
the station.

Collision detection

For more information, see Detecting collisions on page 147.

Events can be used to connect an action to a trigger. For ex-
ample, you can attach one object to another when they collide
or a signal is set. For more information, see Creating an event
on page 150.

Event handling

In simulations I/O signals are normally set either by the robot
program or by events. With the I/O simulator you can set signals
manually, which provides a quick test of specific conditions.
For more information, see Simulating I/O signals on page 151.

I/O Simulation

With the simulation monitoring functions you enhance the
simulation by adding traces along the TCP movements or alerts
triggered by defined speeds or motions. For more information,
see Enabling simulation monitoring on page 152.

Simulation Monitoring

With the process timer you measure the time for a process to
complete. For more information, seeMeasuring simulation time
on page 153.

Process time measurement

Time handling during simulation
When simulating stations with events or several controllers, or other time managing
equipment, time can be managed in two modes: either as free runtime or as time
slices. RobotStudio uses time slice mode by default, but you can switch to free
runtime, if required.

Free runtime
Since all controllers use the same computer resources, their synchronization might
not be exactly as in the real world if they run independently of each other (called
free run mode). The cycle time will be correct, but the timing for setting signals
and triggering events might be inaccurate.
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Time Slice
Time slices can be used to ensure that the timing for signals and other interaction
between controllers is accurate. In this mode, RobotStudio synchronizes the
controllers by dividing a time segment into small slices and waiting for all controllers
to complete a current time slice before any controller can start anew. Thus, the
controllers are synchronized, and the cycle time will be calculated correctly. The
drawbacks are that the virtual FlexPendant cannot be open, and that the simulation
might be somewhat slow and jerky, depending on the complexity of the simulation
and the performance of the computer.

Note

If the simulation uses events or involves several different controllers, the virtual
time mode Time Slice shall be used to make sure that the timing between the
controllers is correctly simulated.
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5.2 Detecting collisions

Overview
With RobotStudio you can detect and log collisions between objects in the station.
The basic concepts of collision detection are explained below.

Collision sets
A collision set contains two groups, Objects A and Objects B, in which you place
the objects to detect any collisions between them. When any object in Objects A
collides with any object in Objects B, the collision is displayed in the graphical view
and logged in the output window. You can have several collision sets in the station,
but each collision set can only contain two groups.
A common use of collision sets is to create one collision set for each robot in the
station. For each collision set you then put the robot and its tool in one group and
all objects you do not want it to collide with in the other. If a robot has several tools,
or holds other objects, you can either add these to the robot’s group as well or
create specific collision sets for these setups.
Each collision set can be activated and deactivated separately.

Collisions and near-misses
In addition to collisions, the collision detection can also watch for near-misses,
which is when an object in Objects A comes within a specified distance from an
object in Objects B.

Recommendations for collision detection
In general, the following principles are recommended to facilitate collision detection:

• Use as small collision sets as possible, splitting large parts and collecting
in the collision sets only relevant parts.

• Enable coarse detail level when importing geometry.
• Limit the use of near-miss.
• Enable last collision detection, if the results are acceptable.

Results of creating a collision set
After you have created a collision set, see Create Collision Set on page 350,
RobotStudio will check the positions of all objects and detect when any object in
ObjectsA collides with any object in ObjectsB.
Activation of detection and displayal of collisions depend on how the collision
detection is set up.
If the collision set is active, RobotStudio will check the positions of the objects in
the groups, and indicate any collision between them according to the current color
settings.
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Collision detection
Collision detection checks whether robots or other moving parts collide with
equipment in the station. In complex stations, you can use several collision sets
for detecting collisions between several groups of objects.
After collision detection has been set up, it does not need to be started, but
automatically detects collisions according to the setup.

Setting when to check for collisions
To set whether to detect collisions always or only during simulation, follow these
steps:

1 On the File menu, click Options.
2 On the Navigation pane to the left, select Simulation: Collision.
3 On the Collision page to the right, select one of the following options from

the Perform collision detection:

DescriptionOption

Collision detection is active only during simulation (when
running RAPID programs in the virtual controller).

During simulation

Collision detection is always active, even when moving objects
manually or testing reachability.

Always

Modifying a collision set
To modify a collision set, follow these steps:

1 Right-click the collision set and then select Modify Collision set from the
context menu. The Modify Collision set dialog box opens.

2 Select or enter the required values in various fields provided in the dialog
box.

3 Click Apply.
The Modify Collision set dialog box provides the following options:

DescriptionOptions

Collisions between objects in this set will be detected.Active

Specifies the maximum distance between the objects to be
considered a near miss.

Near miss(mm)

Lets the user select the colliding object (part, body, or sur-
face) that must be highlighted when two objects collide. It
also creates a temporary markup at the point of collision
or near miss.

Higlight colliding

Displays the collision in the selected color.Collision color

Displays the near miss in the selected color.Near miss color

Shows markup at collision or near miss.Show markup at collision

Detect collisions even if the objects are invisible.Detect collisions between invis-
ible objects
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Setting the objects for collision detection
To set the objects for collision detection, follow these steps:

1 Make sure that the objects for collision detection are placed correctly in
collision sets.

2 Make sure that the collision set for the objects is activated, which is indicated
by an icon in the Layout browser:

DescriptionIcon

Active. Collisions between objects in this set will be detected.

xx050033

Not active. Collisions between objects in this set will not be detected.

xx050007

To activate or deactivate collision sets, continue with the following steps:
3 Right-click the collision set to change and then click Modify Collision set to

bring up a dialog box.
4 Select or clear the Active check box and then click Apply.

Setting near-miss detection
Near-misses occur when objects in collision sets are close to colliding. Each
collision set has its own near-miss settings. For setting near-miss detection, follow
these steps:

1 In the Layout browser, right-click the collision set to change and then click
Modify Collision set to bring up a dialog box.

2 In the Near miss box, specify the maximum distance between the objects to
be considered a near-miss and then click Apply.

Setting logging options
In addition to the graphical display of collisions, you can also log the collisions to
the output window or a separate log file:

1 On the File menu, click Options.and under Simulation, click Collision.
2 On the Navigation pane to the left, select Simulation: Collision.
3 On the Collision page to the right, select Log collisions to Output window

check box.
The collision log is displayed in the output window.

4 On the Collision page to the right, select Log collisions to file check box
and enter the name and path to the log file in the box.
A separate file for logging collisions is created below the check box.
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5.3 Creating an event

Overview
Events enhance your simulations by defining actions that are carried out when
specific trigger conditions are fulfilled. You can use events to:

• Attach one object to another, for example, a work piece to a gripper when
simulating material handling, seeAttaching and detaching objects on page77.

• Set signals, for example, when simulating signals set by equipment other
than the controller, see Simulating I/O signals on page 151.

• Start or stop the process timer, see Measuring simulation time on page 153.
Used for creating new events, the Create New Event Wizard is launched from the
Event manager, see Event Manager on page 353.

Prerequisites
Before creating the event, make sure that the station contains all signals and objects
that are planned to be used as triggers or affected by the action.
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5.4 Simulating I/O signals

Procedures
When simulating I/O signals you can either create events that set signal values
when specified trigger conditions are fulfilled, or you can set signal values manually.
For procedures using the event manager, see Event Manager on page 353.
For procedures using the I/O simulator, see I/O Simulator on page 362.

Related information
For information about controlling I/O signals from the RAPID program, seeCreating
RAPID instructions for setting I/O signals on page 122.
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5.5 Enabling simulation monitoring

Overview
The simulation monitor commands are used to visually detect critical robot
movements during simulation by drawing a colored line that follows the TCP.

To enable TCP tracing
To enable TCP tracing, follow these steps:

1 On the Simulation tab, click Monitor to bring up a dialog box.
2 In the left pane, select the appropriate robot.
3 On the TCP Trace tab, select the Enable TCP Trace check box. This activates

TCP tracing for the selected robot.
4 Optionally, change the length and color of the trace. For detailed information,

see Monitor on page 364.

To enable simulation alerts
To enable simulation alerts, follow these steps:

1 On the Simulation menu, click Monitor to bring up a dialog box.
2 In the left pane, select the appropriate robot.
3 On the Alerts tab, select the Enable Simulation Alerts check box. This

activates simulation alerts for the selected robot.
4 In the threshold value boxes, specify the threshold for the alerts. Setting the

threshold to 0 is equivalent to disabling the alert. For detailed information,
see Monitor on page 364.
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5.6 Measuring simulation time

Stopwatch feature for measuring simulation time
The Simulation tab's Stopwatch feature is used for measuring the time taken
between two trigger points in a simulation, and also for the simulation as a whole.
The two trigger points are called the Start Trigger and the End Trigger.
When a stopwatch is setup, the timer starts when the Start Trigger occurs, and
stops when the End Trigger occurs. The kinds of triggers you can specify are:

• Simulation Start
• Simulation Stop
• Target Changed

Additionally, specify the mechanical Unit and the target.
• I/O Value

Additionally, specify the source mechanical unit from where the signal comes,
the type of I/O signal and the value of the signal.

You can several stopwatches setup for a simulation. You can also specify a different
name for each stopwatch.
For information on how to use the Stopwatch feature, see Stopwatch on page 365

Tip

While you are on the Simulation tab, you can check the RobotStudio status bar
for the Simulation Time, that is, from simulation start to simulation stop.
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6 Working online
6.1 Connecting a PC to the controller

General
In general there are two ways of physically connecting a PC to the controller, to
the service port or to the factory network port.

The service port
The service port is intended for service engineers and programmers connecting
directly to the controller with a PC.
The service port is configured with a fixed IP-address, which is the same for all
controllers and cannot be changed, and has a DHCP server that automatically
assigns an IP-address to the connected PC.

The factory network port
The factory network port is intended for connecting the controller to a network.
The network settings can be configured with any IP-address, typically provided by
the network administrator.

Limitations

Note

The maximum number of connected network clients using Robot Communication
Runtime is:

• LAN port: 3
• Service port: 1
• FlexPendant: 1

The maximum number of applications using Robot Communication Runtime
running on the same PC connected to one controller has no built-in maximum.
However, UAS limits the number of logged-on users to 50.
The maximum number of concurrently connected FTP clients is 4.
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Ports on the computer unit DSQC 639
The illustration below shows the two main ports on the computer unit DSQC 639,
the service port and the LAN port.

connecti

Service port on the computer unit (connected to the service port on the controller
front through a cable).

A

LAN port on the computer unit (connects to factory network).B

Note

The LAN port is the only public network interface to the controller, typically
connected to the factory network with a public IP-address provided by the network
administrator.
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Ports on the computer unit DSQC1000
The illustration below shows the two main ports on the computer unit DSQC1000,
the service port and the WAN port.

A

B

xx1300000609

Service port on the computer unit (connected to the service port on the controller
front through a cable).

A

WAN port on the computer unit (connects to factory network).B

Note

The WAN port is the only public network interface to the controller, typically
connected to the factory network with a public IP-address provided by the network
administrator.
LAN1, LAN2, and LAN3 can only be configured as private networks to the IRC5
controller.
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Connecting a PC to the controller

NoteAction

Refer to the system documentation for your
PC, depending on the operative system
you are running.

Make sure that the network setting on the
PC to be connected is correct.
When connecting to the service port:

• The PC must be set to “Obtain an
IP address automatically” or set as
described in Service PC Informa-
tion in the Boot Application on the
FlexPendant.

When connecting to the factory network
port:

• The network settings for the PC de-
pend on the network configuration
setup by the network administrator.

1

For more information, seeNetwork settings
on page 159.

Connect a network cable to the network
port of your PC.

2

connectb

A Service port on the controller

When connecting to the service port:
• Connect the network cable to the

service port on the controller, or to
the service port on the computer
unit.

When connecting to the factory network
port:

• Connect the network cable to the
factory network port on the com-
puter unit.

3
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6.2 Network settings

Overview
This topic describes the network settings for a PC connected to a controller, which
is a prerequisite for working online.
You can connect the PC to the controller through an Ethernet network in the
following ways:

• Local network connection
• Service port connection
• Remote network connection

Local network connection
You can connect your PC to the same Ethernet network that the controller is
connected to. When the PC and the controller are connected correctly and to the
same subnet, the controller will be automatically detected by RobotStudio.
The network settings for the PC depend on the network configuration. For setting
up the PC, contact the network administrator.

Service port connection
When connecting to the controller's service port, you can either obtain an IP address
for the PC automatically, or you can specify a fixed IP address.
If you are not sure how to set up the service port connection, contact the network
administrator.

Automatic IP address
The controller's service port has a DHCP server that will automatically give your
PC an IP address if it is configured for this. For detailed information see Windows
help on configuring TCP/IP.

Fixed IP address
Instead of obtaining an IP address automatically, you can also specify a fixed IP
address on the PC you connect to the controller.
Use the following settings for a fixed IP address:

ValueProperty

192.168.125.2IP address

255.255.255.0Subnet mask

For detailed information about how to set up the PC network connection, see
Windows help on configuring TCP/IP.
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Note

Obtaining an IP address automatically might fail if the PC already has an IP
address from another controller or Ethernet device.
To ensure that you get a correct IP address if the PC was previously connected
to an Ethernet device, do one of the following:

• Restart the PC before connecting to the controller.
• Run the command ipconfig /renew from the command prompt after

connecting the PC to the controller.

Remote network connection
To enable a connection to a controller on a remote subnet or over the local network,
the relevant network traffic must be allowed through any firewalls between the PC
and the controller.
The firewalls must be configured to accept the following TCP/IP traffic from the PC
to the controller:

• UDP port 5514 (unicast)
• TCP port 5515
• Passive FTP

All TCP and UPD connections to remote controllers are initiated by the PC, that is
the controller only responds on the given source port and address.

Firewall settings
The firewall settings are applicable irrespective of whether you are connected to
a real controller or a virtual controller.
The following table describes the necessary firewall configurations:

ApplicationRemote
Service

Local
Service

Remote
Ad-
dress

ProtocolDirec-
tion

ActionNameStatus

robnetscan-
host.exe

5512,5514AnyAnyUDP/IPOutAllowRobNetscan-
Host

robnetscan-
host.exe

Any5513AnyUDP/IPInAllowIRS5Control-
ler

robcomc-
trlserver.exe

5515AnyAnyTCP/IPOutAllowRobComC-
trlServer

AnyFTP(21)AnyAnyTCP/IPOutAllowRobotFTP

RobotStu-
dio.exe

80AnyAnyHTTPOutAllowRobotStudio

RobotStu-
dio.exe

443AnyAnyHTTPSOutAllowRobotStudio

Note

Port 443 is not required for controller communication, but it is required for external
communication with ABB for availing services like upgrade notifications and
online services.
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In addition, the following table describes the necessary firewall configurations for
the RobotWare option, Integrated Vision:

ApplicationRemote
Service

Local
Service

Remote
Ad-
dress

ProtocolDirec-
tion

ActionNameStatus

RobotStu-
dio.exe

23AnyAnyTCP/IPOutAllowTelnet

RobotStu-
dio.exe

1069AnyAnyTCP/IPOutAllowIn-Sight Pro-
tocol

RobotStu-
dio.exe

10691069AnyUDP/IPIn/OutAllowIn-Sight Dis-
covery

RobotStu-
dio.exe

1212AnyAnyTCP/IPOutAllowUpgrade port
(PC only)

RobotStu-
dio.exe

50000AnyAnyTCP/IPOutAllowDataChannel

Note

RobotStudio uses the current Internet Options, HTTP, and proxy settings to get
the latest RobotStudio news. To view the latest RobotStudio news, go to the File
tab and then the Help sub-tab.

Connecting to the controller
1 Make sure the PC is connected to the controller's service port and that the

controller is running.
2 On the File menu, click Online and then select One Click Connect.

This takes you to the Controller tab.
3 Click Add Controller
4 Click Request Write access.

ThenIf the controller is in mode

You will now get Write Access if it is available.Auto

A message box on the FlexPendant will allow you to
grant remote Write Access to RobotStudio.

Manual
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6.3 User Authorization

Overview
This section describes the controller's User Authorization System (UAS), which
restricts what different users are allowed to do with the robot. This is for protecting
data and functionality from unauthorized use.
The user authorization is managed by the controller, which means that the UAS
settings remain for the controller regardless of which system it is running. It also
means that the UAS settings apply to all tools for communicating with the controller,
like RobotStudio or the FlexPendant. The UAS settings defines the users and
groups that can access the controller, and what actions they are granted access
to.
For procedures, see User Accounts on page 421.

Users
UAS users are accounts with which persons log on to the controller. Furthermore,
the users are added to groups to which access grants are given.
The users are defined in the controller by a user name and a password. For logging
on to a controller, the user must type in a defined user name with a correct
password.
A user can either have the state activated or deactivated in the UAS. When a user
is deactivated it is not possible to log on to the controller using that account. It is
the UAS administrator that activates and deactivates the users.

The Default user
All controllers have a default user named Default User with a publicly known
password robotics. TheDefault User cannot be removed and the password cannot
be changed. However, a user having the grant Manage UAS settings can modify
and restrict the controller grants and application grants of the Default User.

Note

From RobotWare 6.04 it is also possible to deactivate the Default User, see User
Accounts on page 421.

Groups
In UAS, groups are defined sets of grants for accessing the controller. To the
groups you then add the users who shall have the grants defined by the group.
A good practice is to create groups that resembles the professions that work with
the robots in your organization. For example, you can create groups for
administrators, programmers and operators.

The Default group
All controllers have a default group named Default Group, to which all grants are
given and to which the default user belongs. This group cannot be removed, but
it can be changed by the user having the grant Manage UAS settings.
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Note

There is a risk changing the group membership of the default user. If you by
mistake clear the Default User check box or any Default Group grant, you will
get a warning. Make sure that there is at least one user defined that has the grant
Manage UAS settings. If the Default group and no other group have the grant
Manage UAS settings, you may lose your ability to manage users and groups.

Grants
Grants are permissions to perform actions or access data on the controller. You
use the grants by giving them to groups, to which you then add the users who shall
have the grants.
Grants may be either controller grants or application grants. Depending on the
actions that you will perform, you may need several grants. For procedures, see
UAS Grant Viewer on page 426.

Controller grants
Controller grants are validated by the robot controller and apply to all tools and
devices accessing the controller.

Application grants
Application grants are used by a specific application, for example the FlexPendant,
and will only be valid using that application. Application grants can be added by
add-ins and used in customer applications.

Local and remote clients
RobotStudio normally acts as a remote client of the controller and a device
connected to the FlexPendant connector on the controller acts as a local client.
The privileges of a remote client is restricted when the controller is in manual mode
when compared to a local client, for example, a remote client cannot start program
execution or set the program pointer.

RobotStudio as local client
RobotStudio can act as a local client thereby can get full access to the controller
functionality without restrictions in manual mode. When you select the local client
checkbox in the Add controller dialog or in the Login dialog you can get local
client privileges by pressing the enabling switch on the safety device twice, for
example, the FlexPendant, JSHD4, or the T10.
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6.4 The System Builder

6.4.1 About System Builder

Overview
This section describes how you create, build, modify and copy systems to run on
virtual and real controllers. These systems may even be converted to boot media
and downloaded to a real controller.
The system points out the robot models and options to use; it also stores
configurations and programs for the robots. Therefore, it is good practice to use
a unique system for each station even if the stations use the same basic setup.
Otherwise, changes in one station may accidently overwrite data used in another
station.

Note

Use System Builder to create and modify systems based on RobotWare 5.xx.
Use Installation Manager to create and modify systems with RobotWare versions
6.0 and later, see The Installation Manager on page 183.

About virtual and real systems
The system you run on virtual controllers can either be a real system built on real
RobotWare keys or a virtual system built on virtual keys.
When using real systems, the RobotWare keys define which options and robot
models shall be used, thus helping you to configure the system correctly. Real
systems can be run both on virtual controllers and real IRC5 controllers.
When using virtual keys, all options and robot models are available, which is useful
for evaluation purposes, but requires more configuration when creating the system.
Systems built on virtual keys can only be run on virtual controllers.

Prerequisites
Creating a system entails applying a predefined template to a station, reusing an
existing system or letting RobotStudio propose a system based on a layout.
To create a system, the following conditions must be met:

• The RobotWare media pool must be installed on your PC.
• You must have a RobotWare key for the system, if creating a system to run

on a real controller. The RobotWare key is a license key that determines
which robot models to use and which RobotWare options to run on the
controller. The license key is delivered with the controller.

• If you want to create a system for virtual use only, you can use a virtual key
instead. Virtual keys are generated by the wizard. When using virtual keys,
you select the robot models and options to use in the Modify Options section
of the wizard.

• Downloading to the real controller requires a direct connection from your
computer to the service or Ethernet port of the controller.
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Administering systems
Systems can be administered from the System Builder dialog box in the following
ways:

• View system properties, see Viewing system properties on page 166.
• Build a system, see Building a new system on page 167.
• Modify or delete a system, see Modifying a system on page 171.
• Copy a system, see Copying a system on page 175.
• Create a system from backup, seeCreating a system frombackup on page176.
• Download a system to a controller, seeDownloading a system to a controller

on page 177.
• Create boot media, see Creating boot media on page 178.
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6.4.2 Viewing system properties

Overview
All systems you create with the System Builder are stored locally on your computer.
It is recommended that you store them in one or more dedicated system directories.

Viewing system properties
To view system properties and add comments, follow these steps:

1 In the System Builder dialog box, select a system from the Systems box.
If necessary, in the System directory list, you can navigate to the folder in
which your systems are stored

2 The system properties are then displayed in the System Properties box.
Optionally, type a comment in the Comments box, and click Save.
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6.4.3 Building a new system

Overview
The New Controller System Wizard, used for building a new system, is launched
from the System Builder.

Starting the wizard
To start the wizard, follow these steps:

1 Click System Builder to bring up a dialog box.
2 In the Actions group, click Create New. This starts the wizard.
3 Read the information on the welcome page and click Next.

Specifying the name and location
To determine where on your computer to store the system you are creating, follow
these steps:

1 In the Name box, enter a name for the system you are creating.
2 In the Path box, enter the path to the system directory in which you will store

the system.
You can also click the Browse button and browse to the system directory.

3 Click Next.

Entering the RobotWare keys
The RobotWare keys determine which RobotWare versions and parts to use in the
system.
Creating a system to run on either IRC5 controllers or virtual controllers requires
at least two keys: one for the controller module and one for each drive module in
the cabinet. The keys are delivered together with the controller.
For creating a system to run on virtual controller only (for example, in Virtual IRC5),
you can use virtual keys. Virtual keys give access to all options and robot models,
but limits the use of the system to virtual controllers only.
To enter the key for the controller module, follow these steps:

1 In theController Key box, enter the controller key. You can also clickBrowse
and browse to the key file. If creating a system for virtual use only, select
the Virtual Key check box, and the controller key will be generated by the
wizard.

2 In the Media Pool box, enter the path to the media pool. You can also click
Browse and browse to the folder.system

3 In the RobotWare Version list, select which version of the RobotWare you
want to use. Only RobotWare versions that are valid for the used key are
available.

4 Click Next.
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Entering the drive keys
To enter the keys for the drive modules:

1 In the Drive Key box, enter the key for the drive module. You can also click
the Browse button and browse to the key file. If you used a virtual controller
key, a virtual drive key is already generated by the wizard.

2 Click the right arrow button next to the Drive Key box. The key now appears
in the Added drive keys list.
For real systems the drive key determines the connected robot model. For
virtual systems you select the robot model in the Modify Options page. The
default model is IRB140.

3 If you have a MultiMove system, repeat steps 1 and 2 for each drive key to
add.
If you have a MultiMove system, make sure that the keys are numbered in
the same way as their corresponding drive modules are connected to the
controller module. Use the up and down arrows to rearrange the drive keys,
if necessary.

4 If you want to create the system as it is now, click Finish.
If you want to modify options, or add options, parameter data or additional
files to the home directory, click Next.

Adding additional options
Here you can add options, such as external axes and dispense applications, that
are not included in the basic system. Options require a license key and must be
first imported to the media pool. To add additional options, follow these steps:

1 In the Key box, enter the option key. You can also click the Browse button
and browse to the option's key file.

2 Click the Arrow button.
The option that the key unlocks is now displayed in the Added Options list.

Note

If several versions of an additional option exists, only the latest version
can be selected. To use an older version, remove the other versions of the
additional option from the Mediapool.
System Builder can modify a system only when all referenced additional
options and RobotWare mediapool are placed in the same folder. It is not
possible to modify a system that uses a mediapool embedded in a Pack
and Go file. You must copy the mediapool to a common mediapool folder
and create a system from backup.

3 Repeat steps 1 and 2 for all options you want to include.
4 Choose whether you want to create the system as it is now, or to continue

with the wizard.
If you want to create the system as it is now, click Finish.
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If you want to modify options, or add parameter data or additional files to the
home directory, click Next.

Modifying options
Here you can set up and configure the options in your system. For virtual systems,
you also select the robot models to use. To modify any options, follow these steps:

1 In the Option tree, expand the option folders to the level where you find the
option you want to modify.
Only the options unlocked by the used keys are available.

2 Modify the option.
3 Repeat steps 1 and 2 for all options you want to modify.
4 Choose whether you want to create the system as it is now, or to continue

with the wizard.
If you want to create the system as it is now, click Finish.
If you want to add parameter data or additional files to the home directory,
click Next.

Adding parameter data
Parameter data is stored in the parameter data files (.cfg files). Each parameter
topic has its own parameter file. You can add only one parameter file for each topic.
To add parameter data, follow these steps:

1 In the Parameter data box, enter the path to the folder for the parameter data
files. You can also click the Browse button and browse to the folder.

2 In the list of parameter data files, select the file you want to include and press
the Arrow button. Repeat for all files you want to include.
The included parameter data files will now appear in the Added parameter
data files list.
Repeat steps 1 and 2 for each parameter data file you want to add.

3 Choose whether you want to create the system as it is now, or to continue
with the wizard.
If you want to create the system as it is now, click Finish.
If you want to add additional files to the home directory, click Next.

Adding files to the home directory
You can add any type of file to the system’s home directory. When the system is
loaded to a controller, these files will also be loaded. To add files to the system's
home directory, follow these steps:

1 In the Files box, enter the path to the folder for the files you want to include.
You can also click the Browse button and browse to the folder.

2 In the list of files, select the file to add and click the Arrow button. Repeat
for all files you want to add.
The added files will now appear in the Added files list.

3 Choose whether you want to create the system as it is now, or to continue
with the wizard.
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If you want to create the system as it is now, click Finish.
If you want to read a summary before you create the system, click Next.

Completing the New Controller System Wizard
To complete the wizard, follow these steps:

1 Read the system summary.
2 If the system is OK, click Finish.

If the system is not OK, click Back and make modifications or corrections.
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6.4.4 Modifying a system

Overview
TheModify Controller SystemWizard, used to modify existing systems, is launched
from the System Builder.The wizard helps you with tasks like changing robots,
adding and removing external axes and other options. A system that is running
must be first shut down before modification.

Starting the wizard
To start the wizard when creating a new station:

1 If the system is currently running, on theControllermenu, point to Shutdown
and then click Shutdown.

2 On the Controller menu, click System Builder to bring up a dialog box.
3 In the System directory list, enter or browse to the system directory. Select

a system from the list beneath, review the system properties and add and
save any comments.

4 In the Actions group, click Modify. This starts the wizard.
5 Read the information on the welcome page and click Next.

Modifying the program revision
The RobotWare versions that are available for the system are determined by the
controller key. The key is essential to the system and cannot be modified.
To use another RobotWare version than the available ones, create a new system
with another key.
To optionally modify the program revision, follow the appropriate step or steps:

1 To keep the current RobotWare version, select Yes and then click Next .
2 To replace the current RobotWare version, Select No, replace it..
3 In the Media pool box, enter the path to the media pool. You can also click

the Browse button and browse to the folder.
4 In the New program revision box, select which version of RobotWare you

want to use. Only RobotWare versions that are valid for the RobotWare key
are available.

5 Click Next.

Adding or removing drive keys
The drive key corresponds to the drive modules in your controller. For MultiMove
systems, you have one drive module (and one key) for each robot. The keys for
your system are delivered together with the controller.
the system is created with a vritual controller key, virtual drive keys are generated
by the wizard. when you have added one virtual drive key for each robot, you select
which robot to use for each key on the Modify Options page.
To optionally add or remove the keys for the drive modules, follow these steps:

1 To add a key for a drive module, enter the key in the Enter Drive Key box.
You can also click the Browse button and browse to the key file.
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2 Click the right arrow button. The key now appears in the Added drive key
list.
If you have a MultiMove system, repeat steps 1 and 2 for each drive key to
add.

3 To remove a drive module, select the corresponding key in the Added drive
key list and click Remove drive key.
If you have a MultiMove system, repeat step 3 for each drive key to remove.

4 If you have a MultiMove system, make sure that the keys are numbered in
the same way as their corresponding drive modules are connected to the
controller module. Use the up and down arrows to rearrange the drive keys,
if necessary.

5 Choose whether you want to create the system as it is now, or to continue
with the wizard.
If you want to create the system as it is now, click Finish.
If you want to modify options, parameter data or add files to or remove files
from the home directory, click Next.

Adding or removing additional options
To optionally add or remove additional options:

1 To add an add-in, in the Enter Key box, enter the option key. You can also
click the Browse button and browse to the option's key file.

2 Click the Arrow button.
The option that the key unlocks is now displayed in the Added Options list.

Note

If several versions of an additional option exists, only the latest version
can be selected. To use an older version, remove the other versions of the
additional option from the Mediapool.

3 Repeat steps 1 and 2 for all options you want to include.
4 To remove an add-in, In the additional options, in the Added options list,

select the add-in you want to remove.
5 Click Remove.
6 Choose whether you want to create the system as it is now, or to continue

with the wizard.
If you want to create the system as it is now, click Finish.
If you want to modify parameter data or add files to or remove files from the
home directory, click Next.

Modifying options
To optionally modify any options, follow these steps:

1 In the Option tree, expand the option folders to the level where you find the
option you want to modify.
Only the options unlocked by the used keys are available.
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2 Modify the option.
3 Repeat steps 1 and 2 for all options you want to modify.
4 Choose whether you want to create the system as it is now, or to continue

with the wizard.
If you want to create the system as it is now, click Finish.
If you want to modify parameter data or add files to or remove files from the
home directory, click Next.

Adding or removing parameter data
Parameter data is stored in the parameter data files (.cfg files). each parameter
topic has its own parameter file. You can add only one parameter file for each topic.
To addor remove parameter data, follow these steps:

1 To add parameter data, in the Parameter data box, enter the path to the
folder for the parameter data files. You can also click the Browse button and
browse to the folder.

2 In the list of parameter data files, select the file you want to include and press
the Arrow button. Repeat for all files you want to include.
The included parameter data files will now appear in the Added parameter
data files list.
Repeat steps 1 and 2 for each parameter data file you want to add.

3 To remove parameter data, in the Added parameter data files list, select the
parameter data file to remove.

4 Click Remove.
5 Choose whether you want to create the system as it is now, or to continue

with the wizard.
If you want to create the system as it is now, click Finish.
If you want to add to or remove files from the home directory, click Next.

Add files to or remove files from the home directory
You can add any type of file to the system’s home directory, or remove files from
it. When the system is loaded to a controller, these files will also be loaded. To
optionally add files to or remove files from the system's home directory, follow
these steps:

1 To add files, in the Files box, enter the path to the folder for the files you
want to include. You can also click the Browse button and browse to the
folder.

2 In the list of files, select the file to add and click the Arrow button. Repeat
for all files you want to add.
The added files will now appear in the Added files list.

3 To remove files, in the Added files list, select the file to remove.
4 Click Remove.
5 Choose whether you want to create the system as it is now, or to continue

with the wizard.
If you want to create the system as it is now, click Finish.
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If you want to read a summary before you create the system, click Next.

Complete the Modify Controller System wizard
To complete the wizard, follow these steps:

1 Read the system summary.
2 If the system is OK, click Finish.

If the system is not OK, click Back and make modifications or corrections.

Result
Modifications will take effect when the wizard is completed.
If the system has been downloaded to a controller, it must be downloaded again
before the modifications will take effect on the controller.
If the system is used by a VC, restart the controller using the restart mode Reset
controller for the changes to take effect.

Deleting a system
To delete a system, follow this steps:

1 From the SystemBuilder dialog box, select the system and then clickDelete.
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6.4.5 Copying a system

Copy a system
To copy a system, follow these steps:

1 From the System Builder dialog box, select the system and then click Copy
to bring up a dialog box.

2 Enter a name for the new system and a path, and then click OK.
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6.4.6 Creating a system from backup

Overview
The Create System from Backup Wizard, which creates a new system from a
controller system backup, is launched form the System Builder. In addition, you
can change the program revision and options.

Starting the wizard
To start the wizard, follow these steps:

1 From the System Builder dialog box, click Create from Backup. This starts
the wizard.

2 Read the information on the welcome page and click Next.

Specifying the name and location
To specify the destination folder, follow these steps:

1 In the Name box, enter a name for the system you are creating.
2 In the Path box, enter the path to the system directory in which you will store

the system.
You can also click the Browse button and browse to the system directory.

3 Click Next.

Locating the backup
To locate a system from backup, follow these steps:

1 In the Backup folder box, enter the path to the backup folder. Alternatively,
click the Browse button to browse to it. Click Next.

2 In the Media Pool box, enter the path to the media pool containing the
appropriate RobotWare program. Confirm the backup information that now
appears in the wizard. Click Next.

176 Operating manual - RobotStudio
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

6 Working online
6.4.6 Creating a system from backup



6.4.7 Downloading a system to a controller

Overview
All systems you access from the System Builder are stored on your computer. If
you wish to run a system on a robot controller, you must first load it to the controller,
which then requires a restart.

Load a system
To load a system to a controller, follow these steps:

1 From the System Builder dialog box, select a system and then clickDownload
to Controller to bring up a dialog box.

Note

Systems with incompatible hardware versions will not be displayed in the
Download to Controller dialog box.

2 Specify the Destination Controller for the system.

if...You can select by using the...

the controller has been detected automat-
ically.

Select controller from list option

your PC and the robot is connected to the
same network.

Specify IP address or controller name
option

You can only use the controller name in
DHCP networks.

your PC is directly connected to the con-
troller's service port.

Use service port option

3 Optionally, click Test Connection to confirm that the connection between
the computer and the Controller is OK.

4 Click Load.
5 Answer Yes to the question Do you want to restart the controller now?

The controller restarts immediately and the downloaded system
starts automatically.

Yes

The controller does not restart immediately.No
To start using the downloaded system, you have to:

a Restart the controller using the restart mode Start Boot Ap-
plication.

b select the system manually

The downloaded system is removed from the controller.Cancel
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6.4.8 Creating boot media

Overview
Boot media is an entire system which the System Builder packs to a single file and
commonly stores on a hard disk or USB memory. The controller then accesses
the file through its Ethernet port or USB port, respectively.

Creating boot media
To create boot media, follow these steps:

1 From the System Builder dialog box, create a new system. For creating a
new system, see Building a new system on page 167.

2 From the System Builder dialog box, select a new system or an existing
system and then click Boot Media.

3 In the Path box, enter the path to the folder where you want to store the boot
media file. Alternatively, browse to the location.

4 Click OK.

Result
To load the boot media system to a controller, first connect it and then restart the
controller using the restart mode Start Boot Application.
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6.4.9 Examples using the System Builder when offline

6.4.9.1 A system with support for one robot and one positioner external axis

Overview
In this example we will use the System Builder to create an offline system to use
in a new RobotStudio station with one IRB1600 robot and one IRBP 250D positioner
external axis.

Prerequisites
When creating systems for positioner external axes, you need the media pool and
the license key file for that specific positioner. In this example we will use a media
pool and license key file for a demo positioner.
Paths to files and folders assume that RobotStudio and the RobotWare media pool
have been installed at their default locations on Windows XP. If not, adjust the
paths accordingly.

Starting the New Controller System Wizard
To create a system like the one described above, follow these steps:

1 Click System Builder to bring up a dialog box.
2 In the dialog box, click Create New to bring up the New Controller System

Wizard.
3 Read the welcome text, and click Next to continue to the next page.

Entering the controller key
1 Select the Virtual key check box. A virtual controller key now appears in the

Controller Key box. In this example we will use the default media pool and
RobotWare version.

2 Click Next to continue to the next page.

Entering drive keys
1 Click the Right Arrow button next to the Enter Drive key box to create one

drive key for the robot.
2 Click Next to continue to the next page.

Adding options
This is where we point out the key file for the positioner.

1 Next to the Enter key box, click the browse button and select the key file.

Continues on next page
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In this example, browse to and select the file extkey.kxt in the folder
C:\Program Files\ABB Industrial IT\Robotics
IT\MediaPool\3HEA-000-00022.01.

Tip

In the MediaPool folder media pools for several standard positioners are
installed. They are named by the positioner’s article number, with a suffix
that indicates if it is configured for single-robot or MultiMove systems.

2 Click the Right Arrow button next to the Enter key box to add the key for the
positioner.

3 Click Next and continue to the next page of the wizard.

Modifying options
When creating robot systems from real robot keys, the key sets the options. But
since we are using a virtual key, we have to set the options manually. To set the
options necessary for a positioner, follow these steps:

1 Scroll down to the RobotWare / Hardware group and select the 709-x
DeviceNet check box.
This option is for the communication between the controller and the track
external axis.

2 Scroll down to the DriveModule1 / Drive module application group and
expand the ABB Standard manipulator option. Select the IRB 1600 option.
This option sets the robot to an IRB 1600-5/1.2.

3 Scroll down to theDriveModule1 > Drivemodule configuration group; select
the Drive System 04 1600/2400/260 option; expand the Additional axes
drive module group and select the R2C2 Add drive option.

a Expand the Drive type in position Z4 group and select the 753-1 Drive
C in pos Z4 option

b Expand the Drive type in position Y4 group and select the754-1 Drive
C in pos Y4 option

c Expand the Drive type in position X4 group and select the755-1 Drive
C in pos X4 option

Continues on next page
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This option adds drive modules for the positioner axes.

Note

When using the latest drive system, do the following:
Scroll down to the DriveModule1 > Drive module configuration group;
select the Drive System 09 120/140/1400/1600 Compact option; expand
the Power supply configuration group and select 1-Phase Power supply
or 3-Phase Power supply (as applicable) > Additional axes drive module
> Additional drive

a Expand the Drive type in position X3 group and select the Drive
ADU-790A in position X3 option

b Expand the Drive type in position Y3 group and select the Drive
ADU-790A in position Y3 option

c Expand the Drive type in position Z3 group and select the Drive
ADU-790A in position Z3 option

4 Click Finish and the system will be created. When starting the system in a
RobotStudio station, you have to set up the system to load a model for the
positioner and to get the motions to work properly. See Placing external axes
on page 104 for more information.
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6.4.9.2 Options settings for systems with positioners

Overview
This is an overview of the RobotWare options to set when creating a system for
positioner external axes. Note that besides setting the RobotWare options, you
must add an additonal option key for the positioner.

Media pools and option keys for the positioners
If you have the media pool and option key for your positioner, you can use these
files.
If not, media pools for standard positioners are installed with RobotStudio. The
path to these media pools in a default installation is:C.\program files\ABB Industrial
IT\Robotics IT\MediaPool. In this folder a media pool for each positioner is located.
These are named by the article number of the positioner, with a suffix that indicates
if it is configured for a single-robot or a MultiMove system.
In the Additional option page of the System Builder, you should add the option
for the positioner by opening the mediapool folder for the positioner to add and
selecting the extkey.kxt file.

Options for positioners in single-robot systems
When adding a positioner to a single-robot system, the positioner will be added to
the same task as the robot. Below, the options to set on the Modify Options page
of the System Builder for such a system are listed:

• RobotWare > Hardware > 709-x DeviceNet > 709-1 Master/Slave Single
• Optionally, for using the system with ArcWare also add RobotWare >

Application arc > 633-1 Arc
• DriveModule 1 > Drive module configuration > Drive System 04

1600/2400/260 > RC2C Add drive > 753-1 Drive C in pos Z4 > 754-2 Drive
T in pos Y4 > 755-3 Drive U in pos X4

Options for positioners in MultiMove robot systems
When adding a positioner to a MultiMove robot system, the positioner shall be
added to a task of its own (thus you also have to add a drive key for the positioner).
Below, the options to set on the Modify Options page of the System Builder for
such a system are listed:

• RobotWare > Hardware > 709-x DeviceNet > 709-1 Master/Slave Single
• RobotWare > Motion coordinated part 1 > 604-1 MultiMove Coordinated

Optionally, expand the MultiMove Coordinated option and select process
options for the robots.

• Optionally, for using the system with ArcWare, addRobotWare >Application
Arc > 633-1 Arc

• DriveModule 1 > Drive module configuration > Drive System 04
1600/2400/260 > RC2C Add drive > 753-1 Drive C in pos Z4 > 754-2 Drive
T in pos Y4 > 755-3 Drive U in pos X4. For the other drive modules, no
additional axes should be configured.
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6.5 The Installation Manager

6.5.1 About Installation Manager

Overview
This section describes how to create, modify, and copy systems to run on real and
virtual controllers using the Installation Manager.

Note

Use Installation Manager to create and modify systems with RobotWare versions
6.0 and later. Use System Builder to create and modify systems based on earlier
versions of RobotWare, see The System Builder on page 164.

About real and virtual systems and license files
When using real license files to create a system, the license files contain the options
that the user has ordered, and in most cases no additional configuration is required.
Real license files can both be used to create real systems and virtual systems.
When using virtual license files to create a system, all options and robot models
are available, which is useful for evaluation purposes, but requires more
configuration when creating the system. Virtual license files can only be used to
create virtual systems.

Products
Product is the collective name for the different software such as RobotWare,
RobotWare add-ins, third party software and so on. Products are either free or
licensed, licensed products require a valid license file.

Deployment packages and the repository
Installation Manager can be used to produce an installation or update package
offline on a USB-stick, which later can be installed from the FlexPendant. The
repository is the storage where all files needed to create and modify RobotWare
systems are placed.
For information on using the repository and creating deployment packages, see
Operating manual - IRC5 Integrator's guide.

Prerequisites
The following are the prerequisites for creating a system:

• A RobotWare license file for the system, when creating a system to run on
a real controller. The license file is delivered with the controller.

• A virtual license file for creating a system for virtual use. All products are
delivered with a virtual license file.

• Installing on a real controller requires a connection from the computer to the
service or Ethernet port of the controller.
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6.5.2 Startup and settings

Starting Installation Manager
On the Controller tab, in the Configuration group click Installation Manager to
start the Installation Manager application.
This window provides two options. Select Network to create systems for real
controllers and Virtual to create systems for virtual controllers.

Setting application preferences
Before creating a system using Installation Manager, it is recommended to set the
path to the desired location where products, licenses, and backups are located
and where virtual systems will be created.

1 On theController tab, in theConfiguration group click InstallationManager.
2 In the Installation Manager window, click Preferences. The Preferences

window opens.
3 Browse and select folders for Product path(s), License path(s), Virtual

systems path(s), and Backup path(s) in respective lists.
The User name and Password boxes are populated with the default
credentials provided to you with your RobotStudio license. These credentials
are applicable only for a real controller.

4 In the Default System Name box, enter the default system name. When you
create a new system, this name will be assigned by default.

5 Click OK to set the preferences.
Advanced users can select the location to install virtual controllers. Select the
Virtual products installation path(s) check box and then click Browse to select
the folder. You can see the selected path in the drop-down list box. Clear the check
box to enable the default path.
For information on using the repository and creating deployment packages, see
Operating manual - IRC5 Integrator's guide.

Settings file
Settings file contains the selected options. When Installation Manager connects
to a system, it reads options from the Settings file. Any change in the options are
mapped in the file.
Use the Settings buttons to perform the following tasks with the settings file.

DescriptionButtons

Click this button to export the current settings of the system.Export settings

Click this button to import settings to the system. The current settings of
the system will be cleared before performing this operation.

Import settings

Click this button to add settings to the current setup of the system.Add settings

Click this button to revert to the current settings of the system.Revert
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6.5.3 Building a new system

Creating a new system for a real controller
1 In the Installation Manager window, click Controllers, and then click the

Network tab.
The Network tab shows the name and IP address of all the available
controllers on the LAN network and/or any controller attached through the
service port.

2 Select your controller in the controller list and clickOpen. Installation Manager
fetches information from the controller.

3 Click New. The Create New pane appears.
4 In theCreate New pane, in theName box, enter the name of the new system.
5 Click Next. The Products tab gets selected.
6 Click Add, the Select Product window opens. Select the product manifest

file and click OK.
If you want to add more products such as Add-ins, clickAdd again and select
the product. To find a product that is not in the list, click Browse and then
select the file from the particular folder.

7 Click Next. The Licenses tab gets selected.
8 ClickAdd, the Select Licensewindow opens. Select the license file and click

OK.
Repeat the step to add multiple license files to your system.

9 Click Next, the Options tab gets selected. This pane shows the System
Options, Drive Modules and Applications. Here you are able to customize
your options.

10 Click Next, the Confirmation tab gets selected and shows an overview of
the system options.

11 Click Apply, the system gets created on the controller.
Once the installation completes, a Restart Controller dialog appears, click Yes to
restart the controller. Click No to manually restart controller later, the controller
stores the new system or the changed system and these changes will take effect
during the next restart.

Note

Changing the RobotWare version needs BootServer update. Controller must be
restarted for BootServer update. Hence, the controller will be restarted
automatically when you change the RobotWare.

Creating a new system for a virtual controller
1 In the Installation Manager window, click Controllers, and then click the

Virtual tab.
2 Click New. The Create New pane opens.
3 In theCreate New pane, in theName box, enter the name of the new system.

Continues on next page
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4 Click Next. The Products tab gets selected.
5 Click Add, the Select Product window opens. Select the product manifest

file and click OK.
If you want to add more products such as Add-ins, clickAdd again and select
the product. To find a product that is not in the list, click Browse and then
select the file from the particular folder.

6 Click Next. The Licenses tab gets selected.
7 ClickAdd, the Select Licensewindow opens. Select the license file and click

OK.
Repeat the same step to add multiple license files to your system.

8 Click Next, the Options tab gets selected. This pane shows the System
Options, Drive Modules and Applications. Here you are able to customize
your options.

9 Click Next, the Confirmation tab gets selected and shows an overview of
the system options.

10 Click Apply, the system gets created.
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6.5.4 Modifying a system

Modifying a system for a real controller
1 In the Installation Manager window, select Controllers and then select the

Network tab.
2 Select your controller in the controller list and clickOpen. Installation Manager

fetches information from the controller.
3 Select the particular system that you want to modify.

The Overview pane displays the system options of the selected system.

Note

To be able to modify a system it must first be activated. Select the system
you want to modify and press the activate button.

4 Click Next. The Products tab gets selected. All products and add-ins that
were part of the selected system will be displayed here.

• To upgrade/downgrade a product select the product and clickReplace.
• To remove a product select the product and click Remove.

Note

It is not possible to remove the RobotWare product.

5 ClickNext. The Licence tab gets selected. The license details of the selected
system will be displayed here. Here you are able to add/remove licenses.

6 Click Next. The Options tab gets selected. Here you are able to customize
your options.

7 Click Next, the Confirmation tab gets selected and shows an overview of
the system options.

8 Click Apply for the changes to take place.
Once the installation completes, a Restart Controller dialog appears, click Yes to
restart the controller. Click No to manually restart controller later, the controller
stores the new system or changed system and these changes will take effect during
the next restart.

Note

Any change in the RobotWare version needs a BootServer update, which requires
a controller restart. The controller will be restarted automatically.

Modifying a system for virtual controller
1 In the Installation Manager window, select Controllers and then select the

Virtual. Here you are able to view the list of all virtual systems.
2 Select the particular system that you want to modify.

The Overview pane will display the system options of the selected system.

Continues on next page
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3 Click Next. The Products tab gets selected. All products and add-ins that
were part of the selected system will be displayed here.

• To upgrade/downgrade a product select the product and clickReplace.
• To remove a product select the product and click Remove.

Note

It is not possible to remove the RobotWare product.

4 ClickNext. The Licence tab opens. The license details of the selected system
will be displayed here. Here you are able to add/remove licenses.

5 Click Next. The Options tab opens. This pane shows the System Options,
Drive Modules and Applications. Here you are able to customize your
options.

6 Click Next, the Confirmation tab gets selected and shows an overview of
the system options.

7 Click Apply for the changes to take place.

Deleting a system from a real controller
1 In the Installation Manager window, select Controllers and then select the

Network tab.
2 Select your controller in the controller list and clickOpen. Installation Manager

fetches information from the controller.
3 Select the system you want to delete and then click Remove.

The selected system gets deleted.

Note

The active system cannot be deleted. First activate a different system, or
deactivate the system by using the restart mode Start Boot Application.

Deleting a system from virtual controller
1 In the Installation Manager window, select Controllers and then select the

Virtual orNetwork tab. Here you are able to view the list of all virtual systems.
2 Select the system you want to delete and then click Remove.

The selected system gets deleted.

Note

When you create a system for virtual controller, corresponding products are
installed in the user APPDATA folder, and many virtual controller systems point
to these products. Hence, products are not deleted while deleting a system from
virtual controller.
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6.5.5 Copying a system

Copying a system from a virtual controller to a real controller
To be able to copy a system from a virtual controller to a real controller, the virtual
controller system must have been created with real license files.

1 In the Installation Manager window, select Controllers and then select the
Network tab.

2 Select your controller in the controller list and click Modify. Installation
Manager fetches information from the controller.

3 Click New. The Create New pane opens.
4 Enter the name of the system in the Name box, and then click the virtual

system option under Create new from.
5 Click Select, the Select Virtual System pane opens, select the particular

system and then click OK.
6 Click Next. The Products tab gets selected. All products and add-ins that

were part of the selected system will be displayed here.
7 ClickNext. The Licenses tab gets selected. The license details of the selected

system will be displayed here.
8 Click Next. The Options tab gets selected. Here you are able to

select/deselect options to customize them.
9 Click Next, the Confirmation tab gets selected and shows an overview of

the system options.
10 Click Apply, the system gets created.

Once the installation completes, a Restart Controller dialog appears, click Yes to
restart the controller. Click No to manually restart controller later, the controller
stores the new system or changed system and these changes will take effect during
the next restart.

Copying a virtual controller system
1 In the Installation Manager window, select Controllers and then select the

Virtual tab. Here you are able to view the list of all virtual systems.
2 Click New, the Create New pane opens.
3 Enter the name of the virtual system in the Name box, and then click the

virtual system option under Create new from.
4 Click Select, the Select Virtual System pane opens, select the particular

system and then click OK.
5 Click Next. The Products tab gets selected. All products and add-ins that

were part of the selected system will be displayed here.
6 ClickNext. The Licence tab gets selected. The license details of the selected

system will be displayed here.
7 Click Next. The Options tab gets selected. Here you are able to

select/deselect options to customize them.
8 Click Next, the Confirmation tab gets selected and shows an overview of

the system options.

Continues on next page
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9 Click Apply for the changes to take place.
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6.5.6 Creating a system from backup

Creating a system from backup for a real controller
1 In the Installation Manager window, select Controllers and then select

Network tab.
2 Select your controller in the controller list and clickOpen. Installation Manager

fetches information from the controller.
3 Click New, the Create New pane opens.
4 Enter the name of the system in the Name box, and then click backup option

under Create new from.
5 Click Select, the Select Backup pane opens, you can select the particular

backup system and then clickOK. If the right RobotWare already exists, then
the version will be selected.

Note

In the folder hierarchy of the backup path, the name of the valid backup
system folder that must be selected will be set in bold. Similarly, names
of all valid backup systems will be marked in bold in the folder hierarchy.
User must select one of the valid backup folders for further system creation.

6 Click Next. The Products tab gets selected. All products and add-ins that
were part of the backup system will be displayed here. You can add new/other
product(s) and/or replace RobotWare version if needed.

7 ClickNext. The Licenses tab gets selected. The license details of the backup
system will be displayed here. You are able to view the license(s) from the
backup system. Here you can add new/more licenses.

8 ClickNext theOptions tab gets selected, select/deselect options to customize
them.

9 Click Next, the Confirmation tab gets selected and shows an overview of
the system options.

10 Click Apply, the system gets created.
Once the installation completes, a Restart Controller dialog appears, click
Yes to restart the controller. Click No to manually restart controller later, the
controller stores the new system or changed system and these changes will
take effect during the next restart.

Creating a system from backup for a virtual controller
1 In the Installation Manager window, select Controllers and then select the

Virtual tab. Here you are able to view the list of all virtual systems.
2 Click New, the Create New pane opens.
3 Enter the name of the system in the Name box, and then click backup option

under Create new from.
4 Click Select, the Select Backup pane opens, you can select the particular

backup system and then click OK.
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If the right RobotWare already exists, then the version will be selected. If the
RobotWare does not exist, click Replace to select the RobotWare.

Note

In the folder hierarchy of the backup path, the name of the valid backup
system folder that must be selected will be set in bold. Similarly, names
of all valid backup systems will be marked in bold in the folder hierarchy.
User must select one of the valid backup folders for further system creation.

5 Click Next. The Products tab gets selected.
All products and add-ins that were part of the backup system will be displayed
here. You can add new/other product(s) and/or replace RobotWare if needed.

6 Click Next. The Licenses tab gets selected. Here you are able to view the
license details of the backup system.

7 Click Next, the Options tab gets selected, select/deselect options to
customize them.

8 Click Next, the Confirmation tab gets selected and shows an overview of
the system options.

9 Click Apply, the system gets created.
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6.5.7 Renaming a system

Renaming a system
You can rename an active system for a real controller without re-installation.

1 In the Installation Manager window, select Controllers and then select
Network tab.

2 Select the active sytem which must be renamed.
3 Click Rename. The Rename System dialog appears.
4 In the Enter the new name for the system box, type in the new name.
5 Click Rename.
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6.5.8 A MultiMove system with two coordinated robots

Overview
In this example we will use the System Builder to create a coordinated offline
system with one IRB2400 and one IRB1600 robot to use in a new RobotStudio
station.

Starting the New Controller System Wizard
To create a system like the one described above, follow these steps:

1 Click System Builder to bring up the dialog box.
2 In the dialog box, click Create New to bring up the New Controller System

Wizard.
3 Read the welcome text, and click Next to continue to the next page.

Entering the name and path
1 In the Name box, enter the name of the system. The name must not contain

blank spaces or non-ASCII characters.
In this example, name the system MyMultiMove.

2 In the Path box, enter the path for the folder to save the system in, or click
the Browse button to browse to the folder or create a new one.
In this example, save the system in C:\Program Files\ABB Industrial
IT\Robotics IT\RobotStudio\ABB Library\Training Systems.

3 Click Next to continue to the next page.

Entering the controller key
1 Select the Virtual key check box. A virtual controller key now appears in the

Controller Key box. In this example we will use the default media pool and
RobotWare version.

2 Click Next to continue to the next page.

Entering drive keys
1 Click the Right Arrow button next to the Enter Drive key box twice to create

one drive key for each robot.
2 Click Next to continue to the next page.

Adding options
1 This system does not require any additional option keys. Click Next and

continue to the next page of the wizard.

Modifying options
When creating robot systems from real robot keys, the key sets the options. But
since we are using a virtual key, we have to set the options manually.

Continues on next page
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When creating a system for several manipulators (up to four), you must include
either of the RobotWare options MultiMove Independent, or MultiMove
Coordinated for the related motion tasks to start.

Note

It is recommended to use the System From Layout function when you create
robot systems for RobotStudio. Then the MultiMove option gets added
automatically.

To set the options necessary for a MultiMove, follow these steps:
1 Scroll down to theRobotWare / Motion Coordination part 1 group and select

the MultiMove Coordinated check box.
2 Scroll down to the RobotWare/ Engineering Tools group and select the

Multitasking check box.

Note

The option Advanced RAPID is included in RobotWare- operating system
from RobotWare 5.60 and later.

3 Scroll down to the DriveModule1 / Drive module application group and
expand the ABB Standard manipulator option. Select the IRB 2400 Type A
option, manipulator variant IRB 2400L Type A.

4 Scroll down to the DriveModule2 / Drive module application group and
expand the ABB Standard manipulator option. Select the IRB 1600 option,
manipulator variant IRB 1600-5/1.2.

5 Click Finish and the system will be created.
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6.5.9 The recovery disk function

Introduction
The recovery disk function is for recreating a complete installation of RobotWare
and Add-Ins directly to a SD-card in the PC. The recovery disk function can be
found under both theController tab and theRepository tab in Installation Manager.

Prerequisites
The recovery disk function uses information from a backup to recreate the
RobotWare system that backup has been generated from.
For successful operation these prerequisites are needed:

• A backup for a system using RobotWare 6.0 or later, but not later than the
version of the currently used RobotStudio.

• All products and Add-Ins used by the backup should be located on the pc
(RPK:s and RMF:s).

• A SD-card reader.
• An original ABB Robotics SD-card.
• Administrative rights on the PC.

SD-card creation procedure
1 When the disk recovery function is started, the user will be asked to browse

for the backup folder. Once a valid backup directory is selected, the Write
Disk button is active.

2 The program will then try to locate all products and add-ins referenced in the
selected backup. If one or more product cannot be found, a second directory
browser will appear and the user will be asked to manually locate the product
that could not be found. The program will remember the parent directory of
the selected product, and include this directory in later searches.

3 When all products are located, the user will be asked to insert a SD-card into
the computer, or if already present the user will first be asked to remove the
card. This is to ensure that SD-cards are not overwritten by mistake.

4 Once the SD-card is inserted the user is prompted to confirm that the SD-card
will be permanently overwritten. From this point on and until the operation
is complete, the SD-card will be unusable in any other sense than to be used
by the disk recovery function again.

5 The operation is completed after about one minute, depending on the SD-card
reader performance, and the user is asked to remove the SD-card.

Installation procedure

CAUTION

Always power off the robot controller before changing the SD-card.

1 Power off the robot controller.
2 Replace the SD-card in the controller with the recovery SD-card.
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3 Power on the controller.
4 The controller completes the operation by resetting the system to default

values.
The text Controller is resetting system might appear on the FlexPendant
depending on how long this operation takes.

5 The RobotWare system starts up.
For RobotWare versions greater or equal to 6.04, the backup selected in the
recovery disk creator is automatically restored.

The backup can be found with its original name in the following folder:
/hd0a/BACKUP.
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6.6 Handle I/O

Overview
The I/O system handles input and output signals to and from the controller. Below
are the parts of the system described, as well as common types of signals.
The I/O system window is used to view and set previously configured signals, and
to activate and deactivate devices.

The I/O system
The I/O system of a controller consists of industrial networks, devices and I/O
signals. The industrial network are the controller's connections for devices (for
instance I/O boards) and the devices contain channels for the actual signals.
The industrial networks and devices are displayed in the robot view, as child nodes
under each controller and the I/O signals are displayed in the I/O window.

I/O signals
I/O signals are used to communicate between the controller and external equipment,
or to change variables within a robot program.

Input signals
Input signals notify something for the controller, for instance a feeder belt can set
an input signal when it has positioned a work piece. The input signal can then be
programmed to start a specific part of the robot program.

Output signals
The controller uses output signals to notify that a specified condition has been
fulfilled. For instance, after the robot has finished its sequence, an output signal
can be set. This signal can then be programmed to start a feeder belt, update a
counter or trigger any other action.

Simulated signals
A simulated signal is a signal that is manually given a specific value that overrides
the actual signal. Thus simulated signals might be useful for testing robot programs
without activating or running equipment.

Virtual signals
Virtual signals are signals that are not configured to belong to a physical device.
Instead, they reside inside the controller's memory. A common use for virtual
signals is to set variables and store changes in a robot program.

Procedures
For using the I/O system window, see Inputs/Outputs on page 384.
For adding a signal, see Add Signals on page 396.
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6.7 Configure systems

Configuring system parameters
System parameters may be configured as follows:

• To view topics, types, instances and parameters
• To edit the parameters of an instance
• To copy and paste instances
• To add and delete instances
• To load and save complete configuration files to and from controllers

When working with configurations, the following tools, see Configuration editor on
page 396, are useful:

UseTool

With the Configuration Editor you work with the types and instances
of a specific topic.

The Configuration
Editor

With the Instance Editor, you specify the values of the parameters in
the instances of system parameter types.

The Instance Editor

Note

To edit system parameters, you must have write access to the controller.

Terms

The sum of all parameters that configure the system, these are divided
into topics and types.

System parameters

A collection of parameters relating to a specific area, and the highest
level in the system parameter structure. Examples are Controller,
Communication and Motion.

Topic

A set of parameters for a specific configuration task. A type can be
seen as a pattern describing the construction and properties for the
parameters included in the task. For instance, the typeMotion System
defines which parameters shall be used for configuring a motion
system.

Type

An actualization of a type, an instance is a specific set of parameters
with unique values created from a type pattern. In the Configuration
Editor, each row in the Instance list is an instance of the type selected
in the Type list.

Instance

A property to set when configuring the robot system.Parameter

Contains all public parameters of a specific topic.Configuration file

Viewing configurations
1 To view the topics of a controller, from the Controller tab, expand the

Configuration node for the controller.
All topics in are now displayed as child nodes to the Configuration node.

2 To view the types and instances of a topic, double-click the topic node for
the topic to view.
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The Configuration Editor is now opened, listing all types of the topic in the
Type name list. In the Instance list, each instance of the type selected in the
Type name list is displayed as row. The parameter values of the instances
are displayed in the columns of the instance list.

3 To view detailed parameter information for an instance, double-click the
instance.
The instance editor now displays the current value, restrictions and limits of
each parameter in the instance.

Editing parameters
You can either edit the parameters of one single instance, or you can edit several
instances at one time. Editing several instances at one time is useful when you
want to change the same parameter in several instances, like when moving signals
from one device to another.

1 In theController tab, expand theController and theConfiguration node and
double-click the topic that contains the parameters to edit.
This opens the Configuration Editor.

2 In the Type name list of the Configuration Editor, select the type that the
parameter to edit belongs to.
The instances of the type is now displayed in the Instance list of the
Configuration Editor.

3 In the Instance list, select the instances to edit and press the Enter Key. To
select several instances at once, hold down the SHIFT or CTRL key while
selecting.
Alternatively, right-click an instance and then click Edit.
The Instance Editor is now displayed.

4 In the Parameter list of the Instance Editor, select the parameter to edit and
change the value of the parameter in the Value box.
When editing several instances at one time, the parameter values you specify
will be applied to all instances. For parameters that you do not specify any
new value, each instance will keep its existing value for that parameter.

5 ClickOK to apply the changes to the configuration database of the controller.
For many parameters, the changes will not take affect until the controller is
restarted. If your changes require a restart, you will be notified of this.
You have now updated the controller's system parameters. If you are going
to make several changes, you can wait with the restart until all changes are
done.
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Adding instances
With the Configuration Editor, you can select a type and create a new instance of
it. For example, adding a new instance of the type Signal creates a new signal in
the system.

1 In theController tab, expand theController and theConfiguration node and
double-click the topic that contains the type of which you want to add an
instance.
This opens the Configuration Editor.

2 In the Type name list of the Configuration Editor, select the type of which
you want to add an instance.

3 On theControllermenu, point toConfiguration and clickAdd type (the word
type is replaced by the type you selected previously).
You can also right-click anywhere in the configuration editor and then select
Add type from the shortcut menu.
A new instance with default values is added and displayed in the Instance
Editor window.

4 If required, edit the values.
5 Click OK to save the new instance.

The values in the new instance are now validated. If the values are valid, the
instance is saved. Otherwise, you will be notified of which parameter values
to correct.
For many instances, the changes will not take affect until the controller is
restarted. If your changes require a restart you will be notified of this.
You have now updated the controller's system parameters. If the changes
require a restart of the controller, the changes will not take affect until you
do this. If you are going to make several changes, you can wait with the
restart until all changes are done.

Copying an instance
1 In theController tab, expand theController and theConfiguration node and

double-click the topic that contains the instance to copy.
This opens the Configuration Editor.

2 In the Type name list of the Configuration Editor, select the type of which
you want to copy an instance.

3 In the Instance list, select one or several instances to copy.
If you select several instances and they don't have the same value for all
parameters, these parameters will have no default values in the new
instances.

4 On the Controller menu, point to Configuration and click Copy Type (the
word type is replaced by the type you selected previously).
You can also right-click the instance to copy and then selectCopy Type from
the shortcut menu.
A new instance with the same values as the one you copied is added and
displayed in the Instance Editor window.
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5 Change the name of the instance. If required, also edit the other values.
6 Click OK to save the new instance.

The values in the new instance are now validated. If the values are valid, the
instance is saved. Otherwise, you will be notified of which parameter values
to correct.
For many instances, the changes will not take affect until the controller is
restarted. If your changes require a restart you will be notified of this.
You have now updated the controller's system parameters. If the changes
require a restart of the controller, the changes will not take affect until you
do this. If you are going to make several changes, you can wait with the
restart until all changes are done.

Deleting an instance
1 In theController tab, expand theController and theConfiguration node and

double-click the topic that contains the type of which you want to delete an
instance.
This opens the Configuration Editor.

2 In the Type name list of the Configuration Editor, select the type of which
you want to delete an instance.

3 In the Instance list, select the instance to delete.
4 On the Controller menu, point to Configuration and then click Delete type

(the word type is replaced by the type you selected previously).
You can also right-click the instance to delete and then select Delete type
from the shortcut menu.

5 A message box is displayed, asking if you want to delete or keep the instance.
Click Yes to confirm that you want to delete it.
For many instances, the changes will not take affect until the controller is
restarted. If your changes require a restart you will be notified of this.
You have now updated the controller's system parameters. If the changes
require a restart of the controller, the changes will not take affect until you
do this. If you are going to make several changes, you can wait with the
restart until all changes are done.

Save one configuration file
The system parameters of a configuration topic can be saved to a configuration
file, stored on the PC or any of its network drives.
The configuration files can then be loaded into a controller. They are thereby useful
as backups, or for transferring configurations from one controller to another.

1 In the Controller tab, expand the Configuration node and select the topic to
save to a file.

2 On the Controller menu, point to Configuration and select Save System
Parameters.
You can also right-click the topic and then select Save System Parameters
from the shortcut menu.
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3 In the Save As dialog box, browse for the folder to save the file in.
4 Click Save.

Saving several configuration files
1 In the Controller tab, select the Configuration node.
2 On the Controller menu, point to Configuration and click Save System

Parameters.
You can also right-click the configuration node and then click Save System
Parameters.

3 In the Save System Parameters dialog box, select the topics to save to files.
Then click Save.

4 In the Browse for Folder dialog box, browse for the folder to save the files
in, and then click OK.
The selected topics will now be saved as configuration files with default
names in the specified folder.

Loading a configuration file
A configuration file contains the system parameters of a configuration topic. They
are thereby useful as backups, or for transferring configurations from one controller
to another.
When loading a configuration file to a controller, it must be of the same major
version as the controller. For instance, you cannot load configuration files from an
S4 system to an IRC 5 controller.

1 In the Controller tab, select the Configuration node.
2 On theControllermenu, point toConfiguration and select Load Parameters.

You can also right-click the configuration node and then select Load
Parameters from the context menu.
This opens the Select mode dialog box.

3 In the Select mode dialog box, select how you want to combine the
parameters in the configuration file to load with the existing parameters:

thenIf you want to

selectDelete existing parameters before
loading

replace the entire configuration of the
topic with the one in the configuration file.

click Load parameters if no duplicatesadd new parameters from the configura-
tion file to the topic, without modifying the
existing ones.

click Load parameters and replace du-
plicates

add new parameters from the configura-
tion file to the topic and update the exist-
ing ones with values from the configura-
tion file. Parameters that only exist in the
controller and not in the configuration file
will not be changed at all.

4 Click Open and browse to the configuration file to load. Then click Open
again.

5 In the information box, click OK to confirm that you want to load the
parameters from the configuration file.
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6 When the loading of the configuration file is finished, close the Select mode
dialog box.
If a restart of the controller is necessary for the new parameters to take affect,
you will be notified of this.
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6.8 Handle events

Overview
An event is a message that notifies you that something has happened to the robot
system, be it merely a change in operation mode or a severe error that calls for
your immediate attention. If the event requires any action from you, this is stated
in the event.
Events are displayed in the event logs of the FlexPendant and RobotStudio.
The event log keeps you informed of system status, allowing you to:

• view controller events.
• filter events.
• sort events.
• get detailed information about an event.
• save event log files on your PC.
• clear event records.

Event Log list
The event log list consists of all events matching your filter settings, with the
following information for each event:

The event type is an indication of the severity of the event.Type

The event code is a number that identifies the event message.Code

The event title is a short event description.Title

The event category is an indication of the source of the event.Category

The sequential number indicates the chronological order of the event.Seq. Number

Date and time is when the event occurred.Date and Time

When you select an event in the list, detailed information will appear to the right.

Event type
The event type is an indication of the severity of the event.
There are three types of events:

DescriptionEvent type

A normal system event, such as starting and stopping programs, change of
operating mode, motors on/off and so on.

Information

Information messages never require any action from you, but can be useful
for error tracking, statistics collecting or monitoring user triggered event
routines.

An event that you need to be aware of, but not so severe that the process or
RAPID program needs to be stopped. Warnings, however, often indicate
underlying problems that sooner or later must be solved.

Warning

Warnings must sometimes be acknowledged.

An event that prevents the robot system from proceeding. The running pro-
cess or RAPID program cannot continue, but is stopped.

Error

All errors must be acknowledged. Most errors also require some immediate
action from you in order to solve the problem.
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Note

This information is also indicated by color: blue for information, yellow for warning
and red for an error which needs to be corrected in order to proceed

Event code
The event code is a number that identifies the event message. Together with the
event date and time each event has a unique identity.

Event title
The event title is a short description of the event.

Event category
The category is an indication of the source of the event.

DisplayCategory

All recent events.Common

Events related to changes in operation or operating mode.Operational

Events related to the current system.System

Events related to controller hardware.Hardware

Events related to the running process applications and RAPID pro-
grams.

Program

Events related to the movement of robots or other mechanical units
.

Motion

Events related to input and output signals, serial or network commu-
nication and process buses.

I/O & Communica-
tion

Custom messages that have been programed into RAPID programs.User

Internal low-level controller errors for ABB service personnel.Internal

Events related to Industrial Processes options., such as Spot, Arc
and Dispense.

Process

Errors in a configuration file.Configuration

Events related to Rapid instruction.RAPID

Depending on how the system is configured, additional categories may exist.

Seq number
The sequential number indicates the chronological order of the event; the higher
the number the more recently the event occurred.

Date and Time
Date and time indicate exactly when the event occurred. Along with the event code,
this timestamp guarantees that each event has a unique identity.
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Event description
When you select an event in the list, detailed description about the selected event
is displayed on the right-hand side of the pane which contains a description section,
consequences, causes and suggested actions to solve the problem.

Overview
The Event Log automatically logs all controller events once it is started. By default,
events are displayed in the chronological order specified by Seq Numbers.

Note

Any modifications to the list you see will never affect the event log of the
controller. What you see is just a copy.

Managing events
1 In the Robot View Explorer, select a system.
2 Double-click the Event Log node.

Click the header for the column you want to sort by. To
switch between ascending and descending sorting, click
the header once again.

To sort events

In the Category list select the event category you want to
be displayed.

To filter events

Click Refresh.To clear the event log
This will not affect the event log of the robot controller. It
might still be impossible, however, to retrieve all events
from a cleared record once again, as the oldest ones may
have been erased from the controller hard disk due to lack
of space. It is therefore recommended to save the record
to a log file before clearing.

Select the Log to File check box.To save all events to a
single log file on the
computer

If it remains checked, the log file will be updated with new
events as they occur.

Click Save and then make your category choice. Specify
the location for the log file(s) in the Save As dialog and
then click OK.

To save events of one or
several categories to files
on the computer

If you select All when selecting categories, a log file for
each event category will be created.

Retrieving controller events
To clear the list and retrieve all existing events from the robot controller:

1 Optionally, save the existing Event Log record.
2 Select whether you want the list to be updated when new events occur , or

if you are only interested in viewing events that have already occurred.

...then...To ...

check the Auto Update check box. (Selected by
default.)

get automatic updates when new
events occur

clear the Auto Update check box.say no to automatic updates
when new events occur
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3 To clear the current list, fetch and display all events that are currently stored
in the controller log files.
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7 File tab
7.1 Overview

Overview
The File tab opens the RobotStudio Backstage view which displays information
and metadata about the currently active station, lists recently opened stations and
provides a variety of user options to create a new station, connect to a controller,
save station as viewer, and so on.
The the following table shows the various options available in Backstage view.

DescriptionTabs

Saves a station.Save / Save As

Opens a saved station. Select the LoadGeometry option when you open
or save a station else the geometry gets removed permanently.

Open

Closes a station.Close

Once a station is open in RobotStudio, this tab shows the properties of
the station, and also the robot systems and library files that are part of
the open station.

Information

Displays recently accessed stations.Recent

Creates a new station. See New tab on page 211.New

Prints the contents of the active window.Print

Shares data with others.
• Pack and Go on page 213
• Unpack and Work on page 214
• Station Viewer on page 215

Share

Connects to a controller.
• Add Controller on page 380

Imports and Exports controller.

Online

Creates and works with robot system.
• Building a new system on page 167
• Import Options on page 413

Displays information on installing and licensing RobotStudio. See In-
stalling and licensing RobotStudio on page 44.

Help

Displays information on RobotStudio Options. See Options on page217.Options

Closes RobotStudio.Exit

RobotStudio Solutions
RobotStudio defines solution as the collective name of the folder that contains the
structure for stations, libraries and all related elements. This folder gets created
automatically when the user creates a new solution.
You must define the name and location of the solution before creating the folder
structure and station.
A solution folder contains the following folders and files:

1 Stations: Stations created as part of solution.
2 Systems: Virtual controllers created as part of solution
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3 Libraries: User-defined libraries that are used in the station.
4 Solution file: Opening this file opens the solution.
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7.2 New tab

The Backstage view
The New tab in Backstage view provides many user options. These options are
grouped under the headings Stations and Files.
The following table provides the details of the options that are grouped under these
headings:

LinksTabsHeading

Creating a solution with an empty station on
page 211

Solution with Empty StationStations

Creating a solution with station and robot
controller on page 211

Solution with Station and Robot
Controller

Creating an empty station on page 212Empty Station

Creating a newRAPIDmodule file on page212RAPID Module FileFiles

Creating a controller configuration file on
page 212

Controller Configuration File

Creating a solution with an empty station
1 Click the File tab. The RobotStudio Backstage view appears, click New.
2 Under Stations, click Solution with Empty Station.
3 Enter the name of the solution in the Solution Name box and then browse

and select the destination folder in the Location box. The default solution
path is C:\User\<user name>\Documents\RobotStudio\Solutions.
The solution name will also be used as the name of the included station.

4 Click Create.
The new solution in the specified name gets created. RobotStudio saves this
solution by default.

Creating a solution with station and robot controller
1 In the Backstage view, under Stations, click Solution with Station and Robot

Controller.
2 Enter the name of the solution in the Solution Name box and then browse

and select the destination folder in the Location box.
The default path of solution C:\User\<user

name>\Documents\RobotStudio\Solutions. If you do not specify the
name of the solution, RobotStudio assigns the name Solution1 by default.

3 Under the Controller group, enter the name of the controller in the Name
box or select the robot model from the Robot Model list.
The default location of the virtual controller system when name of the solution
is not specified is C:\Users\<user
name>\Documents\RobotStudio\Solutions\Solution1\Systems.

4 In the RobotWare list, select the required robotware version or click Locations
to set the locations of distribution package and media pool.
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5 Solution with station and robot controller can be created either from a template
or from backup.

• To create from template, selectCreate New and then select the required
robot model from the Robot Model list to create a controller.

• To create from backup, select Create from backup and then browse
and select the required backup file. Also select the Restore backup
check box to restore backup on the new controller.

6 Select the option and click Create.

Creating an empty station
1 In the Backstage view, under Stations, click Empty Station.
2 Click Create.

Creating a new RAPID module file
1 In the Backstage view, under Files, click RAPID Module File.
2 Choose from the following options:

• Click Module (Program Module) to create a blank RAPID module file.
• Click Main Module (Program Module) to create a module with a main

routine.
• Click Module (System Module) to create a module with attributes for

read-only, view-only and not step-in.
According to the selection you make, the created RAPID module file opens
in the RAPID editor.

For more information on managing file based RAPID modules, see Managing file
based RAPID modules on page 453.

Creating a controller configuration file
1 In the Backstage view, under Files, click Controller Configuration File.
2 You can select any of the following options.

• Empty I/O configuration file to create a blank configuration file
• Example I/O configuration file to create an I/O configuration file with

some sample signals.
• Empty MMC configuration file to create a blank MMC configuration

file.
• EmptyMotion configuration file to create a blank motion configuration

file.
• Empty SIO configuration file to create a blank SIO configuration file.
• Empty SYS configuration file to create a blank SYS configuration file.
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7.3 Share

7.3.1 Pack and Go

Prerequisites
Any RobotWare 6 Add-in used by a virtual controller must be installed by the
RobotStudio installer, by downloading from the RobotWare Add-ins section of the
RobotApps page in the Add-Ins tab, or by using the Browse button of the
RobotApps page. The RobotWare Add-Ins that RobotStudio uses are visible in the
Add-Ins browser of the Add-Ins tab.

Note

RobotWare 5 Additional Options will not be visible in theAdd-Ins browser. These
options are always embedded in the Pack&Go.

Packing a station
1 In the Backstage view, under Share data with other people, click Pack and

Go. The Pack & Go dialog opens.
2 Enter the name of the package and then browse and select the location of

the package.
3 Select Password protect the package.
4 Type in your password in the Password box to protect your package.
5 Click OK.

The functions GoOffline and Pack&Go requires any RobotWare Add-Ins used by
the systems to be installed on the PC.

Note

You can create a system in Installation Manager and add it to a RobotStudio
station.
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7.3.2 Unpack and Work

Unpacking a station
1 On the File menu, click Unpack &Work to open the Unpack &WorkWizard.
2 On the Welcome to the Unpack & Work Wizard page, click Next.
3 On the Select package page, click Browse and Select the Pack & Go file

to unpack and Select the directory where the files will be unpacked. Click
Next.

4 On the Controller Systems page, select the RobotWare version and click
Browse to select the path to the Media Pool. Optionally, select the check
box to automatically restore backup. Click Next.

5 On the Ready to unpack page, review the information and then click Finish.
6 On the Unpack & Work finished page, review the results and then click

Close.
During an unpack operation, you are provided with two options, Load files from
local PC and Load files from Pack & Go. Click the option to select the location
from where the required files must be loaded. D

Note

If the Pack & Go file was set as password-protected during creation, then that
password needs to be provided for the station to load.

Note

During an unpack operation, if you select the Copy configuration files to SYSPAR
folder option, the configuration (CFG) files of the back up system inside the
pack& go file gets copied to the SYSPAR folder of the new system. This is to
avoid loss of configuration data during an I- start. Select this option for complex
configurations like paint system.
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7.3.3 Station Viewer

Overview
The Station Viewer can playback a station in 3D on computers that do not have
RobotStudio installed. It packages the station file together with files needed to
view the station in 3D. It can also play recorded simulations.

Prerequisites
• Visual C++ Redistributable for Visual Studio 2015.
• The .NET Framework 4.5 must be installed on the playback computer.

Note

RobotStudio 64-bit edition can create 64-bit Station Viewers. However, a 64-bit
station viewer can run only on the Windows 64-bit operating system.

Creating and loading a Station Viewer
1 To create a Station Viewer, on the File menu, click Share and select Save

Station as Viewer
2 Specify a file name and save as .exe file.

• Select the option Show comments on startup and add text in the box
to view the comment when the Station Viewer is started.

• To save the simulation as Station Viewer, go to the Simulation Control
group, click Play, and then select Record to Viewer. For more
information, see Running a simulation on page 361.

Note

Record to Viewer is enabled in Time Slice mode and it is disabled
when Free Run mode is enabled, see, Overview on page 351.

3 To load a Station Viewer, double-click the package (.exe) file on the target
computer.
The results are displayed in the Output window and the embedded station
file is automatically loaded and presented in a 3D view.

Configuring user settings of a Station Viewer
To configure the user settings of a Station Viewer, on the Filemenu, clickOptions.
Command Buttons

Click this button to save all options in the current page.Apply

Click this button to reset to the settings you had before this
session all values that you have changed on the current page.

Reset

Click this button to reset to their default values all settings on
the current page.

Default

Continues on next page
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Options:General:Appearance

Select the language to be used.Select application language
The default language is the same as that of the target user's
operating system if available, otherwise it is English.

Select the color to be used.Select color theme

Options:General:Graphics

Select the color from the color theme, or from the color stored
in the stations.

Background color

Simulation
When you run a simulation, the movements and visibility of objects are recorded.
This recording is optionally included in the Station Viewer.
Simulation control buttons are enabled when the Station Viewer contains a recorded
simulation.
Following are the Simulation control buttons:

Starts or resumes simulation playbackPlay

Stops simulation playbackStop

Resets all objects to their initial state and process time display to zeroReset

Select to run the simulation once or continuouslyRun mode

Displays the current simulation timeProcess time
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7.4 Options

Common buttons

Click this button to save all options in the current page.Apply

Click this button to reset to the settings you had before this
session all values that you have changed on the current page.

Reset

Click this button to reset to their default values all settings on
the current page.

Default

Options:General:Appearance

Select the language to be used. RobotStudio is available in the
following seven languages: English, French, German, Spanish,
Italian, Japanese, and Chinese (simplified).

Select application lan-
guage

Select the color to be used.Select color theme

Defines the default scale to use for windows that are zoomable,
for example, RAPID Editor, RAPID Data Editor and Configura-
tion Editor.

Default scale for zoomable
windows

Select this check box to view ScreenTips.Show ScreenTips

Select the check box if you want to display the position boxes
in the modify dialog boxes with colored background. Default
value: selected.

Display Position Edit
boxes with
Red/Green/Blue back-
ground

Select this check box to group related document window under
one tab. Modifying this option requires a restart for the changes
to take effect.

Group related document
windows under one tab

Select this check box to restore dialogs or messages which
you may have hidden while using RobotStudio.

Restore hidden dialogs
and messages

Options:General:Licensing

Reverts to Basic mode to use features that do not require
activation.

Disable licensing

Click to view the licenses listed by feature, version, type,
expiration date and status.

View installed licenses

Click to activate RobotStudio license.Activation Wizard

For RobotStudio Basic users, it is mandatory to participate
in the user experience report.

RobotStudio user experience
program

• I want to help improve
RobotStudio

• I do not want to particip-
ate right now

For RobotStudio Premium users, you can choose whether
or not to participate in the user experience report .

Options:General:Units

Select the quantity for which you want to change the units.Quantity

Select the unit for the quantity.Unit

Enter the number of decimals that you want to be displayed.Display decimals

Enter the number of decimals that you want when modifying.Edit decimals

Continues on next page
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Specifies the default format to use for orientations.Default orientation format
• RPY angles (Euler

ZYX)
• Quaternions

Options:General:Advanced

The number of operations that can be undone or redone.
Lowering this value can decrease memory usage.

Number of undo/redo
steps

Warns of orphaned VC processes.Warn about running Virtu-
al Controller processes on
startup

Warns when deleting objects.Show acknowledge dialog
boxwhen deleting objects

Warns when deleting targets and move instructions.Show acknowledge dialog
box when deleting targets
and corresponding move
instructions

Select this check box to bring the output window to front if an
error message is displayed

Bring the output window
to front if an error mes-
sage is displayed

Options:General:Autosave

This check-box is selected by default. RAPID programs are
saved automatically in every 30 seconds.

Enable autosave of RAPID

Unsaved stations are saved automatically at the interval
specified in the minute interval box.

Enable autosave of station

Takes multiple backup of station files as specified in the
Number of backups list and saves it in a sub-folder of the
corresponding Stations folder (StationBackups). Requires
a Solution.

Enable automatic backup of
station files

Select this option to backup the virtual controllers of a
solution when saving the station. The backups are stored
in the Backups folder of the corresponding solution.

Enable automatic backup of
controllers in solution

Options:General:Files & Folders

Shows the default path to the project folder.User Document Directory

Shows the default path to the solutions folder.Solutions Directory

To browse to the project folder, click the browse button....

Select this check box to enable the creation of individual sub-
folders for document types.

Automatically create docu-
ment subfolders

Specify the interval between the savings when using Autosave
in this box.

minute interval

Clears the list of recently accessed stations and controllers.Clear Recent Stations and
Controllers

Launches the Document Locations dialog box. For more inform-
ation, see Document Locations window on page 72.

Document Locations

Continues on next page
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RobotWare 6 and related RobotWare add-ins mediapools are
distributed as distribution packages. For RobotStudio to find
them, they need to be located in a specific folder. If the folder
is not specified, the default location is used.

Additional distribution
package location

On a Windows installation with English language, the default
folder is C:\User\<user name>\AppData\Local\ABB Industrial
IT\Robotics IT\DistributionPackages.
The location can be customized by entering a search path here.

Select this check box to dowload distribution packages to the
user defined location instead of the default folder.

Download packages to
this location

This is where RobotStudio searches for RobotWare 5.xx me-
diapools.

Mediapool

Options:General:Screenshot

Select this option to capture the entire application.Entire application window

Select this option to capture the active document window,
typically the graphics window.

Active document window

Select this check box to save the captured image to the system
clipboard.

Copy to clipboard

Select this check box to save the captured image to file.Save to file

Specify the location of the image file. The default location is
the "My Pictures" system folder.

Location

Browse for the location....

Specify the name of the image file. The default name is "Robot-
Studio" to which is added a date.

File name

Select the desired file format. The default format is JPG.The file suffix list

Options:General:Screen Recorder

Specify the framerate in frames per second.Framerate

Select this option to start recording after the specified time.Start recording after

Select this option to stop recording after the specified time.Stop recording after

Select this option to include the mouse cursor for the functions
Record Application and Record Graphics.

Include mouse cursor

Select this option to use the same resolution as in the graphics
window.

Resolution - Same as win-
dow

Select this option to scale down the resolution as per the
Maximum Width and Maximum Height you specify.

Resolution - Limit resolu-
tion

Specify the maximum width in pixels.Maximum width

Specify the maximum height in pixels.Maximum height

Select the video compression format.Video compression
Note that DivX format is not supported.

Specifies the location of the videos.Location

Enter a file name and a file format. The default format is WMV.File name and Output file
format You can also save the output format as MP4. The recommended

format is MP4.

Continues on next page
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Options:Robotics:Text Editor

Select this check box to view line numbers in the RAPID editorShow line numbers

Select this check box to show the ruler in the RAPID editorShow ruler

Select this check box to show whitespace characters in the
RAPID editor

Show whitespace

Select this check box if you want to wrap long lines.Word wrap

Select this check box to convert tabs to spaces in the RAPID
editor

Convert tabs to spaces

Specify the number of spaces for a Tab press.Tab size

Specify the appearance of the various text classes.RAPID Text styles

Specifies the text color of the RAPID editor.Text color

Specifies the background color of the RAPID editor.Background color

Select this check box for bold-face fonts in the RAPID editor.Bold

Select this check box for italicized fonts in the RAPID editor.Italic

Options:Robotics:RAPID Profiler

Specify the name of the default RAPID log file.Default RAPID log file

Select this check box to manually specify the file name of the
log file always.

Always ask for filename

Select this check box to open the analysis after the log is made.Open analysis when log-
ging is stopped

Options:Robotics:Graphical Programming

Select this check box if you want RobotStudio to display a
warning when there are workobjects with the same name that
have been declared as in other tasks. Default value: selected.

Show dialog when warn-
ing for globally defined
workobjects

Select this check box if you want the synchronize dialog box
to be displayed when you have loaded a program or a module.
Default value: selected.

Show synchronize dialog
box after loading program
/module

Select this check box if you want to be notified that wobj0
and/or tool0 is active and will be used in the current action.
Default value: selected.

Show notification that de-
fault data is used

Select this check box if you want newly created tooldata to be
set as active. Default value: selected.

Set as active when creat-
ing tooldata

Select this check box if you want newly created workobjects
to be set as active. Default value: selected.

Set as active when creat-
ing workobjects

Specify the maximum gap allowed when creating an AutoPath.AutoPath

Options:Robotics:Synchronization

Converting data, such as target to Workobject, shall use the
default behavior for synchronization locations. Default value:
selected.

Use default synchroniza-
tion locations

Notifies of the behavior above. Default value: selected.Showdefault synchroniza-
tion locations notification

Specify the locations for corresponding objects when synchron-
izing to the VC.

Declaration default loca-
tions

Continues on next page
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Options:Robotics:Mechanism

Select the approach vector. Default value: Z.Approach Vector

Select the travel vector. Default value: X.Travel Vector

Select the required option to enable configuration to either allow
the user to set the configuration or to select a configuration
closest to the current one when it jumps to target or move in-
structions. Show dialog for setting the configuration is selec-
ted by default.

When jumping to a target
or move instruction with
undefined configuration

• Show dialog for
setting the configur-
ation

• Use the configura-
tion closest to the
current one

Options:Robotics:Virtual Controller

Select this check box if you want to have the virtual FlexPend-
ant always on top. Default value: selected.

Always on top

Select this check box if you want parts of the virtual FlexPend-
ant to be transparent. Default value: selected.

Enable transparency

After restarting the controller,
• Select this check box to log the console output to "con-

sole.log" in the controller directory
• Select this check box to log the console ouput to a con-

sole window

Logging

Select this check box to automatically open the virtual Operator
Window. Default value: Enabled.

Automatically open virtual
Operator Window

Options:Online:Authentication

Lists the recent users.Recent Users

Click these buttons to remove one or all recent users, respect-
ively.

Remove/Remove All

Select the check box if you want to log off automatically.Enable Automatic Logoff

Determines the length of the session before being automatically
logged off.

Timeout

Select the application that controls the language of the control-
ler event logs.

Displays languages for
controller texts such as
event logs.

• RobotStudio lan-
guage

• FlexPendant lan-
guage

Options:Online:Online Monitor

Specifies the update interval.Update Rate (s)

Sets the revolution limit for joints.Revolute Joint Limits

Sets the linear limit for joints.Linear Joint Limits

Sets the singularities.Singularities

Continues on next page
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Options:Online:Jobs

Specifies the number of devices for which a job
is executed in parallell.

Max number of devices processed in
parallell

Options:Graphics:Appearance

Move the slider to control the multisampling level used to
smooth jagged edges. The available options are hardware de-
pendent. RobotStudio must be re-started for this setting to take
effect.

Anti-aliasing

Specifies the font used in markups.Font

Select the check box to enable advanced lighting by default.Advanced lighting

Click this option to view the perspective view of the object by
default.

Perspective

Click this option to view the orthographic view of the object by
default.

Orthographic

Click the colored rectangle to change default background color.Custombackground color

Select the check box if you want the floor (at z=0) to be dis-
played by default. Change the floor color by clicking the colored
rectangle. Default values: selected.

Show floor

Select the check box if you want the floor to be transparent by
default. Default values: selected.

Transparent

Select the check box if you want the UCS grid to be displayed.
Default value: selected.

Show UCS Grid

Change the UCS grid space in the X and y coordinate directions
by entering the requested value in the box. Default value: 1000
mm (or equivalent in other units).

Grid Space

Select the check box if you want the UCS coordinate system
to be displayed. Default value: selected.

Show UCS coordinate
system

Select the check box if you want the coordinate systems to be
displayed. Default value: selected.

Show world coordinate
system

Select this check box to have the navigation and selection
buttons on the graphics window.

Show navigation and se-
lection buttons

The settings you make take effect when creating a new station or when selecting
Default View Settings from the Settings menu of the View tab of the Graphics
Tools ribbon.

Options:Graphics:Performance

Select if the detail level is to be Auto, Fine, Medium or Coarse.
Default value: Auto.

Rendering detail level

Select the check box if you want to ignore the back-facing tri-
angles. Default value: selected.

Render both sides of sur-
faces

Culling back-facing triangles improves the graphics perform-
ance but may give unexpected display if surfaces in models
are not faced correctly.

Select the size in pixels under which objects will be disreg-
arded. Default value: 2 pixels.

Cull objects smaller than

Continues on next page
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The settings you make here are generic for all objects in RobotStudio. With the
Graphic Appareance dialog box you can, however, override some of these settings
for single objects.

Options:Graphics:Behavior

Select a navigational activity and then specify the mouse but-
tons to be used for the selected navigational activity.

Navigation

Select the navigation sensitivity when using the mouse move-
ments or navigation buttons by clicking the bar and dragging
it into position. Default value: 1.

Navigation sensitivity

Change the selection radius (that is, how close the mouse
cursor click must be to an item to be selected) by entering the
requested pixel value in the box. Default value: 5.

Selection radius (pixels)

Click the colored rectangle to change the highlight color.Selection highlight color

Select the check box to enable temporarily highlighting of items
that may be selected when the mouse cursor passes over them.
Default value: selected.

Selection preview

Select the check box to show the local coordinate system for
the selected objects. Default value: selected.

Show local coordinate
system for selected ob-
jects

Options:Graphics:Geometry

Specify the level of detail required when importing geometries.Detail Level
Select Fine, Medium or Coarse as required.

Options:Graphics:Stereo/VR*

Displays the image available in the VR glasses in the Graphics view.Mirror Output

Move the slider to adjust the quality of the image to an acceptable
level of lag.

Quality

This option is disabled by default for better performance.Disable Anti-Aliasing

Options:Simulation:Clock

Sets the simulation speed relative to real time. You can define
the simulation speed to a maximum of 200%

Simulation speed

Select this check box to run the simulation as fast as possible.As fast as possible
When you select this option, the simulation speed slider is
disabled.

Specifies the simulation timestep.Simulation timestep

When simulating a large number of controllers (such as ten
controllers), this option may increase performance by utilizing
multiple CPU cores.
This option is hardware dependent and hence may give differ-
ent results depending on the computer used.

Run time slice in parallel
for multiple controllers

Options:Simulation:Collision

Select if collision detection is to be performed during simulation
or always. Default value: always.

Perform collision detec-
tion

Continues on next page
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Select this check box if you want the simulation to stop at a
collision or at a near miss. Default value: cleared.

Pause/stop simulation at
collision

Select this check box if you want the collisions to be logged to
the output window. Default value: selected.

Log collisions to Output
window

Select this check box if you want to log the collisions to a file.
Browse for the file to log in by clicking the browse button. De-
fault value: cleared.

Log collisions to file:

Select this check box to enhance the performance by detecting
collisions between geometrical bounding boxes instead of
geometrical triangles. This might result in falsely reported col-
lisions, since the triangles are the true geometry and the
bounding boxes always are larger. All true collisions will,
however, be reported. The larger the object, the greater the
number of false collisions that are likely to be detected.

Enable fast collisiondetec-
tion

Click this button to open the log file specified in the file box in
Notepad.

View

Click this button to delete the log file specified in the file box.Clear

Click this button to browse for the file in which you want to log
the collisions.

...

Options:Simulation:Physics

Set the slider to set the physics collision geometry either
to faster or to a more accurate state.

Collision Geometry detail level
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8 Home tab
8.1 Overview

The Home tab
The Home tab contains the controls required for building stations, creating systems,
programming paths and placing items.
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8.2 ABB Library

About this button
With this button, you can choose robots, positioners and tracks from their respective
galleries.
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8.3 Import Library

About this button
With this button, you can import equipment, geometries, positioners, robots, tools
and training objects to your station libraries.

Importing a library
Use this procedure for importing library files to a station:

1 On the Home menu, click Import Library and select one of the following
controls:

• Equipment
• User Library
• Documents
• Locations
• Browse for Library

Note

You can also import component xml files (*.rsxml) to your station.

2 Click Equipment to import predefined ABB mechanism libraries.
3 Click User Library to select the user defined libraries.
4 Click Documents to open the Documents window. See The Documents

window on page 67
5 Click Locations to open the Document Locations window. See Document

Locations window on page 72.
6 Click Browse for Library to select the saved library files.

Operating manual - RobotStudio 227
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

8 Home tab
8.3 Import Library



8.4 Robot System

8.4.1 Robot System

About this button
With the Robot System button, you can either create a system from layout or
template, choose an existing system, or select a system from a robot gallery and
setup a conveyor tracking mechanism.

Creating a system from layout
1 Click From Layout to bring up the first page of the wizard.
2 In the Name box, enter the name of the system. The location of the system

will be displayed in the Location box.
3 In the RobotWare list, select the version of RobotWare you want to use.
4 Click Next.
5 In the Mechanisms box, select the mechanisms that you want to include in

the system.
6 Click Next.

The wizard now proposes a mapping of the mechanisms to a specific motion
task, in accordance with the following rules:

• Only one TCP robot is allowed per task.
• Up to six motion tasks may be added, but only four TCP robots can be

used, and they must be assigned to the first four tasks.
• The number of tasks may not exceed the number of mechanisms.
• If the system contains one TCP robot and one external axis, they will

be assigned to the same task. It is, however, possible to add a new
task and assign the external axis to it.

• If the system contains more than one TCP robot, any external axes will
be assigned to a separate task. It is, however, possible to move them
to other tasks.

• The number of external axes in a task is limited by the number of
available drive modules in the cabinet (one for large robots, two for
medium, three for small).

If only one mechanism was selected in the previous page, this page will not
be shown.
Tasks can be added and removed using the respective buttons; mechanisms
can be moved up or down using the respective arrows. To map the
mechanisms to tasks, follow this step:

7 Optionally, make any edits in the mapping, and then click Next.
The System Option page appears.

Continues on next page
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8 On the System Option page, you have the option to align Task Frame(s) with
the corresponding Base Frame(s).

• For single robot system, select the checkbox to align task frame with
base frame:

• For MultiMove Independent system, select the check box to align task
frame with base frame for each robot.

• For MultiMove Coordinated system, select the robot from the drop
down list and select the check box to align task frame with base frame
for the selected robot.

9 Verify the summary and then click Finish.
If the system contains more than one robot, the number of tasks and the
baseframe positions of the mechanism should be verified in the System
Configuration window.

Note

To create a system from layout, all your mechanisms such as robots, track
motions and positioners, must be saved as libraries.

Adding a template system
1 Click From Template to bring up a dialog box.
2 In the Select Template System list, either select an appropriate template or

click Browse and browse to one.
3 In the Libraries group, select whether to import libraries or to use the existing

station libraries.
4 In the System group, enter a name and location, and then click OK.

Adding an existing system
1 Click Existing to bring up a dialog box.
2 In the Select System Pool list, select a folder.
3 In the Systems Found list, select a system.
4 In the Libraries group, select whether to import libraries or to use the existing

station libraries.
5 Click OK.

Selecting a system from a robot gallery
1 Click Quick System to bring up a gallery, and then click the appropriate

robot.

Adding objects to the conveyor
1 In the Layout browser, click the conveyor node.
2 Right-click Workpiece source folder and click Add objects to workpiece

source.
3 In the Set Pitch tab, select the part from Available Parts.
4 Enter required Pitch value and set Offset position and Offset orientation.
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5 Click Create.

Modifying the connection between VC and conveyor
1 In the Layout browser, click the Conveyor node.
2 Click Connections.
3 Right-click Connections and select Modify Connection.
4 In the Modify Connection tab, enter new values.
5 Click Apply.

Removing objects from conveyor
1 In the Layout browser, click the Conveyor node.
2 Click the Workpiece source node.
3 Right-click the part that must be removed, and click Remove.

Clear conveyor
Use this option to detatch workobjects, to clear the placed objects and to reset the
conveyor to its start position. To access this option, In the Layout browser right-click
the conveyor and click Clear.
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8.4.2 External Axis Wizard

Overview
The ABB IRC5 controller is capable of controlling a vast number of mechanical
units other than the ABB robot manipulator. Some external equipment such as
workpiece positioners and robot tracks are standard ABB equipment for which
ABB supplies and maintains controller system configuration files. But in many
situations there is a need for customized external equipment.
It is possible to use standard ABB motor units and gear units in customized external
equipment. The configuration file of the motor unit or gear unit in isolation is
supplied and maintained by ABB. The External Axis Wizard tool simplifies the
controller configuration for different combinations of motor units and gear units in
customized mechanical units.
Mechanism modeling functionality in RobotStudio makes it is possible to define
custom kinematic mechanisms. The External Axis Wizard lets you specify
mechanisms to include in the system. First, connect and configure each axis in a
mechanism to a corresponding motor unit or gear unit. Then, the template
configuration files are used to assemble a complete system configuration according
to specification.

Note

The External Axis Wizard can be downloaded from the RobotApps website. To
access the RobotApps website, visit www.abb.com/roboticssoftware.

Limitation
For IRC5P systems (used for painting), the External Axis Wizard supports only up
to three external axes.

Prerequisites
• Build the station, and import or model the geometry of the mechanism. For

information about creating a new station, see Workflow of building a station
on page 83.

• Use the Mechanism Modeling functionality to define custom kinematic
mechanisms. For more information, see Create Mechanism on page 338.

• Add a virtual controller to the station, and include additional drives
corresponding to the axes of the mechanism to the controller system.

• The robot will not be attached to the mechanism. You must manually attach
the robot to the external axis after successful configuration by the External
Axis Wizard.

Using the External Axis Wizard
1 From the Robot System menu, click External Axis Wizard.

The first page of the wizard appears. It lists the the previously defined
mechanisms (including robots) in the Mechanisms box.

Continues on next page
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2 From the Mechanisms box, select the mechanisms to include in the system.
• The mechanism model must be built in such a way that a kinematics

model can be created. The joint chain must be defined such that it can
be described by Denavit-Hartenberg parameters. The mechanism
model must sometimes be modified to be able to keep the flange in
the desired position. This can be done automatically by the External
Axis Wizard, by adding a locked axis.

• For adding an additional locked axis, when prompted, click Ok.
This is a dummy axis with frame definition. This dummy axis is added
to the controller configuration and also to the RobotStudio mechanism.
You cannot jog this additional axis.

3 Click Next.
The mechanisms along with their joints are listed.

4 Configure theMechanical Unit based on the following information. The name
of the mechanism in RobotStudio corresponds to the mechanical unit of the
motion configuration.

• Select the drive module (DM1 - DM4) to use for the mechanical unit.
If the mechanism has more than three joints, or, if there are several
external mechanisms which are to be part of the configuration, then
you need to use additional drive modules. In such cases, before using
the External Axis Wizard, configure the controller system with the
appropriate number of drive modules.

• Optionally, you can use an Activation Relay by selecting the
corresponding check box.
For more information, see Technical reference manual - System
parameters (3HAC050948-001).

• For two axis positioners with rotating axes, where the two axes are in
series, you can optionally select the Error Model check box.
Mechanisms defined with the error model can be calibrated with the
FlexPendant using the standard four point method for each axis. This
will compensate for deviations present in the real mechanisms.

• You can configure two mechanical units to share a drive module.
To share the drive module with a mechanical unit, select that
mechanical unit in the Common Drive list. The list shows all
mechanisms (except TCP robot) with the same number of joints as the
selected one. The joints of the mechanical units use the same logical
axis and drive module. Note that the common drive option is not
available unless an activation relay is chosen for the mechanical unit.
This ensures that two mechanical units sharing a drive cannot be
activated at the same time.

5 Configure the joint based on the following information.
• For each joint select the Motor Unit. You can select a motor unit (MU),

or a gear unit (MTD), or an interchange unit (MID). The list is populated
with the standard motor and gear units provided by ABB.
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Your choice will affect the capacity and cycle time of the external axis.
• Electronically linked motors are two motor units that drive the same

axis. To link a motor unit to another one electronically, select the
respective joint in the Follow list.

• The Drive Unit list is populated with the available drive units of the
system. Each joint will be represented by its selected drive unit.

• You can configure Logical Axis, Transmission, Link,Board andNode
according to your needs.
For more information, see Technical reference manual - System
parameters (3HAC050948-001).

Note

Default values are given for all attributes, except Motor Unit. However, you
must review and change to the correct parameters to give a valid
configuration.

6 Click Next.
The Finish page comes up.

7 To save the configuration to a file, click Save.
The configured kinematics of external axis devices are saved to a
configuration file.

8 To load the saved configuration to the system on exiting from the wizard,
select the Load Configuration to System check box.

9 Click Finish to exit the wizard.
Use the saved configuration files to assemble a complete controller system
configuration according to specification. When a system is configured, the MOC.cfg
file with a subset for the external equipment is saved and a virtual controller is
started for verification.

Note

All mechanisms which have been used in this configuration will be disconnected
from the library. To maintain these changes in a library file (.rslib), you need to
manually save it. This is because the External Axis Wizard may have automatically
adjusted the mechanisms to enable them to be configured.
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8.5 Import Geometry

Importing geometry
1 On the Home menu, click Import Geometry and select one of the following

controls:
• User Geometry
• Browse for Geometry

2 Click User Geometry to select the user defined geomtery.
3 Click Browse for Geometry to browse to the folder where the geometry is

located.
For predefined geometries, click the Geometry icon to the left in the dialog
box.

4 Select the required geometry and click Open.
If you want the geometry to move with another object, attach it to the
requested object, see Attach to on page 486.
To modify the detail level for import of geometries, see Options on page217.

Note

The Modeling tab also contains the Import Geometry option.
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8.6 Export Geometry

Overview
The Export Geometry command is available for component groups, parts, stations
and mechanism links. Right-click an open group, station, part or mechanism link
and then select Export Geometry to access this command.

Exporting Geometry in a station
1 In the Layout browser, right-click an open station and select Export

Geometry.
2 The ExportGeometry:Station pane opens, select the required format from

the Format list.
3 Click Export and select the destination folder.

You can use these steps for a component group, part or mechanism link.

Supported formats
It is possible to export geometry in the following formats in a station.

DescriptionFormat

Selecting this format provides two export options, Export invisible objects
and Only export objects intersecting the floor. You can configure the view
and export all objects or only objects that touch the floor.

dxf, svg
(2D formats)

When you select Only export objects intersecting the floor option, enter
the value of Floor height (mm).
It is possible to export a RobotStudio function as a 2D floor layout when the
View point is set to Top.

When you select this format, Export invisible objects check box is displayed,
select this option to export all invisible objects in the station.

dae
(3D format)

The supported export formats vary for component groups, parts and mechanism
links. The following table lists various supported formats for exporting geometry
for each of these elements:

Supported formatsElements

COLLADA(dae)Group

ACIS(sat), IGES(igs, iges), STEP(stp, step, p21), VDAFS(vda,
vdafs), Catia v4(model, exp), COLLADA(dae), OBJ(obj),
RSGFX(rsgfx), VRML2, STL.

Mechanism links, Parts
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8.7 Frame

8.7.1 Frame

Creating a frame
1 Click Frame.
2 In the dialog box, specify the positions for the frame.

Select the Reference coordinate system to which all pos-
itions or points will be related.

Reference

Click in one of these boxes, and then click the frame pos-
ition in the graphics window to transfer the values to the
Frame Position boxes.

Frame Position

Specify the coordinates for the frame orientation.Frame Orientation

Select this check box to set the created frame as the user
coordinate system.

Set as UCS

Note

The Modeling tab also contains the Frame option.
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8.7.2 Frame from Three Points

Creating a frame from three points
1 Click Frame from Three points to bring up a dialog box.
2 Decide how you want to specify the frame:

SelectTo specify the frame using

PositionX, Y and Z coordinates, a point on the X
axis and a point in the X-Y plane

Three Pointtwo points on the X axis and one point on
the Y axis

3 If you select Position:
• Enter the Position for the object.
• Enter the Point on X axis for the object.
• Enter the Point on X-Y plane for the object.
• Click Create.

4 If you select Three Point:
• Enter the First Point on X axis for the object. This is the point closest

to the frame’s origin.
• Enter the Second Point on X axis for the object. This is the point further

away in the positive X direction.
• Enter the Point on Y axis for the object.
• Click Create.

The Create Frame From Three Points dialog box

Select this option if you want to create the frame by using a
position and two points.

Position

Click in one of these boxes, and then click the frame position
in the graphics window to transfer the values to the Frame
Position boxes.

Frame Position

Click in one of these boxes, and then click the point position
in the graphics window to transfer the values to the Point on
X axis boxes.

Point on X axis

Click in one of these boxes, and then click the point position
in the graphics window to transfer the values to the Point on
X-Y plane boxes.

Point on X-Y plane

Select this option if you want to create the frame by using three
points.

Three Point

Click in one of these boxes, and then click the point position
in the graphics window to transfer the values to the First Point
on X axis boxes.

First Point on X axis

Click in one of these boxes, and then click the point position
in the graphics window to transfer the values to the Second
Point on X axis boxes.

Second Point on X axis

Click in one of these boxes, and then click the point position
in the graphics window to transfer the values to the Point on
Y axis boxes.

Point on Y axis

Continues on next page
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Select this check box to set the created frame as the user co-
ordinate system.

Set as UCS
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8.8 Workobject

Creating a workobject
1 On the Home tab, in the Path Programming group, click Other and select

Create Workobject.
The Create Workobject dialog box appears.

2 In the Misc Data group, enter the values for the new workobject.
3 In the User Frame group, do one of the following:

• Set the position of the user frame by entering values for the Position
x,y,z and the Rotation rx, ry, rz for the workobject by clicking in the
Values box.

• Select the user frame by using the Frame by points dialog box.
4 In the Object Frame group you can reposition the object frame relative to

the user frame by doing any of the following:
• Set the position of the object frame by selecting values for Position x,

y, z by clicking in the Values box.
• For the Rotation rx, ry, rz, select RPY (Euler XYX) or Quaternion, and

enter the rotation values in the Values dialog box.
• Select the object frame by using the Frame by points dialog box.

5 In the Sync Properties group, enter the values for the new workobject.
6 ClickCreate. The workobject will be created and displayed under the Targets

node under the robot node in the Paths&Targets browser.

The Create Workobject dialog box

Specify the name of the workobject.Name

Select whether the workobject is to be held by the robot. If you
select True, the robot will hold the workobject. The tool can
then either be stationary or held by another robot.

Robot holds workobject

Select the mechanical unit that moves the workobject. This
option is applicable only if Programmed is set to False.

Moved bymechanical unit

Select True if the workobject is to use a fixed coordinate sys-
tem, and False if a movable (that is, external axes) will be used.

Programmed

Click in one of these boxes, and then click the position in the
graphics window to transfer the values to the Position boxes.

Position x, y, z

Specify the rotation of the workobject in the UCS.Rotation rx, ry, rz

Specify the frame position of the user frame.Frame by points

Click in one of these boxes, and then click the position in the
graphics window to transfer the values to the Position boxes.

Position x, y, z

Specify the rotation of the workobject.Rotation rx, ry, rz

Specify the frame position of the object frame.Frame by points

Select PERS or TASK PERS. Select the Storage TypeTASK
PERS if you intend to use the workobject in multimove mode.

Storage type

Select the module in which to declare the workobject.Module
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8.9 Tooldata

Creating tooldata
1 In the Layout browser, make sure the robot in which to create the tooldata

is set as the active task.
2 On the Home tab, in the Path Programming group, click Other, and then

click Tooldata.
This opens the Create Tooldata dialog box.

3 In the Misc Data group:
• Enter the Name of the tool.
• Select whether the tool is to be held by the robot in the Robot holds

tool list.
4 In the Tool Frame group:

• Define the Position x, y, z of the tool.
• Enter the Rotation rx, ry, rz of the tool.

5 In the Load Data group:
• Enter the Weight of the tool.
• Enter the Center of gravity of the tool.
• Enter the Inertia of the tool.

6 In the Sync Properties group:
• In the Storage type list, select PERS or TASK PERS. Select TASK

PERS if you intend to use the tooldata in MultiMove mode.
• In the Module list, select the module in which to declare the tooldata.

7 Click Create. The tooldata appears as a coordinate system in the graphics
window.
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8.10 Target

8.10.1 Teach Target

Teaching a target
To teach a target, follow these steps:

1 In the Layout browser, select the workobject and tool for which you want to
teach the target.

2 Jog the robot to the preferred position. To jog a robot linearly, its VC must
be running.

3 Click Teach Target.
4 A new target will be created in the browser, under the active workobject node.

In the graphics window a coordinate system will be created at the TCP
position. The configuration of the robot at the target will be saved.
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8.10.2 Create Target

Creating a target
1 In the Layout browser, select the workobject in which you want to create the

target.
2 Click Create Target to bring up a dialog box.
3 Select the Reference coordinate system you want to use to position the

target:

SelectIf you want to position the target

Worldabsolute in the world coordinate system
of the station

Work Objectrelative to the position of the active
workobject

UCSin a user-defined coordinate system

4 In the Points box, click Add New and then click the desired position in the
graphics window to set the position of the target. You can also enter the
values in the Coordinates boxes and click Add.

5 Enter the Orientation for the target. A preliminary cross will be shown in the
graphics window at the selected position. Adjust the position, if necessary.
To create the target, click Create.

6 If you want to change the workobject for which the target is to be created,
expand the Create Target dialog box by clicking the More button. In the
WorkObject list, select the workobject in which you want to create the target.

7 If you want to change the target name from the default name, expand the
Create Target dialog box by clicking the More button and entering the new
name in the Target name box.

8 Click Create. The target will appear in the browser and in the graphics
window.

Note

The created target will not get any configuration for the robot axes. To add the
configuration values to the target, use either ModPos or the Configurations
dialog box.
If using external axes, the position of all activated external axes will be stored
in the target.

The Create Target dialog box

Select the reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the position in the
graphics window to transfer the values to the Position boxes.

Position

Specify the orientation of the target.Orientation
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Click this button to add a point and its coordinates to the Points
list.

Add

Click this button to modify an already defined point, after you
have selected it in the Points list and entered new values.

Modify

The target points. To add more points, click Add New, click
the desired point in the graphics window, and then click Add.

Points

Click this button to expand or collapse parts of the create target
dialog box.

More/Less

Here you can change the name of the target you are creating.
It is visible only when the create target dialog box is expanded.

Target name

Here you can change the workobject in which the target is to
be created. It is visible only when the create target dialog box
is expanded.

Workobject
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8.10.3 Create Jointtarget

Creating a jointtarget
1 Click Create Jointtarget to bring up a dialog box.
2 If you want to change the default name of the jointtarget, enter the new name

in the Name box.
3 In the Axes Values group, do as follows:

• For theRobot axes, click the Values box and then click the down arrow.
The Joint Values dialog box will be displayed. Enter the joint values
in the boxes and click Accept.

• For the Joint axes, click the Values box and then click the down arrow.
The Joint Values dialog box will be displayed. Enter the joint values
in the boxes and click Accept.

4 Click Create. The jointtarget will appear in the browser and in the graphics
window.

Note

JointTargets for external axis are not visualized in the graphical window.

The Create Jointtarget dialog box

Specify the name of the jointtarget.Name

Click the Values list, enter the values in the Joint values dialog
box and click Accept.

Robot axes

Click the Values list, enter the values in the Joint values dialog
box and click Accept.

External axes

Select the Storage TypeTASK PERS if you intend to use the
jointtarget in multimove mode.

Storage Type

Select the module in which you want to declare the jointtarget.Module
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8.10.4 Create Targets on Edge

Overview
Targets on Edge creates targets and move instructions along the edges of the
geometric surface by selecting target points in the graphics window. Each point
on a geometric edge has certain properties that can be used to position robot
targets relative to the edge.

Creating targets on edge
1 On the Home tab, click Target and select Create Targets on Edge.

The Targets on Edge dialog box appears.

Note

The selection mode in graphics window is automatically set to Surface,
and the snap mode is set to Edge.

2 Click on the surface of the body or part to create target points.
The closest point on the adjacent edge is calculated and added to the list
box on as target points Point 1, Point 2 ....

Note

When an edge is shared between two surfaces, the normal and tangent
directions depend on the surface selected.

3 Use the following variables to specify how a target is related to a point on
the edge.

to...Select...

specify the distance from the edge to the target in the
surface normal direction.

Vertical offset

specify the distance from the edge to the target perpendic-
ular to the edge tangent.

Lateral offset

specify the angle between the (inverse) surface normal
and the approach vector of the target.

Approach angle

specify if the travel vector of the target is parallel or in-
versely parallel to the edge tangent.

Reverse travel direction

Note

For each target point, a preview of the approach and travel vectors are
displayed as arrows and as a sphere representing the point on the edge
in the graphics window. The preview of the arrows are updated dynamically
once the variables are modified.

4 Click Remove to remove the target points from the list box.
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5 Click More to expand the Create Targets on Edge dialog box and to choose
the following advanced options:

to..Use...

change the target name from the default name to a new
user defined name

Target name

select the task for which to add targets.Task
By deafult, active task in the station is selected.

select the workobject for which you want to create the
targets on edge

Workobject

create Move instructions in addition to targets, which
will be added to the selected path procedure.

Insert Move Instructions
in

The active process definition and process template will
be used.

6 Click Create.
The target points and Move instructions (if any) are created and are displayed
in the Output window and graphics window.
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8.11 Empty Path

Creating an empty path
1 In the Paths&Targets browser, select the folder in which you want to create

the path.
2 Click Empty Path.
3 To set the correct motion properties for the targets, select the active process

in the Change Active Process box in the Elements toolbar.
4 If the active template is set to MoveAbsJoint, then:

• A target that is dragged into a path will be converted into a jointtarget
(recognized by a different icon on in the browser).

• Joint targets and their instructions can only use wobj0 and tool0.
• One target can not be used as different types, for example,MoveJoint,

but must be deleted and re-created.
• When the target has been synchronized with the virtual controller, the

joint target values will be calculated and inserted in the RAPID program.
It is possible to call a procedure from another procedure. In the Paths &
Targets browser, click Paths & Procedures to view the folder structure. You
can move procedures between folders using a drag-and-drop operation.
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8.12 AutoPath

Overview
AutoPath helps in generating accurate paths (linear and circular) based on CAD
geometry.

Prerequisites
You need to have a geometric object with edges, curves, or both.

Creating a path automatically
AutoPath feature can create paths from curves or along the edges of a surface.
To create a path along a surface use selection level Surface, and to create a path
along a curve, use selection level Curve. When using Selection level Surface, the
closest edge of the selection will be picked for inclusion in the path. An edge can
only be selected if connected to the last selected edge.
When using Selection level Curve, the selected edge will be added to the list. If
the curve does not have any branches, all edges of the entire curve will be added
to the list if holding the SHIFT button when selecting an edge. The Approach and
Travel directions as defined in the RobotStudio options are used to define the
orientation of the created targets, see Options:Robotics:Mechanism on page 221.
Use this procedure to automatically generate a path.

1 In the Home tab, click Path and select AutoPath.
The AutoPath tool appears.

2 Select the edge or curve of the geometric object for which you want to create
a path.
The selection is listed as edges in the tool window.

Note

• If in a geometric object, you select curve (instead of an edge), then all
the points that result in the selected curve are added as edges to the
list in the graphic window.

• Ensure you always select continuous edges.

3 Click Remove to delete the recently added edge from the graphic window.

Note

To change the order of the selected edges, select Reverse check box.

4 You can set the following Approximation Parameters:

toSelect or enter values in

Set the minimum distance between the generated
points. That is, points closer than the minimum distance
are filtered.

MinDist

Set the maximum deviation from the geometric descrip-
tion allowed for the generated points.

Tolerance
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toSelect or enter values in

Determines how large a circle radius has to be before
considering the circumference as a line. That is, a line
can be considered as a circle with infinite radius.

MaxRadius

Generate a linear move instruction for each target.Linear

Generate circular move instructions where the selected
edges describe circular segments.

Circular

Generate points with a Constant distanceConstant

Set the specified offset away from the last target.End Offset

Sets the specified offset away from the first target.Start Offset

The Reference Surface box shows the side of the object that is taken as
normal for creating the path.
Click More to set the following parameters:

toSelect or enter values in

Generate a new target at a specified distance from the
first target.

Approach

Generates a new target at a specified distance from the
last target.

Depart

5 Click Create to automatically generate a new path.
A new path is created and move instructions are inserted for the generated
targets as set in the Approximation parameters.

Note

The targets are created in the active workobject.

6 Click Close.
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8.13 MultiMove

Overview
For browsing between the pages of the MultiMove window, click the tabs in the
navigation pane. By default the tabs are arranged in an order that corresponds to
the typical workflow:

Setup tab

Here you select the system that con-
tains the robots to program.

Select SystemSystemCon-
fig

Each robot in the system is presented
in its own row in this grid. In the
columns you make the settings as
described below.

System

Select this check box to use the robot
in the MultiMove program.

Enable

Specify if the robot holds the tool or
the work piece.

Type

Displays the name of the robot.Robot

Click this button to update the paths
in the grid if any of the paths have
been changed. The button turns red
if a change has been detected and an
update is necessary.

UpdatePath Config

Each path in the station is presented
in its own row in this grid. In the
columns you make the settings as
described below.

Paths

Select this check box for the paths to
use for the program.

Enable

Displays the order in which the paths
will be executed. To change the order,
use the lists in the path column for
rearranging the rows in which the
paths appear.

Order

Sets the path to be executed here.Path

When creating a new start position,
select a robot that the other will try to
reach here.

Select Robot that other shall jump toStart Posi-
tion

Jumps the other robots to the new
start position.

Apply

Motion Behavior tab
This is used for specifying constraints and rules for how the robots shall move
relative to each other. The default setting is no particular constraints, which results
in the fewest joint movements. However, changing the motion behavior might be
useful for:

• Locking the orientation or position of the tool.
• Optimizing cycle time or reachability by allowing tolerances.
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• Avoiding collisions or singularity by restricting joint motions.
Both Joint Influence and TCP Constraints restrict the robot’s motions. Changes in
these settings might result in lower performance or situations where it is impossible
to find proper solutions. The weight values for Joint Weights and TCP Constraints
set how much the setting for each joint or TCP direction shall affect the robots
relative to each other. It is the difference between the weight values that matters,
not the absolute values. If contradicting behaviors have been set, the one with the
lowest weight value will win.
Tool Tolerance, instead of restricting, enables more motions. Therefore, tolerances
may improve cycle and process times and enhance the reachability of the robots.
Tolerances, too, have weight value; here is set how much the robots shall use the
tolerance. A low value indicates that the tolerance will be used a lot, while a high
value means that the robots will try to avoid using the tolerance.
The joint influence controls the balance of how much the robots will use their joints.
Decreasing the weight value for one axis will restrict the motion for this axis, while
increasing it will promote motion on this axis relative to alternative axes.
The TCP constraints control the position and orientation of the tool. Enabling a
TCP constraint will decrease the motion of the tool and increase the motion of the
work piece.
The tool tolerances control the allowed deviation between the tool and the work
piece. By default, tolerances are not enabled, which means that no deviation is
allowed. Enabling a tolerance, if applicable, might improve motion performance.
For example, if the tool is symmetric around its Z axis, you can enable the Rz
tolerance without affecting the accuracy of the generated paths.
The tool offset sets a fixed distance between the tool and the paths.

Select the robot’s joints to constrain
in this box.

Select RobotJoint Influ-
ence

Displays the robot’s joints and their
constraint weights. Each joint is
presented in its own row.

Joints for Robot

Displays which axis the constraint af-
fects.

Axis

Specify how much the motion for the
axis is constrained. 0 means a locked
axis, while 100 means no constraint
relative to default constraint values.

Influence

This grid displays the position and ro-
tations of the TCP together with their
constraint weights.

Active TCPTCP Con-
straints

Select this check box to activate the
constraint for this TCP pose.

Enable

Displays the TCP pose that is affected
by the constraint.

Pose

Specify the pose value to constrain at.
Either type the value, or click the Pick
from TCP button to use the values of
the current TCP position.

Value

Continues on next page
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Specify how much the motion for the
TCP value is constrained. 0 means a
locked TCP at this pose, while 100
means no constraint relative to default
constraint values.

Influence

Select this check box to activate the
tolerance for this tool pose.

EnableTool Toler-
ance

Displays the tool pose that is affected
by the constraint.

Pose

Specify the pose value to apply the
tolerance around.

Value

Specify the size of the tolerance. 0
means no deviation is allowed, while
100 means all deviations are allowed.

Influence

Select this check box to activate the
offset for this tool pose.

EnableTool Offset

Displays the tool pose that is affected
by the offset setting.

Pose

Specify the value of the offset here.Offset

Create Paths tab
This tab is used for creating RobotStudio paths for the MultiMove robots. The
created paths will accord with the motions displayed during the most recently
played test simulation.
With the settings group you set up the MultiMove properties that connect the tasks
for the tool robot and work piece robot to each other.
With the WP robot settings group you set up the properties for the task that will be
generated for the work piece robot.
The generate path group contains the button that creates the paths.

Specify the first ID number for the
synchronization of the instructions for
the robots.

Start IDSettings

Specify the gap between the succeed-
ing ID numbers.

ID step index

Specify a prefix for the syncident
variable, which connects the sync in-
structions in the tasks for the tool ro-
bot and the work piece robot with each
other.

Sync ident prefix

Specify a prefix for the tasklist vari-
able, which identifies the tasks for the
tool robot and work piece robot to
synchronize.

Task list prefix

Specify a prefix for the generated
paths.

Path Prefix

Specify a prefix for the generated tar-
gets.

Target Prefix

Specify the work object to which the
targets generated for the work piece
robot shall belong.

WP WorkobjectWP robot
settings

Continues on next page
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Specify which tool data the work piece
robot shall use when reaching its tar-
gets.

WP TCP

Clicking this button generates paths
in RobotStudio for the latest tested
motions according to the settings
specified.

Create pathsGenerate
Paths

MultiTeach tab
With this tab you teach complete synchronized move instructions for the robots in
the MultiMove program.

Specify a prefix for the paths to create.Path PrefixSettings

Specify a prefix for the generated tar-
gets here.

Target Prefix

Specify the first ID number for the
synchronization of the instructions for
the robots.

Start ID

Specify the gap between the succeed-
ing ID numbers.

ID step index

Specify a prefix for the syncident
variable, which connects the sync in-
structions in the tasks for the tool ro-
bot and the work piece robot with each
other.

Sync ident prefix

Specify a prefix for the tasklist vari-
able, which identifies the tasks for the
tool robot and work piece robot to
synchronize.

Task list prefix

Select the type of synchronization to
use.

Select type of Sync instruction

Coordinated implies that all move in-
structions are synchronized for the
robots.
Semicoordinated implies that the ro-
bots work independently at some
times and wait for each other at other
(like when repositioning the work
piece).
For detailed information about the co-
ordination types, see the Application
manual - Multimove.

Select the robots for teaching targets.
This grid also displays the workobjects
and tools that will be used for the tar-
gets.

Setup

Displays a hierarchal tree which con-
tains the created move instructions.
The tree is organized the same way
as the tree in the Layout browser.

MultiTeach InformationTeach

Creates move instructions for the ro-
bots selected in the settings to their
current positions. The created move
instructions are immediately inserted
at their correct places in the Multi-
Teach Information tree.

MultiTeach
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Confirms the creation of the instruc-
tions.

Done

Test tab
RobotStudio’s MultiMove window has a page with commands for testing multimove
programs. Its default placement is at the bottom of the MultiMove window.
The status group displays the status of the simulation, that is, whether the current
settings have been tested or if errors have occurred.
In addition to the status group, information from the virtual controller is also
displayed in RobotStudio’s Output window during simulation.

Jumps the robots, respectively, to the
previous and next targets in paths.
The double arrow buttons jump sever-
al targets at once, while the single ar-
row buttons jump one target for each
click.

<< < > >>Play

Click this button to move the robots
along the paths.

Play

Play also has a list box in which you
can activate the following commands:

• Save current position: Saves
the current start position. Since
the calculated motions are
based on the robot start posi-
tion saving the start position is
useful when testing alternative
solutions.

• Restore saved position: Moves
the robots back to the saved
start positions.

• Restore last closed loop posi-
tion: Moves the robots back to
the list used start position.

• Close loop: Finds a suitable
start position based on the ro-
bots’ current positions and
prepares the calculation of
movements.

• Calculate: Calculates and ex-
ecutes the movements.

Sets the speed at which the simulation
is performed.

Simulation speed

Select this check box to make the
simulation stop after running the paths
one time. If cleared, the simulation will
continue playing over and over until it
is stopped manually.

Stop at endSettings

Select this check box to run the simu-
lation as the movements are calcu-
lated.

Simulate Online

This is useful for troubleshooting pur-
poses, since it displays and reports
targets the robot cannot reach.

Continues on next page
254 Operating manual - RobotStudio

3HAC032104-001 Revision: U
© Copyright 2008-2017 ABB. All rights reserved.

8 Home tab
8.13 MultiMove
Continued



Select this check box to stop the sim-
ulation if an error occurs. Cancel on
errors is recommended to use when
simulate online is used to minimize
the number of error messages once
the first error is identified.

Cancel on error

Select this check box to display the
search for a suitable start position in
the graphics window.

Watch Close Loop

Clear the check box to jump the robots
to the start position when it is found.

The MultiMove configure system wizard
The MultiMove configure system wizard guides you through configuring robots
and workobjects for MultiMove system. If the workobjects are not configured
correctly when the MultiMove functions are started, you will be asked whether to
run the wizard. You can also start it manually from the Tools page of MultiMove.
The wizard contains four pages, the information pane at the bottom indicates the
current page.

The workpiece robot page contains a list in which you select
the robot that holds the workpiece.

Workpiece robot

Only one robot can be set up as workpiece robot. If your station
has several robots that hold the workpiece, set up one of them
as workpiece robot and the other as tools robots, and create
paths for these robots in which they only hold the workpiece.

The tool robots page contains a list in which you select the
robots that operate on the work piece.

Tool robots

All robots selected as tools robots will be coordinated to the
workpiece robot. Any robot of the system that is selected
neither as workpiece robot or tool robot will not be coordinated.

The Workobjects page contains a box for each tool robot in
which you specify the workobject in which the targets for the
MultiMove paths shall be created. The wizard will attach this
workobject to the workpiece robot, for enabling MutliMove.

Workobjects

Either type in a name for a new Workobject to create in the
box, or select the Use existing WorkObject check box and
then select one from the list.

The Result page displays a summary of the station configura-
tion.

Result

Either click Done to finish or Previous to go back and change
the setup.

Note

The wizard will not help you configure the RobotWare system correctly. If the
correct options are not used you will not be able to synchronize generated
MultiMove paths to the virtual controller, even if you can use the MultiMove
functions in RobotStudio.
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The Analyze path tool
This tool checks whether existing paths are coordinated correctly for MultiMove.
The analyzer opens in a window of its own and contains three pages. The
information pane at the bottom indicates the current page.

Select to include the task in the ana-
lysis.

EnableSelect Paths

Displays the name of the task.Task

Select the path to analyze for the cur-
rent task.

Path

Click this button to start the analysis.AnalyzeAnalyze

OK. The paths are compatible in the
specified aspect.

reportok

Report

Information. The paths are not fully
compatible in the specified aspect, but
the robot program may still be execut-
able.

reportin

Error. The paths are not compatible in
the specified aspect, and the robot
program is not executable.reporter

The Recalculate ID tool
This is one of the tools for working manually with MultiMove programs. It sets new
sync ID arguments to the move instructions in a MultiMove path. By using the tool
with the same start ID and ID step index on all paths that shall be synchronized,
you can be sure that the IDs match if all paths contain the same number of move
instructions.

Displays the name of the path to recalculate IDs for.Title

Sets the number of the first ID in the path.Start ID

Sets the size of the step to increase the ID number for each
move instruction.

ID Step index

Select this check box to recalculate only those IDs for instruc-
tions that have existing IDs.

Only update instructions
that has ID defined

Clear this check box to also create IDs for instructions that
have no IDs (for example, if you have added new move instruc-
tions that shall be coordinated).

Select this check box to affect only those move instructions
that belong to already synchronized parts of the path.

The Only update instruc-
tions between SyncMove
On/Off check box. Clear this check box to update IDs for instructions in all parts

of the path.
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The Convert path to MultiMove path tool
This is one of the tools for working manually with MultiMove programs. It adds
sync ID arguments to all move instructions in the path and, optionally,
SyncMoveOn/Off instructions, thus preparing an ordinary path for MultiMove use.
You use the tool on one path a time, so for creating a MultiMove program, you
convert one path for each robot and then create a tasklist and syncidents which
you add to the Sync instructions.

Displays the name of the path to recalculate IDs for.Title

Sets the number of the first ID in the path.Start ID

Sets the size of the step to increase the ID number for each
move instruction.

ID Step index

Select this check box to add instructions that start and stop
the synchronization.

Add SyncMoveOn/Off be-
fore and after

The Create Tasklist tool
This is one of the tools for working manually with MultiMove programs. It creates
a variable of the RAPID data type tasks, which identifies the tasks that will be
synchronized. In each SyncMoveOn or WaitSyncTask instruction, you then specify
which tasklist to use.

Specifies the name of the tasklist.Tasklist name

Select the check box for each task to include in the list.Tasks that will be included

The Create Syncident tool
This is one of the tools for working manually with MultiMove programs. It creates
a variable of the RAPID data type SyncIdent, which identifies the sync instructions
that shall be synchronized.

Specifies the name of the SyncIdent variable to create.Syncident name

Select the check box for each task to use this Syncident in.Tasks that SyncIdent will
be created in
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8.14 Teach Instruction

Teaching a move instruction
1 In the Layout browser, make sure the settings for active robot, workobject,

tool, motion type and path are appropriate for the move instruction to create.
2 Jog the robot to the desired location. If jogging the robot using the freehand

mode, you can also use snap modes for snapping its TCP to objects in the
station.

3 Click Teach Instruction. A move instruction is now created last in the path.
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8.15 Move Instruction

Creating a move instruction and a corresponding target
To create a move instruction, follow these steps:

1 Click Move Instruction to bring up a dialog box.
2 Select the Reference coordinate system for the move instruction.
3 Enter the Position to reach for the move instruction by clicking Add New in

the Coordinates box and then click the required to-points in the graphics
window. You can also enter the values in the Coordinates boxes and click
Add.

4 Enter the Orientation for the move instruction.
5 By clicking the More/Less button, you can expand or collapse the Create

Move Instruction dialog box. When the dialog box has been expanded, you
can change the Target name and the Work object to which the target (with
the move instruction) will belong.

6 ClickCreate to create the move instruction. The move instruction will appear
under the path node as a reference to the target.

Note

To view the programmed speed of move instructions in a path, in the
Paths&Targets browser, right-click the path and click View > Show Speeds.
The speed values will be displayed along the path.

TrueMove path
Using the TrueMove path visualization, you can view the the programmed path of
a robot accurately, regardless of the programmed speed. In RobotStudio, the
TrueMove path will be visualized prior to executing the motion in the virtual
controller. The path takes the zone data into account. The TrueMove path
visualization applies to linear and circular motion instructions. Joint movements
are visualized as straight lines even though the robot takes a different path. These
movements are visualized with a dotted line to indicate that the robot will not follow
the path accurately.

The Create Move Instruction dialog box for jointtarget movements

Here you can change the name of the target you create when
creating the move instruction.

Name

Specify the joint values for the robot. Select the box and click
the list to set the values.

Robot axes

Specify the joint values for external axes, if any exist in the
station. Select the box and click the list to set the values.

External axes box

Click this button to expand or collapse parts of the create move
instruction dialog box.

Storage Type

Specify the module in which the jointtarget shall be declared.Module
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8.16 Action Instruction

Creating an action instruction
1 In the Paths&Targets browser, select where to insert the action instruction.

To insert the action instruction at the beginning of a path then select the
path.
To insert the action instruction after another instruction then select the
proceeding instruction.

2 Right click Path and select Insert Action Instruction.
The Create Action Instruction dialog box appears.

3 From the Instruction Templates list, select the action instruction to create.
4 Optionally, modify instruction arguments in the Instruction Arguments grid.

For detailed information about the arguments for each instruction, see the
Action Instruction on page 260.

5 Click Create.
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8.17 Instruction Template Manager

Overview
Use Instruction Template Manager to support instructions other than RobotStudio's
default instructions set, for example, certain instructions like DispL and DispC are
instructions used for glueing by a robot controller system with the RobotWare
Dispense option. You can manually define the instruction templates for such
instructions using the Instruction Template Manager. These instruction templates
are exported to XML format and reused later.
RobotStudio provides pre-defined XML files that can be imported and used for
robot controller systems with certain RobotWare options. For example, it is
recommended to use RobotStudio ArcWelding PowerPac while using RobotWare
Arc. The instruction template supports Robotware options like Continuous
Application Process (CAP), Dispense (Disp), Fixed Position Events (Trigg), Spot
Pneumatic, Spot Servo, Spot Servo Equalizing, Paint, Multimove Coordinated and
Conveyor Tracking. When you start a new system, default instruction templates
are loaded. When starting a system with one or more of these options, the
corresponding instruction templates are added automatically.

Instruction Template Manager
You can use Instruction Template Manager to define instruction templates. In the
Home tab, in Path Programming group, click the arrow next to Multimove to open
the Instruction Template Manager pane. The Instruction Template Manager window
consists of two panes. The names of Move and Action instructions appear in one
pane and the arguments of the selected instruction in the other pane. You can
select the required instruction and set the arguments to customize your instruction
template.
The customized instruction template can be exported to *xml format and can be
imported and reused later. Use various buttons provided in the Instruction Template
Manager window to add or delete Move and Action instructions. You can import
or export the selected template or export all instruction templates here.
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8.18 Settings

8.18.1 Task

Selecting a Task
Select a task from the Task drop-down list. The selected task indicates active task,
to which new workobjects, tooldata, target, empty path or path from curve will be
added.
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8.18.2 Workobject

Selecting a Workobject
Select a workobject from the Workobject drop-down list. The selected workobject
indicates active workobject, to which new targets and move instructions are added.
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8.18.3 Tool

Selecting a Tool
Select a tool from the Tool drop-down list. The selected tool indicates active tool,
to which move instructions are added.
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8.19 The Freehand Group

Move
1 In the Layout browser, select the item you want to move.
2 Click Move.
3 In the graphics window, click one of the axes and drag the item into position.
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8.19.1 Rotate

Rotating an item
1 In the Layout browser, select the item you want to rotate.
2 Click Rotate.
3 In the graphics window, click one of the rotational rings and drag the item

into position.
If you press the ALT key while rotating, the item will snap 10 degrees at a
time.
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8.19.2 Jog Joint

Jogging the joints of a robot
1 In the Layout browser, select the robot you want to move.
2 Click Jog Joint.
3 Click the joint you want to move and drag it to the preferred position.

If you press the ALT key when jogging the joints of the robot, the robot will
move 10 degrees at a time. If you press the f key, the robot will move 0.1
degree at a time.
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8.19.3 Jog Linear

Jogging the TCP of a robot
1 In the Layout browser, select the robot you want to move.
2 In the Freehand group, click Jog Linear. A coordinate system will be

displayed at the TCP of the robot.
3 Click the axis you want to move and drag the TCP to the preferred position.

If you press the f key while jogging the robot linearly, the robot will move
with a smaller step size.
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8.19.4 Jog Reorient

Reorienting the TCP rotation
1 In the Layout browser, select the robot you want to reorient.
2 In the Freehand group, click Jog Reorient.

An orientation ring appears around the TCP.
3 Click the orientation ring and drag the robot to rotate the TCP to the preferred

position.
The X, Y, and Z orientation appears with units.

Note

If you press the ALT key while reorienting, the robot moves by 10 units
and if you press the F key, it moves by 0.1 unit.

Note

The behavior of orientation differs with the different reference coordinate
system (World, Local, UCS, Active Workobject, Active Tool).
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8.19.5 MultiRobot Jog

Jogging robots in multirobot mode
1 In the Freehand group, click MultiRobot Jog. Select the robots to be jogged

from the list of available robots.
2 Select the jogging mode, jog one of the robots and the other ones will follow

the movement.
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8.20 Graphics Tools

Overview
The Graphics Tools helps you to control the graphics view and to modify the
appearance of objects. All available options are grouped under the following tabs.

• View Tab
• Edit Tab
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8.20.1 View Tab

Introduction
Use the View tab to choose view settings, control graphics view and create new
views, and to show/hide the selected targets, frames, paths, parts, and mechanisms.
The View tab options are grouped under the following groups.

• View
• Navigate
• Markups
• Lights
• Clip Planes
• Freehand
• Close

View Group

Introduction
The View group helps you to choose view settings, control graphics view and
create new views, and to show/hide the selected targets, frames, paths, parts, and
mechanisms.The following options are available:

• New View
• View Settings : Projection, Representation, Frame Size
• Settings
• Advanced Lighting
• Show/Hide
• Automatic Transparency
• Statistics
• Stereo Mode

Select New View to create a new view.

View Settings
You can select the following different view settings.

DescriptionSetting

To view the orthographic and perspective view of the object.Projection
• Orthographic
• Perspective

To view the objects as a surface, wireframe, both surface
and wireframe, by removing hidden lines.

Representation
• Surface
• Wireframe
• Both
• Hidden-line removal

To view the frame in large, medium and small sizes.Frame Size
• Large
• Medium
• Small
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Advanced Lighting
Advanced Lighting activates the advanced lighting model that enables features
such as multiple lights, shadows and environment mapping. This feature requires
graphics hardware that supports Direct3D feature level 10_1 or higher.
The standard lighting model is supported on all systems and is optimized for
performance and visibility.

Settings
The Settings button in the View tab provides various display options for graphics.
The Settings commands work on the active graphics view and do not affect
persisted settings or other views. The available options are:

DescriptionSettings

Shows or hides the floor the graphics view.Show Floor

Shows or hides the UCS grid in the graphics view.Show UCS Grid

Shows or hides the world coordinates in the graphics view.Show World Coordinates

Shows or hides buttons in the graphics view.Show Buttons

Adjusts the floor and UCS grid to cover the area used by objects
in the station.

Reset Floor Size

Allows the user to set a custom background for the view.Background Color

Opens the Options dialog box that shows the defaults settings.Default View Settings

Resets the active view to the default settings.Reset to Defaults

Show/Hide
You can either show or hide the following options:

• Target Names
• Frame Names
• Path Names
• All Targets/Frames
• All Paths
• All Parts
• All Mechanisms

Automatic transparency
Automatic Transparency makes objects transparent when they cover a large part
of the graphics view. Click this button to enable Automatic Transparency. If you
enable Automatic Transparency, in 3D view when you zoom in on objects, the
closest part becomes gradually invisible and you would be able to see objects
beyond the closest object.

3D View
The 3D view shows the graphical overview of the robot, tool and its work envelope.
All robot activity is shown-in real time, which provides the opportunity to observe
the actual robot in operation. The user can move the 3D view around the robot for
more details.
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Virtual Reality
The Virtual Reality button gets enabled when you connect VR glasses (Oculus
Rift or HTC Vive) to the PC. RobotStudio and its Station Viewer works with HTC
Vive and Oculus rift. These devices have motion tracking sensors for location and
orientation tracking of the headset and the hand controls. The hand controls can
be used to interact with the virtual reality environment. The use of HTC Vive requires
a high-performance gaming PC. Check the supplier web page for installation details,
http://www.vive.com/ and for details on Oculus rift, visit https://www.oculus.com.

Navigate Group

Introduction
Navigate group contains buttons for creating and managing viewpoint and for
controlling the orientation of graphics.

DescriptionSetting

To view the objects in the following different orientations.
• View All
• View Center
• Top
• Bottom
• Front
• Back
• Left
• Right

View Orientation

Stores the location and direction of a virtual camera in the 3D
environment.

Create Viewpoint

Viewpoint
A Viewpoint stores the location and direction of a virtual camera in the 3D
environment. It stores points of interest in a station to create camera movements
during simulation.

Creating Viewpoint
You can create a viewpoint in a station in two ways:

1 In the View tab, click Create Viewpoint.
2 In the Layout browser, right-click the station and select Create Viewpoint.

A viewpoint is created and displayed (as an eye icon) in the layout browser to the
left.
The position and direction of the Viewpoint can also be visualized as an arrow in
the 3D graphics. By default, the newly created viewpoints are not visible and cannot
be selected by clicking on the graphics.

Viewpoint functions
In the Layout browser, right-click Viewpoint to perform the following functions:

DescriptionFunction

Moves the active 3D view to the location stored in the viewpoint.Move to Viewpoint
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DescriptionFunction

Modifies the viewpoint to the current location and direction of
the active 3D view.

Set to current

This action cannot be undone.

Toggles the visibility of the viewpoint 3D representation.Visible
This action cannot be undone.

Deletes the viewpoint.Delete
This action cannot be undone.

Renames the viewpoint.Rename
This action cannot be undone.

Move to Viewpoint
You can also move active 3D view to the location stored in the Viewpoint using
Event manager.

1 Create a viewpoint.
2 Add an event.

The Create new event dialog box appears.
3 Select Simulation under Activation and Simulation time under Event trig

type. Click Next.
4 Set the activation time. Click Next.
5 Select Move to Viewpoint from Set Action type. Click Next.
6 Select the viewpoint from select Viewpoint and set the transition time.
7 Click Finish.

Move to viewpoint function is also executed when replaying the simulation in a
Station Viewer. In addition, you can switch between view points using the
MoveToViewpoint Smart Components, see Running a simulation on page 361.

Markups Group

Overview
A markup is a text box displayed in the 3D graphics. It is similar to the temporary
text shown when performing measurement or freehand movement, but it is part of
the station.
The markup is displayed as a node in the layout browser and remains so when the
station is saved. It appears as text bubble pointing to a position in the graphics
window.

Creating Markup
Use this procedure to create markup to an object

1 In the Home tab, click View and select Create Markup.
The Create Markup dialog box appears.

Note

Alternatively, in the Layout browser, right-click the station and selectCreate
Markup for the dialog box to appear.
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2 In the Markup Text field, enter a name for the markup text.
3 In the Pointer position field, set the position of the pointer.
4 Select Always on top if you want to display the text on top.
5 Click Create.

Markup functions
In the Layout browser, right-click Markup to perform the following functions:

DescriptionFunction

Shows or hides the markup in the 3D graphics.Visible

Modifies the Markup properties.Modify Markup

Attaches the markup to another graphical object.Attach to

Detaches the attached markup.Detach

Deletes the markup.Delete

Changes the name of the markup object.Rename

Modify Markup
Use this procedure to modify the markup properties:

1 In the Layout browser, right-click the markup and select Modify Markup.
The Modify Markup dialog box appears.

2 Modify the markup text, pointer position or text position.
3 Click Apply for the changes to take effect.
4 Click Close.

Lights Group

Overview
The Lights group helps you to control the number and nature of light sources in
the station when advanced lighting is enabled. There are four different kinds of
light sources:

• Ambient Light – Controls the ambient (background) light level in the station.
• Infinite Light – A directional light source, similar to the sun, this light source

can cast shadows.
• Spotlight – A light source with a cone of influence, this light source can cast

shadows.
• Point light – Casts light radially from a specified position, this light source

can not cast shadows.
By default, a new station contains two infinite light sources in addition to the ambient
light source. The ambient light source cannot be removed or created, but it can be
disabled. The Create Light menu contains commands for creating a new light
source and adding it to the station.

Continues on next page
276 Operating manual - RobotStudio

3HAC032104-001 Revision: U
© Copyright 2008-2017 ABB. All rights reserved.

8 Home tab
8.20.1 View Tab
Continued



Light Properties
In the browser, right-click the light source and then select Light Properties from
the context menu. You can view the Light Properties window. Use this window to
modify the light source. The Light Properties window contains different controls
depending on the type of light.

DescriptionSettings

Enables or disables the light sourceEnabled (all kinds)

Causes objects influenced by the light to cast
shadows

Casts shadows (infinite and spot lights)

Controls the color of the lightColor (all kinds)

Controls the ambient (background) intensity of
the light

Ambient intensity (ambient light)

Controls the intensity of diffuse highlightsDiffuse intensity (infinite, spot and point
lights)

Controls the intensity of specular highlightHighlight (infinite, spot and point lights)

Controls the position of the light sourcePosition (spot and point lights)

Controls the direction of the lightDirection (infinite and spot lights)

Optionally limits the range of influence of the
light

Limit range (spot and point lights)

Controls the angle of the light coneSpotlight angle (spot lights)

Light presets
Light sources are saved in the station. User can use light presets to save a set of
lights for reuse. The Presets menu contains a list of user defined light presets.
When a preset is selected, the light sources in the station are replaced by the
preset. The menu also contains the following commands:

DescriptionCommand

Resets light to the default presetReset lights to default

Saves the lights in the station as a presetSave lights as preset

Allows the user to remove previously created presetsEdit presets

Clip Planes

Overview
A clip plane is an infinite plane that cuts through geometric objects in the station.
Objects on one side of the plane are visible while objects on the other side are
invisible. A station can contain multiple clip planes, but each graphics view can
only have one active clip plane.

Note

Non-geometric objects such as graphic representations of paths and targets are
not affected.
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Creating and Editing a Clip Plane
Use the following procedure to create and edit a clip plane.

1 In the View tab, click Create Clip Plane.
2 In the browser, right-click the clip plane. The context menu appears.
3 In the context menu, click Edit. The Clip Plane property window appears.

When a clip plane is selected in the browser, a graphical representation of the
plane is displayed in the Graphics view. This allows the user to move and rotate
the clip plane by using freehand controls.

Clip Plane Functions

DescriptionFunction

Controls the position of the clip plane, you can select or type in the x, y and z
co-ordinates of the clip plane.

Position

Controls the orientation of the clip plane, you can select or type in the x, y and
z co-ordinates of the clip plane.

Normal

Allows the user to reverse the orientation of the clip plane.Flip

Enables or disables the clip plane in the active graphics view.Active

Freehand
Freehand options are used to move and rotate the selected object. User can select
the coordinate system.

Moving an item
1 In the Layout browser, select the item you want to move.
2 Click Move.
3 In the graphics window, click one of the axes and drag the item into position.

Rotating an item
1 In the Layout browser, select the item you want to rotate.
2 Click Rotate.
3 In the graphics window, click one of the rotational rings and drag the item

into position.
If you press the ALT key while rotating, the item will snap 10 degrees at a
time.

World
Use this option to move or rotate an object in the station in relation with the specified
coordinate system. The following options are available:

• World
• Local
• UCS
• Active Workobject
• Active Tool

Close Graphics
Select this option to close the Graphics Tools tabs.
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8.20.2 Edit Tab

Overview
The Edit tab contains commands for working with materials and their application
on geometric objects. The available options are:

• Materials
• Pick Material
• Apply Material
• Replace Material
• Edit Materials
• Adjust Textures
• Invert Surfaces
• Close Graphics

Appearance Group
The Appearance group contains the following options:

DescriptionSettings

Contains a gallery of predefined and user defined materialsMaterials

Allows the user to select a materialPick Material

Activates or deactivates apply material modeApply Material

Allows the user to replace material in a part that contains several different
materials.

Replace Material

Allows editing of user defined materialsEdit Materials

Allows the user to adjust texture coordinates on surfaces directly in the
main graphics view

Adjust Textures

Allows the user to invert the surfaces when selected in the Grahics win-
dow. The back side of the surface is highlighted in red.

Invert Surfaces

To close the Graphics tools tab.Close Graphics

Materials
TheMaterialmenu contains controls for setting material parameters or for selecting
a material from the list of user defined and predefined materials. It is also possible
to save the current material to the user defined materials list.

Apply Material
When Apply Material is activated, the active material is automatically applied to
the geometric surfaces or objects (depending on selection mode) selected in the
Graphics view. The active material is selected by using the Materials menu or the
Pick Material command. When a material is selected, Apply Material is automatically
activated.

Replace Material
The Replace Material menu allows you to replace material in a part that consists
of different materials. Select a material from the Materials gallery and click on the
surface of the part to replace its material.
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Edit Materials
The Edit Materials menu allows editing of user defined materials. Click this button
to see the list of defined materials. This list can be edited by adding, deleting and
copying materials. The name and description of a material can be changed by
right-clicking in the list. A preview of the selected material is displayed in the
Graphics view.

Adjust Textures
TheAdjust Texturesmenu allows the user to adjust texture coordinates on surfaces
directly in the main Graphics view. When the command is activated and a textured
surface is selected, the user can use the keyboard to move, rotate, mirror and scale
the texture on the surface.

Graphics browser
A separate browser window is displayed when one of the graphics menu is selected.
It contains objects in the station that are related to the graphics system. The
following options are available:

• Markups
• Viewpoints
• Lights
• Clip planes

Close Graphics
Select this option to close the Graphics Tools tabs .
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9 Modeling tab
9.1 Overview

The Modeling tab
The Modeling tab contains the controls for creating and grouping components,
creating bodies, measurements and CAD operations.
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9.2 Component Group

Creating a component group
1 Click Component Group. The Group node will be displayed in the Layout

browser.
2 Click the objects to add to the group. Drag them to the Group node.
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9.3 Empty Part

Creating an empty part
1 Click Empty Part. The Part node will be displayed in the Layout browser.
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9.4 Smart Component

9.4.1 Smart Component

Overview
Smart Component is a RobotStudio object (with or without a 3D graphical
representation) that has the behavior which can be implemented by code-behind
and/or aggregation of other Smart Components.

Terminology
The following table describes the different terminologies that you come across
when working with Smart Component.

DefinitionTerm

A .NET class associated with a Smart Component that can
implement custom behavior by reacting to certain events, for
example simulation time steps and changes in property values.

Code behind

An object attached to a Smart Component that has value, type
and certain other characteristics. The property value is used
by code behind to control the behavior of the Smart Component.

[Dynamic] property

Connects the value of one property to the value of another
property.

[Property] binding

Key-value pairs that contain additional information about a
dynamic property, for example value constraints.

[Property] attributes

An object attached to a Smart Component that has a value and
a direction (input/output), analogous to I/O signals on a robot
controller. The signal value is used by code behind to control
the behavior of the Smart Component.

[I/O] signal

Connects the value of one signal to the value of a different
signal.

[I/O] connection

The process of connecting several Smart Components using
bindings and/or connections in order to implement a more
complex behavior.

Aggregation

Data object contained in a Smart Component. Uses include
code behind assembly and localized resources.

Asset
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9.4.2 Smart Component Editor

Overview
The Smart Component Editor allows you to create, edit, and aggregate Smart
Components using a graphical user interface. It is an alternative to using the xml
based library compiler.

Layout of a Smart Component Editor
It consists of an icon, the name, the description for the component wherein the
description can be modified by typing in the text box, and a combo box.
The combo box specifies the language for editing localized strings (captions and
descriptions) in the component. The default language is always English, even if
the application language is different. For more information, see Assets on page287.
The Smart Component Editor consists of the following tabs:

• The Compose tab on page 286
• The Properties and Bindings tab on page 289
• The Signals and Connections tab on page 292
• The Design tab on page 295

Opening a Smart Component Editor
Click Smart Component or select Edit Component from the context menu.
The Smart Component Editor window appears.

Protecting a Smart Component from edits
You can protect a Smart Component from being edited. To protect the smart
component, right-click the smart component, and then click Protected. You can
also optionally specify a password that will be required to unlock the component
for edits.
Protecting a Smart Component hides its internal structure and protects it from
edits. You can use this feature to hide the complexity in the smart component, and
to secure the functionality. Child components in a protected smart component are
hidden in all RobotStudio browsers and also in the Signal Analyzer browser.

Note

Protecting a Smart Component in this manner is a way of hiding complexity, and
is not for providing security or securely protecting it.
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9.4.3 The Compose tab

Overview
The Compose tab consists of the following:

• Child components on page 286
• Saved States on page 287
• Assets on page 287

Child components
It is a list box that displays all the objects contained by the component. Objects
connected to a library have an overlay that indicates that the objects are locked.
Smart Components are displayed first followed by other type of objects.
If an object is selected from the list, the following commands are displayed in the
right panel:

DescriptionCommand

Adds a child object to the component from the list.Add component
You can select a built-in base Smart Component, a new empty
Smart Component, a library from file or a geometric part from
file.
Base components are organized as sub-menus based on the
usage. For example, Signals and Properties, Sensors, Actions
and so on. Recently used base components are listed at the
top.
For more information about base Smart Component, see Basic
Smart Components on page 296.

Sets the context of the Editor to the parent of the component
that is currently being edited. If the parent is the station, see
Station Logic on page 359.

Edit parent

Disconnects the selected object from library, allowing it to be
edited.

Disconnect from library

Opens a dialog box where you can export and save the com-
ponent definition along with its properties as an *.rsxml file

Export to XML

Right-click on the selected object to display the following context menu items

DescriptionItem

Sets the context of the Editor to the selected child object.Edit

Deletes the child object.Delete

Indicates if the object should be displayed in the Layout
browser.

Show in Browser

Sets the object as the Role of the component. The Smart
Component will inherit certain characteristics of the Role object.
For example, attaching a component with a tool as Role to a
robot will cause a ToolData to be created.

Set as Role

Opens the Property editor dialog box for the object. See Prop-
erty Editor on page 313.

Properties
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Saved States
The state of the component can be saved to be restored later. The state contains
selected modifiable aspects of the component and its child components at the time
when the state was saved. The following commands are available:

DescriptionCommand

Opens the Save Current State dialog box. See Save Current
State on page 287.

Save Current State

Restores the component to the selected state.Restore Selected State

Opens a window that displays detailed information about the
selected state.

Details

Deletes the selected state.Delete

Save Current State
1 In the Name text box, enter a name for the state. If a state with the same

name already exists, you will be asked to overwrite the existing state.
2 In the Description text box, enter the description for the state.
3 In the Values to save, select the value to be saved.
4 Select the check box to save the state of all child components.

Note

When working on a station level,
• In the Values to save, you can also select certain Virtual Controller

values in the saved states.
• You need not select the option Recursive as the state of the station

is always saved.
For more information, see Station Logic on page 359.

Assets
The assets contained in the component are displayed as grid.
The following commands are available:

DescriptionCommand

Opens a dialog box and allows you to browse and select any
file as an asset.

Add Asset

Opens a dialog box and allows you to browse and select an
image that represents a Smart Component.

Set Icon

Replaces the data of all the assets with the data of the corres-
ponding file on the disk. If the file is not available, a warning
message is displayed in the output window.

Update All Assets

Opens the selected asset in the associated programView

Opens a dialog box and allows you to save the selected asset.Save

Deletes the selected asset.Delete
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Note

The text resources (descriptions) for properties and signals are stored in an asset
calledResources.<language-id>.xml. If this is deleted, the texts for that language
will be empty and the default (English) will be used. The default language when
authoring a component is always English, regardless of the application language.
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9.4.4 The Properties and Bindings tab

Overview
The Properties and Bindings tab consists of the following:

• Dynamic Properties on page 289
• Property Bindings on page 290

Dynamic Properties
The dynamic properties contained in the component are displayed in a grid.
The following commands are available

DescriptionCommand

Opens the Add Dynamic Property dialog box. See Add or Edit
Dynamic Property on page 289.

Add Dynamic Property

Opens the Expose Child Property dialog box. See Expose Child
Property on page 290.

Expose Child Property

Opens the Edit Dynamic Property dialog box for the selected
property.

Edit

Deletes the selected property.Delete

Add or Edit Dynamic Property
The Add Dynamic Property dialog box allows you to create a new dynamic property
or edit an existing property.
The following controls are available:

DescriptionControl

Specifies an identifier for the property. The identifier must be
alphanumeric, start with a letter and must be unique.

Property Identifier

Detailed description of the property.Description

Indicates if the property value should be possible to modify in
GUI such as the Property Editor.

Read-only

Specifies the type of the property from a list of allowed types.Property Type

Specifies the value of the property. The control is updated when
you change the property type and/or attributes.

Property Value

Allows you to add, remove, and modify property attributes.Attributes
The following lists the available attributes:

• MinValue
• MaxValue
• Quantity
• Slider
• AutoApply

Numeric attributes are specified in SI units.

Note

When editing an existing property, the Identifier and Type controls are locked
and cannot be modified. If the input is valid the OK button is enabled, allowing
you to add or update the property. If not, an error icon is displayed.
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Expose Child Property
The Expose Child Property dialog box allows you to add a new property and bind
to an existing property in a child object. The new property will have the same type
and attributes as the child property.
The following controls are available:

DescriptionControl

Identifier of the new property. By default, this is the same as
the identifier of the selected child property.

Property Identifier

Specifies the direction of the property bindingBinding Direction

Specifies the child object for which to expose a property.Source or Target Object

Specifies the child property.Source or Target Property

Property Bindings
The property bindings contained in the component are displayed in a grid.
The following commands are available:

DescriptionCommand

Opens the Add Binding dialog box.Add Binding

Opens the Add Expression Binding dialog box.Add Expression Binding

Opens the Edit Binding or Edit Expression Binding dialog box,
depending on the type of binding selected.

Edit

Deletes the selected binding.Delete

Add or Edit Binding
The Add Binding dialog box allows you to create or edit a property binding.
The following options are available:

DescriptionControl

Specifies the owner of the source property.Source Object

Specifies the source of the binding.Source Property

Specifies the owner of the target property.Target Object

Specifies the target of the binding.Target Property
Only properties of the same type as the source property type
are listed.

Allows the target property to be set two times in the same
context, which otherwise generates an error.

Allow cyclic binding

The target list box, besides dynamic properties also displays
some common properties such as object transform that can
only be used as target and not as source.

Continues on next page
290 Operating manual - RobotStudio

3HAC032104-001 Revision: U
© Copyright 2008-2017 ABB. All rights reserved.

9 Modeling tab
9.4.4 The Properties and Bindings tab
Continued



Add or Edit Expression Binding
The Add Expression Binding dialog box allows you to specify a mathematical
expression as the source of a property binding.
The following controls are available:

DescriptionControl

Specifies the mathematical expressions.Expression
The following lists the allowable mathematical expressions:

• Allowed operators: +, - (unary and binary) *, /, ^ (power),
Sin(), Cos(), Sqrt(), Atan() and Abs().

• Allowed operands: Numeric constants, PI, and Numeric
dynamic properties on the current smart component and
any child smart components.

The text box has the IntelliSense-like funtionality which allows
you to select from the available properties. If the expression
entered in the text box is invalid, an error icon is displayed.

Specifies the owner of the target property.Target Object

Specifies the target of the binding.Target Property
Only numeric properties are listed.
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9.4.5 The Signals and Connections tab

Overview
The Signals and Connections tab consists of the following:

• I/O Signals on page 292
• I/O Connections on page 293

I/O Signals
The I/O Signals contained in the component are displayed in a grid.
The following commands are available:

DescriptionCommand

Opens the Add I/O Signals dialog box.Add I/O Signals

Opens the Expose Child Signal dialog box.Expose Child Signal

Opens the Edit Signal dialog box.Edit

Deletes the selected signal.Delete

Add or Edit I/O signals
TheAdd I/O Signals dialog box allows you to edit an I/O signal, or add one or more
I/O signals to the component.
The following controls are available:

DescriptionControl

Specifies the type and direction of the signal.Type of Signal
The following are the available types of signals:

• Digital
• Analog
• Group

Specifies the name of the signal.Signal Base Name
The name must contain an alphanumeric character and start
with a letter (a-z or A-Z).
If more than one signal is created, numeric suffixes specified
by Start Index and Step are added to the names.

Specifies the initial value of the signal.Signal Value

Text that describes the signal. When creating multiple signals,
all will have the same description.

Description

Specifies that a digital signal should have transient behavior.Auto-reset
This applies to digital signals only. Indicates that the signal
value is automatically reset to 0.

Specifies the number of signals to create.Number of Signals

Specifies the first suffix when creating multiple signals.Start Index

Specifies the suffix interval when creating multiple signals.Step

Specifies the minimum value for an analog signal.Minimum
This applies to Analog signal only.

Specifies the maximum value for an analog signal.Maximum
This applies to Analog signal only.
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DescriptionControl

Indicates if the property should not be visible in GUI such as
the Property Editor and I/O Simulator.

Hidden

Indicates if the property value should be possible to modify in
GUI such as the Property Editor and I/O Simulator.

Read only

Note

When editing an existing signal, only the Signal Value and Description can be
modified, while all other controls are locked.

If the input is valid,OK is enabled allowing you to create or update the signal. If
not, an error icon is displayed.

Expose Child signal
The Expose Child Signal dialog box allows you to add a new I/O signal that is
connected to a signal in a child object.
The following controls are available:

DescriptionControl

Specifies the name of the signal to be created. By default, it is
the same as the name of the selected child signal.

Signal Name

Specifies the object for which to expose a signal.Child Object

Specifies the child signal.Child Signal

I/O Connections
The I/O Connections contained in the component are displayed in a grid.
The following controls are available:

DescriptionControl

Opens the Add I/O Connection dialog box.Add I/O Connection

Opens the Edit I/O Connection dialog box.Edit

Opens the Manage I/O Connections dialog box.Manage I/O Connections

Deletes the selected connection.Delete

Sorts by moving the selected connections up and down the
list.

Move Up or Move Down

Add or Edit I/O Connection
The Add I/O Connection dialog box allows you to create an I/O connection or edit
an existing connection.
The following controls are available:

DescriptionControl

Specifies the owner of the source signal.Source Object

Specifies the source of the connection. The source must either
be an output from a child component, or an input to the current
component.

Source Signal

Specifies the owner of the target signal.Target Object
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DescriptionControl

Specifies the target of the connection. The target must be of
the same type as the source, and either an input to a child
component or an output from the current component.

Target Signal

Allows the target signal to be set two times in the same context,
which would otherwise generate an error.

Allow cyclic connection

Manage I/O Connections
The Manage I/O Connections dialog box displays a graphical view of the I/O
connections of the component.
It allows you to add, remove, and modify connections. Only digital signals are
displayed.
The following controls are available:

DescriptionControl

Lists the signals used in the connections, source signals to the
left and target signals to the right. Each signal is specified by
the owner object and the signal name.

Source / Target Signals

Displays connections as an arrow from source to targetConnections

Specifies a logic operator and a delay time. It performs digital
logic on input signals.

Logic Gates

• Add Source - Adds a source signal to the left.
• Add Target - Adds a target signal to the right.
• Add Logic Gate - Adds a logic gate at the center

Add

Removes the selected signal, connection or logic gate.Remove

Managing I/O connections
Use this procedure to add, remove, and create new I/O connections:

1 Click Add and select Add Source or Add Target or Add Logic Gate to add
a source signal or target signal or logic gate respectively.

2 Move the cursor towards the Source Signal until a cross hair appears.
3 Click and drag the left mouse button towards the logic gate to create a new

I/O connection.
4 Select the signal, connection, or logic gate and click Remove to delete.
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9.4.6 The Design tab

Overview
The Design tab displays a graphical view of the structure of the component. It
includes the child components, internal connections, properties and bindings. The
Smart Component can be organized on the viewing screen and their viewing
position will be stored with the station.

Using the Design tab
You can do the following in the Design tab:

DescriptionAction
• Click Auto Arrange to organize the components co-

herently.
• Use the Zoom slider to zoom the view.

Move child components and
their positions.

Connections and bindings are color coded and highlighted
to avoid confusion.

Select a component from the
graphical view.

By default, Show Bindings, Show Connections, and Show
unused check-box are selected.

• De-select Show Bindings check-box to hide the
bindings.

• De-select Show Connections check-box to hide the
connections.

• De-selectShowunused check-box to hide the unused
components.

1 Select the source signal or property. The cursor is
displayed as a pen.

2 Drag and drop the cursor on the target signal or
property.

If the target is valid, a connection and binding is created.

Create connections and
bindings

If the target is invalid, the cursor changs to "not allowed"
symbol.
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9.4.7 Basic Smart Components

Overview
The base components represent a complete set of basic building block components.
They can be used to build user defined Smart Components with more complex
behavior.
This lists the basic Smart Components available and are described in the following
sections:

• Signals and Properties on page 296
• Parametric Primitives on page 300
• Sensors on page 302
• Actions on page 305
• Manipulators on page 307
• Other on page 309

Signals and Properties

LogicGate
The signal Output is set by the logical operation specified in Operator of the two
signals InputAand InputB, with the delay specified in Delay.

DescriptionProperties

The logical operator to use.Operator
The following lists the various operators:

• AND
• OR
• XOR
• NOT
• NOP

Time to delay the output signal.Delay

DescriptionSignals

The first input.InputA

The second input.InputB

The result of the logic operation.Output

LogicExpression
Evaluates a logic expression.

DescriptionProperties

The expression to evaluate.String

The following lists the various operators:
• AND
• OR
• NOT
• XOR

Operator
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DescriptionSignals

Contains the result of the evaluation.Result

LogicMux
Output is set according to: Output = (Input A * NOT Selector) + (Input B * Selector)

DescriptionSignals

When low, the first input is selected.Selector
When high, the second input is selected.

Specifies the first input.InputA

Specifies the second input.InputB

Specifies the result of the operation.Output

LogicSplit
The LogicSplit takes Input and sets OutputHigh to the same as Input, and OutputLow
as the inverse of Input.
PulseHigh sends a pulse when Input is set to high, and PulseLow sends a pulse
when Input is set to low.

DescriptionSignals

Specifies the input signal.Input

Goes high (1) when input is 1.OutputHigh

Goes high (1) when input is 0.OutputLow

Sends pulse when input is set to high.PulseHigh

Sends pulse when input is set to low.PulseLow

LogicSRLatch
TheLogicSRLatch has one stable state.

• When Set=1, Output=1 and InvOutput=0
• When Reset=1, Output=0 and InvOutput=1

DescriptionSignals

Sets the output signal.Set

Resets the output signal.Reset

Specifies output signal.Output

Specifies Inverse output signal.InvOutput

Converter
Converts between property values and signal values.

DescriptionProperties

Converts to AnalogOutput.AnalogProperty

Converts to DigitalOutput.DigitalProperty

Converts to GroupOutput.GroupProperty

Converts from DigitalInput and to DigitalOutput.BooleanProperty
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DescriptionSignals

Converts to DigitalProperty.DigitalInput

Converted from DigitalProperty.DigitalOutput

Converts to AnalogProperty.AnalogInput

Converted from AnalogProperty.AnalogOutput

Converts to GroupProperty.GroupInput

Converted from GroupProperty.GroupOutput

VectorConverter
Converts between Vector3 and X, Y,and Z values.

DescriptionProperties

Specifies the X-value of Vector.X

Specifies the Y-value of Vector.Y

Specifies the Z-value of VectorZ

Specifies the vector value..Vector

Expression
The Expression consists of numeric literals (including PI), parentheses,
mathematical operators +,-,*,/,^ (power) and mathematical functions sin, cos, sqrt,
atan, abs. Any other strings are interpreted as variables, which are added as
additional properties. The result is displayed in Result.

DescriptionSignals

Specifies the expression to evaluate.Expression

Specifies the result of evaluation.Result

Specifies automatically generated variables.NNN

Comparer
The Comparer compares First value with Second value, using Operator. Output is
set to 1 if the condition is met.

DescriptionProperties

Specifies the first value.ValueA

Specifies the second value.ValueB

Specifies the comparison operator.Operator
The following lists the various operators:

• ==
• !=
• >
• >=
• <
• <=

DescriptionSignals

True if the comparison evaluates to true, otherwise false.Output
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Counter
Count is increased when the input signal Increase is set, and decreased when the
input signal Decrease is set. Count is reset when the input signal Reset is set.

DescriptionProperties

Specifies the current count.Count

DescriptionSignals

Adds one to the Count when set to True.Increase

Subtracts one from the Count when set to True.Decrease

Resets the Count to zero when set to high.Reset

Repeater
Pulses Output signal Count number of times.

DescriptionProperties

Number of times to pulse Output.Count

DescriptionSignals

Set to high (1) to pulse Output Count times.Execute

Output pulse.Output

Timer
The Timer pulses the Output signal based on the given interval.
If Repeat is unchecked, one pulse will be triggered after the time specified in
Interval. Otherwise, the pulse will be repeated at the interval given by Interval.

DescriptionProperties

Specifies the time to pass before the first pulse.StartTime

Specifies the simulation time between the pulses.Interval

Specifies if the signal should be pulsed repeatedly or only once.Repeat

Specifies the current simulation time.Current time

DescriptionSignals

Set to True to activate the timer, and False to deactivate it.Active

Sends pulses at the specified time intervals.Output

StopWatch
The StopWatch measures time during simulation (TotalTime). A new lap can be
started by triggering the Lap input signal. LapTime shows the current lap time. The
time is only measured when Active is set to 1. The times are reset when the input
signal Reset is set.

DescriptionProperties

Specifies the accumulated time.TotalTime

Specifies the current lap time.LapTime

If true, TotalTime and LapTime will be set to 0 when the simu-
lation starts.

AutoReset

Continues on next page
Operating manual - RobotStudio 299
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

9 Modeling tab
9.4.7 Basic Smart Components

Continued



DescriptionSignals

Set to True to activate the stop watch, and False to deactivate
it.

Active

Resets Total time and Lap time when set to high.Reset

Starts a new lap.Lap

Parametric Primitives

ParametricBox
The ParametricBox generates a box with dimensions specified by length, width,
and height.

DescriptionProperties

Specifies the length of the box in the X-axis direction.SizeX

Specifies the length of the box in the Y-axis direction.SizeY

Specifies the length of the box in the Z-axis directionSizeZ

Specifies the generated part.GeneratedPart

False to remove the geometry data from the generated part.
This can make other components such as Source execute
faster.

KeepGeometry

DescriptionSignals

Set to high (1) to update the generated part.Update

ParametricCircle
The ParametricCircle generates a circle with a given radius.

DescriptionProperties

Specifies the radius of the circle.Radius

Specifies the generated part.GeneratedPart

Specifies the generated wire object.GeneratedWire

False to remove the geometry data from the generated part.
This can make other components such as Source execute
faster

KeepGeometry

DescriptionSignals

Set to high (1) to update the generated part.Update

ParametricCylinder
The ParametricCylinder generates a cylinder with the dimensions given by Radius
and Height.

DescriptionProperties

Specifies the radius of the cylinder.Radius

Specifies the height of the cylinder.Height

Specifies the generated part.GeneratedPart

False to remove the geometry data from the generated part.
This can make other components such as Source execute
faster.

KeepGeometry
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DescriptionSignals

Set to high (1) to update the generated part.Update

ParametricLine
The ParametricLine generates a line with a given end point or a given length. If
either of them is changed, the other one will be updated accordingly.

DescriptionProperties

Specifies the end point for the line.EndPoint

Specifies the length of the line.Length

Specifies the generated part.GeneratedPart

Specifies the generated wire object.GeneratedWire

False to remove the geometry data from the generated part.
This can make other components such as Source execute
faster.

KeepGeometry

DescriptionSignals

Set to high (1) to update the generated part.Update

LinearExtrusion
The LinearExtrusion extrudes SourceFace or SourceWire along the vector given
by Projection.

DescriptionProperties

Specifies the face to extrude.SourceFace

Specifies the wire to extrude.SourceWire

Specifies the vector to extrude along.Projection

Specifies the generated part.GeneratedPart

False to remove the geometry data from the generated part.
This can make other components such as Source execute
faster.

KeepGeometry

CircularRepeater
The CircularRepeater creates a number of given copies of Source around the center
of the SmartComponent with a given DeltaAngle.

DescriptionProperties

Specifies the object to copy.Source

Specifies the number of copies to create.Count

Specifies the radius of the circle.Radius

Specifies the angle between the copies.DeltaAngle

LinearRepeater
The LinearRepeater creates a number of copies of Source, with the spacing and
direction given by Offset.

DescriptionProperties

Specifies the object to copy.Source
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DescriptionProperties

Specifies the distance between copies.Offset

Specifies the number of copies to create.Count

MatrixRepeater
The MatrixRepeater creates a specified number of copies in three dimensions,
with the specified spacing of the object in Source.

DescriptionProperties

Specifies the object to copy.Source

Specifies the number of copies in the X-axis direction.CountX

Specifies the number of copies in the Y-axis direction.CountY

Specifies the number of copies in the Z-axis direction.CountZ

Specifies the offset between the copies in the X-axis direction.OffsetX

Specifies the offset between the copies in the Y-axis direction.OffsetY

Specifies the offset between the copies in the Z-axis direction.OffsetZ

Sensors

CollisionSensor
The CollisionSensor detects collisions and near miss events between the First
object and the Second object. If one of the objects is not specified, the other will
be checked against the entire station. When the Active signal is high and a collision
or a near miss event occurs and the component is active, the SensorOut signal is
set and the parts that participate in the collision or near miss event are reported
in the first colliding part and second colliding partof the Property editor.

DescriptionProperties

The first object to check for collisions.Object1

The second object to check for collisions.Object2

Specifies the near miss distance.NearMiss

The part of First object that has a collision.Part1

The part of Second object that has a collision.Part2
• None
• Near miss
• Collision

CollisionType

DescriptionSignals

Specifies if the CollisionSensor is active or not.Active

True if there is a NearMiss or Collision.SensorOut
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LineSensor
The LineSensor defines a line by the Start, End, and Radius. When an Active signal
is high, the sensor detects objects that intersect the line. Intersecting objects are
displayed in the ClosestPart property and the point on the intersecting part that is
closest to the line sensors start point is displayed in the ClosestPoint property.
When intersection occurs the SensorOut output signal is set.

DescriptionProperties

Specifies the start point.Start

Specifies the end point.End

Specifies the radius.Radius

Specifies the part that intersects the line sensor.SensedPart
If several parts intersect, then the one closest to theStart point
is listed.

Specifies the point on the intersecting part, closest to the Start
point.

SensedPoint

DescriptionSignals

Specifies if the LineSensor is active or not.Active

True if the sensor intersects with an object.SensorOut

PlaneSensor
The PlaneSensor defines a plane by Origin, Axis1, and Axis2. When the Active
input signal is set the sensor detects objects that intersect this plane. Intersecting
objects are displayed in the SensedPart property and when intersection occurs
the SensorOut output signal is set.

DescriptionProperties

Specifies the origin of the plane.Origin

Specifies the first axis of the plane.Axis1

Specifies the second axis of the plane.Axis2

Specifies the part that intersects the PlaneSensor.SensedPart
If several parts intersect, then the one listed first in the Layout
browser is selected.

DescriptionSignals

Specifies if the PlaneSensor is active or not.Active

True if the sensor intersects with an object.SensorOut

VolumeSensor
The VolumeSensor detects objects that are inside or partly inside a box-shaped
volume. The volume is defined by a Corner Point, the Length, Height, and Width
of the sides and the orientation angles.

DescriptionProperties

Specifies the local origin of the box.CornerPoint

Specifies the orientation (Euler ZYX) relative to Reference.Orientation

Specifies the length of the box.Length
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DescriptionProperties

Specifies the width of the box.Width

Specifies the height of the box.Height

The percentage of the volume to react on. Set to 0 to react on
all objects.

Percentage

Allow an object to be sensed if only a part of it is inside the
volume sensor.

PartialHit

The last object that either entered or left the volume.SensedPart

The objects sensed in the volumeSensedParts

The total volume sensedVolumeSensed

DescriptionSignals

Set to high (1) to activate the sensor.Active

Goes high (1) when an object is detected within the volume. Is
reset immediately after an object has been detected.

ObjectDetectedOut

Goes high (1) when an object is detected to leave the volume.
Is reset immediately after an object has left the volume.

ObjectDeletedOut

Goes high (1) when the volume is full.SensorOut

PositionSensor
The PositionSensor monitors the position and orientation of an object.
The position and orientation of an object is updated only during the simulation.

DescriptionProperties

Specifies the object to monitor.Object

Specifies the reference coordinate system (Parent or Global).Reference

Specifies the reference object, if Reference is set to Object.ReferenceObject

Specifies the position of the object relative to Reference.Position

Specifies the orientation (Euler ZYX) relative to Reference.Orientation

ClosestObject
The ClosestObject defines a Reference object or a Reference point. When the
Execute signal is set, the component finds the ClosestObject, ClosestPart, and the
Distance to the reference object, or to the reference point if the reference object
is undefined. If RootObject is defined, the search is limited to that object and its
descendants. When finished and the corresponding properties are updated the
Executed signal is set.

DescriptionProperties

Specifies the object to get the closest object to.ReferenceObject

Specifies the point to get the closest object to.ReferencePoint

Specifies the object whose children to search.RootObject
Empty means entire station.

Specifies the object closest to Reference object or Reference
point.

ClosestObject
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DescriptionProperties

Specifies the part closest to Reference object or Reference
point.

ClosestPart

Specifies the distance between the Reference object and the
Closest object.

Distance

DescriptionSignals

Set to True to find the Closest part.Execute

Sends a pulse when completed.Executed

Actions

Attacher
The Attacher will attach Child to Parent when the Execute signal is set. If the Parent
is a mechanism, the Flange to attach to must also be specified. When the input
Execute is set, the child object is attached to the parent object. If Mount is checked,
the child will also be mounted on the parent, with the Offset and Orientation
specified. The output Executed will be set when finished.

DescriptionProperties

Specifies the object to attach to.Parent

Specifies the Index of mechanism flange to attach to.Flange

Specifies the object to attach.Child

If true, the object to attach mounts on the attachment parent.Mount

Specifies the position relative to the attachment parent when
using Mount.

Offset

Specifies the orientation relative to the attachment parent when
using Mount.

Orientation

DescriptionSignals

Set to True to attach.Execute

Sends a pulse when completed.Executed

Detacher
The Detacher will detach the Child from the object it is attached to when the Execute
signal is set. If Keep position is checked, the position will be kept. Otherwise the
child is positioned relative to its parent. When finished, the Executed signal will be
set.

DescriptionProperties

Specifies the object to detach.Child

If false, the attached object is returned to its original position.KeepPosition

DescriptionSignals

Set to True to remove the attachment.Execute

Sends a pulse when completed.Executed
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Source
The Source property of the source component indicates the object that should be
cloned when the Execute input signal is received. The parent of the cloned objects
is specified by the Parent property and a reference to the cloned object is specified
by the Copy property. The output signal Executed signifies that the clone is
complete.

DescriptionProperties

Specifies the object to copy.Source

Specifies the copied object.Copy

Specifies the parent to the copy.Parent
If not specified, the copy gets the same parent as the source.

Specifies the position of the copy relative its parent.Position

Specifies the orientation of the copy relative its parent.Orientation

Marks the copy as transient if created during simulation. Such
copies are not added to the undo queue and are automatically
deleted when the simulation is stopped. This is used to avoid
increased memory consumption during simulation.

Transient

DescriptionSignals

Set to True to create a copy of the object.Execute

Sends a pulse when completed.Executed

Sink
The Sink deletes the object referenced by the Object property. Deletion happens
when the Execute input signal is received. The Executed output signal is set when
the deletion is finished.

DescriptionProperties

Specifies the object to remove.Object

DescriptionSignals

Set to True to remove the object.Execute

Sends a pulse when completed.Executed

Show
When the Execute signal is set, the object referenced in Object appears. When
finished, Executed signal will be set.

DescriptionProperties

Specifies the object to show.Object

DescriptionSignals

Set to True to show the object.Execute

Sends a pulse when completed.Executed
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Hide
When the Execute signal is set, the object referenced in Object will be hidden.
When finished, Executed signal will be set.

DescriptionProperties

Specifies the object to hide.Object

DescriptionSignals

Set to True to hide the object.Execute

Sends a pulse when completed.Executed

Manipulators

LinearMover
The LinearMover moves the object referenced in the Object property with a speed
given by the Speed property in the direction given by the Direction property. The
motion starts when the Execute input signal is set and stops when Execute is reset.

DescriptionProperties

Specifies the object to move.Object

Specifies the direction to move the object.Direction

Specifies the speed of movement.Speed

Specifies the coordinate system in which values are specified.
It can be Global, Local, or Object.

Reference

Specifies the reference object, if Reference is set to Object.ReferenceObject

DescriptionSignals

Set to True to start move the object, and False to stop.Execute

Rotator
The Rotator rotates the object referenced in the Object property with an angular
speed given by the Speed property. The axis of rotation is given by CenterPoint
and Axis. The motion starts when the Execute input signal is set and stops when
the Execute is reset.

DescriptionProperties

Specifies the object to rotate.Object

Specifies the point to rotate around.CenterPoint

Specifies the axis of the rotation.Axis

Specifies the speed of the rotation.Speed

Specifies the coordinate system in which values are specified.
It can be Global, Local, or Object.

Reference

Specifies the object which are relative to CenterPoint and Axis,
if Reference is set to Object.

ReferenceObject

DescriptionSignals

Set to True to start rotating the object, and False to stop.Execute
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Positioner
The Positioner takes an Object, Position, and Orientation as properties. When the
Execute signal is set the object is repositioned in the given position relative to the
Reference. When finished the Executed output is set.

DescriptionProperties

Specifies the object to position.Object

Specifies the new position of the object.Position

Specifies the new orientation of the object.Orientation

Specifies the coordinate system in which values are specified.
It can be Global, Local, or Object.

Reference

Specifies the object which are relative to Position and Orienta-
tion, if Reference is set to Object.

ReferenceObject

DescriptionSignals

Set to True to start move the object, and False to stop.Execute

Set to 1 when operation is completed.Executed

PoseMover
The PoseMover has a Mechanism, a Pose, and Duration as properties. When the
Execute input signal is set the mechanism joint values are moved to the given
pose. When the pose is reached the Executed output signal is set.

DescriptionProperties

Specifies the mechanism to move to a pose.Mechanism

Specifies the Index of the pose to move to.Pose

Specifies the time for the mechanism to move to the pose.Duration

DescriptionSignals

Set to True, to start or resume moving the mechanism.Execute

Pauses the movement.Pause

Cancels the movement.Cancel

Pulses high when the mechanism has reached the pose.Executed

Goes high during the movement.Executing

Goes high when paused.Paused

JointMover
The JointMover has a Mechanism, a set of Joint Values and a Duration as
properties. When the Execute input signal is set the mechanism joint values are
moved to the given pose. When the pose is reached the Executed output signal is
set. The GetCurrent signal retrieves the current joint values of the mechanism.

DescriptionProperties

Specifies the mechanism to move to a pose.Mechanism

Specifies if J1-Jx are relative to the start values, rather than
absolute joint values.

Relative

Specifies the time for the mechanism to move to the pose.Duration
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DescriptionProperties

Joint values.J1 - Jx

DescriptionSignals

Retrieve current joint values.GetCurrent

Set to True to start moving the mechanism.Execute

Pauses the movementPause

Cancels the movementCancel

Pulses high when the mechanism has reached the pose.Executed

Goes high during the movement.Executing

Goes high when paused.Paused

Other

GetParent
The GetParent returns the parent object of the input object. The executed signal
is triggered if a parent is found.

DescriptionProperties

Specifies the object to whose parent is to be found.Child

Specifies the parent of the childParent

DescriptionSignals

Goes high (1) if the parent exists.Output

Note

The Child list for Properties:GetParent does not show every part or object in
the station. However, if you do not find the required part or object in the list, then
add it from the browser or graphic window by clicking it.

GraphicSwitch
Switches between two parts, either by clicking on the visible part in the graphics
or by setting and resetting the input signal.

DescriptionProperties

Displayed when the signal is high.PartHigh

Displayed when the signal is low.PartLow

DescriptionSignals

Input signal.Input

Output signal.Output

Continues on next page
Operating manual - RobotStudio 309
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

9 Modeling tab
9.4.7 Basic Smart Components

Continued



Highlighter
The Highlighter temporarily sets the color of the Object to the RGB-values specified
in Color. The color is blended with the original color of the objects as defined by
Opacity When the signal Active is reset, Object gets its original colors.

DescriptionProperties

Specifies the object to highlight.Object

Specifies the RGB-values of the highlight color.Color

Specifies the amount to blend with the object's original color
(0-255).

Opacity

DescriptionSignals

True sets the hightlight. False restores the original color.Active

Logger
Prints a message in the output window.

DescriptionProperties

Format string.Format
Supports variables like {id:type}, where type can be d (double),
i (int), s (string), o (object)

Formatted message.Message

Message severity: 0 (Information), 1 (Warning), 2 (Error).Severity

DescriptionSignals

Set to high (1) to print the message.Execute

MoveToViewPoint
Moves to the selected viewpoint in the given time, when the input signal Execute
is set. The output signal Executed is set when the operation is completed.

DescriptionProperties

Specifies the viewpoint to move to.Viewpoint

Specifies the time to complete the operation.Time

DescriptionSignals

Set to high (1) to start the operation.Execute

Goes high (1) when the operation is completed.Executed

ObjectComparer
Determines if ObjectA is the same as ObjectB.

DescriptionProperties

Specifies the object to compare.ObjectA

Specifies the object to compare.ObjectB

DescriptionSignals

Goes high if the objects are equal.Output
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Queue
The Queue represents a FIFO (first in, first out) queue. The object in Back is added
to the queue when the signal Enqueue is set. The front object of the queue is shown
in Front. The object in Front is removed from the queue when the signal Dequeue
is set. If there are more objects in the queue, the next object is shown in Front. All
objects in the queue are removed from the queue when the signal Clear is set.
If a transformer component (such as LinearMover) has a queue component as its
Object, it will transform the contents of the queue, rather than the queue itself.

DescriptionProperties

Specifies the object to enqueue.Back

Specifies the first object in queue.Front

Contains unique IDs of the queue’s elements.Queue

Specifies the number of objects in the queue.NumberOfObjects

DescriptionSignals

Adds the object in Back to the end of the queue.Enqueue

Removes the object in Front from the queue.Dequeue

Removes all objects from the queue.Clear

Removes the object in Front from the queue and from the sta-
tion.

Delete

Clears the queue and removes all objects from the stationDeleteAll

SoundPlayer
Plays the sound specified by Sound Asset when the input signal Execute is set.
The asset must be a .wav file

DescriptionProperties

Specifies the sound file that should be played. Must be a .wav
file.

SoundAsset

DescriptionSignals

Set to high to play the sound.Execute

StopSimulation
Stop a running simulation when the input signal Execute is set.

DescriptionSignals

Set to high to stop the simulation.Execute

Random
Random generates a random number between Min and Max in Value when Execute
is triggered.

DescriptionProperties

Specifies minimum value.Min

Specifies maximum value.Max

Specifies a random number between Min and Max.Value
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DescriptionSignals

Set to high to generate a new random number.Execute

Goes high when the operation is completed.Executed
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9.4.8 Property Editor

Overview
The Property editor is used to modify the values of dynamic properties and I/O
signals for a Smart Component. By default, the Property editor is displayed as a
tool window to the left.
Each dynamic property is represented by a control. The type of control that is
displayed depends on the property type and property attributes.
Properties with the Hidden flag set to true are not displayed. Read-only properties
cannot be modified but are only displayed.
The values are validated according to the property attributes. If an invalid value is
entered, an error icon is displayed next to the control and the Apply button is
disabled.
If you set the AutoApply attribute of a property to true, the value is applied
whenever you change the value in the control. You can apply the values of other
properties by clicking theApply button. If the component has no properties without
AutoApply, then the Apply button will never be enabled.
You can toggle the value of a digital signal by clicking the control. Similarly, you
can change the value of an analog or group signal by entering the new value in
the text box.

Opening the Property editor
You can open the Property editor dialog box in any one of the following ways:

• Right-click context menu for a Smart Component and select Properties.
• Launches automatically when the Smart Component Editor is started.
• Launched when you add a base component. See Basic Smart Components

on page 296.
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9.4.9 The Simulation Watch window

Overview
The Simulation Watch allows you to monitor the values of dynamic properties and
I/O signals in Smart Components. It specifies the simulation that should be paused
when a value changes or meets a condition.

Layout of the Simulation Watch window
The Simulation Watch window by default takes the lower tab area in the RobotStudio
GUI.
The window contains a list view of four columns with one row for each watch item:

DescriptionWatch item

Specifies the Simulation break point and Break Condition.Break
For more information, see Setting Breakpoints on page 315.

Specifies the object that owns the property or signal (for station
signals the name of the station is displayed).

Object

Specifies the watched property or signal.Property/Signal

Specifies the current value of the property or signal.Value

Adding and Deleting the Watch items
Use this procedure to add or delete a watch item.

Note

As a prerequisite, you should add smart component, its properties and signals.
For more information, see Smart Component Editor on page 285.

1 In the Simulation Watch window, right-click and select Add to display the
Add submenu.
The Add submenu displays a recursive view of all the smart components,
their properties and signals. The top level submenu displays the station
signals.

Note

Watch items that are already watched are not displayed in the recursive
view.

2 From the Add submenu, select property or signal to add a single property
or signal of a component.

3 From the Add submenu, select Add all to add all the properties and signals
of a component.
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4 In the Simulation Watch window, right-click on the row of the watch item
and select Delete to delete one or more watch items.

Note

The Watch items are saved in the station and are restored when the station
is opened.

Setting Breakpoints
You can set the breakpoint in one of the following ways:

1 To set the simulation breakpoint, select the check box next to a watch item.

Note

By default, the simulation is paused whenever the value of the property or
signal changes.

2 In the Simulation Watch window, right-click on the row of the watch item
and select Break Condition.
The Break Condition dialog box appears.

• Set the simulation to paused, when the value meets a certain logical
condition. The condition can be viewed in the Break column of the
Watch window.

• When a breakpoint is reached, the simulation is paused which is
indicated by both the Play and Stop buttons being enabled.

• If the Simulation Watch window is hidden behind the other windows,
it is brought to the front and the text of the corresponding watch item
turns red.

Note

• Break condition can be specified only for the properties of numeric
and string types, and not for the object types.

• After the current simulation time step is completed, all the remaining
Smart component events are executed before the simulation is actually
paused.
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9.5 Tags

Overview
For a complex RobotStudio station containing many robots, parts, paths, targets
and other objects the browser and the 3D graphics view becomes cluttered. Tags
function helps the user to identify objects in the cluttered 3D graphics view and in
the browser during station modeling and offline programming.
Using tags function, you can group objects in a defined structure by labeling them.
It is possible to hide or show these tags independent of the other tags. A hidden
tagged object is invisible in the browser and in the 3D graphics window unless it
is labeled by a currently visible tag.

Tip

For easy and quick access of Tags function, add it to the Quick Access Toolbar
using the customize Commands.

Creating a New Tag
Use any of the following steps to create a new tag.

• In the Modeling tab, select Tags and then click New Tag.
• Right-click the object and in the context menu, click Tags and then clickNew

Tag. The object will be labeled by the tag
The new tag appears in the browser with the default name. Press F2 and select
Rename from the context menu to rename the tag.
Use any of the following steps to hide or show tagged objects.

• In the Tag browser, right-click the tag and then check/uncheck Visible.
• Click the Tags menu and then check/uncheck the tag to show/hide the tag.

Tag Visibility
When a tag is invisible/ unchecked, the corresponding tagged object will be hidden
in the 3D graphicas view and in the browsers (layout, path and targets, modeling).
If an object is labeled by several tags, the object will be visible when at least one
of the tags is set visible. Untagged objects are always visible.

Note

The regular visible property remains and overrides the tag visibility. If regular
visible property is unchecked for an object, the object will be hidden in the 3D
graphics view but it is visible in the browser. For a tagged object, when the
visibility is unchecked, the object will be hidden in the 3D graphics view and in
the browser.
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9.6 Selection of Objects

Overview
In 3D view, you can select an object by drawing a selection rectangle using a mouse
cursor.

Deep rectangle selection
The Deep rectangle selection (default selection mode) is enabled if you press and
hold the SHIFT key and draw a rectangle in the 3D view using the mouse. This
mode selects objects covered by the selection rectangle regardless of its visibility.

Shallow rectangle selection
Shallow rectangle selection is enabled if you press SHIFT + S keys and draw a
rectangle in the 3D view using the mouse. In this mode, you can optionally select
the currently visible object.
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9.7 Solid

Creating a solid
1 Click Solid and then click the type of solid you want to create to bring up a

dialog box.
2 Enter requested values in the dialog box and click Create. For detailed

information about the specific dialog box for the curve to create, see below:

The Create Box dialog box

A
B

C

D

xx060000

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the corner point in
the graphics window to transfer the values to the Corner Point
boxes, or type the position. The corner point will be the local
origin of the box.

Corner Point (A)

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Orientation

Specify the box dimension along its X axis.Length (B)

Specify the box dimension along its Y axis.Width (C)

Specify the box dimension along its Z axis.Height (D)

The Create Box from 3-Points dialog box

A

C

B

xx060001

Select the Reference coordinate system to which all positions
or points will be related.

Reference
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This point will be the local origin of the box.Corner Point (A)
Either type the position, or click in one of the boxes and then
select the point in the graphics window.

This point is the the corner, diagonal to the local origin. It sets
the X and Y directions of the local coordinate system, as well
as the dimension of the box along these axes.

Point on diagonal of XY-
plane (B)es

Either type the position, or click in one of the boxes and then
select the point in the graphics window.

This point is the corner above the local origin, It sets the Z
direction of the local coordinate system, as well as the dimen-
sion of the box along the Z axis.

Indication Point Z-axis (C)

Either type the position, or click in one of the boxes and then
select the point in the graphics window.

The Create Cone dialog box

A
B

C

xx060002

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Base Center
Point boxes, or type the position. The center point will be the
local origin of the cone.

Base Center Point (A)

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Orientation

Specify the radius of the cone.Radius (B)

Specify the diameter of the cone.Diameter

Specify the height of the cone.Height (C)

The Create Cylinder dialog box

A

C

B

xx060003
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Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Base Center
Point boxes, or type the position. The center point will be the
local origin of the cylinder.

Base Center Point (A)

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Orientation

Specify the radius of the cylinder.Radius (B)

Specify the diameter of the cylinder.Diameter

Specify the height of the cylinder.Height (C)

The Create Pyramid dialog box

A

B

C

xx060004

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Base Center
Point boxes, or type the position. The center point will be the
local origin of the pyramid.

Base Center Point (A)

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Orientation

Either type the position, or click in the box and then select the
point in the graphics window.

Center to Corner Point (B)

Specify the height of the pyramid.Height (C)

Specify the number of sides of the pyramid. The maximum
number of sides is 50.

Number of Sides

The Create Sphere dialog box

B

A

B

xx060005
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Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Center Point
boxes, or type the position. The center point will be the local
origin of the sphere.

Center Point (A)

Specify the radius of the sphere.Radius (B)

Specify the diameter of the sphere.Diameter
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9.8 Surface

Creating a surface
1 Click Surface and then click the type of solid you want to create to bring up

a dialog box.
2 Enter requested values in the dialog box and click Create. For detailed

information about the specific dialog box for the curve to create, see below:

The Create Surface Circle dialog box

A

B

xx060006

Select theReference coordinate system, to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Center Point
boxes, or type the position. The center point will be the local
origin of the circle.

Center Point (A)

If the object shall be rotated relative to the reference coordinate
system, specify the rotation.

Orientation

Specify the radius of the circle.Radius (B)

Specify the diameter of the circle.Diameter

The Create Rectangle dialog box

A
B

C

xx060007

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Start Point
boxes, or type the position. The start point will be the local
origin of the rectangle.

Start Point (A)
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If the object shall be rotated relative the reference coordinate
system, specify the rotation.

Orientation

Specify the length of the rectangle.Length (B)

Specify the width of the rectangleWidth (C)

The Create Surface Polygon dialog box

A

B

xx060008

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Center Point
boxes, or type the position. The center point will be the local
origin of the polygon.

Center Point

Either type the position, or click in one of the boxes and then
select the point in the graphics window.

First Vertex Point

Specify the number of the vertices here. The maximum number
of vertices is 50.

Vertices

The Create Surface from Curve dialog box

Select a curve by clicking it in the graphics window.Select Curve from graph-
ics
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9.9 Curve

Creating a curve
1 Click Curve and then click the curve you want to create to bring up a dialog

box.
2 Enter requested values in the dialog box and click Create. For detailed

information about the specific dialog box for the curve to create, see below:

The Create Line dialog box

xx050034

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the start point in the
graphics window to transfer the values to the Start Point boxes.

Start point (A)

Click in one of these boxes, and then click the end point in the
graphics window to transfer the values to the End Point boxes.

End Point (B)

The Create Circle dialog box

xx050035

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Center Point
boxes.

Center point (A)

Specify the orientation coordinates for the circle.Orientation

Specify the radius of the circle.Radius (A-B)

Alternatively, specify the diameter.Diameter
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The Create Three Points Circle dialog box

xx050036

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the first point in the
graphics window to transfer the values to the First Point boxes.

First Point (A)

Click in one of these boxes, and then click the second point in
the graphics window to transfer the values to the Second Point
boxes.

Second Point (B)

Click in one of these boxes, and then click the third point in
the graphics window to transfer the values to the Third Point
boxes.

Third Point (C)

The Create Arc dialog box

xx050037

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the start point in the
graphics window to transfer the values to the Start Point boxes.

Start Point (A)

Click in one of these boxes, and then click the second point in
the graphics window to transfer the values to the Mid Point
boxes.

Mid Point (B)

Click in one of these boxes, and then click the end point in the
graphics window to transfer the values to the End Point boxes.

End Point (C)
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The Create Elliptical Arc dialog box

xx050038

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Center Point
boxes.

Center Point (A)

Click in one of these boxes, and then click the end point for
the major axis of the ellipse in the graphics window to transfer
the values to the Major Axis End Point boxes.

Major Axis End Point (B)

Click in one of these boxes, and then click the end point for
the minor axis of the ellipse in the graphics window to transfer
the values to the Minor Axis End Point boxes.

Minor Axis End Point (C)

Specify the start angle for the arc, measured from the major
axis.

Start Angle (α)

Specify the end angle for the arc, measured from the major
axis.

End Angle (β)

The Create Ellipse dialog box

xx050039

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of the Center Point boxes, and then click the
center point in the graphics window to transfer the values to
the Center Point boxes.

Center Point (A)

Click in one of these boxes, and then click the end point for
the major axis of the ellipse in the graphics window to transfer
the values to the Major Axis End Point boxes.

Major Axis End Point (B)

Specify the length of the minor axis of the ellipse. The minor
radius will be created perpendicular to the major axis.

Minor Radius (C)
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The Create Rectangle dialog box

xx050040

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the start point in the
graphics window to transfer the values to the Start Point boxes.
The rectangle will be created in the positive coordinate direc-
tions.

Start Point (A)

Specify the orientation coordinates for the rectangle.Orientation

Specify the length of the rectangle along the x axis.Length (B)

Specify the width of the rectangle along the y axis.Width (C)

The Create Polygon dialog box

xx050041

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the center point in
the graphics window to transfer the values to the Center Point
boxes.

Center Point (A)

Click in one of these boxes, and then click the first vertex point
in the graphics window to transfer the values to the First Vertex
Point boxes. The distance between the center point and the
first vertex point will be used for all vertex points.

First Vertex Point (B)

Specify the number of points to be used when creating the
polygon. The maximum number of vertices is 50.

Vertices
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The Create Polyline dialog box

xx050042

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Specify each node of the polyline here, one at a time, by either
typing the values, or by clicking in one of these boxes, and
then selecting the point in the graphics window to transfer its
coordinates.

Point Coordinates

Click this button to add a point and its coordinates to the list.Add

Click this button to modify an already defined point, after you
have selected it in the list and entered new values.

Modify

The nodes of the polyline. To add more nodes, click Add New,
click the desired point in the graphics window, and then click
Add.

List

The Create Spline dialog box

xx050043

Select the Reference coordinate system to which all positions
or points will be related.

Reference

Specify each node of the spline here, one at a time, by either
typing the values, or by clicking in one of these boxes, and
then selecting the point in the graphics window to transfer its
coordinates.

Point Coordinates

Click this button to add a point and its coordinates to the list.Ad

Click this button to modify an already defined point, after you
have selected it in the list and entered new values.

Modify

This nodes of the spline. To add more nodes, click Add New,
click the desired point in the graphics window, and then click
Add.

List
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9.10 Border

Creating a curve
1 ClickBorder and then click the border you want to create to bring up a dialog

box.
2 Enter requested values in the dialog box and click Create. For detailed

information about the specific dialog box for the border to create, see below:

The Create Border Between Bodies dialog box
To use the create border between bodies command, the station must contain at
least two objects.

xx050044

Click in this box and then select the first body in the graphics
window.

First Body

Click in this box and then select the second body in the
graphics window.

Second Body

The Create Border Around Surface dialog box
To use the create border around surface command, the station must contain at
least one object with a graphical representation.

xx050045

Click in this box and then select a surface in the graphics win-
dow.

Select Surface
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The Create Border From Points dialog box
To use the create border from points command, the station must contain at least
one object.

en050000

Click in this box and then select an object in the graphics win-
dow.

Selected Object

Specify the points that define the border here, one at a time,
by either typing the values, or by clicking in one of these boxes,
and then selecting the point in the graphics window to transfer
its coordinates.

Point Coordinates

Click this button to add a point and its coordinates to the list.Add

Click this button to modify an already defined point, after you
have selected it in the list and entered new values.

Modify

The points that define the borders. To add more points, click
Add New, click the desired point in the graphics window, and
then click Add.

List
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9.11 Intersect

The Intersect dialog box

A B

xx060009

Select this check box to keep the original bodies when creating
the new body.

Keep Original

Select the body from which you want to make an intersection
(A) by clicking it in the graphics window.

Intersect... (A)

Select the body with which you want to make an intersection
(B) by clicking it in the graphics window.

...and (B)

A new body will be created based on the common area between
the selected bodies A and B.
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9.12 Subtract

The Subtract dialog box

A B

xx060010

Select this check box to keep the original bodies when creating
the new body.

Keep Original

Select the body from which you want to subtract (A) by clicking
it in the graphics window.

Subtract... (A)

Select the body you want to subtract (B) by clicking it in the
graphics window.

...with (B)

A new body will be created based on the area of body A sub-
tracted with the common volume between body A and B.
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9.13 Union

The Union dialog box

A B

xx060011

Select this check box to keep the original bodies when creating
the new body.

Keep Original

Select the body that you want to unify (A) by clicking it in the
graphics window.

Union... (A)

Select the body that you want to unify (B) by clicking it in the
graphics window.

...and (B)

A new body will be created based on the areas of the two se-
lected bodies A and B.
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9.14 Extrude Surface or Curve

Extruding a surface or curve
1 From the selection level toolbar, select Surface or Curve, as appropriate.
2 In the graphics window, select the surface or curve you wish to extrude. Click

Extrude Surface or Extrude Curve, as appropriate. The Extrude Surface or
Curve dialog box opens below the Modeling browser.

3 For extrusion along a vector, fill in the values.
For extrusion along a curve, select the Extrude Along Curve option. Click
the Curve box, and select the curve in the Graphics window.

4 If you wish the form to appear as a surface model, clear theMake Solid check
box.

5 Click Create.

The Extrude Surface or Curve dialog box

Denotes the surface or curve to be extruded.Surface or Curve
To select the surface or curve, first click in the box, then select
the surface or curve in the graphics window.

Enables extrusion along a specified vector.Extrude Along Vector

The start point of the vector.From Point

The end point of the vector.To Point

Enables extrusion along a specified curve.Extrude Along Curve

Denotes the curve used as a sweep path.

xx0600003076

Curve

To select the curve, first click the box, then the curve in the
graphics window.
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Select this check box to convert the extruded form into a solid.Make Solid
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9.15 Line from Normal

Creating a line from normal
1 Click Surface Selection.
2 Click Line to Normal to bring up a dialog box.
3 Click on a face to select it in the Select Face box.
4 In the Length box, specify a length for the line.
5 Optionally, select the Invert Normal check box to invert the direction of the

line.
6 Click Create.
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9.16 The Measure Group

Tip

Make sure to select the appropriate snap mode and selection levels before
making your measurements.

Measuring distances or angles
1 Click the type of measurement you want to use:

SelectTo measure the

Point to pointdistance between two points you select in the graphics
window.

Angleangle defined by three points you select in the graphics
window.
The first point to select is the converging point, thereafter
you shall select one point on each line.

Diameterdiameter, with the circle defined by three points you select
from the graphics window.

Minimum distanceclosest distance between two objects you select in the
graphics window.

The mouse pointer will turn into a ruler when you have activated any of the
measurement functions.

2 In the graphics window, select the points or objects to measure between.
Information about the measuring points is displayed in the Output window.
The results will be displayed in the Measurements tab in the Output window
when all points have been selected.

3 Optionally, repeat step 3 for making a new measurement of the same type.

Tip

You can also activate and deactivate the measurement functions from the
measurement toolbar.
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9.17 Create Mechanism

Create a new mechanism
1 Click Create Mechanism.

The Mechanism Modeler opens in create mode.
2 In the Mechanism Model Name box, enter a mechanism name.
3 From the Mechanism Type list, select a mechanism type.
4 In the tree structure, right-click Links, and then click Add Link to bring up

the Create Link dialog box.
A suggested name appears in the Link Name box.

5 In the Selected Part list, select a part (which will be highlighted in the graphics
window) and click the arrow button to add the part to the Parts list box.
The Selected Part list then automatically selects the next part, if any more
are available. Add these, as required.

Note

Parts that are part of a library or mechanism cannot be selected.

6 Select a part in the Parts list box, enter any values in the Selected Parts
group boxes, and then click Apply to Part.
Repeat for each part, as required.

7 Click OK.
8 In the tree structure, right-click Joints, and then click Add Joint to bring up

the Create Joint dialog box.
A suggested name appears in the Joint Name box.

9 Complete the Create Joint dialog box, and then click OK.
10 In the tree structure, right-click Frame/Tool Data, and then click Add

Frame/Tool to bring up the Create Frame/Tool dialog box.
A suggested name appears in the Frame/Tool Data name box.

11 Complete the Create Frame/Tool dialog box, and then click OK.
The validity criteria for the Frame/Tool node are as follows:

12 In the tree structure, right-click Calibration, and then click Add Calibration
to bring up the Create Calibration dialog box.

13 Complete the Create Calibration dialog box, and then click OK.
14 In the tree structure, right-clickDependency, and then clickAddDependency

to bring up the Create Dependency dialog box.
15 Complete the Create Dependency dialog box, and then click OK.
16 If all nodes are valid, compile the mechanism, see Compiling a mechanism

on page 339.

Create Conveyor
1 Click Create Conveyor. The Create Conveyor browser opens.
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2 From the Conveyor Geometry list, select a geometry.
3 In the Reference Frame, enter the base frame values (Position and

Orientation) relative to the World/local origin of the selected graphic
component.
The Reference Frame defines the position where objects appear on the
conveyor.

4 From the Type list, select the type of conveyor.

Note

Only linear conveyors are supported.

5 In the Conveyor length box, enter the length of the conveyor. The Create
Mechanism gets enabled.

6 Click Create to create the conveyor.
7 Build a new system using Building a new system on page 185.

In the System Options pane, scroll down to Motion Coordination and then
select 606-1 Conveyor Tracking under Conveyor Control Options.

8 Create a new station using this new system.

Create connection between virtual controller and conveyor
1 In the Modeling tab, click Create Connection.
2 In the Create Connection tab, select the conveyor library in the Conveyor

list and then select the mechanical unit of the system.
3 Set a suitable offset (base frame of the conveyor). This offset defines the

location of the base frame of the conveyor mechanical unit in relation to the
Conveyor reference frame.

4 Under the Connection Window, set appropriate values for Minimum and
Maximum distances, and Start Window Width.

5 Under Base Frames, select the following options:
• Select Station Values to update the virtual controller with the station

layout values.
• Select Align Task Frame to move the task frame to the connection (to

align it with the base frame). The conveyor base frame will become
zero.

• Select Use Controller Values to update the station layout and the task
frame to match the virtual controller values.

6 Click Create.

Compiling a mechanism
When compiling, a new mechanism, created in the create mode of the Mechanism
Modeler, is added to the station with the default name "Mechanism_" followed by
an index number.
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When compiling, an existing editable mechanism, modified in the modify mode of
the Mechanism Modeler, is saved without any poses, joint mapping ot transition
times.
To compile a mechanism, follow these steps:

1 To compile a new or edited mechanism, click Compile Mechanism.
The mechanism is inserted into the active station. The link parts are cloned
with new names, but the corresponding links will update their part references.
When the Mechanism modeler is closed, these cloned parts will be removed.

2 The Mechanism Modeler now switches to modify mode. To complete the
mechanism, see below.

Completing or modifying a mechanism
To complete the modeling of a mechanism, follow these steps:

1 If the values in the Joint Mapping group are correct, click Set.
2 Configure the Poses grid. To add a pose, click Add and then complete the

Create Pose dialog box. Click Apply, followed by OK.
• To add a pose, click Add and then complete the Create Pose dialog

box. Click Apply, followed by OK.
• To edit a pose, select it in the grid, click Edit, and then complete the

Modify Pose dialog box. Click OK.
• To remove a pose, select it in the grid and then click Remove.

3 Click Edit Transition Times to edit transition times.
4 Click Close.

The Create Mechanism dialog box

Specifies the model name of the mechanism.Mechanism Model Name

Specifies the mechanism type.Mechanism Type

The components of the mechanism in a tree structure. The tree
structure will not be visible unless the mechanism is editable.
Each node (link, joint, frame, calibration and dependency) can
be edited in its own dialog box, see below.

Tree structure

Click this button to compile the mechanism. This button will
not be visible unless the mechanism is editable and the
mechanism model name is valid.

Compile Mechanism

The Create Conveyor Mechanism dialog box

Specifies the reference coordinates, World, Local and UCS.
Based on the selection, the position and orientation values
change.

Reference

Specifies the part to be selected for the conveyor.Conveyor Geometry

Specifies the type of conveyor.Type

Specifies the length of the conveyor.Conveyor Length

Click this button to compile the mechanism. This button will
not be visible unless the mechanism is editable and the
mechanism model name is valid.

Create
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The Create/Modify Link dialog box
A link is a moving component of a mechanism. Selecting a link node will highlight
it in the graphics window.

Specifies the name of the link.Link Name

Specifies the parts to add to the Part list box.Selected Part

The BaseLink is where the kinematical chain begins. This must
be the parent of the first joint. A mechanism may have only
one BaseLink.

Set as BaseLink

Adds a selected part to the Part list box.

xx060000

Click this button to remove a selected part from the Part list
box.

Remove Part

This group manipulates the transform of the selected part.Selected Part

Specify the position of the part.Part Position

Specify the orientation of the part.Part Orientation

Click this button to apply the settings to the part.Apply to Part

The Create/Modify Joint dialog box
A joint is the axis where two links move in relation to each other. The available
options are Rotational, Prismatic and Four Bar joint on page 342. Selecting a joint
node will display a yellow-green line in the graphics window.

Specifies the name of the joint.Joint Name

Specifies the joint type. The default option is Rotational.
Changing the Joint Type clears the Joint Limits below.

Joint Type.

Specifies the parent link, usually the first joint of the mechan-
ism.

Parent Link

Specifies the child link. To be valid, the parent and child links
may not be identical to each other, and the pair must be unique.

Child Link

Select this check box to make the joint active. An active joint
is one that a user can move, while an inactive joint is a slave
to an active joint.

Active

This group specifies the axis around or along which the child
moves.

Joint Axis

Specify the start point of the axis vector.First Position

Specify the end point of the axis vector.Second Position

Demonstrates how the child link moves along its axis.Jog Axis
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Specifies the limits in each direction to which a joint may move.
The options are Constant, Variable and No.

Limit Type

This group is visible in Constant or Variable mode.Joint Limits

Specifies the minimum joint limit.Min Limit

Specifies the maximum joint limit.Max Limit

This group is visible in Constant or Variable mode.Joint Limits

In Variable mode, variable limit points may be added as an
advanced way of delimiting the area of movement.

xx060012

Variable Limits

Adds a selected point to the Point list box.

left-cli

Click this button to remove a selected point from the Point list
box.

Remove

Four Bar joint
The Four Bar joint consists of several links/parts. This joint is of closed-loop type
hence it cannot be modeled with the standard functionality of the Mechanism
Modeler that otherwise supports open loop mechanisms only. The Four Bar joint
is typically used for car motor hoods or trunk lids.
Limitations of Four Bar joint

• Available only for Device type joints.
• The joint preview does not support Four Bar joints.

Note

The mechanism must be compiled before testing Four Bar joint. If you must
change the mechanism, use the Modify Mechanism command to re-open the
Mechanism Modeler of the corresponding mechanism.

The Modify Frame/Tool Data dialog box
A frame/tool data node determines the link and location of a frame.

Specifies the name of the frame or tool data.Frame/Tool Data name

Specifies the link to which the frame or tool belongs.Belongs to Link

Specify the position of the transform.Position
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Specify the orientation of the transform.Orientation

Select this box to select the values from a target or frame,
which is selected in the box beneath the check box.

Select values from tar-
get/Frame

This group is visible if the mechanism is a tool.Tool Data

Specifies the mass of the tool.Mass

Specify the center of gravity of the tool.Center of Gravity

Specify the moment of inertia of the tool.Moment of Inertia lx, ly, lz

The Create Calibration dialog box
A calibration contains transforms for calibrating the joints. Two calibrations cannot
share the same joint.

Specifies the joint to be calibrated.Calibration belongs to
Joint

Specify the position of the transform.Position

Specify the orientation of the transform.Orientation

The Create Dependency dialog box
A dependency is a relationship between two joints, by either a factor or a complex
formula.

Specifies the joint whose motion will be controlled by other
joints.

Joint

Select this option to specify a lead joint and factor.Use LeadJoint and factor

Specifies the lead joint.LeadJoint

This list holds a double which denotes the extent to which the
lead joint will control the main joint.

Factor

Select this option to enter a formula in the box.Use Formula

The Modify Mechanism dialog box
The Modify Mechanism dialog box contains the objects found in the Create
mechanism dialog box, as well as the following:

These boxes handle the joint mapping of the mechanism. When
editing, the mechanism must be disconnected from its library.

Joint Mapping

The values must be integers from 1 – 6 in ascending order.

Click this button to set the joint mapping.Set

Displays the poses and their joint values.Poses
Selecting a pose will move the mechanism to it in the graphics
window.

Click this button to bring up the Create Pose dialog box for
adding a pose.

Add

Click this button to bring up the Modify Pose dialog box for
editing a selected pose.

Edit

A SyncPose cannot be edited unless the mechanism is discon-
nected from its library.

Click this button to remove the selected pose.Remove
A single SyncPose cannot be removed.
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Click this button to edit the transition times.Set Transition Times

The Create/Modify Pose dialog box

Specifies the name of the pose. If the pose is a SyncPose, this
box is not editable.

Pose Name

The names "HomePosition" and "SyncPosition" are disallowed.

Select this box to specify the home pose of the mechanism. If
selected, the non-editable pose name will be "HomePose".

Home Pose

Click this button to bring up the joint jog tool.Launch Joint Jog Tool

Click this button to set the current joint values in the Joint
Values group.

Use Current

Click this button to reset the joint values in the Joint Values
group to what they were when the dialog box was opened.

Reset Values

Specify the joint values of the pose.Joint Values

The Set Transition Times dialog box
The Set Transition Times dialog box is designed like a distance table in a road
atlas. The default values are zero.

Specifies the start of the transition for the named pose.From Pose

Specifies the end of the transition for the named pose.To Pose
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9.18 Create Tool

Creating a tool
You can create a robot hold tool by using the Create Tool Wizard. The wizard
allows you to easily create a tool from an existing part or by using a dummy part
to represent a tool. To create a tool complete with tooldata, follow these steps:

1 Click Create Tool.
2 In the Tool Name box, enter a tool name and choose one of the following

options:

ActionOption

Select one of the existing parts from the list. The selected
part will represent the tool graphics.

Use Existing

The selected part must be a single part. Parts with attach-
ments cannot be selected.

A cone will be created to represent the tool.Use Dummy

3 Continue entering theMass of the tool, theCenter of Gravity and theMoment
of Inertia Ix, Iy, Iz, if these values are known.

Note

If you do not know the correct values, the tool can still be used for
programming motions, but this data must be corrected before running the
program on real robots or measuring cycle times.

Tip

If the tool is built from materials with a similar density, you can find the
center of gravity by clicking the tool model using the Center of gravity
snap mode.

4 Click Next.
5 In the TCP Name box, enter a name for the Tool Center Point (TCP).

Note

The default name is the same as the name of the tool. If creating several
TCPs for one tool, each TCP must have a unique name.

6 Enter the position of the TCP relative to the world coordinate system, which
represents the tool mounting point, by any of the methods below:

DescriptionMethod

Click in the Values from Target/Frame box, then select
the frame either in the graphics window or the
Paths&Targets browser.

Read values from exist-
ing target or frame
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DescriptionMethod

In the Position and Orientation boxes, type the values.Enter position and orient-
ation manually. If Use Dummy Part is selected, the position value can not

be 0,0,0. At least one coordinate has to be > 0 in order for
a cone to be created.

7 Click the arrow right button to transfer the values to the TCP(s): box.
If the tool shall have several TCPs, repeat steps 5 to 7 for each TCP.

8 Click Done.
The tool is created and appears in the Layout browser and in the graphics
window.

Creating tooldata for an existing geometry
Ensure to select the robot in which tooldata is created. To create tooldata for an
existing geometry, follow these steps:

1 Click Create Tool and select Use Existing and the imported tool from the
list.

2 Enter the requested data in the boxes in the Create Tool Wizard.
3 Attach the tool by dragging it to the robot.

What to do next
To make the tool ready to use, do one of the following:

• To make the robot hold the tool, attach the tool to the robot.
• In the graphics window, check the position and orientation of the TCP. If it

is incorrect, modify the values in the tool frame part of the tooldata.
• To simplify future usage of the created tool, save it as a library. On the File

menu, click Save As Library. Browse to the folder where you want to store
the tool component, enter a name for the tool component and click Save.

346 Operating manual - RobotStudio
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

9 Modeling tab
9.18 Create Tool
Continued



9.19 Physics Tools

Overview
Use the Physics feature to include physics simulation together with the traditional
robot simulation/programming tools. When you apply physics behavior to various
RobotStudio objects like, joints, cable, parts and so on, they will follow the rules
of physics during simulation.

Note

Cable simulation works only for the 64 bit version of RobotStudio.

Creating a cable
1 In the Modelling tab, in the Create group, click Cable to create a cable, the

Create Cable pane opens, set cable properties like length, radius, material
and so on here.
You can also create a cable from the Physics contextual tab.

2 Click to add the start and end points of the cable in the station/robot.
3 Select a point on the cable, and drag it to add control point. You can also set

the control point in theCreate Cable pane. The control point can be any Free
Point or an Attached Point. You can attach the cable to any objects using
the Attached to list box in the Create Cable pane.

4 Click Create to the new cable gets displayed in the Layout browser.

Setting the properties of materials
Select one of the following options to set/edit the material of cable.

• In the Physics contextual tab, in Rigid Bodies group, click Material. The
Physics Material pane opens. You can select your material either from the
standard material list or can use custom material. Click the Edit Materials
option to edit material properties.

• In the Modelling browser, right-click a part and then click Physics\Material\
Material Properties to open the Physics Material pane. You can select your
material either from the standard material list or can use custom material.
Click the Edit Materials option to edit material properties.

Modifying length of a cable
1 In the Layout browser, right-click cable, then clickModify Cable. TheModify

Cable pane opens.
2 Edit the required parameter and click Apply.

Click options Shorter or Longer to stretch or skew the cable.
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Applying Behavior to objects
Use the behavior feature to set various motion related characteristic to a
RobotStudio object. A physics object follows the rules of physics during simulation.
In the Layout browser, right-click a part and then select Physics to set various
behavior options.The following setting are possible.

• Inactive: This object will not interact with other objects during simulation.
• Fixed: The position of the object remains fixed during simulation.
• Kinematic: During simulation, RobotStudio controls the motion of the object.
• Dynamic: During simulation the object follows rules of physics while in motion.

Similarly any joint created using the Physics Joint options will follow rules of
physics. These options are Rotational joint, Prismatic joint, Ball joint and Lock
joint.
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10 Simulation tab
10.1 Overview

The Simulation tab
The Simulation tab contains the controls for setting up, configuring, controlling,
monitoring and recording simulations.
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10.2 Create Collision Set

Overview
A collision set contains two groups, Objects A and Objects B, in which you place
the objects to detect any collisions between them. When any object in Objects A
collides with any object in Objects B, the collision is displayed in the graphical view
and logged in the output window. You can have several collision sets in the station,
but each collision set can only contain two groups.

Creating a collision set
1 Click Create Collision Set to create a collision set in the Layout browser.
2 Expand the collision set and then drag one of the objects to the ObjectsA

node to check for collisions.
If you have several objects you want to check for collisions with objects in
the ObjectsB node, for example, the tool and the robot, drag all of them to
the ObjectsA node.

3 Drag the objects to the ObjectsB node to check for collisions.
If you have several objects you want to check for collisions with objects in
the ObjectsA node, for example, the work piece and the fixture, drag all of
them to he ObjectsB node.

Tip

Selecting a collision set or one of its groups (Objects A or Objects B) highlights
the corresponding objects in the graphical window and the browser. Use this
feature to quickly check what objects have been added to a collision set or to
one of its groups.
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10.3 Simulation Setup

Overview
The Simulation Setup dialog box is used to perform the following two main tasks.

• Setting up the sequence and entry point in the robot program
• Creating simulation scenarios for different simulated objects

Prerequisites
To set up a simulation, the following conditions must be met:

• At least one path must have been created in the station.
• The paths to be simulated must have been synchronized to the virtual

controller.

Setup simulation pane
From this pane, you can perform the combined task of configuring the program
sequence and program execution such as entry point, and running the execution
mode.
You can create simulation scenarios containing different simulated objects and
connect each scenario with a predefined state to ensure that the correct state is
applied to all project objects before running the scenario. If you want to simulate
a specific part or segment of the cell where not all simulated objects in the cell are
included, you can set up a new scenario and add only the objects needed for
simulation.
The Setup simulation pane consists of the following:

DescriptionOption

Lists all active station scenarios.
• Add: Click to add a new scenario.
• Remove: Click to delete the selected scenario.
• Rename: Click to rename the selected scenario.

Active Simulation scen-
ario

Initial state of the simulation.Initial state

Opens the Station Logic pane.Manage states

Displays all objects that can be part of a simulation. Objects that
utilize simulation time can be part of a simulation. For example,
Virtual Controllers and Smart Components. When you create a
new scenario, all objects are selected by default.

Simulated objects

• Time slice: This option makes RobotStudio always use the
time slice mode.

• Free run: This option makes RobotStudio always use the
free run mode.

Virtual time mode

Setting up a simulation
1 Click Simulation Setup to bring up the Setup Simulation pane.
2 Select the tasks to be active during simulation in the Select Active Tasks

box.
3 Select the run mode as either Continuous or Single Cycle.
4 From the Simulated Objects list select the task.
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5 Select the entry point from the Entry point list.
6 Click Edit to open the RAPID program where the user can edit the procedure.

Creating simulation scenarios
1 Click Simulation Setup to bring up the Setup Simulation pane.
2 Under Active Simulation Scenario ,

• Click Add to create a new scenario in the Simulated objects box.
• Click Remove to delete the selected scenario from the Simulated

objects box.
3 Select a saved state for the scenario from the Initial state list.
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10.4 Event Manager

Creating an event
1 Click Event Manager.
2 Click Add to open the New Event Wizard.
3 Complete the New Event wizard to create the event.

Event manager main parts

eventman

DescriptionPart

The Task pane.1
Here you create new events, or copy or delete existing events selected in
the Event grid.

The Event grid.2
Displays all events in the station. Here you select events to edit, copy or de-
lete.

The Trigger editor.3
Here you edit the properties of the events trigger. The upper part of the trigger
editor is the same for all triggers, and the lower part adapts to the selected
trigger type.

The Action editor.4
Here you edit the properties of the events action. The upper part of the action
editor is the same for all actions, and the lower part adapts to the selected
action type.

The task pane parts

DescriptionPart

Starts the Create New Event Wizard.Add

Deletes the event selected in the Event grid.Delete

Copies the event selected in the Event grid.Copy

Refreshes the Event manager.Refresh

Export

Import
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The event grid columns
In the event grid, each row is an event and the columns in the grid display their
properties.:

DescriptionColumn

Displays whether the event is active or not.
• On: The action is always carried out when the trigger

event occurs.
• Off: The action is not carried out when the trigger event

occurs.
• Simulation: The action is only carried out if the trigger

event occurs when running a simulation.

Activation

Displays the type of condition that triggers the action.
• I/O signals changed: Changes a digital I/O signal.
• I/O Connection: Simulates the behavior of a Program-

mable Logic Controller (PLC).
• Collision: Starts or ends a collision or near-miss

between objects in a collision set.
• Simulation time: Sets the activation time.

Note

The Simulation time button is enabled once the activation is
set to Simulation.

Trigger Type

The trigger type cannot be changed in the trigger editor. If you
want another trigger type than the current one, create a com-
pletely new event.

When the trigger type is I/O Signal Trigger, this column displays
to which system the signal used as trigger belongs.

Trigger System

A dash (-) signifies a virtual signal.

The name of the signal or collision set used as trigger.Trigger Name

Displays the condition of the event under which triggering oc-
curs.

• 0: The I/O signal used as trigger switches to false.
• 1: The I/O signal used as trigger switches to true.
• Started: A collision starts within the collision set used

as trigger.
• Ended: A collision ends within the collision set used as

trigger.
• Nearmiss started: A near-miss starts within the collision

set used as trigger.
• Near miss ended: A near-miss ends within the collision

set used as trigger.

Trigger Parameter
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DescriptionColumn

Displays the action type that occurs in conjunction with the
trigger

• I/O Signal Action: Changes the value of a digital input
or output signal.

• Attach Object: Attaches an object to another.
• Detach Object: Detaches an object from another.
• TurnOn/Off SimulationMonitor: Toggles the simulation

monitor of a specific mechanism.
• Turn On/Off Timer: Toggles the process timer.
• MoveMechanism to Pose: Moves the selected mechan-

ism to a predefined pose and thereafter sends a station
signal. Activates or deactivates the process timer.

• Move Graphical Object: Moves a graphical object to a
new position and orientation.

• Show/Hide Graphical Object: Shows or hides the
graphical object.

• Do Nothing: No action occurs.
• Multiple: The event triggers multiple actions, either all

at once or one at a time, each time the trigger is activ-
ated. Each action can be viewed in the action editor.

Action Type

When the action type is Change I/O, this column displays the
system to which the signal to change belongs.

Action System

A dash (-) signifies a virtual signal.

Displays the name of the signal to change, when the action
type is Change I/O.

Action Name

Displays the condition after the action has occurred.
• 0: The I/O signal will be set to false.
• 1: The I/O signal will be set to true.
• On: Turns the process timer on.
• Off: Turns the process timer off.
• Object1 -> Object2: Displays the object to which another

will be attached when the action type is Attach object.
• Object1 <- Object2: Displays the object from which an-

other will be detached when the action type is Detach
object.

• Ended: A collision ends within the collision set used as
trigger.

• Nearmiss started: A near-miss starts within the collision
set used as trigger.

• Near miss ended: A near-miss ends within the collision
set used as trigger.

• Multiple: Signifies multiple actions.

Action Parameter

Displays the time when the event trigger was executed.Time
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The trigger editor parts
In the trigger editor you set the properties of the trigger. The upper part of the editor
is common for all types of triggers, and the lower part adapts to the trigger type at
hand.

Parts common to triggers

DescriptionPart

Sets whether the event is active or not.
• On: The action is always carried out when the trigger

event occurs.
• Off: The action is not carried out when the trigger event

occurs.
• Simulation = The action is only carried out if the trigger

event occurs when running a simulation.

Activation

Text box for comments and notes about the event.Comments

Parts specific to I/O signal triggers

DescriptionPart

Select the system to which the I/O to use as a trigger belongs.Active Controller

Displays all signals that can be used as triggers.Signals

For digital signals, sets whether the event shall trigger when
the signals are set as true or false.

Trigger Condition

For analog signals, which are only available for station signals,
the event shall trigger under any of the following conditions:
Greater than, Greater/Equal, Less than, Less/Equal, Equal
to, Not equal to.

Parts specific to I/O connection triggers

DescriptionPart

Opens a dialog box for adding an activator signal to the Activ-
ator Signals pane.

Add

Removes a selected activator signal.Remove

Opens a dialog box for adding an operator symbol to the Con-
nections pane.

Add >

Removes a selected operator symbol.Remove

Specifies the delay in seconds.Delay (s)

Parts specific to Collision triggers

DescriptionPart

Set the kind of collision to use as trigger.
• Started: Triggers when a collision starts.
• Ended: Triggers when a collision ends.
• Near miss started: Triggers when a near-miss starts.
• Near miss ended: Triggers when a near-miss ends.

Collision Type

Select the collision set to use as trigger.Collision set
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The action editor parts
In the action editor you set the properties of the actions for the event. The upper
part of the editor is common to all types of actions, and the lower part adjusts to
the selected action.

Parts common to all actions

DescriptionPart

Adds a new action that occurs when the triggering condition
fulfills. You can add several different actions that either are
performed at once or one at a time each time the event triggers.
The following types of actions are available:

• Change I/O: Changes the value of a digital input or out-
put signal.

• Attach object: Attaches an object to another.
• Detach objeect: Detaches and object from another.
• Turn On/Off Timer:Activates or deactivates the process

timer.
• Do Nothing: No action occurs (might be useful for ma-

nipulating sequences of actions).

Add Action

Removes the action selected in the Added Actions list.Remove Action

When selected, the actions are performed one at a time each
time the trigger occurs. When all actions in the list have been
performed, the event will restart with the first action in the list.

Cyclic

When cleared, all actions are performed at once every time the
trigger occurs.

Lists all actions of the event, in the order they will be executed.Added Actions

Rearranges the order in which the actions are executed.Arrow

Parts specific to I/O Actions

DescriptionPart

Displays all systems of the station. Select the system to which
the I/O to change belongs.

Active Controller

Displays all signals that can be set.Signals

Sets whether the event shall set the signals to true or false.Action
If the action is connected to an I/O Connection, this group will
not be available.

Parts specific to Attach actions

DescriptionPart

Select an object in the station to attach.Attach object

Select the object in the station to attach to.Attach to
• Update position = Moves the local origin of the attached

object to the attachment point of the other object when
making the attachment. For mechanisms, the attachment
point is the TCP or the flange; for other objects, it is the
local origin.

• Keep position = Keeps the current position of the object
to attach when making the attachment.

Update position / Keep
position

If the mechanism you attach the object to has several flanges
(attachments points), select the one to use.

Flange index
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DescriptionPart

Optionally, specify an offset between the objects when making
the attachment

Offset Position

Optionally, specify an offset between the objects when making
the attachment

Offset Orientation

Parts specific to Detach actions

DescriptionPart

Select an object in the station to detach.Detach object

Select the object in the station to detach from.Detach from

Parts specific to Turn On/Off Simulation Monitor actions

DescriptionPart

Selects the mechanism.Mechanism

Sets whether the action shall start or stop the simulation
monitor function.

Turn Simulation Monitor
On/Off

Parts specific to Turn On/Off Timer actions

DescriptionPart

Sets whether the action shall start or stop the process timer.Turn On/Off Timer

Parts specific to Move Mechanism to Pose actions

DescriptionPart

Selects the mechanism.Mechanism

Selects between SyncPose and HomePose.Pose

Lists the station signals that are sent after the mechanism
reaches its pose.

Station signal to set when
Pose reached

Click this button to add a digital signal to the grid.Add Digital

Click this button to remove a digital signal from the grid.Remove

Parts specific to Move Graphical Object actions

DescriptionPart

Select a graphical object in the station to move.Graphical Object to Move

Sets the new position of the object.New Position

Sets the new orientation of the object.New Orientation

Parts specific to Show/Hide Graphical Object actions

DescriptionPart

Select a graphical object in the station.Graphical Object

Sets whether the object is shown or hidden.Show/Hide
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10.5 Station Logic

Introduction to Station Logic
The Station Logic has some of the characteristics of a Smart Component. It can
be used to work with these characteristics on the station level.
The Station Logic editor consists of the following tabs similar to that of a Smart
Component editor:

• Compose
• Properties and Bindings
• Signals and Connections
• View

For more information on the characteristics of a Smart Component editor, see
Smart Component on page 284.

Opening Station Logic
You can launch Station Logic in any of the following two ways:

• In the Simulation tab, click Reset and select Manage States.
• In the Layout browser, right-click the station and select Station Logic.

Differences between Station Logic and Smart Component
The following table lists some of the differences while working with Station Logic
and a Smart Component:

Station LogicSmart Component

The Editor window do not have the descrip-
tion text box wherein the description can be
modified.

The Editor window consists of a text box
displaying the description of the component
that is used for modifying the text.

The Compose tab has the following options:
• Child components
• Saved States

The Compose tab has the following options:
• Child components
• Saved States
• Assets

The Properties and Bindings tab has the
following options:

• Property Bindings

The Properties and Bindings tab has the
following options:

• Dynamic Properties
• Property Bindings

You can create connections to and from I/O
signals in a VC.

In the Signals and Connections tab, when
working with Add or Edit I/O Connections,
you do not have the option of selecting the
VCs in the station from the the SourceObject
and Target Object list.

In the Signals and Connections tab, when
working with Add or Edit I/O Connections,
you have the option of selecting the VCs in
the station from the the Source Object and
Target Object list.
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10.6 Activate Mechanical Units

To activate or deactivate mechanical units manually
1 Click Activate Mechanical Units to bring up a dialog box.
2 In the Activate Mechanical Units dialog box, select the check boxes for the

mechanical units to set as active. When activating a mechanical unit that
shares a common drive unit, the other mechanical unit sharing that drive unit
will be deactivated automatically.
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10.7 Simulation Control

Running a simulation
1 In the Simulation Control group,

to...Click...

start and resume the simulation.
• The Pause button is enabled once you start the

simulation
• The Play button is changed to Resume once you

pause the simulation.
• Click Resume to resume the simulation.

Play/Resume

start the simulation and to record it to a Station Viewer.Play and select Record
to Viewer The Save As dialog box appears where the simulation is

saved.

pause and step the simulation.
• The Pause button is changed to Step once you start

the simulation.
• Click Step to run the simulation in steps.

You can set the simulation timestep. See Options:Simula-
tion:Clock on page 223.

Pause/Step

reset the simulation to its initial state. See Resetting sim-
ulation on page 361.

Reset

Note

When running a simulation in time slice mode, all breakpoints set in the
RAPID editor windows will be deactivated temporarily.

Note

During the simulation play, if a user does not want more objecs to be added
to the conveyor, in Layout browser, expand the conveyor node, then
right-click the object source and clear the Enabled option.

Resetting simulation
1 In the Simulation Control group, click Reset to reset the simulation.
2 ClickReset and select Save Current state to store states of objects and VCs

to be used in a simulation scenario. For more information, see Save Current
State on page 287.

3 Click Reset and select Manage states to launch Station Logic. For more
information, see Station Logic on page 359.
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10.8 I/O Simulator

Setting I/O signals using the I/O Simulator
1 Click I/O Simulator. This opens the I/O simulator.
2 If the station contains several systems, select the appropriate one in the

Select System list.
3 In the Filter list and I/O Range list, make selections that display the signals

to set. Depending on the filter used, you might also set a filter specification.
4 To change the value of a digital I/O signal, click it.

To change the value of an analog signal, type the new value in the value box.

The I/O Simulator window
With RobotStudio’s I/O simulator window, you can view and manually set existing
signals, groups and cross-connections during program execution, thus making it
possible to simulate or manipulate the signals.
The I/O simulator window displays the signals for one system at a time, in groups
of 16 signals. For handling large sets of signals, you can filter which signals to
display and also create custom lists with favorite signals for quick access.

io_overv

DescriptionPart

Select System. Select the system whose signals you want to view.1

Filter type. Select the type of filter to use.2

Continues on next page
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DescriptionPart

Filter Specification. Select the filter for limiting the signal display. For ex-
ample, if Board is set as filter type, then you select the board whose signals
you want to view.

3

Inputs. Displays all input signals that pass the applied filter.4
If more than 16 signals pass, only 16 signals at a time are displayed. Then
use the I/O range list to select the signals to view.

Outputs Displays all output signals that pass the applied filter. If more than
16 signals pass, only 16 signals at a time are displayed. Then use the I/O
range list to select the signals to view.

5

Edit Lists. Click this button to create or edit lists of favorite signals.6

I/O Range. When more than 16 signals pass the filter, use this list to select
the range of signals to display.

7

Types of signal filters

DescriptionFilter

Displays all signals on a specific board. To select a board, use
the Filter Specification list.

Board

Displays all signals that belong to a specific group. To select
a group, use the Filter Specification list.

Group

Displays all signals in a favorite list. To select a list, use the
Filter Specification list.

User List

Displays all digital input signals of the system.Digital Inputs

Displays all digital output signals of the system.Digital Outputs

Displays all analog input signals of the system.Analog Inputs

Displays all analog output signals of the system.Analog Outputs

Signal icons

Digital signal with value 1.

value 1

Digital signal with value 0.

value zero

The cross in the upper right corner indicates that the signals
are a cross-connection.

cross connec

The -1 in the upper right corner indicates that the signal is in-
verted.

inverted

Value box for groups or analog signals.

value box
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10.9 Monitor

The TCP Trace tab

Select this check box to activate tracing of the TCP path for
the selected robot.

Enable TCP Trace

Select this check box to activate tracing of moving workobject.Follow moving Workob-
jects

Select this check box to remove the current trace when simu-
lation starts.

Clear trace at simulation
start

You can set the color of the trace here.Primary color

Select this check box to assign a particular color to the TCP
path of the selected signal.

Color by signal

Select this button to define how the trace shall be colored. As
the signal changes between the values defined in the From
and To boxes, the color of the trace also varies according to
the color scale.

Use color scale

You can assign a color to the trace which gets displayed when
the signal value meets the specified conditions.

Use secondary color

Select this check box to view events along the trace.Show events

Click this button to remove the current trace from the graphics
window.

Clear TCP traces

The Alerts tab

Select this check box to activate simulation alerts for the selec-
ted robot.

Enable Simulation Alerts

Select this check box to see a warning message when a
threshold value is exceeded. If TCP trace is not enabled, this
is the only display of the alert.

Log Alerts to Output Win-
dow

Specify the threshold value for TCP speed alerts.TCP Speed

Specify the threshold value for TCP acceleration alerts.TCP Acceleration

Specify how close joint five can be to zero rotation before
alerting.

Wrist Singularity

Specify how close each joint can be to its limits before alerting.Joint Limits
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10.10 Stopwatch

Stopwatch for measuring process time
The Stopwatch feature is used for measuring the time taken between two trigger
points in a process, and also for the process as a whole. The two trigger points
are called the Start Trigger and the End Trigger.
When a stopwatch is setup, the timer starts when the Start Trigger occurs, and
stops when the End Trigger occurs.

Setting up a Stopwatch
1 On the Simulation tab, in the Monitor group, click Stopwatch.

The Stopwatch settings dialog appears.
2 Specify a Name for the stopwatch.
3 Select a Start Trigger and an End Trigger for the stopwatch.

The following parameters are listed for selection as triggers:
• Simulation Start
• Simulation Stop
• Target Changed

Additionally, specify the mechanical Unit and the target.
• I/O Value

Additionally, specify the source mechanical unit from where the signal
comes, the type of I/O signal and the value of the signal.

4 Click Add.
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10.11 Signal Analyzer

10.11.1 Signal Analyzer for both real and virtual controllers

The Signal Analyzer functionality helps in displaying and analyzing signals from
a robot controller. Using the Signal Analyzer, you can optimize the robot program.
The Signal Analyzer functionality is present for both virtual and real controllers.
The version adapted for real controllers is called Signal Analyzer Online. The
following section describes the Signal Analyzer functionality for virtual controllers,
though it includes certain common features.
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10.11.2 Signal Setup

Overview
This feature allows you to configure the signals to be saved for the next simulation.
The signals are recorded from the controller information stream and are stored in
the station.

Layout of Signal Setup
The Signal Setup window displays all the signals available for recording. It also
displays the signals selected for recording.
The Signal Setup window has the following options:

• Select Signals view
• Current Setup view
• Refresh

Select Signals view
Displays all the available source signals. By default, the source tree is expanded.
In the source tree, you can select the check-box and add the signal to the Current
Setup view.
The signals are organized in a hierachical tree structure. You can expand or collapse
the nodes (except the signal nodes which are at the lowest level) either from the
context menu or double-click the node.

Current Setup view
Displays all the selected signals.
To remove a signal, Right-click the signal and select Delete.

Refresh
The Signal Setup window, by default, will be updated automatically, if a signal is
added or removed. However, in some cases, a manual refresh may be needed.
In the Signal Setup window, click Refresh to ensure all signals are displayed in
the window.

Available signals
The following tables show the signals that are available for setting up. You can
subscribe to a maximum of 12 signals simultaneously.

Available signalsCategory

Total Motor Power. See the description
provided after this table.

Controller Signals

Total Power Consumption. See the descrip-
tion provided after this table.

All domainsEventLog

All signalsI/O System

J1-J6Joint

Near Limit. See the description provided after
this table.
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Available signalsCategory

Fine PointTarget

Target Changed , Tool Changed, Workobject
Changed

Maximum Linear Acceleration in WorldTCP

Orientation Q1-Q4 Current Workobject

Orientation Speed in Current Workobject

Pos X, Y, Z in Current Workobject

Robot Configuration cf1, cf4, cf6, cfx

Speed in Current Workobject

Zone Entered, Zone Left

TCP

All signalsSmart Components

Total Motor Power
The Total Motor Power signal shows the total instantaneous power for each joint.
It may be positive or negative.
The instantaneous power for a specific joint is positive when it accelerates and
negative when it decelerates. If one joint is accelerating at the same time as another
joint is decelerating, then the negative energy from the decelerating joint is reused
by the accelerating joint. If the sum of the instantaneous power of all joints is
negative then the power surplus cannot be reused but it is burned off in the bleeder.
For a virtual robot the signal is based on a nominal robot during typical conditions,
for a real robot the signal is based on the torque for that particular robot in the
actual conditions. For a real robot the value of the motor power signal depends on
various factors, for example, the temperature of the robot and the length of the
cables.

Note

Total Motor Power signal represents the power consumed by the mechanical
robot arm and not the power that is fed into the controller cabinet from the power
network. The power used by the controller cabinet is excluded.

Total Motor Energy
The Total Motor Energy signal is the cumulative sum of the positive part of the
Total Motor Power.
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Purpose of signals
The purpose of the Total Motor Power and Total Motor Energy signals is to provide
an estimate of the power and energy used by the robots. For virtual robots, these
signals can be used to identify peaks in the power usage to enable the robot
programmer to adjust the robot program with the aim to reduce the power
consumption. For real robots, the signals can be used to compare the power usage
of different robot individuals running the same robot program, to see if any robot
differs significantly from the others. Any such deviation may indicate that the robot
needs maintenance.

Near Limit
Near Limit checks the distance to the closest limit for each joint. If any joint is less
than 20 degrees from a limit, the Near Limit signal will show the current value.
Otherwise, the value of the signal will be constant at 20 degrees. If more than one
joint is below 20 degrees from a limit, then the one that is closest will be looked
at.

Setting up the signals
Use this procedure to configure the signals to be saved for the next simulation:

1 Load a station with system. See New tab on page 211 .
2 In the Simulation tab, click Signal Analyzer and select Signal Setup.

The Signal Setup window appears.
3 In the Select Signals view, select the signals to be configured and stored

for simulation.
The selected signals are added in the Current Setup window.

4 In the Current Setup view, right-click Station Database and select Enabled.
This ensures that all selected signals will be recorded whenever a simulation
is running.

Note

• Disabling the station database will stop the recording but stores the
configuration and all completed recordings in the station.

Note

• You can analyze the recorded signals. See Layout and usage on
page 371.

• You can organize the saved signal data. See History on page 374.
• Disable signal recording as soon as the analysis is completed to avoid

the station file size to increase.
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Note

It is not possible to subscribe to signals connected to a unit of type
LOCAL_GENERIC. Attempting to do so produces this error message in
the Output window:
Failed to subscribe on signal:
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10.11.3 Layout and usage

Layout of Signal Analyzer
The following figure shows the layout of the Signal Analyzer

en1100000034

Displays a toolbar with options to configure and to work with
the Signal Analyzer.

Toolbar1

Displays a colored bar representing a segment where the signal
is set.

Digital signal values2

Displays analog and numeric signal values.Analog signal values3

Displays discrete events, such as EventLog messages.Events4

Displays information about all recorded signals for the current
data session.

Signals table5

Toolbar
The toolbar displays the following options:

DescriptionOption

For selecting the signal recording to be displayed. These sig-
nals are also available in Signal History. See History on
page 374.

Drop-down list

For moving the time forward and backward.Timer slider

For zooming in / out the time axis.Zoom in/out buttons

For enabling data to be shown live, that is, as recorded during
a simulation.

Live data button

For displaying the crosshairs following the mouse.Crosshair

For enabling / disabling vertical axis autoscaling.Auto scale button

For displaying the line markers for each sample in the analog
/ numeric graph.

Line marker button

For exporting the data to a file.Save button
The data can be saved in Microsoft Excel 2007 format and tab
delimited text format.
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Digital signal values
It displays one row per digital signal, showing the signal state over time. A solid
colored bar indicates the signal is set (value=1), otherwise the signal is cleared
(value=0). The signal name is displayed to the left.
Move the mouse over the colored bars to view additional information like the time
stamps when the signal was set and reset.

Analog signal values
It displays a 2D line graph for each analog signal. It consists of the following:

• Left-side vertical axis
• Horizontal axis displaying time in seconds
• Plot area displaying the signal graphs
• Optional right-side vertical axis.

You can configure the individual signals to use the right-side vertical axis scale
from the signals table at the bottom of the window. This axis is hidden by default.
The following actions can be performed in this segment:

• Scale the vertical axes: If you select the autoscale button in the toolbar, then
the vertical axes will automatically scale to ensure that the line graphs are
visible. You can modify the vertical scale using the mouse if the cursor is
over the axis value area. This automatically deselects the autoscale button.

• Pan and Zoom time axis: If the cursor is over the central, main area of the
plot, then you can scale, pan, and zoom the time axis using the mouse.

Events
It displays one row per selected event category. Each event is indicated with a
diamond shaped icon. Click this icon to display a popup with more information
about the event.

Signals table
Displays information about each recorded signal. This enables you to configure
settings for each signal such as color, visibility, whether to use left or right vertical
axis and so on.

Using the Signal Analyzer
Use this procedure to analyze the recorded signal data:

1 Set up the signals to be analyzed. See Setting up the signals on page 369.
2 Record signal data by running a simulation. See Setting up the signals on

page 369.
3 In the Simulation tab, click Signal Analyzer.
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The Signal Analyzer window appears.

Note

• If the station does not contain any saved signal data, you will then
have to setup the signals to analyze and record by running a
simulation. See Signal Setup on page 367.

• You can organize the saved signal data. See History on page 374.
• The sample interval of the Signal Analyzer is 24 ms, hence signal

changes within this interval will not be captured.
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10.11.4 History

Overview
This feature displays and helps in organizing saved signal recordings of the current
RobotStudio station.

Layout of Signal History
You can do the following from the Signal History window:

• Click the column header to sort the history in ascending or descending order.
• Click the drop-down to group the history as View By Today or View by Order.

Organizing the Signal History
Use this procedure to organize the signal history:

1 Create a saved signal data in the station. See Setting up the signals on
page 369.

2 In the Simulation tab, click Signal Analyzer and select History.
The Signal History window with all the stored signal history elements are
displayed.

Note

The signal history elements in the Signal History window is updated
automatically whenever the signals are setup and the simulation is started
/ stopped.

3 In the Signal History window, right-click a history element and select:
• Analyze: To open the Signal Analyzer window.
• Export: To save selected history elements to a file.

Note

The maximum number of signals that can be exported to Excel is
limited to 26.

• Delete: To remove the selected signal recording permanently.
• Rename: To rename the signal recording.

Note

Disable signal recording as soon as the analysis is completed to avoid the station
file size to increase.
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10.12 Record Movie

Prerequisites
For optimal results, first configure the options, see Options:General:Screen
Recorder on page 219.

Recording the screen
1 In the Record Movie group, click Record application to capture the entire

application window, orRecord graphics to capture just the graphics window.
2 When you are done, click Stop Recording. A dialog box appears in which

you may choose to save the recording or discard it.
3 Click View Recording to playback the latest capture.

Recording the simulation
1 In the Record Movie group, click Record Simulation to record the next

simulation to a video clip.
2 When you are done, click Stop Recording.

The simulation is saved in a default location which is displayed in the output
window.

3 Click View Recording to playback the recording.
The recording of simulation starts when you click Play in the Simulation tab.

Note

Record Simulation gives better output quality thanRecord application orRecord
graphics.

Operating manual - RobotStudio 375
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

10 Simulation tab
10.12 Record Movie



10.13 Conveyor Tracking Mechanism

10.13.1 Conveyor Tracking

Overview
Conveyor tracking is the function where the robot follows a workobject mounted
on a moving conveyor. This section describes how to create a conveyor, add and
remove objects to and from the conveyor, create targets during tracking, and
simulate conveyor.
RobotStudio does not support tracking of circular conveyors. Only linear conveyors
are supported. For more information, see the Application manual - Conveyor
tracking.

Conveyor tracking mechanism
This procedure describes the workflow for making a conveyor tracking system
work in RobotStudio.

1 Create a conveyor mechanism. See Create Conveyor on page 338.
2 Setup the conveyor. See Adding objects to the conveyor on page 229.

For information on setting up a conveyor tracking station with two robots
working on the same conveyor, see Setting Conveyor tracking on page 85.

3 Jog the conveyor as well as the robot and teach some targets. See
Mechanism Joint Jog on page 509.

4 Simulate the conveyor. See Conveyor Simulation on page 377.
5 Remove objects from conveyor. See Removing objects from conveyor on

page 230.
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10.13.2 Conveyor Simulation

Running a conveyor simulation
1 Create Action Instructions. See Action Instruction on page 260.

Create the following five action instructions along with Move instructions:
ConfL\Off,ActUnit CNV1,WaitWObj Workobject_1,

DropWObjWorkobject_1 and DeactUnit CNV1.
The following program is an example showing how the sequence of
instructions appears:
ConfL\Off;

MoveJ p0, vmax , fine, tool1;

ActUnit CNV1;

WaitWObj wobjcnv1;

MoveL p10, v1000, z1, tool1\Wobj :=wobjcnv1;

MoveL p20, v1000, z1, tool1\Wobj :=wobjcnv1;

MoveL p30, v500, z20, tool1\Wobj :=wobjcnv1;

MoveL p40, v500, fine, tool1;

DropWObj wobjcnv1;

MoveL p0, v500, fine;

DeactUnit CNV1;

Note

If an error occurs while executing the program, the controller reaches Guard
state. In this state, RobotStudio cannot execute the program during the
next simulation. To recover from this state, open the Control Panel and
switch to Manual Mode and then to Auto Mode.
For more information, see Application manual - Conveyor tracking.

2 Synchronize to VC. See Synchronize to RAPID on page 445.
3 Set up the simulation. See Simulation Setup on page 351.
4 In the Layout browser, right-click the conveyor mechanism and selectMotion.
5 In the Speed box, set the speed during simulation.

Select the Start and Stop buttons to start and stop the conveyor during
simulation.

6 Click Apply.
7 Click Play to run the simulation.

A RAPID program with Conveyor Tracking must be run with the Play button
in the Simulation tab.
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Note

The conveyor speed and direction can be changed while running the simulation.
To jump the conveyor back to the start position, click Reset. This button remains
enabled as long as the station has at least one conveyor.
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11 Controller tab
11.1 Real and virtual controllers

Overview
The Controller tab contains the controls for managing the real controller and also
the controls for synchronization, configuration and tasks assigned to the virtual
controller.
RobotStudio allows you to work with an off-line controller, which is a virtual IRC5
controller running locally on your PC. This offline controller is also referred to as
the virtual controller (VC). RobotStudio also allows you to work with the real physical
IRC5 controller, which is simply referred to as the real controller.
The features on the Controller tab can be categorized as follows:

• Features for both virtual and real controllers
• Features for real controllers
• Features for virtual controllers

For more information on working with a real controller, see Working online on
page 155.
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11.2 Features for both virtual and real controllers

11.2.1 Add Controller

Adding and connecting to a controller
You can connect to real or virtual controller using the Add Controller button.
To connect to a real controller, on the Controller tab click the arrow next to the
Add Controller icon, and then click one of the following commands as per your
requirement:

• One Click Connect - For connecting to the service port of the controller
• Add Controller - For adding available controllers to the network

Note

For connecting RobotStudio to a real controller over the Ethernet (LAN), the
controller system must have the RobotWare option PC-interface. This option is
not required when connecting through the service port.

To start and connect to a virtual controller, on the Controller tab click the arrow
next to the Add Controller icon, and then click Start Virtual Controller.

One Click Connect
The One Click Connect feature allows connecting to a robot controller, that is
connected to the service port, in a single step. You need to do the following before
using this feature:

• Connect the computer to the controller service port.
• Ensure that the network settings on the PC is correct. DHCP should either

be enabled or the IP address should have a specific value. For more
information on network settings, see Network settings on page 159.

On the Controller tab, click the arrow next to the Add Controller icon, and then
click One Click Connect.

Add Controller
1 In the Controller tab, click Add Controller to bring up a dialog box in which

all available controllers are listed.
2 If the controller is not found in the list, type its IP address in the IP Address

box, and then click Refresh.
3 Select the controller in the list and click OK.

Add Remote Controller
1 In the Controller tab, click Add Controller to bring up a dialog box in which

all available controllers are listed.
2 If the controller is not found in the list, type its IP address in the Remote

Controller box, and then click Add.
3 Select the controller in the list and click OK.
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Start Virtual Controller
The Start Virtual Controller command allows you to start and stop a virtual
controller, using a given system path and without needing a station.

Tip

You can use the Start Virtual Controller command when you require a virtual
controller as emulator while developing PC SDK or RobotWare add-ins. You can
also use this command when you need to use the Configuration editor or the
RAPID editor without requiring a station.

Clicking Start Virtual Controller under Add Controller opens the Start Virtual
Controller dialog box. In this dialog box, specify the following:

1 In the System Pool drop-down list specify the location and folder of your PC
where the required virtual controller systems are stored.
To add a folder to this list, click Add and then browse to and select the folder
to be added. To remove a folder from the list, click Remove.

2 The Systems Found table lists the virtual controller systems found in the
selected system folder. Click a system to select it for starting.

3 Select the required check boxes:
• Reset system, to start the VC with the current system and the default

settings
• Local login
• Handle Write Access automatically

Note

A virtual controller system that has been modified using theModify System
function of the System Builder must be restarted with the Reset System
option for the changes to take effect.

Low Bandwidth mode
The low bandwidth mode is useful when connecting RobotStudio to a controller
over a network connection with limited bandwidth. It reduces controller
communication to a fraction of the regular connection mode.

Note

RobotWare version installed in the controller and in the connecting PC must be
same.

You can select the low bandwidth mode while connecting to the controller through
the Add controller dialog.

Continues on next page
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Limitations
In low bandwidth mode;

• the signal analyzer gets disabled.
• system requires manual refresh to update the I/O Viewer, RAPID Watch

window, RAPID Program Pointer, Online Monitor and FlexPendant Viewer
in RobotStudio with the current controller status, hence manual buttons are
added to initiate the refresh.

• semantic check in the RAPID editor will be restricted.
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11.2.2 Events

Overview
You can view events in the Event log. The severity of each event is indicated by
its background color; blue for information, yellow for warning and red for an error
which needs to be corrected to proceed.
On theController tab in theController Tools group, click Events to view the Event
log.

Event log
You can perform the following operations on the Event log.

DescriptionsAvailable opera-
tions

Click any event to see a brief description about the event.View

The Auto Update check box is selected by default, so that new events
appear in the list as they occur.

Automatic update

Clear the check box to disable automatic update. Selecting it again,
fetches and displays the events missed while it was cleared.

You can filter the event log list based on the category of the event or
based on any text in its displayed details.

Filter

To filter the list based on any required text, specify it in the Text box.
Use theCategory drop-down list to filter based on the events categories.
The event categories are: Common, Operational, System, Hardware,
Program, Motion, I/O & Communication, User, Internal, Process, Config-
uration and RAPID.

Click Save, to save the event records of the selected event categories
to log files on the computer.

Save

Select the Log to file check box to enable all events currently in the
Common Event Log to be saved to a log file.

Log to file

The log file will be updated with all new events as they occur.

Operating manual - RobotStudio 383
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

11 Controller tab
11.2.2 Events



11.2.3 Inputs/Outputs

Overview
You can view and set input and output signals in the I/O System window.
To open this window, on the Controller tab, in the Controller Tools group, click
Inputs/Outputs.

Note

For details on local I/O and its features, refer Application manual Local I/O.

I/O System window
The following details of I/O signals are available in the I/O System window:

DescriptionColumn

Shows the name of the signal, name is set by the device's configuration
and cannot be changed from the I/O system.

Name

Shows the type of signal using the abbreviations listed in the following
table.

DescriptionAbbreviation

Digital input signal.DI

Digital output signal.DO

Analog input signal.AI

Analog output signal.AO

Group of signals, working as one input signal.GI

Group of signals, working as one output signal.GO

Type

The signal type is set by the device's configuration and cannot be
changed from the I/O system.

Shows the value of the signal, double-click the signal row to edit the
value.

Value

Shows the minimum value of a signal.Min Value

Shows the maximum value of a signal.Max Value

Shows the simulation status of a signal. When a signal is simulated, you
can specify a value that overrides the actual signal value.

Logical State

You can change the logical state of a signal from the I/O system by
turning the simulation ON/Off.

Shows device to which the signal belongs.Unit
This is set by the device's configuration and cannot be changed from
the I/O system.
You can view this field in RobotWare 6.0 or before.

Shows the industrial network to which the signal belongs.Bus
This is set by the industrial network configuration and cannot be changed
from the I/O system.
You can view this field in RobotWare 6.0 or before.

Shows whether the I/O device is simulated on the industrial network it
is connected to.

Simulated
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DescriptionColumn

Shows the industrial network to which this I/O device is physically con-
nected.

Network

Shows the logical representation of the real I/O device.Device

Shows the bit(s) to which the I/O signal is mapped in the I/O memory
map of the assigned I/O device.

Device Mapping

Shows a free-text categorization to an I/O signal.Category

Shows the Signal Identification Label as defined in the I/O Configuration
database.

Label

It is possible to sort signals according to the signal properties. In the I/O System
window, click the particular field to sort signals according to the field. If you press
the SHIFT key and click multiple column headers then the columns will be sorted
by the order clicked.

I/O System window view
Use the following parameters to set the view of the I/O system window.

• Name and Label: Use the free-text edit boxes above these columns. The
resulting view will show signals that contain the entered text string in the
respective field.

• Simulated: Select this check box to view simulated signals only
• Unit, Bus, and Category: Use the drop-down list boxes above each column

to select the required option for the respective parameter. The resulting view
will show only those signals that have the selected option.

• Clear filter: Click this button to reset the view, and show all signals again.

I/O Signal Data Editor
The I/O signal data editor is a table like editor used for editing signals. In this editor
you can add, delete and sort signals. This table can be exported to Microsoft Excel
for editing and for further importing back to RobotStudio.
Follow these steps to open an I/O signal data editor.

1 In the RAPID tab open a backup file.
2 In the Files browser, select the SYSPAR folder of the backup file and then

right-click the EIO.cfg file.
3 In the context menu, click I/O Signal Data Editor option, the I/O signal data

editor opens.
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11.2.4 ScreenMaker

Overview
ScreenMaker is a tool in RobotStudio for creating customized FlexPendant user
interfaces without the need to learn Visual Studio development environment and
.NET programming.
For more information on ScreenMaker, see ScreenMaker tab on page 539.

Prerequisites

Note

In RobotStudio 6.0, ScreenMaker is only available for the 32-bit edition and is
therefore disabled in the 64-bit edition.

To use ScreenMaker, you need to fulfill the following requirements:
• RobotStudio with Premium license.
• The IRC5 controller(s) require the FlexPendant Interface option in RobotWare

to run ScreenMaker applications.
• Install Microsoft .NET Compact Framework 2.0. Download it from ht-

tp://www.microsoft.com/download
• Install FlexPendant SDK with the same version as the RobotWare on the

target controller. Download it from http://developercenter.robotstudio.com/
For more information on the system requirements, hardware requirements, and
the supported Operating Systems, see RobotStudio Release Notes.

Testing on Virtual/Real controller

Best practices
You must test the screenmaker application on the virtual controller against a virtual
FlexPendant. Having LAN capabilities through the PC Interface option would be
helpful.

Testing and Deploying to a Virtual Controller
Click Deploy in the ScreenMaker to deploy to the connected controller in the
application. In a virtual controller, the application is deployed directly, which can
be used for viewing your application quickly on virtual FlexPendant before deploying
the same to the real controller.

Testing and Deploying to a Real Controller
ClickDeploy in ScreenMaker to deploy to the connected controller in the application.
PC interface option is needed to deploy an application over LAN to real controller.
The application can also be deployed directly through service port.

Launching ScreenMaker
You can launch ScreenMaker either from the Controller tab.

1 In the Controller tab, click the arrow next to the FlexPendant icon.
2 Click ScreenMaker.
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ScreenMaker is launched as a new tab.
The connection to all connected virtual and real controllers can be
established.

Note

For more information, see Managing projects on page 547.
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11.2.5 Restart a controller

When to restart a controller
Some operations require a restart of the controller to take effect. When working in
RobotStudio , you will be notified when a restart is necessary.

Restart
You must restart a controller when:

• You have changed the baseframe of any of the robots belonging to that
controller.

• You have changed the robot's configuration, either with the Configuration
Editor or by loading new configuration files.

• You have added new options or hardware to the system.
• A system failure has occurred.

Advanced restart options
The controller can be restarted with the following advanced restart options:

DescriptionOption

Restarts the controller with the current system and the default
settings.

Reset system

This restart discards the changes made to the robot's configur-
ation. It reverts the current system to the state it had when it
was installed on the controller (an empty system). This restart
deletes all RAPID programs, data and custom configurations
that have been added to the system.

Restarts the controller with the current system and reinstall
RAPID.

Reset RAPID

This restart deletes all RAPID program modules. It can be
useful if the system has changed in such a way that the pro-
grams no longer are valid, for instance if system parameters
used by the program are changed.

This restart applies only to real controllers.Start Boot Application
This restart saves the current system, with the current settings,
and starts the boot application on the FlexPendant from which
you can choose a new system to start with. You can also con-
figure the controller's network settings from the boot applica-
tion.

This restart applies only to real controllers.Revert to last auto saved
Restarts the controller with the current system and the last
known good settings. This restart restores changes made to
the robot's configuration to a previously good state.

Restarting a virtual controller
1 In the Controller browser, select the controller to restart.
2 In the Controller Tools group, click the arrow next to the Restart icon, and

then select one of the following options:

Restarts the VC and activates the changes made to the
system.

Restart

This is the default option if you directly click Restart.
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Restarts the VC with the current system and the default
settings.

Reset system

Restarts the VC with the current system and reinstalls
RAPID.

Reset RAPID

The options for Restart are also present in the context menu when you
right-click a controller in the Controller browser.

Note

A virtual controller system cannot be moved by copying its folder. Instead,
you must use thePack&Go function followed by theUnpack&Work function
to move the systems to a new location.

Restarting a real controller
The following are the prerequisites for restarting a real controller:

• You must have Write access to the controller you are restarting.
• For the advanced restart method Start Boot Application, you must have

access to the controller's FlexPendant.
To restart a real controller:

1 In the Controller browser, select the controller to restart.
2 In the Controller Tools group, click the arrow next to the Restart icon, and

then select one of the following options:

Restarts the real controller and activates the changes
made to the system.

Restart

The controller can be restarted with the following advanced
system restart and recovery options:

• Reset system
• Reset RAPID
• Start Boot Application (FlexPendant required)
• Revert to last auto saved

Advanced

The options for Restart are also present in the context menu when you
right-click a controller in the Controller browser.
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11.2.6 Back up a system

Overview
When backing up a system you copy all the data needed to restore the system to
its current state:

• Information about software and options installed on the system.
• System's home directory and all its content.
• All robot programs and modules in the system.
• All configuration and calibration data of the system.

Prerequisites
To backup a system you must have:

• Write access to the controller
• Logged on to the controller with appropriate grants. For more information,

see User Authorization on page 162.

Creating a Backup
To create a backup, follow these steps:

1 In the Controller browser, select the system you want to backup from the
browser.

2 Right-click and select Create Backup.
The Create Backup dialog box appears.

3 Enter a new backup name and specify a location for the backup, or keep the
default ones.
You can create backup either in the system or in the controller disk using
the following options, Browse File System or Browse Controller.

• To create a backup in the system, selectBrowse File System and then
select the destination folder.

• To create a backup in the controller disk, select Browse Controller
and then select the destination folder in the controller disk.

Note

Do not select Home folder when you specify the destination folder
for backup.

4 Click OK.
The progress of the backup is displayed in the Output window.
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Backup folder
When the backup is complete you will have a folder with the name of the backup
in the specified location. This folder contains a set of subfolders which together
comprise the backup.

CAUTION

If the contents of the Backup folder are changed, then it will not be possible to
restore the system from backup.

DescriptionSubfolders

Contains information necessary for re-creating the system's
software and options from the mediapool.

BACKINFO

Contains a copy of the system’s home directory content.HOME

Contains one subfolder for each task in the system’s program
memory. Each of these task folders contains separate folders
for program modules and system modules.

RAPID

Contains the system's configuration files.SYSPAR

Note

The contents of the PIB board of a IRC5P system (a controller system for painting)
will not be included with the regular RobotStudio backup. Please use the backup
function of the FlexPaintPendant to include the PIB content.
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11.2.7 Restore a system

Overview
When restoring a system from backup, the current system gets the same content
as when the backup was performed. Restoring a system replaces the following
contents in the current system with the content from the backup:

• All RAPID programs and modules in the system.
• All configuration and calibration data of the system.

Note

The system's home directory and all its content are copied from the backup to
the current system.

Prerequisites
To restore a system you must have:

• Write access to the controller.
• Logged on to the controller with appropriate grants. For more information,

see User Authorization on page 162.

Restoring a system

Note

Before proceeding, make sure that the system from the backup is compatible
with the controller you are restoring.

To restore a system, follow these steps:
1 In the Controller browser, select the system you want to restore.
2 Click Backup and select Restore Backup.

The Restore from Backup dialog box appears.

Note

Select the Include Controller Settings check box to restore the UAS
settings, time settings and IP address, and select Include Safety Settings
check box to include the safety settings.

3 In the Restore from Backup dialog box, browse to the destination folder
either in the system or in the controller disk and then select the backup to
restore the system.

4 Click OK.
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The progress of the restore appears in the Output window. The controller is
automatically restarted to load the restored system.

Note

If the system from the backup does not originate from the controller you
are restoring, you get the following message about the mismatch.

en0900001061
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11.2.8 System Builder

Functions of the System Builder
For procedures using the various functions of the System Builder, see About
System Builder on page 164.
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11.2.9 Installation Manager

Functions of Installation Manager
For procedures using various functions of the Installation Manager, see About
Installation Manager on page 183.
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11.2.10 Configuration editor

Configuration editor
From the Configuration Editor you view and edit the system parameters of a specific
topic in a controller. The Instance Editor is a complementary editor with which you
edit the details of a type instance (a row in the Configuration Editor's instance list).
The Configuration Editor has a direct communication with the controller. This means
that changes you make are applied to the controller as soon as you complete the
command.
With the Configuration Editor, including the Instance Editor, you can:

• view types, instances, and parameters
• edit instances and parameters
• copy and paste instances within a topic
• add and delete instances

Layout of the Configuration Editor
The Configuration Editor consists of the Type name list and the Instance list.
The Type name list displays all available configuration types for the selected topic.
The list of types is static. This means you cannot add, delete or rename types.
The Instance list displays all system parameters of the type selected in the Type
name list. Each row in the list is an instance of the system parameter type. The
columns show each specific parameter and its value for each instance of the
parameter type.
The Configuration editor has the following options:

• Controller
• I/O
• Communication
• Motion
• Man-machine communication
• Add Signals

Click the header of a column to sort the column. For sorted columns, the sort order
will be reversed. If you press the SHIFT key and click multiple column headers
then the columns will be sorted by the order clicked.

Add Signals
You must have write access to the controller to be able to open the add signal
window.

Defines the type of signal.Type of Signal

Defines the name for one or more signals.Signal Base Name

Defines the device to which the signal belongs.Assigned to Device

Optionally, offers filtering and sorting based on this category.Signal Identification Label

Defines the number of signals to add in a rangeNumber of Signals

Defines the index (number) to start the range with.Start Index
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Defines the number which the index should increase with.Step

Defines the bits in the I/O memory map of the assigned unit
to which the signal is mapped.

Device Mapping Start

Optionally, offer filtering and sorting based on this category.Category

Defines the write access to I/O signals for categories of I/O
controlling clients connected to the robot controller. This
field is enabled only when Advance checkbox is selected.
Not necessarily Write access. Options are Default, ReadOnly
and All.

Access Level

Specifies the I/O signal value to be used at the start.Default Value

Applies an inversion between the physical value of the signal
and its logical representation in the system.

Invert Physical Value

Layout of the Instance editor
The Instance Editor lists the parameters and their values in the open instance.
In the Value column you can view and edit the value of the parameter.
When you click a row, the lower section of the Instance Editor window displays
the type of parameter, restrictions for the parameter value and other conditons for
the parameter.
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11.2.11 Load Parameters

Prerequisite
You must have write access to the controller.

Loading a configuration file
You can load a configuration file either from the system or from the controller disk.

1 In the Controller browser, select the system and expand the Configuration
node.

2 To load a configuration file from the system, click Load Parameters to bring
up a dialog box.
To load a configuration file from the controller disk, click Load Parameters
from Controller, to bring up a dialog box.

3 In the dialog box, select how you want to combine the parameters in the
configuration file to load with the existing parameters:

then select...If you want to...

Delete existing parameters before load-
ing

replace the entire configuration of the
topic with the one in the configuration file.

Load parameters if no duplicatesadd new parameters from the configura-
tion file to the topic, without modifying the
existing ones.

Load parameters and replace duplicatesadd new parameters from the configura-
tion file to the topic and update the exist-
ing ones with values from the configura-
tion file. Parameters that only exist in the
controller and not in the configuration file
will not be changed at all.

4 Click Open and browse to the configuration file to load. Then click Open
again.

5 In the information box, click OK to confirm that you want to load the
parameters from the configuration file.

6 When the loading of the configuration file is finished, close the Select mode
dialog box.
If a restart of the controller is necessary for the new parameters to take effect,
you will be notified of this.

398 Operating manual - RobotStudio
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

11 Controller tab
11.2.11 Load Parameters



11.2.12 Save Parameters

Overview
The system parameters of a configuration topic can be saved to a configuration
file, stored on the PC or any of its network drives.
The configuration files can then be loaded into a controller. They are thereby useful
as backups, or for transferring configurations from one controller to another.

File-naming conventions
The configuration files should be named with a name that relates to their
corresponding topics. When saving configuration files, the correct name for each
file will be suggested by default.

Saving a configuration file
You can save a configuration file either in the system or in the controller disk.

1 In the Controller browser, select the system and expand the Configuration
node.

2 To save a configuration file in the system, click Save Parameters and then
select the topic to save to a file and click Save.
To save a configuration file in the controller disk, click Save Parameters to
Controller and then select the topic to save to a file and click Save.

3 In the Save As dialog box, browse for the folder to save the file in.
4 Click Save.

Saving several configuration files
1 Select the Configuration node.
2 Click Save System Parameters.
3 In the Save System Parameters dialog box, select the topics to save to files.

Then click Save.
4 In the Browse for Folder dialog box, browse for the folder to save the files

in.
Then click OK.
The selected topics will now be saved as configuration files with default
names in the specified folder.
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11.2.13 Transfer

Overview
The transfer function allows easy transfer of offline-created RAPID programs to
the real robot on the shop floor. This means that you can transfer data from a virtual
controller (which is offline) to a real controller (which is online). As part of the
transfer function you can also compare the data present in the virtual controller
with that present in the real controller and then select which data to transfer.
You can also use the transfer function to transfer data from a virtual controller to
another virtual controller.

Relations for transfer of data
To transfer data, you must first set up a Relation between the two controllers. A
Relation defines the rules for the transfer of data between the two controllers.

Creating a Relation
When you have two controllers listed in the Controller browser, you can create a
Relation between them. To create a Relation:

1 On the Controller tab, in the Transfer group, click Create Relation.
The Create Relation dialog box is displayed.

2 Enter a Relation Name for the relation.
3 Specify the First Controller, from the list.

The First Controller, also called the Source, owns the data being transferred.
4 Specify the Second Controller, from the list. This can either be a real

controller or another virtual controller.
The Second Controller, also called the Target, receives the data being
transferred.

5 Click Ok.
The relation between the controllers is now created.

After this, theRelation dialog box opens, using which you can configure and execute
the transfer. Relations of a controller are listed under its Relations node in the
Controller browser.

Note

The properties of the relation are saved in a XML file under INTERNAL in the
owner controller’s system folder.

Transferring data
You can configure the details of the transfer of data and also execute the transfer,
in the Relation dialog box.
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To open the Relation dialog box, double-click a relation. Alternatively, select a
relation in the Controller browser, and then in the Transfer group, click Open
Relation.

Configuring the transfer
Before executing a transfer, you can configure the data to be transferred, under
the Transfer Configuration heading. Configure using these guidelines:

• Use the check boxes in the Included column to include or exclude the
corresponding items shown in the tree structure. All items in a module that
are included will be transferred. Other non-listed items of a module such as
comments, records and so on will be automatically included in the transfer.

• The Action column shows a preview of the transfer’s result, based on the
items you include or exclude.

• If a module exists both in the source and the target controllers, and the Action
column shows Update, then click Compare in the Analyze column. This
opens the Compare box which shows two versions of the module in different
panes. The affected lines are highlighted and you can also step through the
changes. You can choose one of the following options for the comparison:

- Source with target - Compares the source module with the target
module

- Source with result - Compares the source module with the module
that will be the result of the transfer operation

• BASE (module), wobjdata and tooldata are excluded by default.
• wobjdata wobj0, tooldata tool0, and loaddata load0 of the BASE module are

unavailable for inclusion.
A task can be transferred only if:

• Write access to the target controller is present (must be manually retrieved).
• Tasks are not running.
• Program execution is in the stopped state.

Executing the transfer
After you have configured the transfer, you can execute it.
Under the Transfer heading, the Source and Target modules are shown along with
the arrow showing the direction of the transfer. You can change the direction of
the transfer by clickingChange Direction. This also switches the source and target
modules.
To execute the transfer click Transfer now. A dialog showing a summary of the
transfer appears. Click Yes to complete the transfer. The result of the transfer is
displayed for each module in the output window.
The Transfer now button is disabled if:

• None of the included tasks can be transferred.
• Write access is required but not held.
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Note

If one of several modules fail, then the following error message is displayed.
Module xxx.zzz has failed. Do you want to continue?
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11.2.14 Signal Analyzer Online

Analyzing signals from the controller
The Signal Analyzer Online functionality helps in displaying and analyzing signals
from a robot controller. Using the Signal Analyzer, you can optimize the robot
program.
The Signal Analyzer functionality is present for both virtual and real controllers.
The following section describes the Signal Analyzer functionality for real controllers.
For information on the Signal Analyzer Online functionality for virtual controllers,
see Signal Analyzer on page 366.
To open the Signal Analyzer Online, on the Controller tab, in the Controller Tools
group, clickSignal Analyzer Online. Alternatively, you can open the Signal Analyzer
Online using the context menu in the Signal History window.

Note

The Signal Analyzer Online command in the Controller Tools group is enabled
only if the selected controller is a real controller, or if the controller tree has only
one real controller.

For information about the layout of the Signal Analyzer Online, see Layout of Signal
Analyzer on page 371.

Turning the signal recording on and off
To turn the recording of signals on or off, use the Start recording and Stop
recording buttons.
To start the recording, click Start recording.
To stop the recording, click Stop recording. The recording stops and the recorded
session is saved.

Configuring signals for the next recording
To configure the signals which are to be saved during the next signal recording
session, use the Signal Setup window. For this, click the arrow next to the Signal
Analyzer icon, and then click Signal Setup. The Signal Setup window appears.
The signals that are available for configuration are shown in the Signal Setup
window. For the list of available signals, see Available signals on page 367.
For information on setting up the signals, see Setting up the signals on page 369.
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History
The signal data from each signal recording session is saved. To view these, click
the arrow next to the Signal Analyzer icon, and then click History. For more
information, see History on page 374.

Note

The signal data from each signal recording session is saved as a .sdf file at the
following location. The History feature uses these files.
C:\Users\<your user name>\AppData\Local\ABB Industrial

IT\Robotics IT\RobotStudio\SignalAnalyzer

This path is for a PC with a standard installation of Windows 7 or 8 (English
version). The path may differ if you have a customized installation or use Windows
XP.
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11.2.15 Safety Configuration

Overview
For information on safety configuration, see:

• Application manual - SafeMove
• Application manual - Electronic Position Switches
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11.2.16 Collision Avoidance

Overview
The Collision avoidance functionality prevents the collision between the arms in
a dual arm robot.
To enable this feature, in the Controller browser, right-click any controller and then
click Collision Avoidance and then select Activate Collision Avoidance.

Visualizing collision avoidance
It is possible to view collision avoidance. You can view possible collisions in online
monitor. To enable this feature, in theController browser, right-click any controller
and then click Collision Avoidance and then select Show predicted collisions.
During collision, object in the collision path gets highlighted.
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11.3 Features for real controllers

11.3.1 Request Write Access

Overview
You need Write access for editing programs and configurations or in any other
way to change data on the controller.

Prerequisites for Write access
You can get Write access to any controller as long as the prerequisites are fulfilled.

This has to be fulfilled:When the Controller
is in Mode:

The Write access must not be taken by any other user.Auto

The remote Write access must be granted on the FlexPendant. For
safety reasons, a FlexPendant user can also recall this remote Write
access in manual mode.

Manual

If the prerequisites are not fulfilled you will be denied, or lose, the Write access.
This means that if you have Write access in auto mode and the controller is switched
over to manual mode you will lose the Write access without any warning. This is
because the FlexPendant unit by default has the Write access in manual mode,
for safety reasons. The same will happen if the remote Write access in manual
mode is recalled from the FlexPendant unit.

Result
The Controller Status window will be updated when the request for Write access
is granted.
If the Write access is denied, a message is displayed.
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11.3.2 Release Write Access

Overview
Several users can be logged on to a single controller but only one can have the
write access. You can release the write access when you do not need it anymore.

Result
The Controller Status window will be updated when your access right has changed
from read/write to read only.
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11.3.3 Authenticate

Overview
The data, functionality, and commands on a controller are protected by a User
Authorization system (also called UAS). The UAS restricts the parts of the system
the user has access to. Different users can have different access grants.
You can perform the following functions from the Authenticate menu:

• Login as a Different User
• Log off
• Log off all controllers
• Edit User Accounts
• UAS Grant Viewer

Login as a Different User
1 In the Authenticate menu, click Login as a Different User. The Add new

user dialog box appears.
2 In the User Name box, enter the user name you want to log on as.
3 In the Password box, enter the password for the user name you are logging

on as.
4 Click OK.

Note: If you have previously logged on as a different user and wish to revert as
default user, click Login as Default User.

Log off
In the Authenticate menu, click Log off to log the user off from the controller.

Login off all controllers
In the Authenticate menu, click Log off to log the user off from all the controllers.

Edit User Accounts
For more information on User Accounts, see User Accounts on page 421.

UAS Grant Viewer
For more information on UAS Grant Viewer, see UAS Grant Viewer on page 426.
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11.3.4 File transfer

Overview
You can transfer the files and folders between the PC and a controller through the
File Transfer window.

Prerequisites
The following are the prerequisites to be met:

• The PC must be connected to the same network as the controller, or
connected to the service port of the controller.

• You must be logged on to the controller as a user with UAS grants that allows
file transferring.

Transferring files and folders
Use this procedure to transfer files and folders between the PC and a controller:

1 In the Controller Tools group, click File Transfer.
The File Transfer window appears.

2 In the PC explorer, browse to the folder from or to which you want to transfer
the data.

3 In the Controller explorer, browse to the folder from or to which you want
to transfer the data.

4 Select the item to transfer from the list.
To select several items at once, do one of the following:

then pressTo select

the SHIFT key and select the first and the last item.several adjacent items

the CTRL key and select each item.several non-adjacent
items

the keys CTRL + Aall items in the list

5 When the files and folder to transfer are selected, do one of the following:

then pressTo

CTRL + Xcut the files

CTRL + C, or click Arrowcopy the files
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6 Place the insertion point either in the PC explorer or the Controller explorer
and click CTRL + V.

Note

In the PC explorer or Controller explorer window, right-click to view the
following context menu:

• Transfer
• One level up
• Open
• Refresh
• Cut
• Copy
• Paste
• Delete
• Remove
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11.3.5 FlexPendant Viewer

Overview
FlexPendant Viewer is an add-in to RobotStudio that retrieves and displays a
screenshot from the FlexPendant. The screenshot is generated automatically at
the moment of the request.

Prerequisites
The controller you want to retrieve screen shots from must be added to your robot
view.
A FlexPendant must be connected to the controller. If no FlexPendant is currently
connected (optionHot plug is installed and the jumper plug is used) then no screen
shot can be retrieved.

Using FlexPendant Viewer
1 Make sure you are connected to the controller.
2 In the Controller Tools group, click the arrow next to the FlexPendant icon,

and then click FlexPendant Viewer.
A screen shot will be displayed in the workspace.

3 To reload the screen shot, click Reload in the workspace.
4 To set an automatic reload period for the screen shot, click on the menu

Tools, point to FlexPendant Viewer and click Configure.
Set the desired reload period and select the check-boxActivated. Then click
OK.

Results on the controller
The screenshot will automatically be saved as a file on the controller. When a new
request is sent, a new screenshot is generated and saved, overwriting the previous
file.
No message will be displayed on the FlexPendant.
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11.3.6 Import Options

Importing system options
1 In the Configuration group, click Import Options to bring up a dialog box.
2 In the Option source box, enter the path to the folder where the options to

import are located. You can also click the Browse button and browse to the
folder.

3 In theMedia Pool destination box, enter the path to the media pool you want
to store the options in. You can also click the Browse button and browse to
the media pool folder.

4 Select the options to import and click Import.
To select several options at once, do one of the following:

then hold downTo select

the SHIFT key and select the first and the last option.several adjacent options

the CTRL key and select each option.several non-adjacent options

5 Click OK.

Removing system options
1 In the Configuration group, click Import Options to bring up a dialog box.
2 In the Media Pool destination list, enter the path to the media pool from

which you want to delete the options. You can also click the Browse button
and browse to the media pool folder.

3 Select the options to delete and click Remove.
To select several options at once, do one of the following:

then hold downTo select

the SHIFT key and select the first and the last option.several adjacent options

the CTRL key and select each option.several non-adjacent options

4 Click OK.
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11.3.7 Properties

Overview
You can perform the following actions from the Properties menu:

• Renaming the controller
• Setting the controller date and time
• Setting the Controller ID
• Viewing controller and system properties
• Handling the Device Browser

Renaming the controller
The controller name is an identification of the controller that is independent of the
system or the software running on the controller. Unlike the controller ID, the
controller name does not have to be unique for each controller.

Note

The controller name must be written with characters from the ISO 8859-1 (Latin
1) character set.

1 In the Configuration group, click Properties, and then click Rename.
The Rename Controller dialog box appears.

2 Enter the new name of the controller in the dialog box.
3 Click OK.

The new name will be activated when the controller is restarted.
You will be prompted to either click Yes to restart the controller immediately
or click No to restart later.

Setting the controller date and time
You can either set the date and time to the same as the network time server, or
you can specify the date and time manually.
Use this procedure to set the controller date and time:

1 In the Configuration group, click Properties, and then click Date and Time.
The Set Date and Time dialog box appears.

2 This dialog provides two options: Network Time and Manual Time.
• Select Network Time and in the Time server address box, enter the

IP address of the network time server.
• Select Manual time and then set the Date and Time in the boxes

provided. You can select the required time zone in the Time zone list.

Setting the Controller ID
The Controller ID is by default set to the serial number of the controller and is
thereby a unique identifier of the controller.
The Controller ID is a unique identifier for the controller and should not be changed.
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However, if the hard disk of the controller is replaced, the ID will be lost and you
must set it back to the serial number of the controller.

Note

You must Request Write Access to the controller before setting the controller
ID.

1 In the Configuration group, click Properties, and then click Controller ID.
The Set Controller ID dialog box appears.

2 Enter the Controller ID and then click OK.

Note

Use only characters from the ISO 8859-1 (Latin 1) character set and no
more than 40 characters.

Setting the IP address of the controller
You can set the controller to receive the IP address from the network's DHCP
server or you can manually set the IP address of the controller.

1 On theController tab, in theConfiguration group, Click Properties and then
click Network settings.
The Network settings dialog opens.

2 Select Obtain an IP address automatically to set the controller to receive
the IP address from the network's DHCP server.
OR
Select Use the following IP address and then enter the required IP address
and Subnet mask boxes to manually set the IP address of the controller.

Viewing controller and system properties
You can view the following properties for a controller and its running system.

System PropertiesController Properties

Control ModuleBoot Application

Drive Module #1Controller ID

Serial NumberController Name

System NameInstalled Systems

Network Connections

1 In the Configuration group, click Properties, and then click Controller and
System Properties.
The Controller and System Properties window appears.

2 In the tree view at the left of the window, browse to the node for which you
want to view the properties.
The properties of the selected object are displayed in the Properties list to
the right of the window.
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Viewing the Device Browser
The Device Browser displays the properties and trends of the various hardware
and software devices in a robot controller. To open the Device Browser, in the
Configuration group, click Properties, and then click Device Browser.

Displaying the properties of a device
In the tree view, browse to the node for which you want to view the properties and
then click it. The properties of the selected object, along with their corresponding
values, are listed to the right of the tree view.

Updating the tree view
Press F5, to update the tree view.
Alternatively, right-click inside the tree view pane, and then click Refresh.

Displaying a trend
Select a device in the tree view and then double-click any property, that has a
numerical value, in the right-hand panel. This opens a trend view. The trend view
collects data at a rate of one sample per second.

Hiding, stopping, starting or clearing a trend
Right-click anywhere on the trend view and then click the required command.

Saving system diagnostics
You can create a System Diagnostics data file from RobotStudio.
To save a System Diagnostics data file to your PC, in the Configuration group,
click Properties, and then click Save system diagnostics.
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11.3.8 Go Offline

Overview
The main purpose of this feature is to create a new station with a VC similar to the
connected real controller. This helps a robot technician to work offline, and not
just when connected to the real controller.

Using Go Offline
1 Connect the PC to a real controller.
2 On the Controller tab, click Request Write Access.

For more information on Request Write Access, see Request Write Access
on page 407.

3 Click Go Offline.
The Go Offline dialog box is displayed.

4 Enter a name for the system and browse for the location to save the system.
A new station is created with a VC with the same configuration as the real
controller.

Note

A pre-requisite is that any RobotWare add-ins used by the system must be
available on the PC. A Relation is automatically created between the virtual
controller and the real controller. For more information on Relations, see Transfer
on page 400
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11.3.9 Online Monitor

Overview
This feature allows you to remotely monitor the robot connected to a real controller.
It displays a 3D layout of the connected robot controller and enhances user’s
current perception of reality by adding motion visualization augmentation.

Note

The Online Monitor shows TCP robots and TCP robots with track. When
connecting the Online Monitor to a virtual controller, the motion is shown only if
the virtual controller is using Free-Run mode, not the Time Slice mode.

Using Online Monitor
The following procedure describes the Online Monitor feature in RobotStudio:

1 Connect the PC to a controller and add the controller. See Add Controller on
page 380.

2 Click Online Monitor.
The 3D view of the mechanical units of the controller system is displayed in
the graphics window.

Note

The robot view is refreshed every second with the current joint values of
all the mechanical units.

Gravity parameters in online monitor
Online Monitor displays the orientation of a robot according to its gravity
parameters. The Gravity Alpha, Gravity Beta and Gamma Rotation parameters
define the rotation of the robot around the X, Y and Z axis in the world coordinate
system. The Online Monitor orients the robot in the Graphical view according to
the gravity parameters.
These parameters describe how the robot is oriented in relation with the floor or
ground, whether it is suspended (mounted on the ceiling), shelf mounted (mounted
on the wall), or mounted on the regular floor. If the robot is configured to be mounted
on the ceiling, it will be displayed upside down in the Online Monitor. You can set
these parameters in the Motion configuration file.
For more information about gravity parameters, see Technical reference
manual - System parameters

Indication of TCP
A cone is automatically created to indicate the active tool data being used. The
cone has its base in the robot wrist and its tip at the location of the tool data.
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Kinematic Limitations
When the Kinematic Limitation button is enabled, the graphical 3D viewer indicates
whether the robot is at a joint limit or at a singularity.
For joint limits, the corresponding link is highlighted in yellow to indicate a warning
and in red to indicate an error. The tolerance limits are defined in RobotStudio
Options - Online - Online Monitor.
For singularity, a markup indicates when the axis 5 is close to singularity. The
singularity level is also defined in RobotStudio Options.

Visualizing Safety Zones in Online Monitor
This feature lets you to visualize the current status of the manipulators in a robot
system and provides an augmented reality of the robot cell. It allows you to visualize
a failure scenario, for example, an unplanned stopping of a robot. To give the user
an idea of the physical layout and the safety zone that has caused this stopping
of the robot, safety zones are visualized in online monitor. When the robot enters
a restricted zone, the safemove supervision feature stops the robot.
Features

• A Show Safety Zones button is available in the Online Monitor for each
manipulator in the system, for example, four buttons in a MultiMove system
with four manipulators.

• The name of each tool zone and the corresponding manipulator is shown as
a markup, for example, Rob1 STZ1, …, Rob4 STZ8, Rob1 MTZ1, …, Rob4
MTZ8 and so on.

• Zones that are defined as Allow inside are visualized as a green
semitransparent hollow shape.

• Zones that are defined as Allow outside are visualized as a red
semitransparent solid shape.

• A message is displayed in the output window if no STZ or MTZ is defined for
the manipulator.

• The controller event log message 20468 SC STZ violation is displayed in
the output window if it is present in the controller event log.

Note

You can open one SafeMove Configurator at a time, even though several
controllers may be connected. If the SafeMove Configurator is opened for
one controller, real or virtual, the icon gets disabled for the other controllers.
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11.3.10 Visual SafeMove

Overview
Visual SafeMove is a 3D based configuration tool for SafeMove. The tool is
completely integrated into the RobotStudio user interface and takes full advantage
of the user interface elements such as tabs, browsers, and 3D graphics. Visual
SafeMove is enabled for robots with the SafeMove option. It offers an intuitive way
to visualize and configure safety zones. Visual SafeMove works both with the real
controller and the virtual controller. The Visual SafeMove configurator is available
alongside with the previous configurator.
Only a safety user is allowed to download a configuration. A safety user must be
created before configuring SafeMove. For more information on visual safemove
configurator, see Operating Manual- SafeMove.

Note

You can open one SafeMove Configurator at a time, even though several
controllers may be connected. If the SafeMove Configurator is opened for one
controller, real or virtual, the icon gets disabled for the other controllers.

Starting Visual SafeMove
1 Start a RobotStudio station, a virtual controller, or connect to a real controller.
2 In the RobotStudioController browser, right-click on the controller and select

Authenticate and then Login as a Different User.
3 Select the safety user, for example, SafetyUser. Type the password and click

Login.
4 In the Controller tab, click Online Monitor. (Not needed when running a

RobotStudio station.)
5 In the Controller tab, click Safety, then select Visual SafeMove.
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11.3.11 User Accounts

Overview
All the procedures below require the following steps to be taken before managing
the details:

1 In the Controller browser, select the controller to which you want to manage
a user or group

2 From theController tab, clickRequestWrite Access to provide write access
to the controller.

3 In the Controller tab, click Authenticate and select Edit User Accounts, for
administering UAS accounts, grants, and groups.

Users tab
With the Users tab you set which users will be able to log on to the controller and
which groups the users shall belong to.

users-ta

Users tab Parts
1 The Add button. Opens a dialog box for adding new users.
2 The Edit button. Opens a dialog box for changing the log on name and

password of the user.
3 The Delete button. Deletes the selected user account from the controller.
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4 The Users on this Controller list. Shows the user accounts defined on this
controller. The list has two columns:

DescriptionColumn

The name of the user accountUser

Shows if the account is activated or deactivated. When deac-
tivated, it is not possible to log on using that account.

Status

5 TheActivated/Deactivated item box. Changes the status of the user account.
6 The User’s groups/User’s grants list.

The User’s groups list shows which group(s) the user is a member of. For
changing the membership of a group, select or clear the checkbox in front
of the group name.
The User’s grants list shows the available grants for the selected User’s
group(s). When selecting a grant from the User’s grants list, a description of
the selected grant appears.

users-t0

Adding a user
1 On the Users tab, click Add to bring up a dialog box.
2 In the User Name box, enter the user name. Use only characters from the

ISO 8859-1 (Latin 1) character set and no more than 16 characters.
3 In the Password box, enter the user's password. The password you type in

will not be visible. Use only characters from the ISO 8859-1 (Latin 1) character
set and no more than 16 characters.

4 In the Retype Password box, enter the user's password again.
5 Click OK to add the new user and close the dialog box.
6 Click OK.
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Deleting a user
1 On the Users tab, select the user to delete from the Users on this controller

list and click Delete.
2 To the question Are you sure you want to remove this user?, answer Yes.
3 Click OK.

Setting up group membership
1 On the Users tab, select the user from the Users on this controller list.
2 In the User’s groups list, select the groups the user shall be a member of.
3 Click OK.

Changing a name or password
1 On the Users tab, select the user to edit from the Users on this controller

list and click Edit user.
This opens the Edit dialog box.

2 To change the user name, enter the new name in the User Name box. Use
only characters from the ISO 8859-1 (Latin 1) character set and no more than
16 characters.

3 To change the password, enter the new password in the Password box, then
retype the password in the Retype Password box. Use only characters from
the ISO 8859-1 (Latin 1) character set and no more than 16 characters.

4 Click OK to save the changes to the user and close the dialog box.
5 Click OK.

Activating or deactivating a user
1 On the Users tab, select the user from the Users on this controller list and

click the status text (Activated or Deactivated). An item box appears and you
can change the status.
The user's new state is now displayed in the status column of the Users on
this controller list.

2 Click OK.

Exporting a user list
1 On the Users tab, select the user from the Users on this controller list and

click Export.
2 Browse to the destination folder and click OK. The File password dialog

opens, type in the password and click OK.
3 This opens a Save as dialog box, in which you specify the name and location

for the file with the user list.

Importing a user list
1 On the Users tab, select the user from the Users on this controller list and

click Import.
2 Browse to the file location and click OK. The File password dialog opens,

type in the password and click OK.
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3 This opens an Open file dialog box, in which you browse to the file with the
list to import.

When you have selected the file, the ImportOptionsForm dialog opens.

DescriptionSelect ...

Earlier groups and users will be deleted.Delete existing users and groups
before importing

A new dialog appears.
• Import users but don’t replace duplicates means

that you will not replace the existing users.
• Import users and replace duplicates means that

you will replace the existing users.
• Import groups but don’t replace duplicates means

that you will not replace the existing groups.
• Import groups and replace duplicates means that

you will replace the existing groups.

Advanced options

Adding a group
1 On the Groups tab, click Add.

This opens the Add new group dialog box.
2 In the Group Name box, enter the name of the group. Use only characters

from the ISO 8859-1 (Latin 1) character set and no more than 16 characters.
3 Click OK to add the new group and close the dialog box.
4 Click OK.

Renaming a group
1 On the Groups tab, select the group to rename from the Groups on this

controller list and click Rename.
This opens the Rename Group dialog box.

2 In the Group Name box, enter the name of the group. Use only characters
from the ISO 8859-1 (Latin 1) character set and no more than 16 characters.

3 Click OK to rename the group and close the dialog box.
4 You will now be asked if you want the users who belong to this group to

continue belonging to a group with the old name as well as the new one.

ToClick

Let the users of the group be members to groups with both the
old and the new name. However, the old group will no longer be
defined in the controller's UAS since it is replaced by the new
group.

Yes

This option might be useful if you plan to recreate the old group,
or copy the user's settings to another controller who has the old
group defined.

Delete the user's memberships to the old group. This is to just
replace the old group name with the new one.

No

To cancel the change and keep the old group name, with its user's
memberships.

Cancel

5 Click OK.
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Deleting a group
1 On the Groups tab, select the group to delete from the Groups on this

controller list and click Delete.
2 You will now be asked if you want the users who belong to this group to

continue belonging to it though it is not valid.

ToClick

Let the users of the group remain members to it even if it is no
longer defined in the controller's UAS.

Yes

This option might be useful if you plan to recreate the group, or
copy the user's settings to another controller who has the group
defined.

Delete the user's memberships to the group.No

Cancel the change and keep the group, with its user's member-
ships.

Cancel

3 Click OK.

Giving grants to a group
1 On the Groups tab, select the group from the Groups on this controller list.
2 In the Controller grants/Application grants list, select the grants to give to

the group.
3 Click OK.
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11.3.12 UAS Grant Viewer

Overview
The UAS Grant Viewer page displays information about the grants provided to the
user currently logged in and the groups owning them.

1 In theAuthenticatemenu, clickUASGrant Viewer. TheUASGrantswindow
appears.

en0900000852

Examples of common actions to perform

Necessary grantsAction

Modify controller propertiesRename the controller
Remote restart(A restart of the controller is necessary)

Modify configurationChange system parameters and load configura-
tion files Remote restart

Administration of installed systemInstall a new system

Backup and savePerform a backup
Remote restart(A restart of the controller is necessary)

Restore a backupRestore a backup
Remote restart(A restart of the controller is necessary)

Load programLoad/delete modules

Load programCreate new module.

Edit RAPID codeEdit code in RAPID modules

Backup and saveSave modules and programs to disk

Execute programStart program execution from Task Window

Continues on next page
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Necessary grantsAction

Modify configurationCreate a new I/O signal, that is, add a new in-
stance of the type Signal Remote restart
(A restart of the controller is necessary)

I/O write accessSet the value of an I/O signal

Read access to controller disksAccess to controller disks from File Transfer
window Write access to controller disks

Controller grants

This grant includes all controller grants, also new grants
added in future RobotWare versions. The grant does not
include any application grants or the Safety Controller
configuration grant.

Full access

Gives access to read and write the UAS configuration, that
is to read, add, remove and modify UAS users and groups.

Manage UAS settings

Gives access to perform the following:
• Start/step program (stop is always allowed)
• Move PP to Main
• Execute service routines

Execute program

Gives access to perform the following:
• Modify or teach positions in RAPID code (ModPos)
• During execution modify positions in RAPID code as

single points or as a path (HotEdit)
• Restore ModPos/HotEdit positions to original
• Modify current value of any RAPID variable

Perform ModPos and HotEdit

Gives access to modify current value of any RAPID variable.
This grant is a subset of the grant Perform ModPos and
HotEdit.

Modify current value

Gives access to perform the following:
• Set I/O signal value
• Set signal as simulated and remove simulation
• Set the device and industrial network as enabled/dis-

abled

I/O write access

Gives access to perform a backup and to save modules,
programs and configuration files. The grant gives full FTP
access to the current systems BACKUP and TEMP directory.

Backup and save

Gives access to restore backup and restart the controller
using the restart mode Revert to last auto saved.

Restore a backup

Gives access to modify the configuration database, that is
to load configuration files, change system parameter values
and add/delete instances.

Modify configuration

Gives access to load/delete modules and programs.Load program

Gives access to perform restart and shutdown from a remote
location. No grant is required to perform restart via a local
device, as for example the FlexPendant.

Remote restart

Gives access to perform the following:
• Modify code in existing RAPID modules
• Frame calibration (tool, workobj)
• Commit ModPos/HotEdit positions to current values
• Rename program

Edit RAPID code
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Gives access to perform the following:
• Move PP to routine
• Move PP to cursor
• HoldToRun
• Activate/deactivate RAPID tasks
• Request write access from the FlexPendant
• Enable/disable non-motion execution

Program debug

Gives acces to decrease speed from 100% in Auto mode.Decrease production speed
This grant is not required if speed is already below 100%,
or controller is in Manual mode.

Gives access to perform the following:
• Fine calibrate mechanical unit
• Calibrate base frame
• Update/clear SMB data

Frame calibration (tool, wobj) requires the grant Edit RAPID
code. Manual offset of mechanical unit calibration data and
loading new calibration data from file require the grant
Modify configuration.

Calibration

Gives access to perform the following:
• Install new system
• Reset RAPID
• Reset system
• Start Boot Application
• Select System
• Install system from device

This grant gives full FTP access, that is, the grant gives the
same rights as Read access to controller disks and Write
access to controller disks.

Administration of installed
systems

Gives external read access to controller disks. This grant
is only valid for explicit disk access, for example with an
FTP client or the File Manager of RoboStudio.

Read access to controller
disks

It is possible, for example, to load a program from /hd0a
without this grant.

Gives external write access to controller disks. This grant
is only valid for explicit disk access, for example with an
FTP client or the File Manager of RoboStudio.

Write access to controller
disks

It is possible, for example, to save a program to the control-
ler disk or perform a backup without this grant.

Gives access to set controller name, controller ID and sys-
tem clock.

Modify controller properties

Gives access to delete messages in the controller Event
Log.

Delete log

Gives access to update the revolution counter.Revolution counter update

Gives access to perform a configuration of the Safety Con-
troller. This is valid only for the PSC-option and is not in-
cluded in the Full access grant.

Safety Controller configuration

Continues on next page
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Application grants

Value true gives access to the ABB menu on the FlexPend-
ant. This is the default value if a user does not have the
grant.

Access to the ABB menu on
FlexPendant

Value false means that the user cannot access the ABB
menu when the controller is in Auto mode.
The grant has no effect in Manual mode.

A user having this grant is automatically logged off from
the FlexPendant when switching from Manual mode to Auto
mode.

Log off FlexPendant user when
switching to Auto mode
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11.3.13 Integrated Vision

The Integrated Vision system provides a robust and easy‐to‐use vision system for
general purpose Vision Guided Robotics (VGR) applications. The system features
a complete software and hardware solution that is fully integrated with the IRC5
robot controller and the RobotStudio programming environment. The vision
capability leverages on the Cognex® In-Sight® smart camera family, with embedded
image processing and an Ethernet communication interface.
RobotStudio has been equipped with a vision programming environment that
exposes the full palette of Cognex EasyBuilder® functionality with robust tools for
part location, part inspection and identification. The RAPID programming language
has been extended with dedicated instructions and error tracing for camera
operation and vision guidance.
For more information, see Application manual - Integrated Vision.
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11.3.14 Jobs

Overview
The Jobs feature allows you to perform certain actions on a large population of
robot controllers. A Job is defined by a Device list and an Action. The Action will
be carried out for all controllers in the Device list.

Jobs tab
The Jobs feature is managed from the Jobs Contextual tab. On the Controller tab,
in the Controller Tools group, click Jobs to open the Jobs Contextual tab.
The Jobs Contextual tab contains the following groups.

DescriptionGroups

A user-defined group of robot controllers for applying a job. Device lists can
be reused between jobs.

Device Lists

A command group containing various job options.Jobs

Device Lists group
The Device Lists group contains the following commands and controls.

DescriptionCommands

Opens a new empty device list window for creating a new group of robot
controllers.

New Device List

Opens a previously saved device list to edit or review.Open Device List

Saves the contents of an active device list window to disk in .xlsx format.
These files can be edited in Microsoft Excel without changing the grid
structure.

Save Device List

Populates the active device list window with all controllers that Netscan
finds on the local subnet.

Scan Subnet

Jobs group
The Jobs group contains the following commands and controls.

DescriptionCommands

Opens a new job window.New job

Provides options, Save Job and Edit Job Templates.
• Save Job : Saves the job specification as an .xml file.
• Edit Job Templates: Allows you to edit an existing template

file.

Templates

Verifies the status of the group of robot controllers.Verify

Executes the user-selected action.Execute

Temporarily stops an active action.Pause

Resumes the paused action.Resume

Aborts the active job.Cancel

Continues on next page
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Device List window
You can define the population of robot controllers that the job should be applied
to, using the Device List window. This window contains the metadata of all robot
controllers that are part of the group.

• Network Address: This field is mandatory. IP address or DNS name of the
controller. The controllers can be distributed on multiple subnets. You can
add controllers that cannot be directly found by Netscan from the current
location.

• Controller Name: This is an optional field. This value is used to verify the
controller name that can be identified by the network address.

• System Name: This is an optional field. This value is used to verify the system
name running on the controller that can be identified by the network address.

• Group: This is an optional field. This value is used to filter out a subset of
robot controllers from a list while executing jobs.

• Subgroup: This is an optional field. This value is used to filter out a subset
of robot controllers from a list while executing jobs.

• Comments: This is an optional field. You can type in comments in this field.
If you add a controller to the list using the Scan Subnet command, then the
system displays Found by Netscan message in this field.

Creating a new job
1 On the Controller tab, in the Controller Tools group, click Jobs. The Jobs

contextual tab opens.
2 In the Device Lists group, click New Device List. The Unnamed Device List

window opens.
This device list can be saved in .xlsx format.

3 In the Device Selection area, select a device list in the Device List. The
Group Filter list will be populated if the selected list contains data in the
Group fileld.

4 Enter valid credentials in the Username and Password boxes, or select
Default Credentials if the Default User has sufficient grants to perform the
selected action.
The specified user must be available and this user should have sufficient
grants for all controllers.

5 In the Action list, click the action that you want to perform. Depending on
the selected action, additional action specific data might be required.
To configure these actions, you must provide the required data.

6 In the Jobs group, click Verify/Execute to perform the selected action.
Once the action gets completed, a report and a log file are created. You can
open this report (in .xlsx format) from the History browser. The log file is
used for troubleshooting and support.
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Allow Execution State Running
You can not execute a job when the controller's program execution is in theRunning
state. This precaution is to avoid production getting disturbed when robots are
performing sensitive path following applications such as laser cutting or arc welding.
Jobs such as backup or search RAPID data can put load on the controller. Select
the Allow Execution State Running check box available in the Device Selection
area while executing these jobs.

Supported actions
Using the Jobs feature you can perform the following actions on a group of robot
controllers. You must select the required action in the Selected Action list in the
Jobs window. Some of these actions require the following additional data.

DescriptionAction
• Backup Path: User-defined destination folder for saving the

backup file, this file contains controller specific backup folders
with a date and time stamp in the format Backup_{Date}_{Time}.

• Backup name: The name of the backup file in the format {Sys-
temName}_{Date}. The name template can be modified according
to the user needs. The strings in curly brackets will be replaced
by the current values.

Note

The complete list of options to use for creating the file and folder names
are {NetworkAddress}, {ControllerName}, {SystemName}, {SerialNum-
ber}, {Comments}, {Group}, {Date} and {Time}.

Backup

Creates backup of program modules with a date and time stamp in the
format Backup_{Date}_{Time}. You can specify the name and destination
folder of the backup program module in the Backup name and Backup
Path fields.

Backup Program
Modules

• UAS File: User-selected UAS file.
• UAS File Password: Password of the UAS file. For more details

about creating a UAS file, see User Accounts on page 421.

Update UAS

Threshold (seconds): User-defined threshold time in seconds. The
threshold defines the allowed time difference.

Set Time

Reads the time for each controller and compares it with the local PC
time.

Verify Time

Select this action to set the time zone of the NTP server.Set Time Server
and Time Zone Enter the name of the server in the NTP Server box and select the re-

quired time zone in the Time Zone list.

Reads the specified event logs and saves it to the specified location
on the PC.

Save Event Logs

Searches the event logs for a specified type (All, Warnings and Errors,
Errors) and upto an optional time(in days). You can also specify the
range for the error codes to include in the search.

Search Event Logs

Continues on next page
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DescriptionAction

You can read RAPID Data, I/O Signal values, Configuration parameters
and device information with this function.

• For RAPID Data, you must specify the URL of the RAPID instance
as Task/Module/Data or only Task/Data, for example,
T_ROB1/Module1/myToolData, or T_ROB1/myToolData. The
result will be the value of the instance.

• For I/O Signals, you must specify the name of the signal, for ex-
ample, mySignal. The result will be the signal value.

• For configuration parameters, you must specify the URL to the
instance attribute in the form DOMAIN/TYPE/InstanceName/At-
tributeName, for example MOC/ARM_LOAD/r1_load_4/mass or
EIO/EIO_SIGNAL/diMySignal/access.

• Select the Devices option, to read device information like Main
Computer Fan Speed, Main Computer Module Temperature,
CPU Temperature and Free RAPID Memory(MB) by selecting
the required option in the Copy From the device browser.
To read other properties, copy the device property ID from the
Device Browser. Right-click the desired property and select
Copy device property ID from the context menu. Paste the ID
into the text field above.

See the Technical reference manual - System parameters for the names
of the domains, types and attributes. The result will be the value of the
attribute.

Read Single Data

Searches for RAPID instances that matches the specified search pat-
terns. You can restrict the search to tasks, modules, data types and
names of record fields that match the specified pattern.

Search RAPID
Data

Searches for lines that contain the specified text string. You can restrict
the search to tasks or modules that match a certain name pattern.

Search RAPID
Text

Writes the selected file or directory to the specified target directory.Write File or Direct-
ory

Reads the selected file or directory from HOME folder or from a task.Read File or Direct-
ory

Reads the options, languages and media versions of the controllers.System Informa-
tion

Invokes an external executable.
• External Tool Path: Location of the folder where the external tool

is placed.
• Arguments: User specified arguments which the external tool

passes, for example {SystemName}, { Network address},{Group}
and so on.

• Timeout(s): Specifies command time out period.

Run External Tool

Compares two folders and generates a report with the differences.
These reports are available in two formats, Excel and xml files. These
reports are not exclusive to Compare Folder.

Compare Folder

Jobs with several actions
You can use the Add button to create a job with several Actions. The Remove
button will remove the selected Action. The execution order can be changed by
the Up and Down buttons. There will be one sheet per Action in the resulting Excel
report.
The Save function, Verify and Execute are not specific to the multi-action Job.
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Running job from the Command Prompt window
Use the following steps to run a job or a batch of jobs from the Command Prompt
window.

ActionStep

Create a Job and save it with a suitable name, for example 'Job1'.1
For a default installation of RobotStudio, the job gets saved in C:\Users\<user
name>\Documents\RobotStudio\JobTemplates folder as an *.xml file.

Open Notepad and type in "C:\Program Files (x86)\ABB Industrial IT\Robotics
IT\RobotStudio 6.xx\Bin\Addins\FleetManagement\runjob.exe" "C:\Users\<user
name>\Documents\RobotStudio\JobTemplates\Job1.xml"/defaultcredentials.

2

The example assumes that RobotStudio is installed in the default location. A specific
user name and password can be supplied with the options /user:<user name> and
/password:<password>.

Save the *.txt file with the *.cmd extension.3

Double-click the *.cmd file to run the job.4
Log files and reports get generated and is available in the Jobs browser.

Note

You can schedule jobs using the Task Scheduler.

Operating manual - RobotStudio 435
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

11 Controller tab
11.3.14 Jobs

Continued



11.4 Features for virtual controllers

11.4.1 Virtual FlexPendant

Opening a Virtual FlexPendant
You can open a virtual FlexPendant in one of the following ways:

1 On the Controller tab, in the Controller Tools group, click the arrow next to
the FlexPendant icon, and then click Virtual FlexPendant.

2 Press the keyboard shortcut, CTRL + F5.

Note

The Virtual FlexPendant is applicable while running a virtual controller.
For information on specifying the appearance and placement of virtual
FlexPendant, see Options on page 217.

Note

RobotStudio does not support non-motion execution option. This option can be
set to prevent the real controller from moving, even when, the program is
executing. RobotStudio will ignore this option and move the robot. The non-motion
execution option applies to virtual controllers only.
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11.4.2 Control Panel

The Control Panel dialog box

This group contains the three operational modes of the control-
ler represented by option buttons.

Operation Mode

This option corresponds to the Auto mode on the FlexPendant.Auto
Moving between the Auto and Manual Full Speed options
must proceed via the Manual option.

This option corresponds to the Manual mode on the FlexPend-
ant.

Manual

This option corresponds to the Manual 100% mode on the
FlexPendant.

Manual Full Speed

Moving between theAuto andManual Full Speed options must
proceed via the Manual option.

Click this button to turn on the motors.Motors On

In a manual mode, click this button to simulate holding the
three-position enabling device to turn on the motors.

Enable Device

In a manual mode, click this button to turn off the motors.Release Device

If the controller enters the emergency stop state, click this
button to reset the state.

Reset Emergency Stop
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11.4.3 Shutdown

Shutting down a controller
1 In the Controller browser, select the controller to shut down.
2 Select the controller.
3 Follw these steps to shutdown a controller:

• On the Controller tab, in Controller Tools group, click Restart and
then click Shutdown to shutdown a virtual controller.

• On the Controller tab, in Controller Tools group, click Restart and
then click Shutdown main computer to shutdown a real controller.
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11.4.4 Set Task Frames

Modifying Task frame
1 On the Controller tab, in the Virtual Controller group, click Task Frames.

The Modify Task Frames dialog box appears.
2 Set the reference to World, UCS, or Local.
3 Edit the position and orientation of task frames in the Task Frames coordinate

box.
4 Click Apply.

To the question, Do you also want to move the Base Frames(s)?
• Click Yes to move the base frame, but keeps its relative placement to

the task frame.
• Click No. The following question appears Do you want to update the

controller configuration and restart?. Click Yes to restart the controller
and update the base frame configuration of the connected VC.

Note

If there are any stationary RAPID objects (tooldata, workobjects) connected
to the robot, the following question appears Do you want to keep the
positioning of all stationary RAPID objects?

• Click Yes to keep all the stationary RAPID objects in their global
coordinates.

• Click No to move all the stationary RAPID objects along with the base
frame (same coordinates relative to base frame).
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11.4.5 Edit System

Overview
The Edit System window contains functions for making and viewing advanced
system configurations, such as changing controller and baseframe positions,
calibrating and setting up external axes.
The left side of the Edit System window contains a hierarchical tree with which you
browse to different aspects of the system. The right side contains a property sheet
for the aspect selected in the tree. Below are short descriptions of the property
sheets for each aspect node of the tool.

CAUTION

Editing the system may result in corrupted systems or unexpected robot
behaviors. Be sure to understand the effects of the changes before proceeding.

The System node
The system node contains a box with information about the system and a button
for loading new parameters (configuration files) to the system.

The task node
The task node has no property page.

The mechanism folder node
The property page of this node contains controls for mapping and setting axis and
joints. It is from this page you set up external axes.

The mechanism library node
The property page of this node contains controls for changing the baseframe of
the robot or mechanism. Here, too, you specify whether the baseframe is moved
by another mechanism (coordinated motion), like a track external axis.

Updating the baseframe position
1 Move the mechanical unit (robot or external axis) to its new location using

the ordinary tools for moving and placing objects.
2 In the Controller browser, select the controller for the mechanical unit.
3 On the Controller tab, in the Virtual Controller group, click Edit System.

This opens the System Configuration dialog.
4 Select the node for the mechanical unit in the hierarchical tree. The baseframe

property sheet for the robot is now displayed.
5 Select the baseframe position values to use after restarting the robot.

ToSelect

Reset all changes to the baseframe made since the last
time the system was started.

Controller values
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ToSelect

Reset all changes made to the baseframe since the last
time the station was saved.

Stored station values

Optionally, you can enter new values in the baseframe
coordinate boxes (relative to the controller world coordin-
ate system).

Read and use the current location of the baseframe.Use current station val-
ues Optionally, you can enter new values in the baseframe

coordinate boxes (relative to the controller world coordin-
ate system).

6 Click OK.

Note

For information on adding a track from the Edit System tool, see Track motion
of type RTT or IRBTx003 on page 90.

Calibrating the baseframe position
The positioner mechanism is placed according to the base frame values of the
virtual controller. When a virtual controller is created from backup, in which, the
positioner was calibrated online using four points method, and if the positioner
was not in its sync position at the first calibration point, then the positioner
mechanism will not be aligned with the system's task frame .
You can calibrate base frame values to realign the positioner mechanism with the
system's task frame.

1 In the controller tab, click Edit System. The System Configuration dialog
opens.

2 In the System Configuration window, select the positioner mechanism and
then click Calibrate.
The Base Frame Calibration Position dialog opens.

3 From the System Configuration dialog, copy the Orientation values under
Base Frame and paste these values in the boxes under Orientation in the
Base Frame Calibration Position dialog.

4 ClickApply and then clickOK. You must restart the controller when prompted.
The positioner mechanism will be aligned with the system's task frame now.
Any object attached to the positioner will take the orientation of the positioner.
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12 RAPID tab
12.1 Overview of the RAPID tab

The RAPID tab provides tools and functionalities for creating, editing, and managing
RAPID programs. You can manage RAPID programs which are online on a real
controller, offline on a virtual controller, or standalone programs which are not part
of a system.
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12.2 Synchronize to Station

Synchronizing to the station
1 On the RAPID tab, in the Access group, click the arrow next to the

Synchronize icon, and then click Synchronize to Station.
2 Select the paths to be synchronized to the station from the list.
3 Click OK.

The message Synchronization to Station completed is displayed in the
Output window.

RAPID can be synchronized from the files of the HOME folder as an alternative:
• In the Controller browser, under Home folder, right-click any file and then

click Synchronize to Station to synchronize data and procedures of the
selected file into the station.

• In the Controller browser, under Home folder, right-click any file and then
click Synchronize to File to synchronize data and procedures from the staton
into the selected file.
Before selecting this option, you must synchronize the selected file to the
station. Using theSynchronize to Fileoption can confilict with the synchronize
to RAPID option.

Limitations
• Robtargets that are local to a procedure are not supported by Synchronize

to Station. Only robtargets that are local to a module are supported.
• RobotStudio does not fully support instructions using Offs or RelTool

functions. These are synchronized and will appear in the element browser,
but commands such as View Tool at Target and Locate Target will not work.
Targets used in the instructions will not be visible in graphics. However,
instructions can be programmed and edited using the RAPID Editor and can
be simulated using the virtual controller.

• RobotStudio does not support RAPID programs containing arrays of tooldata,
robtargets and workobjects. These programs will not be synchronized to the
station.

• Workobjects and tooldata that are shared between several tasks must be
specified in RAPID with its full value for each task when programming offline
with RobotStudio. This will trigger a warning Initial value for PERS not updated
in the controller event log. You may ignore this warning. However, you must
carefully ensure that the RAPID variable definitions are the same in all tasks,
otherwise you may get unexpected behavior.
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12.3 Synchronize to RAPID

Synchronizing to RAPID
1 On the RAPID tab, in the Access group, click the arrow next to the

Synchronize icon, and then click Synchronize to RAPID.
2 Select the elements to be synchronized from the list.
3 Click OK.

The message Synchronization to RAPID completed is displayed in the
Output window.

Note

This function is also present in the Controller group on the Home tab.
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12.4 Edit RAPID code

Editing RAPID code using RAPID Editor
The RAPID editor enables you to view and edit programs loaded into a controller,
both real and virtual. The integrated RAPID editor is useful for editing all robot
tasks other than robot motion. With the RAPID editor you can edit the RAPID code
of the program modules and system modules. Each module you open appears in
an editor window of its own, where you can add or edit RAPID code.
For examples of using the RAPID editor, see Examples of using the RAPID editor
on page 473.

General RAPID Editor features
The following are the general features of the RAPID Editor:

• Read-only documents - If the document is read-only (for example, due to
lack of mastership), then the background of the editor area will be light gray
instead of the normal white. Typing in an editor that is in the read-only state
results in a dialog asking you whether RobotStudio should acquire write
access.

• Syntax highlighting - Text is highlighted in different colors depending on
their token classification (such as keyword, identifier and so on). You can
configure these colors in the File tab, under Options:Robotics:RAPID Editor.
For more information, see Options:Robotics:Text Editor on page 220.
In addition to token classification, the editor also shows different colors for
built-in and installed identifiers (such as MoveL) and also for identifiers
declared in user code.

• Quick-Info tooltips - When you hover the mouse pointer over a symbol (such
as a data declaration or procedure call), a tooltip is displayed describing the
symbol. For many built-in symbols (such as MoveJ) a short description is
also displayed. For symbols corresponding to a data declaration, the current
value is also displayed.

• Context-sensitive help - Pressing F1 when the cursor is on a RAPID
programming construct, such as an instruction, opens the related section in
the RAPID reference manual, instead of the main RobotStudio help.

• Auto-indent cursor on return - When you press Enter, the cursor is
automatically indented by the appropriate amount on the following line. For
example, after typing a PROC header, pressing ENTER will indent the cursor
one tab (or the corresponding number of spaces, depending on settings).

• Completion list - When you type in code in the editor, a pop-menu which
lists possible code suggestion maybe displayed depending on the kind of
RAPID code construct being written. The suggestions listed also depend on
where in the document the cursor is.
Pressing comma (,), semi-colon (;), colon (:), equal sign (=), Spacebar, Tab,
or Enter keys automatically inserts the selected item. Press Esc to cancel
the list.

Continues on next page
446 Operating manual - RobotStudio

3HAC032104-001 Revision: U
© Copyright 2008-2017 ABB. All rights reserved.

12 RAPID tab
12.4 Edit RAPID code



• Auto-completion - After typing or completing a procedure call (such as
MoveJ), pressing the Tab key will fill in all required parameters. Note that
this is only available for certain built-in procedures, such as those listed in
the Insert Instruction menu.

• Argument information - While typing in procedure calls and function calls,
tooltips showing argument information are displayed.

• Collapsible regions - All regions of the code can be collapsed. In the RAPID
tab, click Outlining to access this functionality. You can either collapse or
expand all regions or can select a particular region to collapse or expand.

• Error highlighting - Red squiggly lines appear under errors in the code. All
syntax errors and a subset of semantic errors are indicated in this manner.

• Zooming in and out - In the RAPID editor you can zoom in and zoom out of
the code display. Click the plus (+) and minus (-) buttons at the top right
corner of the RAPID editor window to zoom in and zoom out.

Tip

The Zoom in Zoom out feature is also present in the RAPID Tasks, Rapid
Editor, Configuration Editor, Event viewer, and I/O windows.

• Cut, copy, paste and drag and drop - These standard commands for
clipboard handling of text are supported.

• Undo and redo - Standard commands for undo and redo operations are
supported.

• Selection modes - You can select text by character, row and column.
• Line numbers - Line numbers for the RAPID code lines are displayed in the

left margin of the editor.
• Keyboard shortcuts - For keyboard shortcuts in the RAPID Editor, see

Keyboard shortcuts on page 78.
• RAPID compare- To compare the controller version of RAPID module with

the editor/file version, right-click an open module and then click Editor
Version or File. You can compare folders and files using theCompare button.
In the Find group, click Compare and then select the required comparison
options like Controller Version and Editor, Controller Version and File and
Editor and File.
You can configure the comparison results either to show all content with the
differences highlighted or with only the differences between files/folders.
Select Options like BackInfo, PERS variables, Comments, Character case
and White space to add filters. The BackInfo option excludes the timestamp
of the Backinfo.txt file from comparison.

Starting the RAPID Editor
To open a RAPID module in the RAPID editor, in the Controller browser right-click
on a RAPID module, and then click RAPID Editor.
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The RAPID code of the module opens in the editor window.

Tip

You can view the graphical layout, without closing the editor, by clicking the
graphics window tab.

Editing a RAPID program
The Edit group on the RAPID tab has commands which help in editing the lines of
code in the RAPID Editor. Other than standard functions such as Cut, Copy, and
Paste, the following functions are present in the Edit group:

• Comment – To comment out selected lines
Uncomment – To uncomment commented lines
The comment and uncomment buttons in the ribbon will add/remove comment
characters (“!”) at the beginning of the selected line(s).

• Indent – To increase the indent of selected line(s) by four white spaces
Unindent – To decrease the indent of selected line(s) by four white spaces
The indent and unindent buttons in the ribbon will move the selected code
line(s) one tab position to the right/left.

• Format Document - Auto-formats the active document by arranging the
spaces and tabs in the RAPID code.

• Uppercase Keywords - To change RAPID keywords from lowercase to
uppercase. This function operates on the current document.

• Format Selection – This function is similar to Format Document, but with the
difference that it operates on currently selected text.

• Convert Spaces to Tabs - Converts consecutive spaces to the corresponding
number of tabs. This function operates on the current selection.

• Convert Tabs to Spaces - Does the opposite of function above.

Note

To make formatting easier, the tabs and white spaces can be indicated by
arrows and dots, respectively. To enable this go to Options:Robotics:RAPID
Editor (Options:Robotics:Text Editor on page220) and then select the Show
whitespace check box.
By default a Tab consists of four whitespaces. To change this, go to
Options:Robotics:RAPID Editor and set the Tab size as your require.

• Modify Position - Updates the coordinates of the target used in the move
instruction to the current position of the robot.

Edited lines are denoted by change bars which remain until the edits are applied.
Also, the RAPID Editor’s tab sports an asterisk (*) until the edits are applied.
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Adding code snippets
Code Snippets are pieces of code which you can insert into the RAPID Editor. To
view and select a code snippet, in the Insert group, click Snippet.
The list which appears show two kinds of code snippets:

• Predefined code snippets
• User defined code snippets

The following are the predefined code snippets in RobotStudio:
• Array of num, 2x2x4
• Array of num, 2x4
• Array of num, 2x4x2
• Array of num, 4x2
• Module header
• Procedure with parameters
• Procedure with error handler
• Robtarget declaration
• Tooldata declaration
• Workobject declaration

You can also create your own code snippets or save a section of existing code
from the RAPID editor as a code snippet. Such user created code snippets are
also listed along with the predefined snippets.
To save a section of existing code, from the RAPID editor, as a code snippet:

1 Select the code you wish to save as a snippet.
2 In the Insert group, click the arrow next to the Snippet icon, and then click

Save Selection as Snippet.
The Save As dialog box appears. Specify a name for the snippet and save
it. The RobotStudio .snippet files are saved in the following folder.
C:\<Documents and Settings>\<user name>\RobotStudio\Code Snippets

To insert a snippet in the RAPID editor, click the arrow next to the Snippet icon,
and then click the required snippet from the listed snippets.

Note

The folder <Documents and Settings> may be configured with different names,
for example, Data. It may also be translated on localized versions of Windows.
Snippets can also be edited in an XML editor such as Microsoft Visual Studio.
For information on creating customized code snippets, see
http://msdn.microsoft.com/.

Inserting instructions
To insert a predefined instruction into the code:

1 Place the cursor at the required point in the RAPID code.
2 In the Insert group, click Instruction.

A list of pre-defined instructions is shown.
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The instruction is inserted into the code where the cursor is placed.
RobotStudio generates and inserts default arguments to the instruction,
using similar rules as the FlexPendant.

Applying and verifying the edits
To apply the changes made in the editor to the system and also to check the
program go to the Controller group, and click the arrow next to the Apply icon.
Then:

• To apply only the changes in made in the module, currently shown in the
editor, click Apply Changes.
Alternatively, you can also directly click the Apply icon

• To apply the changes made in all modified modules, click Apply All.

Note

The Apply commands are enabled only if there are changes waiting to be applied.
When possible, RobotStudio will try to commit the changes without losing the
program pointer. If this is not possible, you will be asked if it is OK to lose the
program pointer.

To verify the syntactic and semantic correctness of the modules, in the Test and
Debug group, click Check Program.
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12.5 Find and replace RAPID code

Overview
The Find group, on the RAPID tab contains commands for performing Find and
Replace actions on the code in the RAPID editor.

Quick Find
Enter the search string in the Quick find box and then press Enter or F3. If an
instance is found, it is highlighted. Press F3 again to search for the next instance.

Go to line
Enter a line number in the Go to line box and press Enter. The cursor moves to
the corresponding line in the RAPID editor. When multiple tasks are open in the
editor, and if you select the procedure name in the list box, the cursor moves to
the task that contains the specified name.

Jump To
The Jump To list has an item for each routine and data declaration in the program
module. Click an item to move to its location in the code.

Find or Replace
Click Find/Replace to open the Find/Replace dialog. This dialog provides standard
find/replace functionality and the following options.

• Enter the string to search in the Find what list.
• In the Look in list, select the option to specify the location to look for. The

various options are Current Document, Current System, Current Task, or
a folder in your PC (you can browse to a folder to specify it).

The Search Resultswindow displays the results of the find operation. Double-click
a search result to go to the corresponding instance in the RAPID editor. If the
instance is from a module which is not in the RAPID editor, then the module opens
in the editor.

Go To Definition
The Go To Definition command is enabled for an identifier in the RAPID Editor
context menu if the source code for the corresponding symbol definition is available.
ClickGo To Definition to move the cursor to (and select) the corresponding symbol
definition. This action detects symbol definitions such as routine declarations, data
declarations and record definitions.

Navigate forward/backward
Use the Navigate Backward button to move to previous locations of the RAPID
modules being edited, and the Navigate Forward button to return to more recent
locations.
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Find Unused References
Click Find unused references in Task to see all data declarations in the task of
the active module document that are not used anywhere. The results are shown
in the Search Results window. Click Find unused references in Module to see
unused data declarations in the current module.

Find All References
The Find All References command is enabled for identifiers in the editor code.
For a given identifier, click Find All References to search through the entire task
for uses of the same identifier (including its definition). Note that this is not just a
string search. It takes RAPID scoping rules into account. For PERS and syncident
data, this function searches the other tasks for a matching global symbol and return
the uses of those.
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12.6 Manage RAPID modules

Managing file based RAPID modules
File based RAPID modules can be opened in the editor in four different ways:

• Using the Open command on the File tab
• Using the New:RAPID Module File command on the File tab. For more

information, see Creating a new RAPID module file on page 212.
• Double-clicking a module in the File browser of the RAPID tab. For more

information on the File browser, see Manage RAPID files and backups on
page 456.

• Right-clicking the Files nodes and selecting Open in the File browser of the
RAPID tab. For more information on the File browser, see Manage RAPID
files and backups on page 456.

Tip

For file based modules, the standard file commands are applicable: Save/Save
As will save the module; Open will open a module and Close will close the
module.
TheApply Changes command is disabled for file based modules. It is applicable
only for controller based modules.

Creating a new RAPID module
1 On RAPID tab, in the Controller browser, right-click a task and then click

New Module.
The Create Module dialog box opens.

2 Enter a module name.
3 Select the Module type as Program or System, as required.
4 Select one of the following options:

• No Step-In - The module cannot be entered during step-wise execution.
• Read-only - The module cannot be modified.
• View-only - the module cannot be modified, but the attribute can be

removed.
5 Click Create.

Loading a RAPID module
You can load a RAPID module either from the system or from the controller disk.

1 On RAPID tab, in the Controller browser, right-click a task and then click
Load Module to load a module from the system or click Load Module from
Controller to load a module from the controller disk.

2 Browse to and select the module to be loaded to your station, and then click
Open.
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Saving a RAPID module
You can save a RAPID module either in the system or in the controller disk.

1 On RAPID tab, in the Controller browser, right-click a module and then click
Save Module As to save the module in the system and click Save Module
to Controller to save the module in the controller disk.

2 Browse to the location where the new module is to be saved and then click
Save.
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12.7 Edit RAPID data

RAPID Data Editor overview
The RAPID Data Editor allows you direct access to RAPID data values, which you
can view and edit.
To open the RAPID Data Editor, on the RAPID tab go to the Controller browser,
right-click a RAPID module, and then clickRAPIDData Editor. This opens the Data
window which shows the data declarations in that particular module.
Data declarations are grouped according to their data types. All data declarations
belonging to a data type are shown in a table below it. Each row corresponds to a
data declaration and shows the contents of the declaration.

Using the RAPID Data Editor
• Editing the values of a row opens the changed value in the RAPID Editor

window. The new value is shown in both the Data editor and also the RAPID
editor. This means that the changes made in the RAPID data editor are seen
in the RAPID editor, and vice-versa.

Tip

An asterisk (*) on the window tab indicates unsaved changes.

• You can select multiple cells and edit them together.
• You can create, edit or delete a data declaration from the RAPID Data Editor.
• To delete a data declaration, select the row and click theDelete button beside

it.
• To add a new declaration, click New Declaration next to the required data

type. This adds a new row to the table below it having some default properties
and values, which can be edited. However, you cannot add a data type
declaration that is not already present in the module. In such cases, you
must add the declaration manually to the module using the RAPID Editor.

• To view the orientation of robtargets in angles, select the Show quaternions
as RPY angles checkbox in the RAPID Data Editor. Orientations can be
represented in angles and quaternions, set the default representation in the
RobotStudio Options.

Note

The RAPID Data Editor only shows data declarations that contain editable values.
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12.8 Manage RAPID files and backups

Managing RAPID files
1 In the Files browser, right-click the File node and then click Open. The Open

File dialog box appears, browse and open system module (*.sys), RAPID
modules (*.mod), and Configuration files (*.cfg) which resides on your PC or
on a network.

Note

The content of the HOME folder of the connected virtual or real controller
is visible in the Controller browser. Both RAPID and configuration files
can be edited as text files.
For virtual controllers, RAPID modules can be synchronized to the graphics
environment of the station using the context menu of the RAPID module
file. To synchronize any changes back to the RAPID module, use the
command Synchronize to file.

2 A RAPID or system module file opens in the RAPID editor. The system
parameters file (*.cfg) opens in a notepad-like editor.

3 Click the Save button on the Quick Access Toolbar to save the changes.

Note

When you open standalone RAPID modules, the editor may show the code as
having syntax errors if the variable declarations exist in another module.

Managing system backups
Right-click Backup and click Browse, to select and open system backups.
The structure of the backup is reflected in the Files browser under the Backups
node. There is one node for each task defined in the system. The RAPID modules
of each task are shown as its child nodes in the tree view. The editor will find data
declared in other modules and correctly mark the code as being syntactically and
semantically correct.
The contents of the HOME folder are shown in a separate folder. RAPID modules
of the HOME folder will be edited in the standalone mode, which means that the
editor will not find data declared in other modules. The reason is that the editor
cannot know in which context (task) the module should be treated.
The SYSPAR folder will show the configuration files.

Note

There is no syntax check or intellisense for editing configuration files.
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12.9 Manage RAPID code on the controller

12.9.1 Manage RAPID programs

Loading a RAPID program
You can load a RAPID program either from the system or from the controller disk
to a station:

1 On the RAPID tab, in the Controller group, click Program icon and then
select Load Program to load a RAPID program from the system and select
Load Program fromController to load a RAPID program from the controller.
Alternatively, in the Controller browser, right-click the active task under the
station, and click Load Program.

2 In the Open dialog box that appears, browse to the location of the program
to be loaded to your station and click Open.

Saving a program
You can save a RAPID program either in the system or in the controller disk.

1 On the RAPID tab, in the Controller group, click Program icon and then click
Save Program As to save the RAPID program in the system and click Save
Program to Controller to save a program in the controller disk.
Alternatively, in the Controller browser, right-click the active task under the
station, and select Save Program As.

2 In the Save As dialog box that appears, browse to the location where you
want to save your program, and click Save.

Renaming a program
1 On the RAPID tab, in the Controller group, click Program icon and then click

Rename Program.
Alternatively, in the Controller browser, right-click the active task under the
station, and select Rename Program.

2 In the Rename dialog box that appears, enter a new name for your program,
and click Ok.

Deleting a program
1 On the RAPID tab, in the Controller group, click Program and select Delete

Program.
A confirmation dialog is displayed.

2 Click Yes.
The selected program is deleted.

To delete the entire program under a task in a station, in the Controller group, click
Program and then click Delete Program.
Alternatively, in the Controller browser, right-click the task under the station, and
then click Delete Program.
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12.9.2 RAPID Tasks

Overview
The RAPID Tasks window shows the configured tasks of the selected controller
and their state, in a tabular form. To open the RAPID Tasks window, in the
Controller group click RAPID Tasks.
The following table describes the columns displayed for each task.

The task name, as defined by the controller configuration in
topic Controller, type Task.

Task Name

For information on topic Controller type Task, see the Technical
Reference Manual for System Parameters.

A task can be of type Normal, Static, or SemiStatic. This is
defined by the controller configuration in topic Controller, type
Task.

Type

For information on topic Controller type Task, see the Technical
Reference Manual for System Parameters.

Shows which mechanical unit group is used for the task. This is
defined by the controller configuration in topic Controller, type
Task

Mechanical Unit

For information on topic Controller type Task, see the Technical
Reference Manual for System Parameters.

Defined by the Run Mode setting in RobotStudio. For more in-
formation on Run Mode, see Run mode of the controller on
page 461.

Run Mode

Displays the task execution state. A task can be in state Ready,
Running, or Stopped.

• Ready: The program has no PP (program pointer). To set
the program pointer, use the Program Pointer menu of the
RAPID Tab. Alternatively, use the FlexPendant.

• Running: The program is running.
• Stopped: The program has stopped.

For more information on the Program Pointer (PP), see Using
the Program Pointer on page 466.

State

Handles the system behavior when a SemiStatic or Static task
is stopped or not executable.

TrustLevel

The possible values here are NoSafety, SysFail, SysHalt or
SysStop.
A SemiStatic or Static task can only be stopped if it has Trust-
Level as NoSafety. The TrustLevel is defined by the controller
configuration in topic Controller, type Task.
For information on topic Controller type Task, see the Technical
Reference Manual for System Parameters.

The name of the program in the specific task.Program Name

The current module name.Module Name

The current routine name.Routine Name

Use this to set priorities between tasks. The current task will
execute only if the foreground task is idle. This is defined by the
controller configuration in topic Controller, type Task.

Task in Foreground
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Task execution state
A task can be activated, started, and stopped from the Controller browser, with the
following limitations:

• Only Normal tasks can be activated and deactivated. Background tasks will
always be automatically activated.

• Background tasks of type Static and SemiStatic can only be started and
stopped if they have TrustLevel NoSafety.
For detailed information about the different TrustLevel values, see the
Technical reference manual - system parameters.

• You need to have write access and the appropriate grant.
• The limitations concerning task execution that hold for the FlexPendant also

apply to RobotStudio.
The following table shows cases where task execution state cannot be changed.

RobotStudio gives a message that in-
forms the user that...

If...

the operation is not possible.the user does not have the grant Execute pro-
gram or Full access

the operation is not possible.the user changes from manual mode to automat-
ic mode, or vice versa, the user loses the write
access and

the Start operation is not possible.the motors are in off state

Note

It is not possible to override the controller’s safety system, that is, you cannot
stop a background task (Static and SemiStatic) that has the TrustLevel set to a
value other than NoSafety.
For detailed information about the different TrustLevel values, see Technical
reference manual - system parameters.

Activating, starting and stopping tasks
To activate a task, right-click the task in the Controller browser and then turn on
the Active command.
If the prerequisites are met, you can operate the task, such as start and stop the
task, move the program pointer to main and set the run mode.
To start a task, right-click the task in the Controller browser and then click Start
Task. You can start Normal tasks, but you can only start a Static or SemiStatic
task if the TrustLevel is set to NoSafety.

CAUTION

When starting a task, the manipulator axes may move very quickly and sometimes
in unexpected ways! Make sure no personnel is near the manipulator arm!
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To stop a task, right-click the task in the Controller browser and then click Stop
Task. You can stop Normal tasks, but you can only stop a Static or SemiStatic task
if the TrustLevel is set to NoSafety.
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12.9.3 Run Mode

Run mode of the controller
The Run Mode indicates the mode of the controller. It has the following two options:

• Continuous
• Single

You can set the run mode of the controller in the following ways:
• On the RAPID tab, in the Controller group, click Run Mode and then click

either Continuous or Single.
• This method is only applicable to virtual controllers in a station.

On the Simulation tab, in the Configure group, click Simulation Setup and
then select Continuous or Single in the Setup Simulation dialog box.
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12.9.4 Adjust Robtargets

Overview
The Adjust Robtargets feature helps in recalculating and changing the robtarget
data (tooldata and workobject data) while maintaining the joint angles of the robot.
The robtarget data related to the specified source tooldata and workobject will be
adjusted for usage with the new tooldata and workobject. In the RAPID tab, in the
Controller group, click Adjust Robtargets to access this feature.

Prerequisites
• You should have a controller (virtual or real) running with one or more

modules containing procedures with a sequence of move instructions
expressed with a defined tool and workobject.

• You should have RobotStudio Premium license to use this feature.
• The Execute button of the feature Adjust Robtargets will be enabled only if

the selected tool data or workobject data have the same properties, such as
robhold, ufprog, ufmec and so on.

Note

Arrays, event records, and offsets are not supported. Relative tool is also not
supported. Circular move instruction (MoveC) is supported.

Using Adjust Robtargets

Note

Take a backup copy of your modules before adjusting your robtargets.

The following procedure describes the Adjust Robtargets feature in RobotStudio:
1 On the RAPID tab, in the Controller browser, select a RAPID task or module

under the RAPID icon. Then click Adjust Robtargets on the RAPID tab.
Alternatively, right-click the RAPID task or module in theController browser,
and then click Adjust Robtargets in the context menu.
The Robtarget Adjust dialog box appears.

Note

You can accessAdjust Robtargets from theController tab also. Right-click
the RAPID task or module in the Controller browser and then click Adjust
Robtargets in the context menu.

2 If the module you want to adjust is selected, then go to Step 4. Otherwise
continue with the next step.
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3 Select a task from the Task drop-down list and module from the Module
drop-down list.

Note

In the Module drop-down list, you can either select a particular module or
<ALL> to update.

4 Select the source robtarget data (that is, the data defined in the selected
task) from Old tooldata and Old wobjdata drop-down list.

5 Select the destination robtarget data (that is, new tooldata and workobject)
from New tooldata and New wobjdata drop-down list.

6 Click Execute.
The Execute button is enabled only if source robtarget data (that is, old
tooldata and workobject) and destination robtarget data (that is, new tooldata
and workobject) are different.

The module searches for move instructions that use the specified old tooldata or
workobject and recalculates the robtarget data for the new tooldata and workobject.
For example,

1 Select "tool0" as the source tool and "wobj0" as the source workobject.
2 Select "toolb" as the new tool and "wobjb"as the new workobject.
3 Click Execute.

Robtargets of "tool0" and "wobj0" will be replaced with re-calculated robtargets
which correspond to the same robot configuration (all joint angles will be the same),
and with the new tool "toolb" and "wobjb". Note that both the tooldata and the
wobjdata are replaced independently.

Update instruction
By default, the Update instruction check box is selected. This means that move
instructions using the specified source (old) tooldata and workobject will be updated
to use the target (new) tooldata and workobject in addition to recalculating the
robtargets.
If the Update instruction check box is cleared, the robtargets will be recalculated,
but the move instructions will not be updated. They will still use the source tooldata
and workobject.
This feature is useful after the calibration of tooldata and workobject. After
calibration, you might still want to use the old names of the tooldata and workobject,
but update their values and recalculate the robtargets accordingly. The following
sample procedure illustrates how this can be accomplished.

Sample procedure
Prerequisite: RAPID module with robtargets and move instructions that use
uncalibrated tooldata tool1, and workobject wobj1.

1 Calibrate your tooldata tool1, and workobject wobj1. Store the new values
in tool1_calib and wobj1_calib, respectively. Keep the old values of the
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uncalibrated tooldata and workobject in tool1, and wobj1. An error message
gets displayed for an invalid selection of tooldata or workobject data.

2 Open the Adjust robtargets tool and clear the Update instruction check box.
Select your RAPID module, enter tool1, and wobj1 as your old tooldata and
wobjdata, and tool1_calib, and wobj1_calib as the new tooldata and wobjdata,
respectively.

3 Click Execute, and apply the changes to the controller from the RAPID Editor
4 In the RAPID Editor, rename your tooldata tool1 to tool1_uncalib, and

tool1_calib to tool1 and apply the changes to the controller. Also, perform
the same for wobj1.

Now, your robtargets are updated to match the calibrated values of tool1 and wobj1.

Limitations
• If a robtarget is used more than once but with different tools or workobjects,

then a message Target is referenced is displayed in the output window.
• The adjust robtargets function operates on a module level and does not

update any referenced targets defined in other modules. It ignores the scope
of the robtargets when the referenced targets are local to a procedure. In
this case, any targets with the same name in the module scope will also be
updated.

• Adjust Robtargets function works for modules with semantic errors, the editor
excludes the particular line containing the error and continues with program
execution. But Syntax errors stop program execution.
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12.10 Test and debug

12.10.1 Commands for testing and debugging

Test and debug group
The Test and Debug group on the RAPID tab consists of the following commands.

DescriptionCommand

Starts the execution of all normal RAPID tasks in the system.Start

Stops the execution of all normal RAPID tasks in the system.Stop

Starts and executes one statement in all normal tasks in the
system.

Step over

Starts and executes into a routine, while stopping at the begin-
ning of the routine.

Step in

Executes all remaining statements of the current routine, and
stops after the call to the current routine.

Step out

Ignores all breakpoints during simulation.Breakpoint : Ignore break-
points

Toggles a breakpoint at the cursor.Breakpoint : Toggle
breakpoint

Verifies the syntactic and semantic correctness of the RAPID
modules.

Check Program

Other tools such as the Program Pointer (PP) and the RAPID Profiler, which aid in
testing and debugging RAPID code, are explained in detail in the following sections.

Selected tasks
You can use this option to select a particular task from a set of tasks to be stopped
in the Manual Operating mode.
In the Controller group, click the Selected tasks button to view the list of tasks.
You can select the required foreground task(Normal) or background task
(Semistatic/Static) from the list.
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12.10.2 Using the Program Pointer

How the Program Pointer helps
During program execution, the Program Pointer (PP) points to the line of code that
is currently executing.
The function Follow Program Pointer keeps the program pointer visible during
program execution by automatically scrolling the RAPID editor window according
to the movements of the program pointer. To enable the function, in the Test and
Debug group on the RAPID tab, click the arrow next to the Program Pointer icon
and then select Follow Program Pointer.

Note

While the program executes, you can see the program pointer jump across
modules only if those modules are already open in the editor. Hence, you can
decide in which modules you wish to follow the program pointer in, and keep
them open.

The other commands in the Program Pointer menu are:
• Go To Program Pointer – To show the current location of the program pointer

in the RAPID editor
• Go To Motion Pointer – To show the current location of the motion pointer

in the RAPID editor
• To set the program pointer at a particular line code or code segment and

then start program execution from that point, use the Set Program Pointer
options. You can choose from the following options:

- Set Program Pointer to Main in all tasks
- Set Program Pointer to Cursor
- Set Program Pointer to Routine

Maintaining the Program Pointer
The RAPID code can only be edited when the controller is not running, that is when
it is in state Ready or Stopped. In Ready state the program pointer is not set, but
in Stopped state the Program Pointer is set to a specific location of the program.
For limited changes to the RAPID code of a controller in Stopped state, the current
location of the program pointer can be maintained. After such an edit you can
resume program execution from where it was without having to reset the program
pointer.

Note

If the edit is too large for the program pointer to be maintained then a warning
message is displayed to convey this.

The program pointer cannot be maintained, for example, when editing the line of
code at which the program pointer is located. Editing that line of code results in
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resetting the program pointer. In effect, the program will start from the beginning
when the controller is started after the edit.

WARNING

Starting program execution after the program pointer has been reset will cause
the robot to move along the shortest path from its current location to the first
point of the program.
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12.10.3 Using the RAPID Profiler

What's RAPID Profiler
The RAPID Profiler analyzes the execution times on procedure level, identifies
critical procedures and reports these during the execution of RAPID code.

Prerequisites for using the RAPID Profiler
• You should have RobotStudio Premium license to use this feature.
• You should have a controller with one or more executable tasks running.
• When using the RAPID Profiler with a real controller, you require more than

25 MB of free controller disk space.

Note

The RAPID Profiler will automatically stop if either of the following controller
events is generated by the controller. This is to avoid disturbing the robot
operation.

• 20192, Disk memory low (less than 25 MB free storage left)
• 20179, Diskmemory critically low (less than 10 MB free storage left, program

execution is stopped)

How to use the RAPID Profiler
To use the RAPID Profiler:

1 Set the Program Pointer at a desired point in the RAPID code from where
you wish to start your analysis. For example, set the program pointer to Main
in all tasks.

2 On the RAPID tab, in the Test and Debug group, click the arrow next to the
RAPID Profiler icon and then click Start.

3 Start the simulation.
In the background the RAPID Spy feature logs the data about the program’s
execution.

4 After the program execution ends, click the arrow next to the RAPID Profiler
icon and then click Stop.

5 On the RAPID tab, in the Test and Debug group, click the arrow next to the
RAPID Profiler icon and then click Analyze.
The RAPID Profiler window appears, showing the results of the analysis.

Click Export to Excel to export the results to a Microsoft Excel spreadsheet file.
To view the log file of the analysis, click the arrow next to the RAPID Profiler icon
and then click Open log file.

Execution of the Rapid Profiler based on RobotWare version
Depending on the RobotWare version, the RAPID Profiler is executed in one of the
following methods:

• For controller systems with RobotWare versions prior to 5.14, the RAPID
instructions SpyStart and SpyStop must be inserted at the RAPID execution
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start and end, respectively. When the program is run, a Spy log file is
generated. You can open the file for analysis by the RAPID Profiler. Use the
RAPID Profiler menu option Browse for Spy log to open the log file.
For more information about Spy instructions, see Technical referencemanual
- RAPID Instructions, Functions and Data types.

Note

When the RAPID Profiler is used to analyze a log file, there is no information
about in which procedure the SpyStart command is executed. The triggering
procedure defaults to <SpyStart Procedure>.

• For RobotWare version 5.14 or later, the log file can be generated
automatically. Activate the RAPID Profiler and run the program of the
controller. When the program execution stops, the results are presented to
the user.

Limitations
• The Spy function, which produces the input to the RAPID Profiler, does not

produce useful output for systems based for Continuous Application Platform
(CAP), Arc and RW Cutting. This affects the RAPID Profiler that analyses the
log that Spy function generates.

• The RAPID Spy function measures RAPID program execution time and not
motion execution time. To make these two times coincide for the RAPID
procedures, ensure that the last move instruction of all procedures is a stop
point. Otherwise, the RAPID instruction execution time will be lower than the
motion execution time. The reason being the program execution runs ahead
of the motion execution unless the programmed point is a stop point. For
more information on stop points, see RAPID Reference Manual.
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12.11 RAPID Breakpoints window

Overview
The RAPID Breakpoints window lists all current breakpoints for the connected
controllers.

Using the RAPID Breakpoints window
This window displays the following details:

DescriptionColumn

Name of the controller.System

Name of the RAPID task.Task

Name of the RAPID module.Module

Number of the line where breakpoint is applied.Line

The following actions can be performed:
• Double-click a row in the window to open the corresponding module in the

editor.
• Select rows and then press the delete-key to delete the selected breakpoints.
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12.12 RAPID Call Stack window

Overview
The RAPID Call Stack window displays the call stack for the selected task if the
program is in stopped state.

Using the RAPID Call Stack window
This window displays the following details:

DescriptionColumn

Name of the RAPID task.Task

Name of the RAPID module.Module

Name of the precedure.Routine

Number of the line that contains the routine.Line

This field can take values: NORMAL, STATIC and SEMISTATIC.Execution Level
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12.13 RAPID Watch window

Viewing variables and I/O signals
The RAPID Watch window displays the following details of selected variables and
I/O signals during program execution.

DescriptionColumn

Displays variable nameName

Displays variable valueValue

Displays type of datatypeType

Displays system nameSource

You can view and edit the RAPID data of the variables in the RAPID watch window,
both during program execution and when the controller is stopped. However, you
can only view, but not edit, I/O signals in the watch window.
To view a variable or I/O signal in the RAPID Watch window, you need to first add
it to the window. In the RAPID editor, right-click the required variable or I/O signal,
and then click Add Watch.
By default, during program execution the values of the variables are automatically
refreshed in the watch window every 2 seconds. You can also manually refresh
the values.
To enable or disable automatic refresh, in the context menu, select or clear the
Auto Refresh command.
To do a manual refresh, in the context menu, click Refresh (keyboard shortcut F5).

Note

CONST variables cannot be edited.
On closing RobotStudio, the variables and signals added to the watch window
are removed.

On the RAPID Watch window, right-click to display the following context menu:

Used forItem

Copying the valueCopy

Pasting the copied valuePaste

Deleting the watch itemDelete

Selecting all the itemsSelect All

Clearing all the variables and signals from the watch windowClear All

Manually updating the values of the variables and signalsRefresh

Automatically refreshing the values displayed in the watch
window at regular intervals

Auto Refresh

472 Operating manual - RobotStudio
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

12 RAPID tab
12.13 RAPID Watch window



12.14 Examples of using the RAPID editor

Overview
This section provides examples illustrating several useful functions of the RAPID
editor including IntelliSense, code snippets and the watch window.

Editing
Assume that you wish to create an infinite loop whereby the controller receives
commands from a line PLC. The controller communicates with the PLC using digital
I/O signals, but you have forgotten the exact name of the function that reads an
input signal.

1 Using code snippets, create a new procedure.
2 On the Rapid tab, in the Insert group, click Instruction.

A drop-down list of available instructions is displayed.
3 On the Instruction menu, point to I/O, and then click DOutput.
4 Press the spacebar to display the parameter information ToolTip. As you

enter parameters, the ToolTip is updated, displaying the current argument
in bold. The ToolTip is closed either by concluding the instruction with a
semicolon (;), or by pressing ESC.

Tip

At any time you may press CTRL + Spacebar to complete what you have begun
typing. This will either bring up a narrowed-down list of selectable parameters,
or, if only one selection remains, will automatically complete your text.

Tip

After typing the name of an identifier or an instruction, press the TAB key to
automatically fill in the default arguments or parameters. For instructions, the
last used argument of each type will be used.

Searching
Assume that you have programmed targets and motion instructions and
synchronized them to the controller. The number of targets is large, so you decide
to distribute them among several modules.
You may have forgotten in which module your main procedure is found.

1 Press CTRL + F to bring up the Find and Replace dialog box.
2 In the Find what box, type "PROC main". Since no modules are open, in the

Look In list, select Current System, and then click Find All.
The search result is displayed in the Search Results window.

3 Double-click the line matching your search to launch the RAPID editor.
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Adding breakpoints
Now that you have finished editing, you may want to test your loop and add some
breakpoints.

1 Place the insertion on the new statement and press F9 to set a breakpoint.
2 Ensure that the Ignore breakpoints button in the editor toolbar is not clicked,

and click the Play button on the Simulation toolbar.
The program will run and then stop at the breakpoint.

3 To run the program statement by statement, click the Step over button in
the editor toolbar.

Executing
You might want to debug your loop or monitor a specific variable.

1 In the RAPID editor browser, right-click the procedure you want to set as
entry point, and then click Set Program Pointer to Routine.

2 In the RAPID tab, click the Play button.
The program will run and then stop at the next breakpoint.

3 Select a variable for monitoring and drag it to the watch window.
4 Restart the loop and monitor the variable at each iteration.
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13 Add-Ins tab
Overview of the Add-Ins tab

The Add-Ins tab contains the control for PowerPacs, Migration tools and Gearbox
Heat Prediction. The Add-Ins browser shows the installed PowerPacs, General
add-ins.
For instruction on building General add-ins visit the ABB Robotics Developer Center
web site at http://developercenter.robotstudio.com.
General add-ins are loaded from the following folder on your PC: C:\Program
Files (x86)\Common Files\ABB Industrial

IT\RoboticsIT\RobotStudio\Addins

Note

For RobotStudio 64-bit edition:
• Add-ins will be loaded from the following folder: C:\Program Files

(x86)\ABB Industrial IT\RoboticsIT\RobotStudio

6.04\Bin64\Addins.

This is the path on a PC with Microsoft Windows 7, 64-bit English version
on default installation. For customized installations and for operating system
versions in other languages, this path may differ.
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13.1 RobotApps

You can view and download RobotWare, RobotWare Addin and RobotStudio Addins
from the RobotApps window. This window is divided into two panes, The names
of all addins appear on one pane and the details of the selected folder are displayed
on the other pane. You can download a specific version of the addin from this pane.
You can also view and download contents from the ABB RobotApps web page.
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13.1.1 Distribution package

Overview
A distribution package may consist of one or more products. When distributed as
one file, the suffix of the file is .rspak. Use the Install Package command in the
RobotApps page to install a distribution package.
RobotWare Add-In for the StandAlone Controller (SAC) is a separate package.
This package is available in the RobotApps page in the Add-Ins tab. You can
install RobotWare Add-Ins by browsing to a RobotWare Add-In manifest (.rmf file).
The Add-Ins browser shows the installed packages.

Locations of distribution package
In RobotStudio 6, RobotWare and related packages are referred as application
data. A distribution package is available in the following locations.

• ProgramData: used when the appdata is shared among users on the
computer. If RobotWare is installed with RobotStudio, the path is
%ProgramData%\ABB Industrial IT\Robotics IT\DistributionPackages\ and
on a PC with a default installation of Windows 7, the path is
C:\ProgramData\ABB Industrial IT\Robotics IT\DistributionPackages.

• LocalAppData: used if a package or manifest is installed by a particular user.
If RobotWare is installed with RobotStudio, the path is Users\<user
name>\AppData\Local\ABB Industrial IT\Robotics IT\DistributionPackages
and on a PC with a default installation of Windows 7, the path is
C:\Users\<user name>\AppData\Local\ABB Industrial IT\Robotics IT
\DistributionPackages.

• Customized location (optional): may be used when several users share a
package repository. For more information, see Additional distribution
package location in RobotStudio Options:General:Files & Folders.

Note

In the RobotApps page, in the Add-Ins browser, when you hover the mouse
pointer over a package node, the tooltip displays the location information of a
specific package. Right-click an installed package and then click Open Package
Folder to view the location of the selected package folder.
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Unpacked data
When used by a virtual controller, the packages are unpacked into a cached location
residing in a LocalAppData sub-folder, Users\<user name>\AppData\Local\ABB
Industrial IT\Robotics IT\RobotWare. On a PC with a default installation of Windows
7, the path is C:\Users\<user name>\AppData\Local\ABB Industrial IT\Robotics
IT\RobotWare. The content of this folder is similar to the RobotWare 5 Mediapool
folder.

Note

To uninstall a distribution package, right-click the particular package and then
click Uninstall Package. This removes the selected package and related,
unpacked data.
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13.2 Migration tools

Overview
To migrate a robot system from RobotWare 5 to RobotWare 6 you need to use the
migration tools in the Add-ins tab.
If you are upgrading from RobotWare version 5.15 or earlier, you must contact
ABB to replace the controller main computer by DSQC 1000 and also to get a
RobotWare 6 license. You can contact your ABB Robotics Service representative
at www.abb.com/contacts.
For details on the migration process, refer Instruction - RobotWare upgrade and
migration guide.
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13.3 Gearbox Heat Prediction

Overview
The Gearbox Heat Prediction Tool is an add-in for RobotStudio which helps to
predict heat problems in the gearboxes. When the temperature is above a
predefined value, you can adjust the cycle to reduce the temperature or order a
fan that can cool down the gear.
Robots with compact gearboxes have a risk of getting overheated under certain
circumstances. The gearbox temperature is supervised by Service Information
System (SIS). SIS is a software function within the robot controller, that simplifies
maintenance of the robot system. It supervises the operating time and mode of
the robot, and alerts the operator when a maintenance activity is scheduled. It also
supervises large robots from damaging the motors during high load operations
with a safety shutdown.
The temperature supervision is based on an algorithm that predicts the stationary
temperature of the gearboxes and motors of the robot. The algorithm predicts the
heat based on the character of the robot motion and also the room temperature.
Intensive motion (high average speed and /or high average torque and/or short
wait time) will increase the heat of the gearbox and motors.
To avoid overheating, SIS stops the robot if the temperature becomes too high.
For large robots, there is an option to add a cooling fan to axis 1, 2, and sometimes
axis 3, to allow the robot to run even with a heavy duty program.

Note

Gearbox Heat Prediction is not supported for Tool and External axis. When a
virtual controller has more than one robot, only one robot will have predictions
calculated. The other robots will only display 0% chance of overheating.

Prerequisites
1 RobotStudio 5.14.02 or later.
2 RobotWare 5.14.01 or later.
3 RobotStudio station with controller having a programmed cycle that includes

payload for the robot.

Calculating the Gearbox Heat
Use the following procedure for predicting the heat generated by the robot:

1 Create a new station or open a saved station. The Gearbox heat button is
now visible in the Add-Ins tab.

2 In theAdd-Ins tab, click Gearbox Heat. TheGearbox Heat Predictionwindow
opens.
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3 In the Add-Ins tab, select Enabled to enable the Gearbox Heat Prediction
tool .

Note

For a manipulator without compact gear, Gearbox Heat Prediction is
disabled.

4 Run a simulation.

Note

For RobotStudio Basic, the Play button in the Simulation tab will be
disabled. As such, you will be unable to run the simulation from the
Simulation tab. In such a scenario, use the Play button which will now be
visible in the Gearbox Heat Prediction tab window to run the simulation.

Note

The data is recorded during the simulation only if the Gearbox Heat tool
is enabled. After the recording is finished, you can perform another
recording or perform a calculation for heat related problems.

5 In Cycles, define the behavior of the cycle for predicting the heat generated
by the robot:

• Continuous: Select this option if you want the robot to continuously
calculate the predictions without waiting time between two consecutive
cycles.

• Number of cycles per hour: Select this option if you want to manually
specify the number of cycles per hour for calculation.

• Waiting time between cycles (sec): Select this option to specify the
waiting between cycles. Specify the waiting time in seconds.

6 In Ambient Temperature, define the ambient temperature.
• Use the slider to change the temperature.
• Select Use temperature from controller(s) to reset the the ambient

temperature.

Note

The ambient temperature used in the calculations should be the same
that is used in the configuration of the actual robot in its real
environment.

7 Calculate the result in either of the following ways:
• In the Recordings section, either double-click a recording or select a

recording and click Calculate.
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• In the System section, either double-click a controller or select a
controller and click Calculate.

Note

- The Recordings section displays the recordings to be analyzed
when Gearbox Heat Prediction is enabled.

- The System section displays all the available controllers. Data
for all controllers are recorded at all times and you can select
the controller to be analysed from the list.

The results are displayed for each joint and with fans for the joints that
can have fans installed as an option.

Note

The following factors influence the heat accumulated:
- Axis speed
- Payload
- Room temperature (ambient temperature)
- Waiting time (to allow robot to cool down)

Note

The calculated energy is displayed as different heat levels:
- Green: Indicates no heat problem
- Orange: Indicates it is recommended to install a fan.
- Red: Indicates a fan must be installed.
- Grey: Indicates it is not possible to calculate the possible energy

level for this joint.
- Not available: Indicates the joints that cannot have a fan

installed.

Note

Recommended action is displayed along with the warning level for
each joint.

- Joint: Represents the joint.
- Without fan: Displays the percentage of heat levels calculated

to the corresponding joint without fan.
- With fan: Displays the percentage of heat levels calculated to

the corresponding joint with fan.
- Action: Displays the recommended action.
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14 Context menus
14.1 Add to Path

Creating a move instruction based on an existing target
1 Select the target for which to create the move instruction.
2 From the Home menu, in the Path Programming group, select the type of

move instruction to create.
3 Click Add to Path.

The move instruction will appear under the path node as a reference to the
original target.
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14.2 Align Frame Orientation

The Align Frame Orientation dialog box

Specify the frame or target for which you want to align the se-
lected objects here.

Reference

The axis you specify here will be aligned as on the reference
target/frame for all selected objects.

Align Axis

The axis you specify here will not be changed on the selected
objects by the align function, but will keep its orientation.

Lock Axis
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14.3 Align Target Orientation

Aligning target orientation
1 Select the targets whose orientation you wish to change.
2 Click Align Target Orientation to bring up a dialog box.
3 In the Reference box, specify the target whose orientation you want to use

as reference, by first click in the box and then selecting the target either from
the graphics view or the Layout browser.

4 In the Align Axis box, select the axis whose orientation you want to copy
from the reference target to the selected ones.

5 In the Lock Axis box, select the axis to rotate the target around. The
orientation of this axis will not be changed on the targets. For example, if the
Z axis of all targets are orientated normally to the surface of the work piece
and you want to keep it this way, you should lock the Z axis.

6 Click Apply.

Tip

You can change the Align and Lock axis and click Apply again to reorientate the
targets until you deselect them.

Operating manual - RobotStudio 485
3HAC032104-001 Revision: U

© Copyright 2008-2017 ABB. All rights reserved.

14 Context menus
14.3 Align Target Orientation



14.4 Attach to

Attaching an object
1 In the Layout browser, right-click the child object, click Attach to and click

the parent object in the list.

Attaching an object by drag and drop
1 In the Layout browser, drag the child object to the parent object.
2 In the displayed message, click the corresponding button:

ClickTo

Yesattach the child object and move it to the
attachment point

Noattach the child object and keep its posi-
tion

Cancelnot perform the attachment
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14.5 Configurations

Auto Configuration
Use this procedure for setting the configuration of all targets in the path that are
marked as The configuration is not verified :

Note

For all targets in the path, the function will ignore any existing unverified
configuration and replaces it with optimal configuration with respect to the
configuration of the preceding target.

1 In the Paths&Targets browser, right-click a path, select Configurations and
then select Auto Configuration.
The robot now steps through each target in the path and sets the
configurations.

Note

• If the first target in the path has no configuration assigned, then the
configuration tool appears.

• If the first target has a configuration assigned, then the one assigned
will be used.

The result of auto configuration varies depending on the configuration of
the first target.
The configuration for targets in the path that has a verified configuration,
will not be re-assigned.

Reset Configurations
The configuration data which is a part of the target, when reset, is optimized by
Auto Configuration. As a result, the target / move instruction icon will change and
is marked as The configuration is not verified.
Use this procedure for resetting the configuration:

Note

You can reset the configuration of a path, target, or move instruction.

1 In the Paths&Targets browser, right-click a path, select Configurations and
then select Reset Configurations.

Note

To reset the configuration of a target or move instruction,
In the Paths&Targets browser, right-click a target or move instruction, and
select Reset Configuration.

Continues on next page
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Verify Configurations
Use this procedure for verifying the existing configuration:

Note

Targets and Move instructions marked as The configuration is not verified can
be verified with respect to the configuration.

1 In the Paths&Targets browser, right-click a path, select Configurations and
then select Verify Configurations.

Note

If the existing configuration is correct, then the move instruction is set as
verified.
If the configuration is incorrect, then the target is set as unreachable.

Auto Configuration for a dual-arm robot
A normal robot arm has six axis or degrees of freedom of movement whereas a
dual-arm robot has seven degrees of movement. Hence by configuring its arm
angles, a dual-arm robot can adapt several ways to reach a target. You can set the
arm angle while applying auto configuration.
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14.6 Check Reachability

Checking the reachability
You can use the Check Reachability function to check whether targets are reachable
or not. If you select a path for the check, then the reachability of all move
instructions in the path is checked. This function provides an easy reachability
check which you can use for initial positioning of the robot, its workobject, paths
and targets.
The Check Reachability function ignores the robot axis configuration. The function
indicates a target as being reachable if it can be reached with any robot axis
configuration, and ignores the defined robot axis configuration.

Note

The Check Reachability feature does not verify whether a path can be executed
or not.

1 In the Paths&Targets browser, right-click the workobject or target or path to
be checked for reachability.

2 Click Reachability to see the reachability status of the selected object.
The frames for the selected object change color in the graphic window based
on the reachability status.

MeansColor

The object can be reached.Green

The object cannot be reached at its current position.Red
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14.7 Configurations

Manually setting a robot axis configuration for single targets
1 In the Paths&Targets browser, select a target and then click Configurations

to bring up a dialog box.
2 If more than one configuration solution exist, examine them by clicking them,

one at a time.
The position of the robot with the selected configuration will be displayed in
the graphics window, and the joint values for the configuration will be
displayed in the joint values list below the configurations list.
In most cases, selecting a configuration similar to the previous one is the
best choice.

3 Select the configuration to use and click Apply.
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14.8 Convert Frame to Workobject

Converting a frame to a workobject
1 In the Layout browser, select a frame.
2 Click Convert Frame to Workobject. The new workobject will appear in the

Paths&Targets browser.
3 Optionally, rename or edit the workobject in any way.
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14.9 Work envelope

Overview
The defined area of space through which a robot can move. A robot can only
perform within the confines of this work envelope.

Viewing the work envelope of a robot
1 In the Layout browser, right-click any robot.
2 From the context menu, select Show Work Envelope, the work envelope

options are displayed on the left hand pane.
3 Select the object and the required view, for example, Robot Wrist/Active

Tool and 3D Volume/2D Outline. The corresponding work envelope gets
displayed.
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14.10 Convert to Move Circular

Prerequisites
At least two targets, the via-point target and the end point target, must have been
created.
A path containing at least the via-point target and the end point target, in correct
order, must have been created.

Converting to Move Circular
1 In the Paths&Targets browser, expand the path node that contains the move

instruction to be converted.
2 Select the move instruction that contains the via-point of the circular motion

together with the succeeding move instruction, which will serve as the end
point. You can select several instructions by holding down the SHIFT key
while clicking the instructions.

3 Click Convert to Move Circular. The two selected move instructions will be
converted to a circular move instruction, which includes the via-point and
the end point.

Tip

To convert two move instructions to a circular motion, you can also select and
right-click both move instructions at once and then click Convert to Circular.
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14.11 Copy / Apply Orientation

Copying and applying an orientation
1 In the browser, select the object or target from which to copy the orientation.
2 On the Modify menu, click Copy Orientation.
3 In the browser, select the object or target to which to apply the orientation.
4 On the Modify menu, click Apply Orientation. This can be performed on

several targets or a group of selected targets.
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14.12 Detach

Detaching an object
1 In the Layout browser, right-click the attached object (child) and then click

Detach. The child will be detached from the parent and return to its position
before the attachment.
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14.13 Execute Move Instruction

Prerequisites
The move instruction must exist.
A virtual controller must be running for the robot with the move instruction.

Executing a move instruction
1 In the Paths&Targets browser, browse to the motion instruction to execute

through the Controller, Tasks and Paths nodes.
2 Click Execute move instruction. The TCP of the active robot will move from

the current location to the motion instruction according to the programed
motion properties. If the target for the motion instruction does not have a
stored configuration, the robot will use the configuration nearest the current
one.
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14.14 External Axis Interpolation

Prerequisites
You need to have a path selected and a robot with external axis configured.

Interpolating external axis
1 In thePaths&Targets browser, select a path, right-click and select Interpolate

External Axis.
The Interpolate External Axis dialog box appears.

2 Select the mechanical unit from the Mechanical Unit drop-down list.
3 Select the axis to interpolate from the Axis drop-down list.
4 In the Interpolation drop-down list,

to...select...

set a constant value for the axis in each robtarget.Constant Value
You can set the value from the Value drop-down list.

calculate an axis value such that the
• For a linear axis, robot base is translated the offset

distance relative to the target along the axis direc-
tion.

• For a rotating axis, external axis value is calculated
so that the angle between the TCP approach direc-
tion and the rotational axis zeroposition is kept
constant at the offset angle.

TCP Offset

Calculates the speed for the entire path or between the
selected instructions for smooth functioning of the external
axis.

Constant Speed

5 Click Apply.
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14.15 Graphic Appearance

Overview
With the graphic appearance dialog box you set the graphic properties for an
individual object. These settings override the generic settings made in the options
dialog box. To launch the Graphic Appearance dialog box right-click a part in the
browser and select Graphic Appearance from the context menu.
The right part contains a preview of the part and controls for setting the behavior
and appearance of the preview. The user can work on the entire part, or on
individual bodies or faces by selecting them in the preview.

Graphic Appearance: The Material tab
The Material tab contains controls for setting material parameters or selecting a
material from the list of user defined and predefined materials. It is also possible
to save the current material to the user defined materials.
The Material tab contains two groups: Colors and Textures. The Color group
contains parameters for controlling the color properties of an object. The Textures
group contains the settings for textures. The color and texture setting together
define a material. You can save your current settings as a new material for later
re-use or apply an existing material.
The following options are available:

• Apply material : Provides a list of predefined material that can be applied to
the object.

• Savematerial : Saves the specified combination of color and texture settings
as a material.

Color group

Click this color box to select another color for the object.Simple Color

Controls the transparency of the object.Opacity

Set the color of the object for different light situations here.The color boxes

Specify the reflectiveness of the object here.Shininess

Textures group

Specifies the basic structure of the selected part. It is a stand-
ard 24-bit image displayed on a 3D surface.

Note

Transparency of textures is provided only for .png images.

Base texture

Check this option to specify the texture size. When a material
with a specified texture size is applied to a geometry, Robot-
Studio tries to adjust the texture coordinates so that the texture
image covers the specified area.

Note

This option works best on flat surfaces; on curved surfaces
the size will be approximate.

Specify texture size

Continues on next page
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Specifies how the texture is combined with the specified object
color.

Blend Mode

Provides a highly reflective appearance to the surface.Environment map

Specifies a texture that defines the bumpiness of the surfaceNormal Map

Graphic Appearance: The Properties tab
The Properties tab contains controls for surface properties and texture coordinates.

Surface Properties

By selecting this option surfaces will be rendered regardless
of orientation.

Render both sides

Selected surfaces can be inverted by this button.Invert surface(s)
This process is simplified by checkingHighlight inverted faces,
which will cause the background of surfaces to be displayed
in red.

Generate new normals. If the surface normals of an imported
geometry are of poor quality, they can be recreated by clicking
this button.

Generate new normals

Texture coordinates

Click this button to swap the horizontal and vertical directions
of the texture.

Swap u/v

Select along which directions the commands listed below shall
be applied.

Modify

u is the horizontal axis of the texture.
v is the vertical axis of the texture.

Click this button to set the ratio between the dimensions of the
object and the texture to 1.

Normalize

Click this button to invert the coordinates along the selected
axes. This is the same as mirroring around the other axis.

Flip

Click this button to stretch the texture along the selected axes.Stretch

Click this button to shrink the texture along the selected axes.Shrink

Click this button to move the texture along the selected axes.Shift<

Click this button to move the texture along the selected axes.Shift>
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14.16 Remove internal geometry

Overview
This function reduces the model by removing bodies and faces that are not visible
from outside. Internal bodies will be removed completely while internal faces will
be removed from the graphical representation. To restore the faces, the graphical
representation must be created.

Removing the internal geometry
1 In the Layout browser, right-click the model.
2 Click Modify and then from the context menu, click Remove internal

geometry.
Bodies and faces that are not visible from outside will be removed.
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14.17 Go to Visualization and Go to Declaration

Go to Visualization
The Go to visualization context menu command is available for targets in the
RAPID editor. It takes you to the 3D graphical widow to show you where the target
is found.

Note

This command requires that the RAPID code has been synchronized to the
station.

Go to Declaration
In the Paths & Targets browser, the Go To Declaration context menu command
is available for targets. This command takes you back to the target in the RAPID
editor.

Note

This command requires that the RAPID code has been synchronized to the virtual
controller.
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14.18 Zone visualization

The function shows a semitransparent sphere at each target, that represents the
TCP zone of the programmed zone data. To access this function right-click Path
and then select View and then click Show Programmed Zones or click Show
Actual Zones.
Commands

Shows a 3D sphere of the same radius as the zone size defined in
the RAPID program.

Show programmed
zones

Shows a 3D sphere of the same radius as the minimum of the zone
size the user sets or a zone with radius half the distance to the
preceding or succeeding target in the path. This corresponds to
the zone reduction carried out by the controller during program
execution.

Show actual zones

Depending on the zone data the sphere takes different colors white, red and purple,
white is the default color.

• Red: If the zone data contains the preceding or subsequent target, that is, if
the zone data is larger than the closest distance.

• Purple: If the zone data is greater than half the distance to the preceding or
subsequent target.

• White: The default color
•

Note

True move will not work for a user defined customized zone.
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14.19 Zone reduction

The zone size cannot be larger than half the distance to the preceding or succeeding
target in the path. If a larger zone is specified, the robot automatically reduces it.
The zonedata of zones that are red or purple when visualized with Show actual
zones are replaced by the largest possible standard zone data, for example, if the
largest possible zone is 123 mm, then the zonedata is replaced by z100.
To reduce zone size, follow these steps:

1 In the Paths&Targets browser or the graphics window, select the path.
2 Right-click and select Path and then select Reduce zones to access this

option.
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14.20 Interpolate Path

Reorienting targets in a path by interpolation
1 In the Layout browser or the graphics window, select the path with the targets

to reorient.
2 Click Interpolate Path. to bring up a dialog box.
3 With the Interpolate type options, select whether to use Linear or Absolute

interpolation.
Linear interpolation distributes the difference in orientation evenly, based
on the targets positions along the length of the path. By contrast, absolute
interpolation distributes the difference in orientation evenly, based on the
targets’ sequence in the path.

4 If using the Select Start/End option, select the start and end targets for the
interpolation in the Start target and End target boxes, respectively.

5 Optionally, with the Lock Axis options, select an axis to lock.
6 Click Apply.
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14.21 Invert

Inverting the direction of a face
1 Right-click in the Modeling browser, point to Filter and make sure that both

Show Bodies and Show Faces are selected.
2 In the Modeling browser, expand the node for the object and browse down

to and select the face which direction you want to invert.
3 In the Modeling browser, expand the node for the object and browse down

to and select the face whose direction you want to invert.
4 Click Invert. If the option backface culling is activated, the face will now shift

from visible to not visible, or the other way around, depending on from which
direction you view the face. If backface culling is deactivated, there will be
no visible indication that the direction of the face has been inverted.
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14.22 Jump to Target

Jumping to a target
1 In the Paths&Targets browser, browse to the target to jump to through the

Controller, Tasks and WorkObjects nodes.
2 Click Jump to target.

If the target has a valid configuration for the robot axes stored, the active
TCP of the robot will immediately be positioned at the target. If no valid
configuration is stored, the Select Robot configuration dialog box is
displayed.

3 In the Select Robot Configuration dialog box, select a suitable configuration
solution and click Apply. The selected configuration is now stored with the
target.

Note

You can deactivate the configuration check when jumping to targets. The robot
will then use the configuration solution closest to the current one when reaching
the target. For more information, see Options on page 217.
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14.23 Linked Geometry

Overview
The Linked Geometry feature allows you to load geometry from a shared repository.
If the source file is updated, then the station will be updated with a single click.

Adding Link
You can add a link to a geometry in two ways:

1 In the Home tab, click Import Geometry to open a dialog box.
Select the option Link to Geometry.

2 In the Layout browser, right-click an existing part in the station and select
Add Link.
A dialog box opens where you can select the CAD file to be linked.

Editing Link
To edit an existing link:

1 In the Layout browser, right-click an existing part in the station.
2 Select the option Link to Geometry and click Edit Link.

Deleting Link
To delete an existing link:

1 In the Layout browser, right-click an existing part in the station.
2 Select the option Link to Geometry and click Delete Link.

Updating Linked Geometry
To update a linked geometry:

1 In the Layout browser, right-click an existing part in the station, component
group or the station.

2 Select the option Link to Geometry and click Update Linked Geometry.
The update result is displayed in the output window.

Note

When you select a component group or a station, all linked geometries
within the group or station is updated. If the timestamp on the file is newer
than the timestamp stored in the station, all corresponding parts will be
updated from the source location.
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14.24 Modify Library Component

Modifying a library component
1 In the Layout browser, select the library you wish to modify.
2 Click Disconnect Library.
3 Select the library and then make any modifications to it.
4 Select the modified library, and then click Save As Library.
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14.25 Mechanism Joint Jog

Jogging the joints of a robot
1 In the Layout browser, select the robot.
2 Click Mechanism Joint Jog to bring up a dialog box.
3 Each row in the Jog Joints dialog box represents a joint of the robot. Jog

the joints either by clicking and dragging the bar at each row, or by using the
arrows to the right of each row.
Set the length of each step in the Step box.

The Mechanism Joint Jog dialog box

Move the joints of the objects by dragging the slider on the row
corresponding to each joint. Alternatively, click the buttons to
the right of the row, or type a value.

Joint

The current configuration value.Cfg

The current position of the TCP.TCP

Specify the length of the joint movements for each click of the
buttons to the right of each joint row.

Step

If the robot uses external axes, you can select an axis to jog
from this list. The external axes must belong to the same task
as the object you are jogging for occurring in this list. If no ex-
ternal axes are present in the same task, this list is not avail-
able.

External Axis

Select this check box to reposition the robot according to the
jogging of the external axis.

Lock TCP

For track-external axes the robot will reposition so that the TCP
is locked relative to the world coordinate system.
For positioner-external axes the robot will reposition so that
the position of the robot’s TCP is locked relative to the attach-
ment point of the positioner. The robot will move with the posi-
tioner the same way as when using multi-robot jog.
If no external axes are present in the same task, this check
box is not available.

Move the joint of the external axes by dragging the slider on
the row corresponding to each joint. Alternatively, click the
buttons to the right of the row, or type a value.

External axes joint

If no external axes are present in the same task, this check
box is not available.

Jogging a conveyor

Note

Using the following step, you can attach a workobject to the conveyor:
Click Workpiece source, right-click the part and then select Attach Workobject
and then click workobject.

1 In the Layout browser, click the Conveyor node.
2 Right-click Conveyor and then select Conveyor Jog.

The Conveyor Jog tab opens.

Continues on next page
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3 In the Conveyor Jog tab, click Connection and attached Workobject.
4 Move the slider to jog the conveyor.
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14.26 Mechanism Linear Jog

Jogging the TCP of a robot by using the Linear Jog dialog box
1 In the Layout browser, select the robot.
2 Click Mechanism Linear Jog to bring up a dialog box.
3 Each row in the Linear Jog dialog box represents a direction or rotation for

the TCP. Jog the TCP along the preferred direction or rotation, either by
clicking and dragging the bar at each row, or by using the arrows to the right
of each row.

4 From the Reference list, you can select the coordinate system that you want
to jog the robot relative to.

5 In the Step box, specify the step movement per deg/rad.
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14.27 Mirror Path

The Mirror Path dialog box

Select this option to keep the existing path when mirroring.Duplicate

Select this option to remove the existing path after mirroring.Replace

Select the plane to mirror the path around with these options.
The plane is defined by the selected axes and position of the
reference coordinate system selected below.

X-Y, X-Z and Y-Z

Select the frame or coordinate system to define the mirror plane
in.

Reference

To use another frame than any of the predefined ones, select
Select Frame from the list and specify the frame in the box
below.

If Select Frame is used as Reference frame, specify the frame
to use here by first clicking in the box and then selecting the
frame from the graphics window or the Layout browser.

Select Frame

Select one of these options to mirror the orientation of the tar-
gets. When any of these are selected, the robot will approach
the targets in a mirrored way.

Flip axis X/YZ

The axis you select will change the most for achieving the
mirrored orientation, while the other one will be kept as near
to its current direction as possible.
The axis that is set to the robot’s approach vector cannot be
selected.

Select this option to keep the orientation of the targets. When
selected, the robot will go to the mirrored position, but approach
the target from the same direction as for the original target.

Keep orientation

Select this option to also mirror the robot axis configuration
for the targets. Selecting this option will mirror the robot’s mo-
tions completely.

Mirror Robot Configura-
tion

For using this option, the following conditions must be met:
• The Reference frame must be set to Baseframe.
• The Mirror plane must be set to X-Z.
• The tool of each move instruction must have its TCP in

the X-Z plane of tool0.
• All targets in the path must have robot axis configuration

set.
• The virtual controller must be running.

Click this button to show or hide the commands for naming
and location of generated targets and paths.

More / Less

Specify the name of the path that will be generated by the
mirroring here.

New path name

Specify a prefix for the targets that will be generated by the
mirroring here.

Target prefix

Specify the robot task in which the new targets and path shall
be created.

Receiving robot

Specify the work object in which the new targets shall be cre-
ated.

Receiving work object
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14.28 Mirror

Mirroring a part
1 In the Layout browser, select the part to mirror and right-click.
2 Select Mirror and then click one of the following options from the context

menu:

to create a new part..select...

around YZ planeMirror YZ

around ZX planeMirror ZX

around XY planeMirror XY

Note

The mirror feature is applicable only to objects of type body and part that contains
geometry. Parts and and bodies that are imported without geometry cannot be
mirrored. See Libraries, geometries and CAD files on page 41.
For information on mirroring a path, see Mirror Path on page 512.
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14.29 Modify Curve

Overview
The following table provides an overview of the generic content available in the
Modify Curve dialog box.

Extend a curve at any vertex with a straight line in the direction
of the curve’s tangent.

Extend

Join two or more curves into one. The original curves will be
deleted when joining curves.

Join

Project a curve onto a surface or a body, creating a new curve
on the target part.

Project

Reverse the direction of curves.Reverse

Split a curve in two bodies. Only open curves can be split.Split

Cut a segment of a curve between intersection or end points.Trim

Extending a curve with a straight line in the direction of the curve’s tangent
1 Click the Modify curve and then select Extend Curve from the drop down

menu.
The Extend Curve menu opens.

2 Click the curve you want to extend.
3 In the From start vertex and From end vertex boxes, type or select the

required length you want to extend the curve. In the graphics window a yellow
line displays a preview of the extension.

4 Click Apply.

Joining curves
1 Click the Modify curve and then select Join Curves from the drop down

menu.
The Join Curves menu opens.

2 Click the curves to join in the graphics window. The curves may be either
intersecting or adjacent to be joined.
The Selected curves list displays the curves that will be joined. To remove
a curve from the list, select the list entry and press the DEL key.

3 In the Tolerance box, enter a value. Adjancent curves whose end points lie
within the tolerance will be valid for the operation.

4 Click Apply.

Projecting curves on a surface
1 Click the Modify curve and then select Project Curve from the drop down

menu.
The Project Curves menu opens.

2 Click the curves to project in the graphics window.
Note that when you rest the pointer over the curve, the projection direction
is displayed. The project direction is always the negative Z direction of the

Continues on next page
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User Coordinate System. To change the projection direction, create a new
frame with the desired orientation and set it as user coordinate system.
The Selected curves list displays the curves that will be projected. To remove
a curve from the list, select the list entry and press the DEL key.

3 Click in the Target bodies list and then click the bodies to project on in the
graphics window. The bodies must be in the projection direction and be big
enough to cover the projected curves.
To remove a bodies from the list, select the list entry and press the DEL key.

4 Click Apply. A new curve will now be created in a new part, wrapped around
the surface of the selected bodies.

Reversing curves
1 Click the Modify Curve and then select Reverse Curve from the drop down

menu.
The Project Curves menu opens.

2 Click the curves to reverse in the graphics window.
Note that when you rest the pointer over a curve, the current direction of the
curve is displayed by yellow arrows.
The Selected curves list displays the curves that will be reversed. To remove
a curve from the list, select the list entry and press the DEL key.

3 Click Apply. The curves will now be reversed.

Splitting a curve
1 Click the Modify Curve and then select Split Curve from the menu to open

the tool.
2 Click the curve at the point to split at. Only open curves can be split.

Note that when you rest the pointer over the curve, point of the split is
highlighted. This point is affected by the current snap mode setting.

3 Click Apply. The curve will now be split to two separate curves in the same
part.

Trimming a curve
1 Click the Modify Curve and then select Trim Curve in the menu to open the

tool.
2 Click the curve segment to trim.

Trim only works on single curves with intersection points. If you want to trim
a curve that intersects with another curve, first join the two curves.

3 Click Apply. The selected part of the curve will now be removed.
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14.30 Modify External Axis

Modifying external axis positions in targets
1 Select the targets (one or several) you want to modify, either in the Layout

browser or in the graphics window. If you select several targets, the values
you specify will be applied to all selected targets.

2 Click Modify External Axis to bring up a dialog box.
3 Edit the values of the axis by performing any of the following:

DescriptionAction

In the Eax column, select the value of the external axis
you want to edit, and enter the new value.

Type a new position
value for an axis

Use the arrow buttons to the left of the Joint Values column
for jogging the axis. Then click the right arrow button
between the Joint values column and the Eax column to
transfer the current joint value to the Eax value.

Jog the axis to the new
position

4 Click Apply.

The Modify External Axis dialog box

Jog the joint of the external axis corresponding to each row by
clicking the < button.

<

Jog the joint of the external axis corresponding to each row by
clicking the > button.

>

Enter the axis value for the corresponding joint of the external
axis in the value box.

value box

With the arrow left button, you transfer the value from the Eax
box to the corresponding value box.

<-

With the arrow right button, you transfer the value from the
value box to the corresponding Eax box.

->

Specify the value of the corresponding joint of the external
axis.

Eax
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14.31 Modify Instruction

Modifying an instruction
1 In the Paths&Targets browser, select the instruction you want to modify. If

you want to apply the same properties to several instructions, press the
CTRL key and select them.

2 Click Modify Instruction to bring up a dialog box.
3 For move instructions, select joint or linear motion in the Motion type list.
4 In the Instruction Argument group, modify the values for the instruction.

For details about each argument, see the selected instruction in the RAPID
Reference Manual. For an overview of the arguments for move instructions,
see below.

5 When you have finished modifying, click Apply.
It is possible to change common move instruction parameters such as speed, zone
and tool without opening the edit instruction tool using the context menu. Right-click
any move instruction, then select Modify Instruction to access Speed, Zone or
Tool.

Arguments for move instructions
The table below is an overview of common arguments for move instructions. For
detailed information about the arguments, see the selected instruction in theRAPID
Reference Manual.

UseTo set the

\Concsubsequent instructions to be executed at once.

ToPointdestination target for the instruction target.

Speedspeed for the tool center point, the tool reorientation and ex-
ternal axes.

\Vvelocity of the TCP in mm/s directly in the instruction (it will be
substituted for the corresponding speed data).

\Ttotal time in seconds during which the robot moves (it will be
substituted for the corresponding speed data).

Zonesize of the generated corner path.

\Zposition accuracy of the robot TCP directly in the instruction
(the length of the path will be substituted for the corresponding
zone specified in the zone data).

\Tooltool used for the movement (the TCP of this tool will be posi-
tioned at the destination target).

\Wobjworkobject to which the robot position in the instruction be-
longs.
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14.32 Modify Mechanism

The Modify Mechanism dialog box
See The Modify Mechanism dialog box on page 343.
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14.33 Modify Tooldata

Modifying tooldata
1 In the Layout browser, select the tooldata you want to modify.
2 Click Modify Tooldata to bring up a dialog box.
3 In the Misc Data group:

• Modify the Name of the tool.
• Select if the tool is to be held by the robot in the Robot holds tool list.

4 In the Tool Frame group:
• Modify the Position x, y, z of the tool.
• Modify the Rotation rx, ry, rz of the tool.

5 In the Load Data group:
• Enter a new Weight for the tool.
• Modify the Center of gravity for the tool.
• Modify the Inertia for the tool.

6 In the Sync Properties group:
• In the Storage type list, select PERS or TASK PERS. Select TASK

PERS if you intend to use the tooldata in MultiMove mode.
• In the Module list, modify the module in which to declare the tooldata.

7 Click Apply.
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14.34 Modify Workobject

Modifying a workobject
1 In the Layout browser, select the workobject you want to modify.
2 Click Modify Workobject. to bring up a dialog box.
3 In the Misc Data group, modify the values for the workobject:

• Enter a Name for the workobject.
• In the Robot holds workobject list, select True or False. If you select

True, the robot will move the work piece instead of the tool.
• In the Moved by mechanical unit list, select the mechanical unit with

which the robot movements are coordinated. This setting is only valid
when Programmed has been set to False.

• In the Programmed list, select True or False. True means that the
workobject will use a fixed coordinate system, and False that a movable
coordinate system (that is, coordinated external axes) will be used.

4 In the User Frame group, do one of the following:
• Modify the user frame by entering values for the Position x, y, z and

the Rotation rx, ry, rz for the workobject. Click in one of these boxes,
and then click the position in the graphics window to transfer the values.

• Modify the user frame by using the Frame by points dialog box, see
Frame from Three Points on page 237 .

5 In the Object Frame group, do one of the following:
• Modify the object frame by selecting values for Position x, y, z and

Rotation rx, ry, rz for the workobject.
• Modify the object frame by using the Frame by points dialog box.

6 In the Sync Properties group, modify the values for the workobject:
• In the Storage type list, select PERS or TASK PERS. Select TASK

PERS if you intend to use the workobject in MultiMove mode.
• In theModule list, select the module in which to declare the workobject.

7 Click Apply.

Note

If you change the position of a workobject that is used in a program, you have
to synchronize the affected paths to the virtual controller; otherwise, the program
will not be updated.
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14.35 Move Along Path

Prerequisites
At least one path must have been created in the station.
A virtual controller must be running for the robot to move along the path.

Moving along a path
1 In the Paths&Targets browser, select the path to move along.
2 Click Move along path. In the graphics window, the robot will move along

the path.
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14.36 Move to Pose

Prerequisites
At least one joint position must be defined.
Only one mechanism may be selected at a time.

Moving to a pose
1 In the Layout browser, select one mechanism to move.
2 ClickMove to Pose and then click one of the available poses. In the graphics

window, the mechanism will move to the pose.
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14.37 Offset Position

Offset the position an item
1 Right-click the item you want to move.
2 Click Offset Position to bring up the Offset Position dialog box.
3 In the dialog box, select the reference coordinate system you want to use:

SelectIf you want to move the item

Localrelative to its own coordinate system

Parentrelative to the coordinate system of its
parent

Worldrelative to the coordinate system of the
station

UCSrelative to a user-defined coordinate sys-
tem

Target Reference Framerelative to a target reference frame
This option is available only for targets.

4 In the Translation X, Y, Z boxes, either type the offset, or select it by first
clicking in one of the value boxes and then clicking the point in the graphics
window.

5 Specify the Rotation for the item.
6 Click Apply.
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14.38 Place

Placing an item
1 Select the item you want move.
2 Click Place and then click one of the commands to bring up a dialog box.

ChooseIf you want to move the item

One Pointfrom one position to another without af-
fecting the orientation of the object.
Select the axes to be affected.

Two Pointsaccording to the relationship between a
start and a finish line.
The object will move to match the first
point, then it will rotate to match the
second point.

Three Pointsaccording to the relationship between a
start plane and a finish plane.
The object will move to match the first
point, then it will rotate to match the third
point.

Framefrom one position to a target or frame
position and simultaneously change the
orientation of the object according to the
frame orientation.
The position of the object changes accord-
ing the orientation of the to-point coordin-
ate system.

Two Framesfrom one frame of reference to another

3 Set the reference coordinate system you want to use.
4 Click the points in the graphics window to transfer values to the from-point

boxes to the to-point boxes. For detailed information, see the tables below.
5 Click Apply.

The Place Object by One Point dialog box

Select the reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the primary point
in the graphics window to transfer the values to the Primary
Point - From boxes.

Primary Point - From

Click in one of these boxes, and then click the primary point
in the graphics window to transfer the values to the Primary
Point - To boxes.

Primary Point - To

Select whether the translation is to be performed along the X,
Y or Z axis, or several of the axes.

Translate along these
axes

The Place Object by Two Points dialog box

Select the reference coordinate system to which all positions
or points will be related.

Reference

Continues on next page
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Click in one of these boxes, and then click the primary point
in the graphics window to transfer the values to the Primary
Point - From boxes.

Primary Point - From

Click in one of these boxes, and then click the primary point
in the graphics window to transfer the values to the Primary
Point - To boxes.

Primary Point - To

Click in one of these boxes, and then click the point on the x
axis in the graphics window to transfer the values to the Point
on X-Axis - From boxes.

Point on X-Axis - From

Click in one of these boxes, and then click the point on the x
axis in the graphics window to transfer the values to the Point
on X-Axis - To boxes.

Point on X-Axis - To

Select whether the translation is to be performed along the X,
Y or Z axis, or several of the axes.

Translate along these
axes

The Place an Object by Three Points dialog box

Select the reference coordinate system to which all positions
or points will be related.

Reference

Click in one of these boxes, and then click the primary point
in the graphics window to transfer the values to the Primary
Point - From boxes.

Primary Point - From

Click in one of these boxes, and then click the primary point
in the graphics window to transfer the values to the Primary
Point - To boxes.

Primary Point - To

Click in one of these boxes, and then click the point on the x
axis in the graphics window to transfer the values to the Point
on X-Axis - From boxes.

Point on X-Axis - From

Click in one of these boxes, and then click the point on the x
axis in the graphics window to transfer the values to the Point
on X-Axis - To boxes.

Point on X-Axis - To

Click in one of these boxes, and then click the point on the y
axis in the graphics window to transfer the values to the Point
on Y-Axis - From boxes.

Point on Y-Axis - From

Click in one of these boxes, and then click the point on the y
axis in the graphics window to transfer the values to the Point
on Y-Axis - To boxes.

Point on Y-Axis - To

Select whether the translation is to be performed along the X,
Y or Z axis, or several of the axes.

Translate along these
axes

The Place Object with Frame dialog box

Specify the name of the frame with which you want to place
the object.

Select Frame

The Place by Two Frames dialog box

Select the frame object (For example, Target, Workobject,
Tooldata or Frame) from this dropdown list to set the From
point of moving the object.

From

Select any of the frame object (For example, Target, Workob-
ject, Tooldata or Frame) from this dropdown list to set the To
point of moving the object.

To
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14.39 Protected Smart Component

You can protect a Smart Component from being edited. To protect the smart
component, right-click the smart component, and then click Protected. You can
also optionally specify a password that will be required to unlock the component
for edits.
For more information on protected smart components, see Protecting a Smart
Component from edits in the section Smart Component on page 284.

Note

Protecting a Smart Component in this manner is a way of hiding complexity, and
is not for providing security or securely protecting it.
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14.40 Remove Unused Targets

Removing unused targets
1 In the Paths&Targets browser, select either the Controller node or the Task

node from which you wish to remove the unused targets, and then click
Remove Unused Targets.

2 To the questionAre you sure you want to remove unused targets?, answer
Yes. All targets that not are used by any move instructions are now removed.
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14.41 Rename Targets

Renaming targets
1 In the Paths & Targets browser, select the targets to rename.

To rename all targets in one or several paths, select the paths that contain
the targets.

2 Click Rename targets to bring up a dialog box.
3 In the Target Prefix box, enter a text string to precede the target numbers.
4 Optionally, in the Increment box and the Start with box, change the

numbering series for the target names.
5 Optionally, in the Target Suffix box, enter a text string to follow the target

numbers.
6 Click Apply.
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14.42 Reverse Path

Both target sequence and move instructions are reversed in a way that corresponds
to recording the robot movements and playing the movie backwards. For example,
if the robot used a linear motion to move from a target, it will use a linear motion
to move to the target after the reversal.

xx050047

Note that the move instructions have changed together with the targets. For
example, in the original path, a joint motion was used to reach target 20 and a
linear motion to leave it. After the reversal there is a linear motion to the target and
joint motion from it.
Also, note that the joint target has been converted into an ordinary target; otherwise,
it would not be possible to program a linear motion to that position.

Note

Reverse path feature is available for paint events.
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14.43 Rotate

Rotating an item
1 Select the item you want to rotate.
2 Click Rotate to bring up a dialog box.
3 Select the reference coordinate system you want to use:

SelectIf you want to move the item

Worldabsolute in the coordinate system of the
station

Parentrelative to the coordinate system of its
parent

Localrelative to its own coordinate system

UCSrelative to the user-defined system

User defined axisrelative to an axis defined by two points

Target Reference Framerelative to a target reference frame
Note that this option is available only for
targets.

4 Specify the rotation of the item in the Rotate around x, y, z by first clicking
in one of the boxes, and then click the center position in the graphics window
to transfer the values.

5 If you have selected the coordinate system User defined axis, specify the
Axis start point x, y, z and the Axis end point x, y, z.

6 Specify the Rotation of the item and the axis around which the rotation is to
occur.

7 Click Apply.
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14.44 Rotate Path

Rotating a paths
1 In the Layout browser or the graphics window, select the paths to rotate.
2 Click Rotate path to bring up a dialog box.
3 In the Reference frame list, select the frame to rotate the paths around.

ToSelect

rotate around the station’s world coordinate systemWorld

rotate around the robot’s baseframeBaseframe

rotate around a frame or target that previously has been
set to User Coordinate System.

UCS

rotate around an existing target or frame other than the
listed ones. When using Select Frame, specify the frame
to rotate around further down.

Select Frame

4 If Selected frame was selected in the Reference frame list, specify a frame
or target in the text box by clicking in the box and then selecting the frame
in the graphics window.

5 With the Rotation axis options, select the axis of the frame to rotate around.
6 In the Rotation angle box, enter the rotation.
7 Click Apply.
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14.45 Set Local Origin

Setting the origin of the local coordinate system
1 If the object you want to modify is a library component, first disconnect it

from the library.
2 In the Layout browser or the graphics window, select the part to modify.
3 Click Set Local Origin to bring up a dialog box.
4 In the Set Local Origin dialog box, select the reference coordinate system

you want to use:

SelectIf you want to move

Localrelative to the part’s current local coordin-
ate system

Parentrelative to the coordinate system of its
parent

Worldabsolute in the coordinate system of the
station

UCSrelative to a user-defined coordinate sys-
tem

5 In the Position X, Y, Z boxes, either type the new position or, click to select
it in one of the value boxes and then click the point in the Graphics window.

6 Type the Orientation.
7 Click Apply.
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14.46 Set Normal to Surface

Setting the target orientation normal to a surface
1 In the Paths & Targets browser, select the target to modify.
2 Click Set Normal To Surface to bring up a dialog box.
3 On the Selection Level toolbar, set the selection level.

• To align the target to a specific surface, set the selection level to
surface.

• To align the target to a specific point at the surface, set the selection
level to part.

4 In the graphics window, click the reference surface. This will transfer the
name of the part or surface to the Surface box.

5 In the Approach Direction, click the button for the axis to be used as the
approach direction.

6 To set the distance between the surface and the target in the approach
direction, specify an Offset value.

7 Click Apply.
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14.47 Set Position

Positioning an item
1 Right-click the item you want to move.
2 Click Set Position to bring up the Set Position dialog box.
3 In the dialog box, select the reference coordinate system you want to use:

SelectIf you want to move the item

Localrelative to its own coordinate system

Parentrelative to the coordinate system of its
parent

Worldabsolute in the coordinate system of the
station

UCSrelative to a user-defined coordinate sys-
tem

Target Reference Framerelative to a target reference frame
This option is available only for targets.

4 In the Position X, Y, Z boxes, either type the new position, or select it by first
clicking in one of the value boxes and then clicking the point in the graphics
window.

5 Specify the Orientation for the item.
6 Click Apply.
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14.48 Tool Compensation

Offsetting a path to compensate for tool radius
1 In the Paths&Targets browser or the graphics window, select the path.
2 Click Tool Compensation to bring up a dialog box.
3 In the Distance box, enter the size of the compensation (normally, the tool

radius).
4 Using the Direction options, select whether the new path shall be on the

left or the right side of the current path.
5 Click Apply.

Note

Tool Compensation function supports only planar paths. In planar paths,
the targets are in the same plane. User will be notified when a selected
path is non-planar.
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14.49 Translate Path

Translating a path
1 In the Paths&Targets browser or the graphics window, select the paths to

translate.
2 Click Translate path to bring up a dialog box.
3 In theReference frame list, select the coordinate system to use as reference

for moving the paths.

ToSelect

move relative to the origin of the world coordinate systemWorld

move relative to the origin of the robot’s baseframeBase Frame

move relative to the origin of a frame or target that previ-
ously has been set to User Coordinate System.

UCS

move relative to the origin of an existing target or frame
other then the listed ones. When using Select Frame,
specify the frame to use further down.

Select Frame

move the path from one point to another without specify-
ing any coordinate system.

Point to Point

4 If Select frame was selected in the Reference frame list, specify a frame or
target in the text box by clicking in the box and then selecting the frame from
the graphics window.

5 In the Translation vector box, specify the distance to move the path along
the X, Y and Z axes of the reference frame.
Translation vector is applicable only if a reference frame is used. If Point to
Point is used as reference, specify the start and end points for the translation,
instead. To do this, click in one of the boxes for the point to specify and then
select the point in the graphics window, or type the coordinates of the point.

6 Click Apply.
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14.50 View Robot at Target

Viewing a robot at a target
1 Click View Robot at Target.
2 Select a target, either in the Paths&Targets browser or in the graphics

window.
3 The robot will be shown at each selected target whenever a target is selected.

By stepping through the targets in the browser, it will be easy to see how the
position of the robot changes.

4 To turn the function off, click the command again.
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14.51 View Tool at Target

Viewing a tool at a target
1 Click View Tool at Target and select the tool you want to view at the target.
2 Select a target, either in the Paths&Targets browser or in the graphics

window. You can also multiselect targets to show several copies of the tool.
A copy of the tool will be shown at the selected target. By stepping through
the targets in the browser, it is easy to see how the tool orientation changes.

3 To turn the function off, click the command and clear the check box.
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15 ScreenMaker tab
15.1 Introduction to ScreenMaker

What is ScreenMaker?
ScreenMaker is a tool in RobotStudio for developing custom screens. It is used to
create customized FlexPendant GUIs without learning Visual Studio development
environment and .NET programming.

Why use ScreenMaker?
A customized operator interface on the factory floor is the key to a simple robotic
system. A well-designed custom operator interface presents the right amount of
information at the right time and in the right format to the user.

GUI concepts

xx0800000226

A GUI makes it easier for people to work with industrial robots by presenting a
visual front end to the internal workings of a robotic system. For FlexPendant GUI
applications, the graphical interface consists of a number of screens, each
occupying the user window area (the blue box in the figure above) of the
FlexPendant touch screen. A FlexPendant screen is then composed of a number
of smaller graphical components in a design layout. Typical controls (sometimes
referred as widgets or graphic components) include buttons, menus, images, and
text fields.

Continues on next page
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A user interacts with a GUI application by:
• Clicking a button
• Selecting from a menu
• Typing a text in a text box
• Scrolling

An action such as clicking a button is called an event. Whenever an action is
performed, an event is sent to the GUI application. The exact content of an event
is solely dependent on the graphic component itself. Different components trigger
different types of events. The GUI application responds to the events in the order
generated by the user. This is called event-driven programming, since the main
flow of a GUI application is dictated by events rather than being sequential from
start to finish. Due to the unpredictability of the user’s actions, one major task in
developing a robust GUI application is to ensure that it works correctly no matter
what the user does. Of course, a GUI application can, and actually does, ignore
events that are irrelevant.
The event handler holds sets of actions to be executed after an event occurs.
Similar to trap routines in the RAPID program, the event handler allows the
implementation of application-specific logic, such as running a RAPID program,
opening a gripper, processing logic or calculating.
In summary, from a developer’s point of view, a GUI consists of at least two parts:

• the view part: layout and configuration of controls
• the process part: event handlers that respond to events

Modern GUI development environments often provide a form designer, a (What
You See Is What You Get ) WYSIWYG tool to allow the user to select, position and
configure the widgets. As for event handlers, typically the developer must use a
special programming language recommended by the development environment.

Note

ScreenMaker does not support Undo/Redo operations.

Continues on next page
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FlexPendant concepts

xx0800000228

Running Windows CE, the ABB FlexPendant has limited CPU power and memory
compared to a PC. A custom GUI application must therefore be placed in the
designated folders on the controller hard drive before being loaded. Once loaded,
it can be found in the ABB menu as seen in the figure above. Click the menu item
to launch the GUI application.
As the robot controller is the one actually controlling the robot and its peripheral
equipment by executing a RAPID program, a GUI application needs to communicate
with the RAPID program server to read and write RAPID variables and set or reset
I/O signals.
It is essential for RAPID programmers to understand that there are two different
levels controlling a work cell: an event-driven GUI application running on the
FlexPendant, and a sequential RAPID program running in the controller. These
reside on different CPUs and use different operating systems, so communication
and coordination are important and must be carefully designed.

Limitations
ScreenMaker supports English language when building the application in
RobotStudio. ScreenMaker Designer does not provide a localization tool. Therefore,
applications created with ScreenMaker display the same text specified at the design
time, regardless of the choice of language on the FlexPendant.
When Asian languages are used (Chinese, Japanese, Korean), these screens
display accurately only when the FlexPendant language matches with the the
ScreenMaker language. Otherwise empty markers will be displayed instead of text
characters.
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15.2 Development environment

Overview
This section presents an overview of the ScreenMaker development environment
for creating user screens.

en0900000584

DescriptionParts

Displays group of icons organized in a logical sequence
of functions. See Ribbon on page 543.

Ribbon1

Shows the active screen project and lists the screens that
are defined in the project. For more information, see
Managing projects on page 547.

Project explorer2

Layout to design the screen with the available controls.Design area3

Displays information about the events that occur during
ScreenMaker development.

Output window4

Displays a list of available controls. For more information.
see ToolBox on page 544.

ToolBox / Properties5

Contains the available properties and events of the selec-
ted control(s). The value of the properties can either be a
fixed value or a link to an IRC5 data or an Application
Variable. For more information, see Properties window on
page 546.
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Ribbon
The ScreenMaker tab contains groups of commands organized in a logical sequence
of functions that facilitates the user in managing ScreenMaker projects. The tab
consists of the following groups:

Functions used forGroup

Managing a ScreenMaker project. See Managing projects on
page 547.

Project

Adding screen and application variables. See Managing screens
and Managing application variables on page 566.

Add

Building a project. See Building a project on page 559.Build

Connecting and deploying to the controller. See Connecting
to controller on page558 andDeploying to controller on page559.

Controller

Also for opening the Virtual FlexPendant.

Re-sizing and positioning the controls on the design area. See
Arrange on page 543.

Arrange

Detecting problems in the project and providing a diagnostic
solution. See ScreenMaker Doctor on page 570.

Diagnosis

Closing a project.Close

Arrange
This toolbar displays icons for resizing and positioning controls on the design area.
The icons are enabled once you select a control or group of controls on the design
area.

en0900000592
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ToolBox
ToolBox acts a container for holding all the available controls that can be placed
on a screen.

en0900000407

The following table displays the GUI controls that can be dragged to the design
area.

DescriptionControl

Allows to run a list of actions when either a signal or rapid data
changes

ActionTrigger

Represents an analog value in a barBarGraph

Represents a control that can be clicked.Button
Provides a simple way to trigger an event, and is commonly
used to execute commands. It is labeled either with text or an
image.

Allows multiple selections from a number of options. They are
displayed as a square box with white space (for unselected)
or as a tick mark (for selected).

CheckBox
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DescriptionControl

Represents a control that enables to select items from a listComboBox
Combination of a drop-down list and a textbox. It allows you
to either type a value directly into the control or choose from
the list of existing options.
It is not possible to add I/O signals to the combobox/listbox
control.

Provides a menu system for a ScreenFormCommandBar

Allows to define conditions while defining action triggers. An
action is triggered, if there is any change in value of the data
bound.

ConditionalTrigger

Displays the mode of the Controller (Auto - Manual)ControllerModeStatus

Represents a text box control that can be used to edit the data.DataEditor

Represents a control that plots data with lines or bars.Graph

Represents a Windows control that displays a frame around a
group of controls with an optional caption.

GroupBox

Is a container used to group a set of graphic components. It
usually has a title at the top.

Displays a two states value, like a Digital Signal.LED

Represents a control to display a list of items.ListBox
Allows the user to select one or more items from a list con-
tained within a static, multiple line text box.

Represents a text box control that can be used to edit a number.
When the user clicks it, a Numpad is opened.

NumEditor

It is not recommended to add a NumEditor in a container con-
trol.

Represents a spin box that displays numeric values.NumericUpDown

Used to group collection of controls.Panel

Represents a picture box control that displays images.PictureBox

Allows to select only one of a predefined set of options.RadioButton

Displays the execution status of the Controller Rapid Domain
(Running - Auto)

RapidExecutionStatus

Represents a Windows button control that calls a RapidRoutine
when clicked

RunRoutineButton

Displays and lets change a two states value, like a Digital
Output Signal.

Switch

Manages a set of tab pages.TabControl

Very commonly used widget that displays text, a label is usually
static, that is, it has nointeractivity. A label generally identifies
a nearby text box or other graphic component.

TpsLabel

Used to change the values of RAPID variables or Application
variables.

VariantButton

Note

For more information on using these controls and their properties, see the section
Development environment on page 542 and the chapterUsing the FlexPendant
SDK of the Application manual - FlexPendant SDK.
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Properties window
A control is characterized by its properties and events. Properties describe the
appearance and behavior of the component, while events describe the ways in
which a control notifies its internal state change to others. By changing the value
of a property, the controls have a different look and feel, or exhibit different behavior.

en0900000408

DescriptionElement

Displays the selected component, and lists the
available components of the active design
screen.

Graphical component name panel1

en0900000409

Properties window toolbar2

1 Organizes table panel in categories
2 Organizes table panel alphabetically
3 Displays Properties in table panel
4 Displays Events in table panel

Displays all the properties or events in two-
columns. The first column shows the property
or event name, the second shows the value of
the property or name of the event handler.

Table panel3

Display information about a property or event.Information panel4
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15.3 Working with ScreenMaker

15.3.1 Managing projects

Overview
This section describes how to manage projects in ScreenMaker. A complete cycle
includes creating, saving, building, connecting, and deploying a ScreenMaker
project.
You can manage a project (create, delete, load, or save) either from the
ScreenMaker ribbon or the context menu.

Creating a new project
ScreenMaker does not support Unicode characters. Hence, do not use these
characters when you create a ScreenMaker project.
Use the following procedure to create a new project:

1 Click New from the ScreenMaker ribbon or right-click Project context menu
and select New Project.
The New ScreenMaker Project dialog box appears.

Note

You can create a new project either from ScreenMaker installed templates
or ScreenMaker custom templates.

2 To create a new project from the ScreenMaker installed templates,
a Click Simple Project.
b Enter a name and specify the location for the new project. By default,

the new project is saved on C:\My Documents\RobotStudio\My
ScreenMaker Projects.

c Click OK.
d A screen MainScreen(main) is added in the tree view.

3 To create a new project from the ScreenMaker custom templates,
a Click Basic, Standard, or Extended.
b Enter a name and specify the location for the new project. By default,

the new project is saved on C:\My Documents\RobotStudio\My
ScreenMaker Projects.

c Click OK.

Note

• If you select the templateBasic, a project with two screens are created.
• If you select the template Standard, a project with four screens are

created.
• If you select the template Extended, a project with six screens are

created.
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Loading a project or template
Use this procedure to load an existing project or an existing template:

1 Click Open from the ScreenMaker ribbon or right-click Project context menu
and select Open Project.
The Open Screen Project File dialog box appears.

WARNING

A warning message appears when you open an existing ScreenMaker
project where the FlexPendant SDK version is different from the version
the project was created.

2 Browse to the location of the project file or template file to be loaded and
click Open.

Note

You can also load an existing project using a quick access method.
1 Click Recent from the ScreenMaker ribbon or right-click Project context

menu and select Recent Projects.
2 Select the project file from the list of most recently opened projects.

Saving a project
To save a project or template, follow this step:

• Click Save from the ScreenMaker ribbon or right-click Project context menu
and select Save.

To save the existing project or template with a new name, follow this step:
• Click SaveAs from the ScreenMaker ribbon or right-click Project context

menu and select SaveAs.

Note

• Project files are saved with the extension *.smk.
• Template files are saved with the extension *.smt.

SaveAs FlexPendant Project
To save the ScreenMaker project as a FlexPendant project, in the project context
menu, click SaveAs FlexPendant Project.
The project is saved with the extension *.csproj which can be opened using
Microsoft Visual Studio 2008.
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Designing screens
This section describes adding, copying, renaming, deleting, and editing a screen.

Overview
The Form designer is a tool to edit or design a screen. It allows you to design the
screen with the required controls and the design area resembles a FlexPendant
screen.

Editing a screen
To edit a screen, follow these steps:

1 Drag a control from the toolbox and drop it on the design area.
The Properties window displays all the properties of the control.

2 Select the control and resize or reposition for configuration.

Note

You can either select a single control or multiple controls:
• Single control : Left-click the control on the design area or select the

control from the list in the Properties window.
• Multiple controls: Left-click on the design area, drag the mouse and

create a window selecting all the controls.

3 Click the smart tag on the upper right corner of the control to perform the
basic tasks of configuration. See Configuring data binding on page 567.

Note

You can perform additional configuration by editing the attributes in the
Properties window. See Properties window on page 546.

Using ScreenMaker controls
This section describes building the GUIs using the following controls from the
ToolBox.

ActionTrigger
An action trigger initiates an event, such as making a hidden object visible when
an action is performed using a control. It allows to run a list of actions when the
property value changes. The property value can be bound to a signal, rapid data,
or application variable.
ActionTrigger control can also be used to invoke the application from RAPID.
Use this procedure to add an ActionTrigger control::

Action

Drag an ActionTrigger control from the ToolBox on to the design area.1
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Action

You can modify the name, set the default value and configure data binding value
for a ActionTrigger control.

• To set the values of a property, see Properties window on page 546.
• You can set the trigger event for an ActionTrigger to any of the event handler

created either from a control or from an Events Manager option.
• To configure the data binding values, see Configuring data binding on

page 567.
• To set the application variables, see Managing application variables on

page 566.

2

Note

An action is not triggered when the screen is launched for the first time, but is
triggered when there is a difference in the bound value at any point of time. This
functionality is supported only in RobotWare 5.12.02 or higher.

Example: Consider a signal being bound to the value property. The value of the
signal changes at runtime on performing a specific action. The event handler
configured for ActionTrigger control gets triggered based on this signal value
change.

TpsLabel
TpsLabel is a standard Windows label that displays a descriptive text.
Use this procedure to add a TpsLabel control:

ActionStep

Drag a TpsLabel control from the ToolBox on to the design area.1

You can set the values, setup events, configure data binding values and set the
application values for a TpsLabel control.

• To set the values of a property, see Properties window on page 546.
• To set up the events, see Defining Events on page 554.
• To configure the data binding values, see Configuring data binding on

page 567.
• To set the application variables, see Managing application variables on

page 566.

2

You can set the option Allow Multiple States to true and change the property.
1 Click Allow Multiple States. The StatesEditor dialog box appears.
2 Click the check-box Allow Multi-States, select the properties to change from

Properties For States and click OK.

3

The controls Button, PictureBox, and TpsLabel support AllowMultipleStates. For
more information on how to use AllowMultipleStates, see Picture object and
changing images due to I/O on page 573.

Panel
Panel is used to group a collection of controls.
Use this procedure to add a Panel control:

ActionStep

Drag a Panel control from the ToolBox on to the design area.1

You can add a group of controls to a panel.2
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ActionStep

You can modify the name, set the default value and binding value for a Panel control.
• To set the values of a property, see Properties window on page 546.
• To set up the events, see Defining Events on page 554 .
• To configure the data binding values, see Configuring data binding on

page 567.
• To set the application variables, see Managing application variables on

page 566.

3

Note

Currently only EventHandler, CancelEventHandlers, and MouseEventArgs are
supported.

ControllerModeStatus
ControllerModeStatus displays the mode of the controller (Auto - Manual).
Use this procedure to add a ControllerModeStatus control:

ActionStep

Drag a ControllerModeStatuscontrol from the ToolBox on to the design area.1

You can set the values, setup events, configure data binding values, and set the
application variables for a ControllerModeStatus control.

• To set the values of a property, see Properties window on page 546.
• To set up the events, see Defining Events on page 554.
• To configure the data binding values, see Configuring data binding on

page 567.
• To set the application variables, see Managing application variables on

page 566.

2

You can select the image to be displayed when the controller is in Auto mode and
in Manual mode.

• Click AutoImage in the Properties window and browse to select the image
to be displayed in Auto mode.

• Click ManualImage in the Properties window and browse to select the image
to be displayed in Manual mode.

3

RapidExecutionStatus
RapidExecutionStatus displays the execution status of the Controller Rapid Domain
(Running - Auto). This control is used
Use this procedure to add a RapidExecutionStatus control:

ActionStep

Drag a RapidExecutionStatus control from the ToolBox on to the design area.1

You can set the values, setup events, configure data binding values, and set the
application values for a RapidExecutionStatus control.

• To set the values of a property, see Properties window on page 546.
• To set up the events, see Setup Events.
• To configure the data binding values, see Configuring data binding on

page 567.
• To set the application variables, see Managing application variables on

page 566.

2
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ActionStep

You can select the image to be displayed when the Program is running and is
stopped.

• Click RunningImage in the Properties window and browse to select the image
to be displayed when the Program is running.

• Click StoppedImage in the Properties window and browse to select the image
to be displayed when the Program is stopped.

3

RunRoutineButton
RunRoutineButton represents a Windows button that calls a RapidRoutine when
clicked.

Note

To call a routine containing movements, you are not recommended to use the
RunRoutine Button control. Instead use a normal button control to call a Trap
routine. In the Trap routine, use instructions such as StopMove, StorePath,
RestorePath and StartMove to control the movements of the robot.

Use this procedure to add a RunRoutineButton control:

ActionStep

Drag a RunRoutineButton control from the ToolBox on to the design area.1

Click the smart tag on the RunRoutineButton and select one of the following Run-
RoutineButtonTasks.

• Define Actions before calling Routine
• Select Routine to call
• Define Actions after calling Routine

2

Click Define Actions before calling Routine to define an action/event before calling
the routine.

3

The Events Panel dialog box appears.

Click Define Actions after calling Routine to define an action/event afterre calling
the routine.

4

The Events Panel dialog box appears.

Click Select Routine to call.5
The Controller Object Binding dialog box appears.

In the Properties window, set the value for the following properties:
• RoutineToCall - Set the routine to be called. Indicates the RAPID Routine

that will be called when this button is pressed.
• AllowInAuto - Set to True or False. Indicates if the routine could be called

in the Auto mode.
• TextAlign - Set to MiddleLeft and MiddleCenter. Indicates the text alignment.

Note the following restrictions:
• You cannot bind RunRoutineButton to built-in Service routines.
• Only user defined procedures with no arguments can be bound.
• Set the PP to task before performing action through RunRoutineButton.

6
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CommandBar
CommandBar allows you to add menu items in a controlled and organized order.
Use this procedure to add menu items to the CommandBar control:

ActionStep

Drag a CommandBar control from the ToolBox on to the design area.1
The CommandBar appear at the bottom of the screen.

Click the smart tag on the CommandBar and select Add/Remove Items.2
The MenuItem Collection Editor window appears.

Click Add.3
A new menu item is added and its properties are displayed which can be edited.
Note that while editing the menu item, ensure that the property Text is filled. If not,
nothing appears on the CommandBar.

To remove the menu item, select the menu item and Click Remove.4

Click Close to close the MenuItem Collection Editor window.5

To add an event to a menu item, for example menuItem1 on the command bar,
use this procedure:

ActionStep

Go to the Properties window and select menuItem1 from the drop-down list.1

Click Events icon and then double-click the Click event. This opens the Events
Panel dialog for the Click event.

2

Click Add Action from the Events Panel dialog. This opens a sub-list of actions.3

Click an action from the sub-list of actions to add it to menuItem1's Click event.4

Note

ScreenMaker does not support the FlexPendant controls feature to add sub menu
items on CommandBar.

VariantButton
The VariantButton control is a simple button control with additional features and
properties. Using this control, you can change the values of RAPID or Application
variables.
Use this procedure to add the VariantButton control:

ActionStep

Drag a VariantButton control from the ToolBox on to the design area.1

You can perform the following VariantButton tasks from the SmartTag:
• Define Actions before value change
• Define Actions after value change

2
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ActionStep

You can set the following VariantButton specific properties from the Properties
window:

• Select Increment or Decrement from Behavior drop down. The default beha-
vior of VariantButton is Increment.

• Select StepRate and set the rate at which the value must be varied.
• Select DataType to which the value should be bound and set the value

property of the selected datatype.
Supports only the RAPID datatypes,Num and Dnum. For more information on data
binding, see Configuring data binding on page 567.

3

You can also perform the following common tasks from the Properties windows:
• Set BackColor, ForeColor, Location, and Size of the control.
• Select True or False from the Visible dropdown to hide or unhide the control.
• Select True or False from the Enabled drop down to enable or disable the

control.

4

ConditionalTrigger
The ConditionalTrigger button defines the condition while defining action triggers.
An action will be triggered if there is a change in the value of the data bound.
Use this prcodedure to add the ConditionalTrigger control:

ActionStep

Drag a ConditionalTrigger control from the ToolBox on to the design area.1

You can set the following ConditionalTrigger properties from the Properties window:
• Select the condition to execute from the Condition drop down. The following

are the supported conditions AND, OR, XOR, NOT, and EQUAL.
• Select True or False from the Enabled drop down to enable or disable the

control.
• Select LHS and RHS and bind the data value to Controller Object or Applic-

ation Variable. For more information on data binding, see Data binding on
page 567.

2

Defining Events
Event handler is a set of actions to be executed after an event occurs.
To set up an event, follow these steps:

1 Select the control for which the event handler is to be defined.
2 Open the Events Panel dialog box in any one of the following ways:

• Double-click the control.
• Right-click the control, select Events Manager, click Add enter the

name, and click OK and close.
• Click smart tag and select the task from the list.
• In the Properties window, click Events icon and select the desired

event from the list.
3 Click Add Action to add an action from a predefined list of actions.

The following table lists the set of predefined actions:
• Open Screen
• Close Screen

Screens
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• Set a Digital Signal
• Invert a Digital Signal
• Pulse a Digital Signal
• Read a Signal
• Write a Signal
• Reset a Digital Signal

Signals

• Read a Rapid Data
• Write a Rapid Data

RapidData

• Read and WriteApplication Variable
• Call another Action list
• Call .NET method
• Call Custom Action
• Call FP Standard View

Advanced

4 Select the action from the left window and perform the following:
• Click Delete to delete the action.
• Click Move Up or Move Down to change the order of execution of

actions.
5 Click OK

Deleting an event handler
To delete a user created event handler, do the following:

1 Right-click the control, select Events Manager. The Events Manager dialog
box appears.

2 Select the event handler to be deleted from the list and click Delete.

Advanced Actions

Call another Action List
Existing event handlers from Events Manager can be reused by other controls
while defining actions for event. You can call another event handler from an existing
event handler.
In the following example, listbox1_SelectedIndexChanged event handler is called
from comboBox1_SelectionIndexChanged event handler.
Select the Show warning message before performing actions check box to have
a warning displayed before you can perform these actions.

Call .NET Method
You can import the dlls and add references to the Advanced tab of the Project
Properties dialog box.
Once the references are defined, .NET methods appear in the Project Properties
dialog box and can be included in the Actions list which will be executed on
performing the desired action.
The .NET assembly supports only public static methods.
Double click the method and bind the return value to the application variable.
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Binding can be done only to the application variable. For more information, see
Application variable data binding on page 569.

Note

ScreenMaker allows you to call static methods of the public classes defined in
another DLL. This DLL is usually a class library or a control library. It has the
following limitations and the user should be aware of them while using .Net DLLs.

• DLL’s references must be in the same directory in order to load the DLL.
• ScreenMaker provides access only to the static methods which contain basic

data types such as string, int, double, boolean, object.

The following procedure provides information on creating a .NET assembly. This
assembly can be added as a reference to ScreenMaker Project and for performing
certain computations which are not directly possible using ScreenMaker or to call
methods of FlexPendant or PCSDK.
Use Visual Studio 2010 or above to create a .NET assembly.

1 Create a new project with Class Library as your template.
2 Create public static methods like the following.

namespace SMDotNetMethods

{

public class Methods

{

/// <summary>

/// Inverts a boolean value

/// </summary>

/// <param name ="Value">input boolean value</param>

/// <returns>inverted boolean value</returns>

public static bool InvertBool(bool value)

{

return (value == false);

}

/// <summary>

/// Increments a numerical value

/// </summary>

/// <param name="value">value to be incremented</param>

/// <returns>incremented value</returns>

public static double Increment(double value)

{

return (value + 1);

}

}

}

3 Build the project.
4 Use the assembly generated from this Class Library project.
5 Add it as a reference to the ScreenMaker project.
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Call Custom Action
You can add an user control to the ScreenMaker toolbox and call a custom method
for that control by defining it in the ScreenMaker.dll.config file.
Call Custom Action supports only the Graph control.

Call FP Standard View
Standard FlexPendant screens can be opened on any action performed on the
control. The standard FlexPendant screens include Rapid Editor, Rapid Data,
LogOff, Jogging, Backup and Restore.
For example, on button1_click, Rapid Editor view is opened.

Editing the property value
You can edit the property value of a control from the Properties window in three
ways:

1 By typing the numerics, strings and text. For example, Location, Size, Name
etc.

2 By selecting the predefined values from the list. For example, BackColor,
Font etc.

3 By entering the values in the dialog box. For example, Enabled, States,
BaseValue etc.

Deleting an event handler
To delete a user created event handler, do the following:

1 Right-click the control, select Events Manager. The Events Manager dialog
box appears.

2 Select the event handler to be deleted from the list and click Delete.

Modifying Project properties
Project properties define the properties of the ScreenMaker project, including how
the GUI is loaded and displayed in the FlexPendant.
Use this procedure to modify the project properties:

1 Right-click Project context menu and select Properties.
The Project Properties dialog box appears.

2 In the Display tab under Caption, enter the text in the Caption of the
Application field to edit the caption.
The updated caption appears in the ABB Menu on the right side.

3 In the Display tab under ABB Menu, select the following options,

DescriptionOption

application is visible to the left in the ABB Menu.Left

application is visible to the right in the ABB Menu.Right

application is not visible at all in the ABB Menu.None
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Note

The applications that uses the option None cannot be run on RobotWare
releases earlier than 5.11.01.

4 In theDisplay tab underABBMenu, browse and select theABBmenu image.
5 In the Display tab under TaskBar, browse and select the TaskBar image.

Note

By default, the Use Default Image and Use Menu Image checkbox is
enabled and the deafult image tpu-Operator32.gif is selected.

6 In the Display tab under Startup , select Automatic to load the screen
automatically at the Startup.

Note

By default, the start up type is Manual.

7 In theAdvanced tab underRun Settings, select Launch virtual FlexPendant
after deploying checkbox.
The virtual FlexPendant will be launched after deploying the ScreenMaker
project to the virtual controller.

Note

This feature is not applicable if connected to a real controller.

8 In the Project Properties dialog, select the General tab to view the project
properties which includes, Name, Assembly, Version and Path.
Version displays the specific versions of Controller and FlexPendant SDK
that the ScreenMaker project uses.

Connecting to controller
Use this procedure to connect to both real and virtual controllers:

1 Click Connect from the ScreenMaker ribbon or right-click Project context
menu and select Connect.
The Select a Robot Controller dialog box appears.

Note

Click the Connect dropdown from the ScreenMaker ribbon to directly
connect to the controller.
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2 Click Refresh to find a list of all the available controllers.

Note

By default, the currently connected controller is highlighted and has a small
icon before the row as an indicator.

3 Select the controller to be connected from the list and click Connect.
The connection status is displayed in the Project tree view.

To remove the connection with the controller, click Disconnect from the Project
context menu.

Building a project
The result from building the ScreenMaker project is a set of files including DLL file
and images. The ScreenMaker project can be compiled into binary format (.dll)
that can be deployed on a FlexPendant.
Use this procedure to build a project:

1 Click Build from the ScreenMaker ribbon or right-click Project context menu
and select Build
The result is displayed in the output window.

Deploying to controller
Use this procedure to deploy a ScreenMaker project to a real controller or virtual
controller:

1 Connect to the controller you want to deploy to. SeeConnecting to controller
on page 558.

2 ClickDeploy from the ScreenMaker ribbon or right-click Project context menu
and select Deploy Screen to Controller.
The Download dialog box appears displaying the progress of download. It
disappears once the download is successful.
The TpsViewxxxxxx.dll file is downloaded.

3 Restart the controller.

Note

• If a real controller is used, you can reboot the FlexPendant by moving
its joystick three times to the right, once to the left, and once towards
you.

• If a virtual controller is used, you can reboot the FlexPendant by closing
the virtual FlexPendant window.

Closing a project
To close a project, follow this step:

• Right-click Project context menu and select Close Project.
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Closing ScreenMaker
To close ScreenMaker, follow this step:

• Click Close ScreenMaker from the ScreenMaker ribbon.

Managing ScreenMaker Widgets

What is a widget
A widget is a visual building block, containing an information arrangement, which
represents an aspect of a robot application. It is a reusable and sharable user
interface building block which can help speed up the development of screens.
A ScreenMaker widget is similar in function to the widgets used in computer
programming. The widget is an element of a graphical user interface (GUI) that
displays an information arrangement which is changeable by the user. The widgets,
when combined in an application, hold data processed by the application and the
available interactions on this data.

Widget Workflow
Widget created from ScreenMaker can be used in ScreenMaker application and
in Production Screen application.
The following are the steps required to create a Widget in ScreenMaker.

1 Start RobotStudio.
2 Launch ScreenMaker.
3 Create a new Widget Project or open an existing widget project.

For information on how to create a new widget project, see Creating a
ScreenMaker widget project on page 561.

4 Connect to a real or a virtual controller, as required.
5 If required, change the widget properties, using theWidget Properties dialog

box.
For information on the Widget Properties dialog box, see Specifying widget
properties on page 564.

6 Drag-and-drop the necessary user interface components, as you would in a
normal ScreenMaker project.

7 Link the user interface properties to the IRC5 data or to the application
variables

8 Build the widget project. The widget component is created and saved in
...\Documents\RobotStudio\Widget Components folder.

Sample use case
Consider a case where you want to design a production screen which can do the
following:

• Display a graph
• Show alarms
• Show status of the controller
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To achieve this:
1 Create a new widget project in ScreenMaker and names it as, for example,

GraphWidget.
2 Drags-and-drop the graph control and other necessary controls on the widget

form.
3 Connect to a real or virtual controller, as required.
4 Bind the controls to the controller data.
5 Use the widget properties dialog box, to change the size of the widget.
6 Build the project
7 Download the output to the production screen.

You can then repeat the above steps to create widgets either in the same or in
different projects based on your need to show the alarms and the status of the
controller.

Creating a ScreenMaker widget project
1 On the ScreenMaker tab, clickNew. Alternatively, in the project context menu,

click New Project.
The New ScreenMaker Project dialog box appears.

2 Under Widget Templates, click Widget.
3 Specify a name for the widget project.

ScreenMaker widgets projects are by default stored in the
...\Documents\RobotStudio\Widget Projects folder.

4 Click Ok.
The widget project along with a screen MainScreen(main), appears in the tree
view. The widget project has .wzp file name extension. Widgets also appear in the
Toolbox.

Note

• You can open one widget project at any time. Close an open widget project
before opening a new one.

• A widget project has only one screen, the main screen, on which the widgets
are designed. All controls defined on a widget are considered as one widget.

• Widgets are loaded into the toolbox from a folder that contains the widget
component DLLs, from Additional Options folder under MediaPool and from
RobotApps Repository. If you delete the widget components from these
locations (...\Documents\RobotStudio\Widget Components), then
the widgets will not appear in the Toolbox.

Creating Production Screen Widget
ScreenMaker helps the user to create two types of widgets, Production Screen
widget and Standard widget. Controls in a widget can be bound to rapid or signal
data.
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The Production Screen option is a framework for creating a customized GUI that
can be used to present process data and status and execute FlexPendant
applications.
To run widgets on the Production Screen, FlexPendant Interface option must be
selected. For more information on Production Screen. Use the following procedure
to create the Production Screen widget.

1 In the Screenmaker ribbon, select New. The New Project dialog opens
2 Select Widget Template to create a new widget project.
3 Drag and drop controls to the widget.
4 Select Widget Properties, Widget Properties dialog opens.
5 Under Type, click Production Screen and click OK.
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6 Build the project.

xx1400000275

The ProductionSetup.xml file must be updated with widget details to view the
widget that was created in the Production Screen. You can findProductionSetup.xml
under $System\HOME\ProdScr and Widget components under
$System\HOME\ProdScr\tps.
An example of widget detail is provided here:

<Widget>

<Name>Widget_9</Name>

<Page>1</Page>

<Assembly>Widget_9.dll</Assembly>

<Type>Widget_9.Widget_9</Type>
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<Position>

<X>1</X>

<Y>2<Y>

</Position>

<ZIndex>1</ZIndex>

<Bindings>

<Binding PropertyName ="led1.Value" BindingType="SIGNAL"
DataName="MOTLMP" />

<Binding PropertyName ="button1.Text" BindingType="RAPID"
DataName="T_ROB1/BASE/wobj0" />

</Bindings>

</Widget>

The production screen provides the flexibility to modify bindings of the widget.
This is provided under Bindings tag as shown here:

<Bindings>

<Binding PropertyName ="led1.Value" BindingType="SIGNAL"
DataName="MOTLMP" />

<Binding PropertyName ="button1.Text" BindingType="RAPID"
DataName="T_ROB1/BASE/wobj0" />

</Bindings>

Specifying widget properties
To specify the properties of a widget project, right-click a widget project, and then
click Properties. The Widget Properties dialog box appears.
You set and modify the following in the properties for the widget project:

• Name of the project
• Size of the widget - x,y (in mm)
• Select the type of Widget

- Production Screen: The Widget can be used with Production Screen
environment

- ScreenMaker: The Widget can be used with ScreenMaker applications

Modifying Binding Information of Widget
Use this option to modify the binding information of widget. When a widget is built
from the Widget Project, an xml file is created. This xml contains widget details
and binding information. This entry must be vailable in the Production.xml file to
work with the Production Screen Environment .

<Bindings>

<Binding PropertyName ="meter1.Value" BindingType="IO"
DataName="aoMeterSignal" />

<Binding PropertyName ="meter1.Title" BindingType="RAPID"
DataName="Flow1Title" />

</Bindings>

It is possible to create, use and modify the bindings of a widget created from
ScreenMaker and to view the results in Production Screen and in ScreenMaker
application environment.
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Building and Deploying
The output of the Widget Project is a single Widget Component dll file, for example,
TpsViewMyWidget.dll. The widgets built from the Widget Project are used in the
ScreenMaker project. Widgets cannot be deployed to the controller from
ScreenMaker. If Widgets are used in ScreenMaker projects, it gets deployed.
When the ScreenMaker project which uses a widget is built, the widget component
is added as a reference to the project.
When the ScreenMaker project output is deployed to the controller, the referenced
widget components are also copied to the system HOME folder.
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15.3.2 Application variables

Overview
Application Variables are variables defined inside a ScreenMaker application. An
application variable is similar to a RAPID variable. It supports the data types
supported by RAPID, such as num, dnum, string, tooldata, wobjdata, and so on.
An application variable’s definition includes its name, data type and initial value.
During the execution of the ScreenMaker application, an application variable has
a persistent value. It can store values coming from controller data or can be used
to write values to controller data. Therefore, it is like an intermediate persistent
variable which is used during RAPID execution along with other RAPID variables.

Managing application variables
To create, delete, and rename an application variable, follow these steps:

1 On the ScreenMaker tab, in the Add group, click Application Variables.
Alternatively, in the ScreenMaker browser, right-click the project, and then
click Application Variables.
The Project Application Variables dialog box appears.

2 Click Add and define the name, type and value of the new variable.
3 Select the variable, click Delete to delete a variable.
4 Select the variable, clickRename, enter the new name and clickOK to rename

a variable.
5 Click Close.

You can view the application variables related to a project listed in the Project
Application Variables dialog box. To filter and view the variables according to their
data types, use the Type list.

Note

For information on application variable data binding, seeData binding on page567.
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15.3.3 Data binding

Overview
Data binding is the mechanism that links a GUI property with an external data
source such that whenever the data source is updated the GUI property will be
updated automatically and vice verse. Databinding has the following three aspects:

• A unidirectional connection means that an update of the data source is
reflected by the GUI, or vice versa; a bidirectional connection means that
updates to either are reflected by the other.

• A temporal connection can be suspended and resumed at any time.
• A convertable connection negotiates between the different data types or

formats between the data source and the GUI property.
A screen has to be linked with data to be useful. There are two ways of linking the
data with the GUI properties:

• Controller object data binding on page 568
• Application variable data binding on page 569

Configuring data binding
Data binding can be configured in the following two ways:

Using smart tag
Smart tags perform basic configuration tasks like binding default GUI property with
controller data. The controls that either display or edit information normally have
a value property to represent the information. Smart tag binds the value to the
controller object.

• On the design area, select the control and click the smart tag. The tasks
menu appears.

to...Click...

bind data to a Controller Object.Bind Value to a Controller Ob-
ject For more information, see Controller object data binding

on page 568.

binding data to a application variable.Bind Value to an Application
Variable For more information, seeApplication variable data binding

on page 569.

Using Binding menu
1 On the design area, select the control.
2 In the Properties window, locate the row from the table for binding the value.
3 Select the property and click the list to display the Binding menu.

to...Click...

removes the existing data binding.Remove actual binding

select available data in the controller for binding.Bind to a Controller object
For more information, see Controller object data binding
on page 568.
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to...Click...

select available data in project temporary data store for
binding.

Bind to an Application variable

For more information, seeApplication variable data binding
on page 569.

Configuring data binding for different controls
Almost all the controls defined in the toolbox (except ComboBox and ListBox) have
the following two options for binding values:

• Bind to a Controller Object
• Bind to an Application Variable

Binding to an array can be done with the following controls:
• DataEditor
• ComboBox
• ListBox

DescriptionControl

The default index value is 1. DataEditor is designed in such a way
that the default value of the Rapid array starts with 1 and not 0.

DataEditor

The default index value is -1. You can enter the appropriate index
value but cannot bind to a controller object or an application
variable.

ComboBox and ListBox

Note the following:
• You can limit the number of items to be displayed in the

ComboBox and ListBox of an array.
• While using a ComboBox, a RAPID index starts with 1 (1

specifies the first element) and the ComboBox index starts
with 0( 0 specifies the first index).

• When adding items to the ListBox or ComboBox control,
it is not possible to add I/O signals.

For more information on RAPID array, see What is RAPID array on page 574.

Controller object data binding
Controller object data binding lets you to select the data in the controller for binding.
Use this procedure to set up a binding with controller objects:

1 Select Bind to a Controller Object either using smart tag or binding menu.
The Controller Object Binding dialog box appears.

2 In the Type of Object group, select either Rapid data or Signal data.
3 In the Shared group, select Built-in data only to access shared Rapid data.

When you select Built-in data only, the option Signal data and the text box
Module are disabled.

4 If you select Rapid data, from the Scope group, select a task and module
from the list.
When you select Signal data, the Scope group is disabled.

5 In the See list, select the desired data.
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Note

ScreenMaker supports binding to only constant and persistant variables. The
variables must not be declared LOCAL. TASK PERS is supported
For example, the following binding is supported:
PERS num n1:=0;

TASK PERS num n2:=0;

CONST num n3:=0;

The following binding is not supported:
LOCAL PERS num n1:=0;

VAR num n1:=0

Application variable data binding
Application variables are used for data binding in the same way as controller data.
See Controller object data binding on page 568.
Use this procedure to set up a binding with application variables:

1 Select Bind to an Application Variable either using smart tag or binding
menu.
The Application Variables Bind Form dialog box appears.

2 Select an application variable and the field to connect.
3 Click Setup Variables to manage the variables.

The Project Application Variables dialog box appears. See Managing
application variables on page 566.

4 Click OK.
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15.3.4 ScreenMaker Doctor

Overview
ScreenMaker Doctor is a diagnostic solution to detect problems in the ScreenMaker
project. It helps analyze the project and fix errors such as:

• Unused events
• Broken references, application variables, signals, modules, and Rapid data
• RunRoutine issue

Using ScreenMaker Doctor
Use this procedure to launch ScreenMaker Doctor, detect and report issues, and
to view causes and solutions:

1 In the ScreenMaker ribbon, click ScreenMaker Doctor.
The ScreenMaker Doctor Wizard opens.

2 Click Next.
The wizard starts detecting issues and are reported as Completed Checks.
The detected issues are categorized as:

• Broken References
• Unused Events
• Broken ApplicationVariables
• Broken Signals
• Broken Modules
• Broken RapidData
• RunRoutine issue
• Broken Routine
• Other Dependencies

3 Click View Causes and Solutions to generate a report.
The left hand side of the report displays issues under each category and the
right hand side of the report displays the Probable Causes and Solutions for
the issues.
To check for issues again using the same instance, click Re-Detect Issues.

Note

In order to detect the signal data and RAPID, ScreenMaker project should be
connected to the controller.

Errors fixed by ScreenMaker Doctor
The following sections show you how errors, which can be fixed by ScreenMaker
Doctor, may manifest.

Unused Events
The following sequence of actions will result in creating unused events.

1 Create a ScreenMaker project.
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2 Define events for the controls.
3 Define the events Button1_Click and Button2_Click for the controls

Button1and Button2 respectively.
4 Delete the control Button1. The event Button1_Clickwill still exist. An unused

event is created.
You can run ScreenMaker Doctor to detect and fix this error.

Broken Reference
The following sequence of actions will result in creating broken references.

1 Create a ScreenMaker project.
2 Define events for the controls.
3 Define the events Button1_Click and Button2_Click for the controls

Button1and Button2 respectively.
4 Define action ScreenOpen - Screen2 for the event Button1_Click.
5 Delete or rename the screen. A broken reference is created.

You can run ScreenMaker Doctor to detect and fix this error.

Broken Application Variables
The following sequence of actions will result in creating broken application variables.

1 Create a ScreenMaker project.
2 Add an Application variable to the project.
3 Rename or delete the Application variable. No error is reported.

An error is reported during the run time due to the broken application variable.
You can run ScreenMaker Doctor to detect and fix this error.

Broken Rapid Data/Signals
If rapid data is bound but not found in the controller connected in the ScreenMaker
project, then perform the following procedure:

1 Create a ScreenMaker project.
2 Connect to a controller.
3 Bind the properties of the controls with controller data.
4 Build the project and deploy it to the controller.

The application works.
5 Connect the ScreenMaker project to another controller and deploy the same

project.
The application produces errors in the FlexPendant.

6 Run ScreenMaker Doctor. It detects that RapidData is not found in the
controller, thereby suggesting to define the same.

Broken Modules
If modules are bound but not found in the controller connected in the ScreenMaker
project, then perform the following procedure:

1 Create a ScreenMaker project.
2 Connect to a controller.
3 Bind the properties of the controls with controller data.
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4 Build the project and deploy to controller.
The application works.

5 Connect the ScreenMaker project to another controller and deploy the same.
The application produces errors in the FlexPendant.

6 Run ScreenMaker Doctor.
It detects that the module in which the rapid data was defined is not found
in the controller, thereby suggesting to define the same. ScreenMaker doctor
also detects Hidden modules.

RunRoutine Issue
A check is made whether ScreenMaker.sys file is loaded on the controller or not.
An issue is detected if the system module is not loaded.
You can run ScreenMaker Doctor to detect and fix this error.
ASystem.NullReferenceException appears ifScreenMaker.sys entry is not available
in SYS.CFG file of robot system. To overcome this issue, add the following entry
underCAB_TASKS_MODULES in the SYS.CFG file and save and load the modified
file back into the robot system and then restart the robot system.
File "RELEASE:/options/gtpusdk/ScreenMaker.sys" -ModName

"ScreenMaker"\ -AllTask -Hidden
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15.4 Frequently asked questions

How to deploy manually to a Virtual Controller
If for any reason you wish to manually by-pass the Deploy button in RobotStudio
and the virtual controller, the following information describes what files are to be
moved.

Actions

Location of output files
The files that contain the FlexPendant application from ScreenMaker are found
(for example) in the bin directory under the My ScreenMaker Projects located in
the My documents directory of the user.
For example,MyDocuments\My ScreenMaker Projects\SCM_Example\binwhere
SCM_Example is the example ScreenMaker project.
The files in the bin directory are to be copied to a location where the Virtual
FlexPendant can read them during the start of the FlexPendant.

Location where the Virtual FlexPendant reads the files
The recommended location for manually copying the ScreenMaker output files is
the location of the virtual controller system.
If the system is created manually from System Builder, it is located in the My
Documents directory.
For example, My Documents\IRB4400_60_SCM_Example\HOME where
IRB4400_60_SCM_Example is the example controller system.
If the system is created by a Pack-and-Go and then restored, it is located in the
RobotStudio\Systems folder.
For example,
MyDocuments\RobotStudio\Systems\IRB4400_60_SCM_Example\HOMEwhere
IRB4400_60_SCM_Example is the example controller system.

Copy files
Copy the files from the ScreenMaker output to the Home directory of the virtual
controller system.
Restart the Virtual FlexPendant and the new application will be loaded.

Picture object and changing images due to I/O
The typical user objective is to have an image that changes when an I/O signal
changes, this is common for a digital input to affect the state on the FlexPendant.

Actions
This is accomplished by adding an image and allowing the image to have multiple
states.
Set AllowMultipleState to TRUE and set the Image state.
Create two states and add images for each state:
The Value property is extremely important. If binding to a digital input then there
are two states for the input, 0 and 1. Set the Value property to the value of the
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bound variable. 0 and 1 for digital input. It is also possible to bind to RAPID variables
and have multiple states and values for the values in the RAPID variable.
Set the SelectedStateValue property to bind to a controller object:

How to get radio buttons to show state when entering
The objective is to have two radio buttons that controls one digital output. When
the screen is loaded, the buttons should show the current state of the output.

Actions
Create a group or a panel and place the two radio buttons on the group or panel.
For button1, set the property default value to True and bind the property to the
value of the controller digital output signal.
For button2, do not do any changes.
When the screen is loaded, the state of the two radio buttons is established
correctly.

What is RAPID array
A RAPID array is a variable that contains more than one value. An index is used
to indicate one of the values.

Sample RAPID array
Consider the following RAPID code.
VAR string part{3} := ["Shaft", "Pipe", "Cylinder"];

Here, ‘part’ is a RAPID array which consists of three values. The index of the array
in part ranges from 1 to 3.
The index of a RAPID array should not be negative and should start with 1.

Screen navigation
Screen navigation in ScreenMaker follows a tree structure.
Consider the following example,

• To open screen A1, you first have to open Screen A
• To navigate from screen A1 to screen B1, you first have to close screen A1

and then Screen A and navigate from Main Screen through Screen B to
screen B1.

• Similarly, to navigate from screen B1 to screen C1, you first have to close
screenB1 andScreen B and then navigate fromMain Screen throughScreen
C to screen C1.
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15.5 Tutorial

15.5.1 Overview

About this chapter
This chapter is designed as a tutorial to take you through the steps involved in
designing a FlexArc Operator Panel.
The FlexArc Operator Panel is a simple arc welding cell, where the robots can
perform the following three different jobs.

DescriptionJob

Welding the partProduce

Service the welding gunService

Calibrate with bull’s eyeBull’s Eye

The FlexArc Operator Panel displays the following graphic elements:
• Controller Status (controller mode auto or manual and the RAPID execution

status)
• Part Status (number of produced parts, the average cycle time per part, and

a Reset button)
• Robot jobs (Produce, Service, and Bull’s Eye) and Robot locations (Robot

at home position, service location, calibration location, and part location)
• Start and Stop buttons
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15.5.2 Designing the FlexArc operator panel

Procedure
Use this procedure to design the FlexArc operator panel:

InformationAction

Select the following options,
• FlexPendant Interface
• PC Interface

For more information about creating
a system, seeCreating a system from
layout on page 228.

Create a system for the FlexArc operator panel.1

For more information on loading these
files, see Loading a configuration file
on page 398 and Loading a RAPID
module on page 453.

Load EIO.cfg and MainModule.mod files.2

By default:
• For Windows XP, the files can

be found at C:\Documents and
Settings\<user name>\My Doc-
uments\RobotStudio\My
ScreenMaker Projects\Tutorial

• ForWindows 7, the files can be
found at C:\Users\<user
name>\Documents\RobotStu-
dio\My ScreenMaker Pro-
jects\Tutorial
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InformationAction

The following signals are created after loading
EIO.cfg file

Connec-
tion

DescriptionTypeIO

Dl_Ro-
botAtHome
= DO_SIM-
HOME

Indicates robot
at home posi-
tion

DlDl_Ro-
botAtHome

Dl_RobotAt-
Bullseye =
DO_SIMBU-
LLS

Indicates robot
at bull's eye
position

DlDl_RobotAt-
Bullseye

Dl_RobotAt-
Service =
DO_SIM-
SERVICE

Indicates robot
at service posi-
tion

DlDl_RobotAt-
Service

Dl_PRO-
DUCE =
DO_PRO-
DUCE

Indicates robot
is producing
part

DlDl_PRO-
DUCE

Simulate robot
at home

DODO_SIM-
HOME

Simulate robot
at bull's eye

DODO_SIMBU-
LLS

Simulate robot
at service

DODO_SIM-
SERVICE

Simulate robot
is producing
part

DODO_PRO-
DUCE

Gl_JOB =
GO_JOB

The code of
ordered job

GlGl_JOB

Simulate job
order

GOGO_JOB

3

For more information about creating
a station, see New tab on page 211.

Create an empty station in RobotStudio with the
system created in the previous step.

4

For more information, see Launching
ScreenMaker on page 386.

Launch ScreenMaker from RobotStudio.5

For more informaton, see Creating a
new project on page 547.

1 Enter the project name as Flex-
ArcGUI, and save it in the de-
fault location, C:\Users\<user
name>\Documents\RobotStu-
dio\My ScreenMaker Pro-
jects\Tutorial.

2 A new tabMainScreenis added
to the Design Surface.

Create a new ScreenMaker project.6

To customize how the GUI should
appear on the FlexPendant, modify
the Project properties. For more in-
formation, see Modifying Project
properties on page 557.

Configure the Project properties.7
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InformationAction

For more information, seeConnecting
to controller on page 558.

Connect to the controller.8

The result appears in the output win-
dow.

Create application variables (temporary vari-
ables) and configure them with the following
data

ValueTypeName

0NumMyResetValue

1NumJobProduce

0NumJobIdle

2NumJobBulls

3NumJobService

9

For more information, seeManaging application
variables on page 566.

For more information, see Designing
the screen on page 580.

Design the Main Screen.10

For more information, see Building
and deploying the project on page586.

Build and Deploy the project.11

• In RobotStudio, press Ctrl+F5
to launch the virtual FlexPend-
ant.

• Click FlexArc operator panel to
launch the GUI.

Note

Ensure that you switch the controller
to Auto mode and start the RAPID
execution.

Open virtual FlexPendant and test the GUI12
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15.5.3 Designing the screen

Introduction to designing the screen
A major effort in the GUI project development is designing screens. The Form
designer in the ScreenMaker allows you to drag controls from the toolbox to the
design surface. Using the Properties window, you can resize, position, label, color,
and configure the controls.

Designing FlexArc Operator Panel screen
Use this procedure to design the FlexArc Operator Panel screen:

1 Drag a GroupBox control from the General category; place it on the design
surface and set the following values in the Properties window.

ValueProperty

14,45Location

150,100Size

Controller StatusTitle

LightGrayBackColor

2 Drag another GroupBox control from the General category; place it on the
design surface and set the following values in the Properties window.

ValueProperty

14,170Location

150,204Size

Part StatusTitle

LightGrayBackColor

3 Drag a ControllerModeStatus control from the Controller Data category; place
it in the Controller Status groupbox created and set the following values in
the Properties window:

ValueProperty

19,40Location

44,44Size

LightGrayBackColor

4 Drag a RapidExecutionStatus control from the ControllerData category; place
it in the Controller Status groupbox created and set the following values in
the Properties window:

ValueProperty

80,40Location

44,44Size

LightGrayBackColor

Continues on next page
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5 Drag a TpsLabel control from the General category; place it in the Part Status
groupbox created and set the following values in the Properties window:

ValueProperty

16,30Location

131,20Size

Parts ProducedText

LightGrayBackColor

TpsFont10Font

6 Drag a NumEditor control from the ControllerData category; place it in the
Parts Status groupbox created and set the following values in the Properties
window:

ValueProperty

16,56Location

116,23Size

Link to RAPID variable partsReady defined in the module
MainModule.

Value

7 Drag another TpsLabel control from the General category; place it in the Part
Status groupbox created and set the following values in the Properties
window:

ValueProperty

16,89Location

131,20Size

Cycle time/partText

LightGrayBackColor

TpsFont10Font

8 Drag another NumEditor control from the General category; place it in the
Part Status groupbox created and set the following values in the Properties
window:

ValueProperty

16,115Location

116,23Size

Link to RAPID variable cycleTime defined in the module
MainModule.

Value

9 Drag a Button control from the General category; place it in the Part Status
group box created and set the following values in the Properties window:

ValueProperty

33,154Location

85,34Size

ResetText

Continues on next page
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Perform the following for the Reset button in the Part Status group:

ActionStep

Double-click the button Reset. The Events Panel dialog box appears which
is used to define the actions for Events.

1

In the Events Panel dialog box, click Add Action; point to Rapid Data and
select Write a Rapid Data.

2

TheAction Parameters dialog box appears; assign Rapid data to the following
value and click OK.

• T_ROB1.MainModule.partsReady to MyResetValue.Value
Similarly, assign Rapid data to the following value and click OK.

• T_ROB1.MainModule.cycleTime to MyResetValue.Value
Two actions of similar type are needed to perform the Reset action. One is
to reset Rapid variable partsReady to 0, the other is to reset Rapid variable
cycleTime to 0.

10 Drag a PictureBox control from the General category; place it on the design
surface and set the following values in the Properties window:

ValueProperty

177,28Location

284,359Size

StretchImageSizeMode

FlexArcCell.GIFImage

Note

You can find the graphic (.GIF ) files at C:\MyDocuments\RobotStudio\My
ScreenMaker Projects\Tutorial\Images.

11 Drag another PictureBox control from the General category; place it on the
design surface and set the following values in the Properties window:

ValueProperty

237,31Location

48,48Size

StretchImageSizeMode

RobotAtHome.GIFImage

TrueAllowMultipleStates
Select Image property from the StatesEditor dialog box.

DI_RobotAtHomeSlectedStateValue

Link State{0} to RobotAtHome_gray.GIFStates
Link State{1} to RobotAtHome.GIF

Continues on next page
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Note

Add AllowMultipleStates option to the PictureBox control. The objective
is to have an image that changes when an I/O signal changes.
For more information on how to use AllowMultipleStates for PictureBox
control, see Picture object and changing images due to I/O on page 573.

12 Drag a Button control from the General category; place it on the design
surface and set the following values in the Properties window:

ValueProperty

486,66Location

116,105Size

StartText

TpsFont20bFont

LimeGreenBackColor

Link to DI_RobotAtHomeEnabled

Perform the following for the Start button:

ActionStep

Double-click the button Start or click the Smart tag and select Define Actions
when clicked. The Events Panel dialog box appears which is used to define
the actions for Events.

1

In the Events Panel dialog box, click Add Action; point to Rapid Data and
select Write a Rapid Data. The Action Parameters dialog box appears.

2

In theAction Parameters dialog box, assign Rapid data to the following value
and click OK.

• T_ROB1.MainModule.JobProduce to Job.

3

13 Drag a Button control from the General category; place it on the design
surface and set the following values in the Properties window:

ValueProperty

486,226Location

116,105Size

StopText

TpsFont20bFont

LimeGreenBackColor

Link to DI_PRODUCEEnabled

Perform the following for the Stop button:

ActionStep

Double-click the button Stop or click the Smart tag and select Define Actions
when clicked. The Events Panel dialog box appears which is used to define
the actions for Events.

1

In the Events Panel dialog box, click Add Action; point to Rapid Data and
select Write a Rapid Data. The Action Parameters dialog box appears.

2

Continues on next page
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ActionStep

In theAction Parameters dialog box, assign Rapid data to the following value
and click OK.

• T_ROB1.MainModule.JobIdle to JobIdle

3

14 Drag a Button control from the General category; place it on the design
surface and set the following values in the Properties window:

ValueProperty

274,246Location

111,47Size

Bull’s EyeText

TpsFont14bFont

Link to DI_RobotAtHomeEnabled

TrueAllowMultipleStates
Select BackColor property from the StatesEditor dialog
box

DI_RobotAtBull'sEyeSelectedStates

Link State{0} to RedStates
Link State{1} to Green

Perform the following for the Bull’s Eye button:

ActionStep

Double-click the button Bull’s Eye or click the Smart tag and select Define
Actions when clicked. The Events Panel dialog box appears which is used
to define the actions for Events.

1

In the Events Panel dialog box, click Add Action; point to Rapid Data and
select Write a Rapid Data. The Action Parameters dialog box appears.

2

In theAction Parameters dialog box, assign Rapid data to the following value
and click OK.

• T_ROB1.MainModule.JobBulls to JobBulls

3

15 Drag a Button control from the General category; place it on the design
surface and set the following values in the Properties window:

ValueProperty

274,324Location

111,47Size

ServiceText

TpsFont14bFont

Link to DI_RobotAtHomeEnabled

TrueAllowMultipleStates
Select BackColor property from the StatesEditor dialog
box

DI_RobotAtServiceSelectedStates

Link State{0} to RedStates
Link State{1} to Green

Continues on next page
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Perform the following for the Service button:

ActionStep

Double-click the button Service or click the Smart tag and select Define Ac-
tions when clicked. The Events Panel dialog box appears which is used to
define the actions for Events.

1

In the Events Panel dialog box, click Add Action; point to Rapid Data and
select Write a Rapid Data. The Action Parameters dialog box appears.

2

In theAction Parameters dialog box, assign Rapid data to the following value
and click OK.

• T_ROB1.MainModule.JobService to JobService

3
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15.5.4 Building and deploying the project

Procedure
1 From the ScreenMaker ribbon, click Build.

For more information on building the project, see Building a project on
page 559.

2 From the ScreenMaker ribbon, click Deploy.
For more information on deploying the project, see Deploying to controller
on page 559.

3 In RobotStudio, press Ctrl+F5 to launch the Virtual Flexpendant and click
FlexArc Operator Panel to open the GUI.

Note

Ensure that you start the RAPID execution and switch the controller into
Auto mode.
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A Technical support
Overview

Contacting ABB
If you have any questions or problems with your RobotStudio installation, please
contact your local ABB Robotics Service representative, see
http://www.abb.com/contacts.

Have the following in mind
1 Running the latest version of RobotStudio ensures that it works properly and

also includes improvements and new product functionality. ABB recommends
that you update to the latest version of RobotStudio whenever a new version
is available and before contacting ABB for support.

2 Provide a brief description explaining how to reproduce your problem.
3 Provide screenshots if applicable. (Use ALT + PRINT SCREEN to get an

image of the active window instead of the entire screen.)
4 Generate a Full Scan with the RobotStudio Support Tool available next to

RobotStudio in the Start menu. (Click Start > Programs > ABB Industrial IT
> Robotics IT > RobotStudio > RobotStudio Support Tool, then click on
Run Full Scan and then click Save Report. Save this report and attach it
with your problem description.

5 Provide us the following user information:
a name
b company
c contact information
d name of the operating system including the language details
e subscription ID of the purchased license
f Machine ID, see Help section of File tab

License support
For license-related questions, please contact the team responsible for license
support directly at softwarefactory_support@se.abb.com
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Index
A
ABB library, 226
action instruction

about, 32
Add Controller, 380
add to path, 483
Adjust Robtargets, 462
alerts

activate, 152
align frame orientation, 484
align target orientation, 485
Application grants, 429
Application Variables, 566

create,delete, rename application variables, 566
attach to object, 486
Authenticate, 409

Edit User Accounts, 409
Login as a Different User, 409
Log in as Default User, 409
Log off, 409
Log off all controllers, 409
UAS Grant Viewer, 409

auto configuration, 487
AutoPath, 248

B
Backup, 390

create backup, 390
Back up

restore backup, 392
browser

Layout, 53
Modeling, 56
Paths & Targets, 54

C
CAD file

troubleshoot and optimize, 96
check reachability, 489
collision

detection, 147
sets, 147

configuration
robot axis, 39

configuration editor, 396
instance editor, 397

configuration file, 202
configuration monitoring

about, 40
Configure data binding, 567

Using Binding menu, 567
Using Smart tag, 567

confJ
about, 40

ConfL
about, 40

Connecting a controller, 558
Controller grants, 427

Backup and save, 427
Calibration, 428
Delete log, 428
Edit RAPID code, 427
Execute program, 427
Full access, 427

I/O write access, 427
Manage UAS settings, 427
Modify configuration, 427
Modify controller properties, 428
Modify current value, 427
Program debug, 428
Read access to controller disks, 428
Safety Controller, 428
Write access to controller disks, 428

controller menu, 202
Controller Shutdown, 438
controller status window, 63

access, 64
controller name, 63
controller state, 63
logged on as, 64
operating mode, 63
program execution state, 63
system name, 63

controller system
create, 164

controller world coordinate system, 35
control panel, 437

enable device, 437
manual full speed, 437
motors on, 437
operation mode, 437
release device, 437
reset emergency stop, 437

convert frame to workobject, 491
coordinate systems, 33
cycle tme

measure, 153

D
data binding

Controller object data binding, 568
Data Binding, 567

Application variable data binding, 569
data declaration, 30
deployment package, 183
detach, 495
detecting collision, 148
device browser, 416

E
element

select, 76
event

create, 150
events, 383
external axis

program, 137

F
File transfer, 410

Controller explorer, 411
PC explorer, 411

FlexPendant Viewer, 412
frame

converting to workobject, 110
crerating by points, 110

Frame
create, 236
create from three points, 237

frames, 33
function, 30
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G
geometry

troubleshoot and optimize, 96
Go Offline, 417
Grants, about, 163
Grants, give to groups, 425
graphics window, 74
Group, about, 162
group, add, 424
group, add user, 423
group, remove, 425
group, rename, 424
Groups, give grants, 425

H
handle events, 205

date and time, 206
event category, 206
event code, 206
event description, 207
event log list, 205
event title, 206
event type, 205
manage events, 207
retrieve controller events, 207
sequential number, 206

I
I/O

set, 151
I/O system, 384

I/O signals, 198
input signals, 198
output signals, 198
simulated signals, 198
virtual signals, 198

import, 94
import geometry, 234
import library, 227
instruction, 30

about, 32
item

select, 76

J
jog

mechanism, 111
robot, 111
several mechanisms, 111

jog reorient, 269
jointtarget

creating, 112

K
keyboard shortcuts, 78

General commands, 78

L
Layout browser, 53
LED, 545
library

troubleshoot and optimize, 96
Load Parameters, 398
local coordinate system

set, 102
local origin

set, 102

M
Manage ScreenMaker project

Close ScreenMaker, 560
ScreenMaker Doctor, 16, 543, 570

Manage ScreenMaker Project, 547
Close project, 559
Create project, 547
Load project, 548
Save project, 548

Manage Screens, 549
Managing ScreenMaker Projects

Build project, 559
MediaPool, 29
Mirror, 513
Modeling browser, 56
Modify project properties, 557
module, 30
move instruction

about, 32
Move instruction

teach, 258
MoveJ

teach, 258
MoveL

teach, 258
MultiMove

programming workflow, 130

N
near-miss detection, 149
network security, 23
network settings, 159

firewall settings, 159
local network connection, 159
remote network connection, 159
service port connection, 159

O
object

select, 76
set local origin, 102
troubleshoot and optimize, 96

Offline and Online browser, 57
Online Monitor, 418
operator window, 65

enabling operator window, 65
show virtual operator window, 65

orientations, 117
align target, 119
copy and apply, 120
target normal to surface, 118
unordered, 117

output window, 62
event types, 62

P
part

set local origin, 102
Password, change for user, 423
path, 114

about, 32
compensating, 115
creating, 114
creating from curve, 114
reversing, 114
rotating, 115
setting axis configuration, 114
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translating, 115
Paths & Targets browser, 54
Placing an item, 524

Frame, 524
One Point, 524
Three Points, 524
Two Frames, 524
Two Points, 524

positioner.program, 137
procedure, 30
process time

measure, 153
program

copy, 141
programming

overview, 109
Program Pointer, 466
Properties, 414

Device Browser, 416
Renaming the controller, 414
Save System Diagnostics, 416
Set controller ID, 414
Set date and time, 414
View controller and system properties, 415

Properties Window
Event Help panel, 546
Graphical Component Name panel, 546
Properties window toolbar, 546
Table panel, 546

Property editor, 313

R
RAPID

concepts, 30
copy program, 141

RAPID Data Editor, 455
RAPID Editor, 446
RAPID instructions, 121
RAPID Profiler, 468
RAPID task, 458
RAPID Watch window, 472
reachability

test, 128
Relation, 400
Release Write Access, 408
remote subnet, 160
repository, 183–184
Request Write Access, 407
Restore, 392
robot

programming overview, 109
Robot system button, 228

adding an existing system, 229
adding a template system, 229
conveyor setup, 229
create system from layout, 228

RobotWare, 28
license key, 28

RobotWare system, 28
routine, 30
Run mode, 461

continuous, 461
single, 461

S
safety, 22
safety configuration, 405

set task frame, 439
Signal Analyzer, 366
signals

set, 151
simulate

alerts, 152
create event, 150
measure process time, 153
set signals, 151
TCP trace, 152

simulation, 145, 147
simulation control, 361
Simulation watch, 314

Break condition, 315
station

build workflow, 83
pan, 74
rotate, 74
zoom, 74

station world coordiante system, 33
Stopwatch, 365
switch, 545
synchronization, 140

station to VC, 140
VC to station, 140

system
create, 164
create with positioner, 179
RobotWare, 28

System Builder, 164, 394
about virtual and real systems, 164
building new system, 167
copying system, 175
create boot media, 178
create system from backup, 176
download a system to controller, 177
modify controller system, 171
viewing system properties, 166

System Configuration, 440
controller values, 440
stored station values, 441
used current station values, 441

system parameters, 199
editing parameters, 200
load parameters, 203
save system parameters, 202

T
target, 112

about, 32
creating, 112
modifying, 112
modifying with ModPos, 112
removing unused, 113
renaming, 112
teaching, 112

Targets on Edge, 245
TCP, 33
TCP trace

activate, 152
ToolBox

ActionTrigger, 544
BarGraph, 544
CheckBox, 544
ComboBox, 545
CommandBar, 545
ConditionalTrigger, 545
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ControllerModeStatus, 545
DataEditor, 545
Graph, 545
GroupBox, 545
ListBox, 545
NumEditor, 545
NumericUpDown, 545
Panel, 545
PictureBox, 545
RapidExecutionStatus, 545
RunRoutineButton, 545
TabControl, 545

Tool Center Point coordinate system, 33
tooldata, 101
tools, 101
TpsLabel, 545
track

program, 137
Transfer, 400
trap, 30

U
UAS Grant Viewer, 426
UCS, 38
unpack, 214
User, about, 162

User, add, 422
User, add to group, 423
User, change password, 423
User, change user name, 423
User, enable and disable, 423
User, remove, 423
User account, 421

User tab, 421
user coordinate system, 38

V
VariantButton, 545
viewpoint, 274

create, 274
move to viewpoint, 275
viewpoint functions, 274

Virtual FlexPendant, 436
Virtual FlexPendant operator window, 65

W
workobject

creating, 110
modifying, 110

WorkObject, 38
workobjects, 110
world coordinate system, 33
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Contact us

ABB AB, Robotics
Robotics and Motion
S-721 68 VÄSTERÅS, Sweden
Telephone +46 (0) 21 344 400

ABB AS, Robotics
Robotics and Motion
Nordlysvegen 7, N-4340 BRYNE, Norway
Box 265, N-4349 BRYNE, Norway
Telephone: +47 22 87 2000

ABB Engineering (Shanghai) Ltd.
Robotics and Motion
No. 4528 Kangxin Highway
PuDong District
SHANGHAI 201319, China
Telephone: +86 21 6105 6666

ABB Inc.
Robotics and Motion
1250 Brown Road
Auburn Hills, MI 48326
USA
Telephone: +1 248 391 9000

www.abb.com/robotics
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